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This book is primarily written for ecologists needing to analyse data resulting
from field observations and experiments. It will be particularly useful for
students and researchers dealing with complex ecological problems, such as
the variation of biotic communities with environmental conditions or the
response of biotic communities to experimental manipulation. Following a
simple introduction to ordinationmethods, the text focuses on constrained
ordinationmethods (RDA, CCA) and the use of permutation tests of statistical
hypotheses aboutmultivariate data. An overview of classificationmethods, or
modern regressionmethods (GLM, GAM, loess), is provided and guidance on
the correct interpretation of ordination diagrams is given. Seven case studies
of varying difficulty help to illustrate the suggested analytical methods, using
Canoco forWindows software. The case studies utilize both the descriptive
andmanipulative approaches, and they are supported by data sets and project
files available from the bookwebsite.
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Preface

Themultidimensional data on community composition, properties of
individual populations, or properties of environment are the bread and butter
of an ecologist’s life. They need to be analysed with taking their multidimen-
sionality into account. A reductionist approach of looking at the properties of
each variable separately does not work inmost cases. Themethods for statisti-
cal analysis of such data sets fit under the umbrella of ‘multivariate statistical
methods’.
In this book, we present a hopefully consistent set of approaches to answer-

ing many of the questions that an ecologist might have about the studied sys-
tems. Nevertheless, we admit that our views are biased to some extent, and
we pay limited attention to other less parametric methods, such as the fam-
ily of non-metric multidimensional scaling (NMDS) algorithms or the group
ofmethods similar to theMantel test or the ANOSIMmethod.We do not want
to fuel the controversy betweenproponents of various approaches to analysing
multivariatedata.Wesimplyclaimthat thesolutionspresentedarenot theonly
ones possible, but they work for us, as well asmany others.
We also give greater emphasis to ordination methods compared to classi-

fication approaches, but we do not imply that the classification methods are
not useful. Our description of multivariate methods is extended by a short
overview of regression analysis, including some of the more recent develop-
ments such as generalized additivemodels.
Our intention is to provide the reader with both the basic understanding of

principles ofmultivariatemethods and the skills needed to use thosemethods
in his/her own work. Consequently, all the methods are illustrated by exam-
ples. For all of them, we provide the data on our web page (see Appendix A),
and for all the analyses carried out by the CANOCO program, we also provide
theCANOCOprojectfiles containingall theoptionsneeded forparticular anal-
ysis. The seven case studies that conclude the book contain tutorials, where the

ix



x Preface

analysis options are explained and the software use is described. The individ-
ual case studiesdiffer intentionally in thedepthof explanationof thenecessary
steps. In the first case study, the tutorial is in a ‘cookbook’ form,whereas a det-
ailed description of individual steps in the subsequent case studies is only pro-
vided for the more complicated and advanced methods that are not described
in the preceding tutorial chapters.
The methods discussed in this book are widely used among plant, animal

and soil biologists, aswell as in thehydrobiology.The slant towardsplant com-
munity ecology is an inevitable consequence of the research background of
both authors.
This handbookprovides studymaterials for the participants of a course reg-

ularly taught at our university calledMultivariate Analysis of Ecological Data.
We hope that this book can also be used for other similar courses, as well as by
individual students seeking improvement in their ability to analyse collected
data.
We hope that this book provides an easy-to-read supplement to the more

exact anddetailedpublications suchas the collectionofCajoTerBraak’spapers
and theCanoco forWindows4.5manual. In addition to the scope of those pub-
lications, this book adds information on classificationmethods ofmultivariate
dataanalysis and introducesmodernregressionmethods,whichwehave found
most useful in ecological research.
In somecase studies,weneeded to comparemultivariatemethodswith their

univariate counterparts. The univariate methods are demonstrated using the
Statistica for Windows package (version 5.5). We have also used this package
to demonstrate multivariate methods not included in the CANOCO program,
such as non-metric multidimensional scaling or the methods of cluster analy-
sis.However, all thosemethods are available in other statistical packages so the
readers can hopefully use their favourite statistical package, if different from
Statistica. Pleasenote thatwehaveomitted the trademarkandregistered trade-
mark symbols when referring to commercial software products.
Wewould like to thank John Birks, Robert Pillsbury and SamaraHamzé for

correcting the English used in this textbook. We are grateful to all who read
drafts of the manuscript and gave us many useful comments: Cajo Ter Braak,
John Birks, Mike Palmer and Marek Rejmánek. Additional useful comments
on the text and the languagewere provided by the students of Oklahoma State
University: Jerad Linneman, Jerry Husak, Kris Karsten, Raelene Crandall and
Krysten Schuler. Sarah Price did a great job as our copy-editor, and improved
the text in countless places.
Camille Flinders, Tomáš Hájek and Milan Štech kindly provided data sets,

respectively, for case studies 6, 2 and 7.
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1

Introduction and datamanipulation

1.1. Why ordination?

Whenwe investigate variationofplant or animal communities across a
rangeofdifferent environmental conditions,weusuallyfindnot only largedif-
ferences in species composition of the studied communities, but also a certain
consistency or predictability of this variation. For example, if we look at the
variationof grasslandvegetation in a landscape anddescribe theplant commu-
nity compositionusing vegetation samples, then the individual samples canbe
usually ordered along one, two or three imaginary axes. The change in the veg-
etation composition is often small as we move our focus from one sample to
those nearby on such a hypothetical axis.
This gradual change in the community composition can often be related to

differing, but partially overlapping demands of individual species for environ-
mental factors such as the average soil moisture, its fluctuations throughout
the season, the ability of species to compete with other ones for the available
nutrients and light, etc. If the axes alongwhichwe originally ordered the sam-
ples can be identifiedwith a particular environmental factor (such asmoisture
or richness of soil nutrients), we can call them a soilmoisture gradient, a nutri-
ent availability gradient, etc. Occasionally, such gradients can be identified in
a real landscape, e.g. as a spatial gradient along a slope from a riverbank, with
gradually decreasing soil moisture. But more often we can identify such axes
along which the plant or animal communities vary in a more or less smooth,
predictable way, yet we cannot find them in nature as a visible spatial gradient
and neither can we identify them uniquely with a particular measurable envi-
ronmental factor. In such cases,we speak aboutgradients of species compos-
ition change.
The variation in biotic communities can be summarized using one of a

wide range of statistical methods, but if we stress the continuity of change

1
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Figure 1-1. Summarizing grassland vegetation composition with ordination:
ordination diagram from correspondence analysis.

in community composition, the so-called ordination methods are the tools
of trade. They have been used by ecologists since the early 1950s, and dur-
ing their evolution these methods have radiated into a rich and sometimes
confusing mixture of various techniques. Their simplest use can be illus-
trated by the example introduced above. When we collect recordings (sam-
ples) representing the species composition of a selected quadrat in a vegeta-
tion stand, we can arrange the samples into a table where individual species
are represented by columns and individual samples by rows. When we ana-
lyse such data with an ordination method (using the approaches described
in this book), we can obtain a fairly representative summary of the grass-
land vegetation using an ordination diagram, such as the one displayed in
Figure 1-1.
The rules for reading such ordination diagrams will be discussed thor-

oughly later on (see Chapter 10), but even without their knowledge we can
read much from the diagram, using the idea of continuous change of compo-
sition along the gradients (suggested here by the diagram axes) and the idea
that proximity implies similarity. The individual samples are represented
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in Figure 1-1 by grey circles. We can expect that two samples that lie near to
each other will be much more similar in terms of list of occurring species and
even in the relative importance of individual species populations, compared to
samples far apart in the diagram.
The triangle symbols represent the individual plant species occurring in the

studied type of vegetation (not all species present in the data were included in
the diagram). In this example, our knowledge of the ecological properties of
the displayed species can aid us in an ecological interpretation of the gra-
dients represented by the diagram axes. The species preferring nutrient-rich
soils (such as Urtica dioica, Aegopodium podagraria, or Filipendula ulmaria) are lo-
catedat the right sideof thediagram,while the speciesoccurringmostly insoils
poor in available nutrients are on the left side (Viola palustris, Carex echinata, or
Nardus stricta). The horizontal axis can therefore be informally interpreted as a
gradient of nutrient availability, increasing from the left to the right side. Sim-
ilarly, the species with their points at the bottom of the diagram are from the
wetter stands (Galium palustre, Scirpus sylvaticus, or Ranunculus repens) than the
species in the upper part of the diagram (such as Achillea millefolium, Trisetum
flavescens, or Veronica chamaedrys). The second axis, therefore, represents a gradi-
ent of soil moisture.
As youhave probably already guessed, the proximity of species symbols (tri-

angles) with respect to a particular sample symbol (a circle) indicates that these
species are likely to occurmore often and/orwith a higher (relative) abundance
than the species with symbolsmore distant from the sample.
Our example study illustrates the most frequent use of ordination meth-

ods in community ecology. We can use such an analysis to summarize com-
munity patterns and compare the suggested gradients with our independent
knowledge of environmental conditions. But we can also test statistically the
predictive power of such knowledge; i.e. address the questions such as ‘Does
the community composition change with the soil moisture or are the identi-
fied patterns just amatter of chance?’ These analyses can be donewith the help
of constrained ordinationmethods and their use will be illustrated later in
this book.
However, we do not need to stopwith such exploratory or simple confirma-

tory analyses and this is the focusof the rest of thebook.The rich toolboxof var-
ious types of regression and analysis of variance, including analysis of repeated
measurements on permanent sites, analysis of spatially structured data, vari-
ous types of hierarchical analysis of variance (ANOVA), etc., allows ecologists to
address more complex, and often more realistic questions. Given the fact that
the populations of different species occupying the same environment often
share similar strategies in relation to the environmental factors, it would be
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very profitable if one could ask similar complex questions for the whole biotic
communities. In this book, we demonstrate that this can be done andwe show
the reader how to do it.

1.2. Terminology

The terminology for multivariate statistical methods is quite compli-
cated. There are at least two different sets of terminology. One, more general
and abstract, contains purely statistical terms applicable across thewhole field
of science. In this sectionwegive the terms from this set in italics andmostly in
parentheses. The other represents amixture of terms used in ecological statis-
tics with themost typical examples coming from the field of community ecol-
ogy. This is the set on which wewill focus, using the former just to refer to the
more general statistical theory. In thisway,we use the same terminology as the
CANOCO software documentation.
In all cases, we have a data set with the primary data. This data set con-

tains records on a collection of observations – samples (sampling units).∗ Each
sample comprises values for multiple species or, less often, the other kinds
of descriptors. The primary data can be represented by a rectangular matrix,
where the rows typically represent individual samples and the columns repre-
sent individual variables (species, chemical or physical properties of the water
or soil, etc.).†

Very often our primary data set (containing the response variables) is accompa-
niedby anotherdata set containing the explanatory variables. If ourprimarydata
representcommunitycomposition, thentheexplanatorydata set typically con-
tainsmeasurements of the soil orwater properties (for the terrestrial or aquatic
ecosystems, respectively), a semi-quantitative scoring of human impact, etc.
Whenweuse the explanatoryvariables inamodel topredict theprimarydata (like
community composition), we might divide them into two different groups.
The first group is called, somewhat inappropriately, the environmental
variables and refers to the variables that are of prime interest (in the role of
predictors) in our particular analysis. The other group represents the covari-
ables (often referred to as covariates in other statistical approaches), which are

∗ There is an inconsistency in the terminology: in classical statistical terminology, samplemeans a
collection of sampling units, usually selected at random from the population. In community ecology,
sample is usually used for a description of a sampling unit. This usage will be followed in this text.
The general statistical packages use the term casewith the samemeaning.

† Note that this arrangement is transposed in comparisonwith the tables used, for example, in
traditional vegetation analyses. The classical vegetation tables have individual taxa represented by
rows and the columns represent the individual samples or community types.
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also explanatory variables with an acknowledged (or hypothesized) influence
on the response variables. We want to account for (subtract, partial-out) such an
influence before focusing on the influence of the variables of prime interest
(i.e. the effect of environmental variables).
As an example, let us imagine a situation where we study the effects of soil

properties and type of management (hay cutting or pasturing) on the species
composition of meadows in a particular area. In one analysis, we might be
interested in the effect of soil properties, paying no attention to the manage-
ment regime. In this analysis, we use the grassland composition as the species
data (i.e. primary data set, with individual plant species as individual response
variables) and the measured soil properties as the environmental variables
(explanatory variables). Based on the results, we can make conclusions about
the preferences of individual plant species’ populations for particular environ-
mental gradients, which are described (more or less appropriately) by the
measured soil properties. Similarly, we can ask how the management type
influencesplant composition. In this case, thevariablesdescribing themanage-
ment regime act as environmental variables. Naturally, we might expect that
the management also influences the soil properties and this is probably one
of the ways in which management acts upon the community composition.
Based on such expectation,wemay ask about the influence of themanagement
regime beyond that mediated through the changes of soil properties. To
address such a question, we use the variables describing the management
regime as the environmental variables and the measured soil properties as
the covariables.∗

One of the keys to understanding the terminology used by the CANOCO
program is to realize that the data referred to by CANOCO as the species data
might, in fact, be any kind of data with variables whose values we want to
predict. Forexample, ifwewould like topredict thequantitiesofvariousmetal
ions in river water based on the landscape composition in the catchment area,
then the individual ions would represent the individual ‘species’ in CANOCO
terminology. If the species data really represent the species composition of a
community, we describe the composition using various abundance measures,
including counts, frequency estimates, and biomass estimates. Alternatively,
we might have information only on the presence or absence of species in ind-
ividual samples. The quantitative and presence-absence variables may also
occur as explanatory variables. These various kinds of data values are treated in
more detail later in this chapter.

∗ This particular example is discussed in the Canoco forWindowsmanual (Ter Braak & Šmilauer, 2002),
section 8.3.1.
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Table 1-1.The types of the statistical models

Predictor(s)
Response
variable(s) . . . Absent Present

. . . is one • distribution summary • regressionmodels sensu lato

. . . aremany • indirect gradient analysis • direct gradient analysis
(PCA, DCA, NMDS)

• cluster analysis • discriminant analysis (CVA)

CVA, canonical variate analysis;DCA,detrendedcorrespondenceanalysis;NMDS,
non-metric multidimensional scaling; PCA, principal components analysis.

1.3. Types of analyses

If we try to describe the behaviour of one or more response variables,
the appropriate statistical modelling methodology depends on whether we
study each of the response variables separately (or many variables at the same
time), and whether we have any explanatory variables (predictors) available
whenwe build themodel.
Table1-1 summarizes themost important statisticalmethodologies used in

these different situations.
If we look at a single response variable and there are no predictors avail-

able, thenwe can only summarize the distributional properties of that variable
(e.g. by a histogram, median, standard deviation, inter-quartile range, etc.).
In the case of multivariate data, we might use either the ordination approach
represented by the methods of indirect gradient analysis (most prominent
are the principal components analysis – PCA, correspondence analysis – CA,
detrended correspondence analysis – DCA, and non-metric multidimensional
scaling – NMDS) or we can try to (hierarchically) divide our set of samples into
compact distinct groups (methods of cluster analysis, see Chapter 7).
Ifwehave one ormorepredictors available andwedescribe values of a single

variable, thenweuse regressionmodels in thebroadsense, i.e. includingboth
traditional regression methods and methods of analysis of variance (ANOVA)
and analysis of covariance (ANOCOV). This group of methods is unified under
the so-called general linear model and was recently extended and enhanced
by the methodology of generalized linear models (GLM) and generalized
additive models (GAM). Further information on these models is provided in
Chapter 8.
If we have predictors for a set of response variables, we can summarize

relations between multiple response variables (typically biological species)
and one or several predictors using the methods of direct gradient analysis
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(mostprominent are redundancy analysis (RDA) and canonical correspondence
analysis (CCA), but there are several othermethods in this category).

1.4. Response variables

The data table with response variables∗ is always part of multivariate
analyses. If explanatory variables (see Section 1.5), which may explain the val-
ues of the response variables, were not measured, the statistical methods can
try to construct hypothetical explanatory variables (groups or gradients).
The response variables (often called species data, based on the typical con-

text of biological community data) can often bemeasured in a precise (quanti-
tative) way. Examples are the dry weight of the above-ground biomass of plant
species, counts of specimens of individual insect species falling into soil traps,
or thepercentage cover of individual vegetation types in aparticular landscape.
We can compare different values not only by using the ‘greater-than’, ‘less-
than’ or ‘equal to’ expressions, but also using their ratios (‘this value is two
times higher than the other one’).
In other cases,we estimate the values for theprimarydata on a simple, semi-

quantitative scale. Good examples are the various semi-quantitative scales
used in recording the composition of plant communities (e.g. original Braun-
Blanquet scale or its variousmodifications). The simplest possible formof data
are binary (also called presence-absence or 0/1) data. These data essentially cor-
respond to the list of species present in each of the samples.
If our response variables represent the properties of the chemical or phys-

ical environment (e.g. quantified concentrations of ions or more complicated
compounds in the water, soil acidity, water temperature, etc.), we usually get
quantitative values for them, but with an additional constraint: these charac-
teristics do not share the same units of measurement. This fact precludes the
use of some of the ordination methods† and dictates the way the variables are
standardized if used in the other ordinations (see Section 4.4).

1.5. Explanatory variables

The explanatory variables (also called predictors or independent vari-
ables) represent theknowledge thatwehave about our samples and thatwe can
use to predict the values of the response variables (e.g. abundance of various

∗ also called dependent variables.
† namely correspondence analysis (CA), detrended correspondence analysis (DCA), or canonical
correspondence analysis (CCA).
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species) in aparticular situation. For example,wemight try topredict the com-
position of a plant community based on the soil properties and the type of land
management.Note thatusually theprimary task isnot theprediction itself.We
try touse ‘prediction rules’ (derived,mostoften, fromtheordinationdiagrams)
to learnmore about the studied organisms or systems.
Predictors can be quantitative variables (concentration of nitrate ions in

soil), semi-quantitative estimates (degree of human influence estimated on a
0–3 scale) or factors (nominal or categorical – also categorial – variables). The
simplest predictor form is a binary variable, where the presence or absence of
a certain feature or event (e.g. vegetation was mown, the sample is located in
study area X, etc.) is indicated, respectively, by a 1 or 0 value.
The factors are the natural way of expressing the classification of our samp-

les or subjects: For example, classes of management type for meadows, type
of stream for a study of pollution impact on rivers, or an indicator of the
presence/absence of a settlement near the sample in question.When using fac-
tors in the CANOCO program, we must re-code them into so-called dummy
variables, sometimes also called indicator variables (and, also, binary vari-
ables). There is one separate dummy variable for each different value (level) of
the factor. If a sample (observation) has a particular value of the factor, then
the corresponding dummy variable has the value 1.0 for this sample, and the
other dummy variables have a value of 0.0 for the same sample. For example,
we might record for each of our samples of grassland vegetation whether it is
a pasture, meadow, or abandoned grassland. We need three dummy variables
for recording such a factor and their respective values for ameadoware0.0,1.0,
and 0.0.∗

Additionally, this explicit decomposition of factors into dummy variables
allows us to create so-called fuzzy coding. Using our previous example, we
might include in our data set a site that had been used as a hay-cut meadow
until the previous year, butwasused as pasture in the current year.We can reas-
onably expect that both types of management influenced the present compos-
ition of the plant community. Therefore, we would give values larger than 0.0
and less than1.0 for both thefirst and seconddummyvariables. The important
restriction here is that the valuesmust sum to 1.0 (similar to the dummy varia-
bles coding normal factors). Unless we can quantify the relative importance of
the two management types acting on this site, our best guess is to use values
0.5, 0.5, and 0.0.

∗ In fact, we need only two (generally K−1) dummy variables to code uniquely a factor with three
(generally K ) levels. But the one redundant dummy variable is usually kept in the data, which is
advantageous when visualizing the results in ordination diagrams.
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If we build a model where we try to predict values of the response variables
(‘species data’) using the explanatory variables (‘environmental data’),we often
encounter a situationwhere someof the explanatoryvariables affect the species
data, yet these variables are treated differently: we do not want to interpret
their effect, but only want to take this effect into account when judging
the effects of the other variables.We call these variables covariables (or, altern-
atively, covariates). A typical example is an experimental design where sam-
plesaregrouped into logicalorphysicalblocks.Thevaluesof responsevariables
(e.g. species composition) for a group of samples might be similar due to their
spatial proximity, so we need to model this influence and account for it in our
data. The differences in response variables that are due to the membership
of samples in different blocks must be removed (i.e. ‘partialled-out’) from the
model.
But, in fact, almost any explanatory variable can take the role of a covariable.

For example, in a project where the effect of management type on butterfly
community composition is studied, we might have the localities at different
altitudes. The altitude might have an important influence on the butterfly
communities, but in this situation we are primarily interested in the manage-
ment effects. If we remove the effect of the altitude, we might get a clearer
picture of the influence that the management regime has on the butterfly
populations.

1.6. Handlingmissing values in data

Whatever precautions we take, we are often not able to collect all the
data values we need: a soil sample sent to a regional lab gets lost, we forget to
fill in a particular slot in our data collection sheet, etc.
Mostoften,we cannotgobackandfill in the empty slots, usuallybecause the

subjects we study change in time. We can attempt to leave those slots empty,
but this is often not the best decision. For example, when recording sparse
community data (we might have a pool of, say, 300 species, but the average
number of species per sample is much lower), we interpret the empty cells in a
spreadsheet as absences, i.e. zero values. But the absence of a species is very dif-
ferent from the situationwherewe simply forgot to look for this species! Some
statisticalprogramsprovideanotionofmissingvalues (itmightbe represented
as a word ‘NA’, for example), but this is only a notational convenience. The
actual statisticalmethodmust deal further with the fact that there aremissing
values in the data. Here are few options wemight consider:

1. We can remove the samples in which themissing values occur. This works

well if themissing values are concentrated in a few samples. If we have,
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for example, a data set with 30 variables and 500 samples and there are

20missing values from only three samples, it might be wise to remove

these three samples from our data before the analysis. This strategy is

often used by general statistical packages and it is usually called

‘case-wise deletion’.

2. On the other hand, if themissing values are concentrated in a few

variables that are not deemed critical, wemight remove the variables

from our data set. Such a situation often occurs whenwe are dealing with

data representing chemical analyses. If ‘every thinkable’ cation

concentration wasmeasured, there is usually a strong correlation among

them. For example, if we know the values of cadmium concentration in

air deposits, we can usually predict the concentration ofmercury with

reasonable precision (although this depends on the type of pollution

source). Strong correlation between these two characteristics implies that

we canmake good predictions with only one of these variables. So, if we

have a lot ofmissing values in cadmium concentrations, it might be best

to drop this variable from our data.

3. The twomethods of handlingmissing values described abovemight

seem rather crude, because we lose somuch of our data that we often

collected at considerable expense. Indeed, there are various imputation

methods. The simplest one is to take the average value of the variable

(calculated, of course, only from the samples where the value is not

missing) and replace themissing values with it. Another, more

sophisticated one, is to build a (multiple) regressionmodel, using the

samples with nomissing values, to predict themissing value of a variable

for samples where the values of the other variables (predictors in the

regressionmodel) are notmissing. This way, wemight fill in all the holes

in our data table, without deleting any samples or variables. Yet, we are

deceiving ourselves – we only duplicate the information we have. The

degrees of freedomwe lost initially cannot be recovered.

If we then use such supplemented data in a statistical test, this test makes
an erroneous assumption about the number of degrees of freedom (number
of independent observations in our data) that support the conclusion made.
Therefore, the significance level estimates are not quite correct (they are ‘over-
optimistic’). We can alleviate this problem partially by decreasing the statis-
tical weight for the samples where missing values were estimated using one
or another method. The calculation can be quite simple: in a data set with
20 variables, a sample with missing values replaced for five variables gets
a weight 0.75 (=1.00 − 5/20). Nevertheless, this solution is not perfect. If
we work only with a subset of the variables (for example, during a stepwise
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selection of explanatory variables), the samples with any variable being
imputed carry the penalty even if the imputed variables are not used.
Themethods of handlingmissing data values are treated in detail in a book

by Little & Rubin (1987).

1.7. Importing data from spreadsheets – WCanoImp program

The preparation of input data for multivariate analyses has always
been the biggest obstacle to their effective use. In the older versions of the
CANOCO program, one had to understand the overly complicated and un-
forgiving format of the data files, which was based on the requirements of
the FORTRAN programming language used to create the CANOCO program.
Version 4 of CANOCO alleviates this problem by two alternative means. First,
there is now a simple format with minimum requirements for the file con-
tents (the free format). Second, and probably more important, is the new, easy
method of transforming data stored in spreadsheets into CANOCO format
files. In this section, we will demonstrate how to use the WCanoImp program
for this purpose.
Let us start with the data in your spreadsheet program. While the majority

of users will work with Microsoft Excel, the described procedure is applicable
to any other spreadsheet program running under Microsoft Windows. If the
data are stored in a relational database (Oracle, FoxBASE, Access, etc.) you can
use the facilities of your spreadsheet program to first import the data into it.
In the spreadsheet, youmust arrange your data into a rectangular structure, as
laid out by the spreadsheet grid. In the default layout, the individual samples
correspondto the rowswhile the individual spreadsheet columns represent the
variables. In addition, you have a simple heading for both rows and columns:
thefirst row (except theemptyupper left corner cell) contains thenamesofvari-
ables,while thefirst columncontains thenames of the individual samples.Use
of heading(s) is optional, becauseWCanoImp is able to generate simple names
there.When using the heading row and/or column, youmust observe the lim-
itations imposed by the CANOCOprogram. The names cannot havemore than
eight characters and the character set is somewhat limited: the safest strategy
is to use only the basic English letters, digits, dot, hyphen and space.Neverthe-
less, WCanoImp replaces any prohibited characters by a dot and also shortens
any names longer than the eight characters. Uniqueness (and interpretability)
of the names can be lost in such a case, so it is better to take this limitation into
account when initially creating the names.
The remaining cells of the spreadsheet must only be numbers (whole or

decimal) or they must be empty. No coding using other kinds of characters is
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Figure 1-2. Themain window of theWCanoImp program.

allowed. Qualitative variables (‘factors’) must be coded for the CANOCO prog-
ram using a set of ‘dummy variables’ – see Section 1.5 formore details.
When the datamatrix is ready in the spreadsheet program, youmust select

the rectangular region (e.g. using the mouse pointer) and copy its contents to
the Windows Clipboard. WCanoImp takes the data from the Clipboard, de-
termines their properties (range of values, number of decimal digits, etc.) and
allows you to create a new data file containing these values, and conforming to
one of two possible CANOCO data file formats. Hopefully it is clear that the
requirements concerning the format of the data in a spreadsheet program
apply only to the rectangle being copied to the Clipboard. Outside of it, you
can place whatever values, graphs or objects you like.
The WCanoImp program is accessible from the Canoco for Windows prog-

rammenu (Start>Programs> [Canoco forWindows folder]). This import utility
has an easy user interface represented chiefly by one dialog box, displayed in
Figure 1-2.
The upper part of the dialog box contains a short version of the instructions

provided here. Once data are on the Clipboard, check the WCanoImp options
that are appropriate for your situation. The first option (Each column is a Sample)
applies only if you have your matrix transposed with respect to the form des-
cribed above. This might be useful if you do not have many samples (because
Microsoft Excel, for example, limits the number of columns to 256) but a high
number of variables. If you do not have names of samples in the first column,
you must check the second checkbox (i.e. ask to Generate labels for: . . . Samples),
similarly check the third checkbox if the first row in the selected spreadsheet
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rectangle corresponds to the values in the first sample, not to the names of the
variables. The last checkbox (Save inCondensedFormat) governs the actual format
used when creating the data file. The default format (used if this option is not
checked) is the so-called full format; the alternative format is the condensed
format. Unless you are worried about using too much hard disc space, it does
not matter what you select here (the results of the statistical methods will be
identical, whatever format is chosen).
After you have made sure the selected options are correct, you can proceed

by clicking the Savebutton. Youmust first specify thenameof thefile to be gen-
erated and the place (disc letter and folder) where it will be stored.WCanoImp
then requests a simple description (one line of ASCII text) for the data set being
generated. This one line then appears in the analysis output and reminds you
of the kind of data being used. A default text is suggested in case you do not
care about this feature. WCanoImp then writes the file and informs you about
its successful creation with another dialog box.

1.8. Transformation of species data

As will be shown in Chapter 3, ordination methods find the axes
representing regression predictors that are optimal for predicting the values
of the response variables, i.e. the values in the species data. Therefore, the
problem of selecting a transformation for the response variables is rather sim-
ilar to the problem one would have to solve if using any of the species as a
single response variable in the (multiple) regression method. The one addi-
tional restriction is the need to specify an identical data transformation for all
the response variables (‘species’), because such variables are oftenmeasured on
the same scale. In the unimodal (weighted averaging) ordinationmethods (see
Section 3.2), the data values cannot be negative and this imposes a further res-
triction on the outcome of any potential transformation.
This restriction is particularly important in the case of the log transformat-

ion. The logarithm of 1.0 is zero and logarithms of values between 0 and 1 are
negative. Therefore, CANOCOprovides a flexible log-transformation formula:

y ′ = log(A · y + C )

You should specify the values of A andC so that after the transformation is app-
lied to your data values (y ), the result (y ′) is always greater or equal to zero. The
default values of both A and C are 1.0, which neatly map the zero values again
to zero, and other values are positive. Nevertheless, if your original values are
small (say, in the range0.0 to0.1), the shift causedby adding the relatively large
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value of 1.0 dominates the resulting structure of the data matrix. You can adj-
ust the transformation in this case by increasing the value of A to 10.0. But the
default log transformation (i.e. log(y + 1)) workswell with the percentage data
on the 0 to 100 scale, or with the ordinary counts of objects.
The question of when to apply a log transformation and when to use the

original scale is not an easy one to answer and there are almost asmany answers
as there are statisticians. We advise you not to think so much about distribu-
tional properties, at least not in the sense of comparing frequency histograms
of the variables with the ‘ideal’ Gaussian (Normal) distribution. Rather try to
work out whether to stay on the original scale or to log-transform by using the
semantics of the hypothesis you are trying to address.
As stated above, ordination methods can be viewed as an extension of mul-

tiple regression methods, so this approach will be explained in the simpler
regression context. You might try to predict the abundance of a particular
species in samples based on the values of one ormore predictors (environmen-
tal variables, or ordination axes in the context of ordination methods). One
can formulate the question addressed by such a regression model (assuming
just a single predictor variable for simplicity) as ‘Howdoes the average value of
species Y change with a change in the environmental variable X by one unit?’
If neither the response variable nor the predictors are log-transformed, your
answer can take the form ‘The value of species Y increases by B if the value of
environmental variable X increases by one measurement unit’. Of course, B is
thentheregressioncoefficientof the linearmodelequationY =B0 + B · X + E .
But in other cases, youmight prefer to see the answer in a different form, ‘If the
valueof environmental variable X increasesbyoneunit, the average abundance
of the species increases by 10%’. Alternatively, you can say ‘The abundance
increases 1.10 times’. Here you are thinking on amultiplicative scale, which is
not the scale assumed by the linear regression model. In such a situation, you
should log-transform the response variable.
Similarly, if the effect of a predictor (environmental) variable changes in a

multiplicative way, the predictor variable should be log-transformed.
Plant community composition data are often collected on a semi-

quantitative estimation scale and the Braun–Blanquet scale with seven
levels (r ,+, 1, 2, 3, 4, 5) is a typical example. Such a scale is often quantified in
the spreadsheets using corresponding ordinal levels (from 1 to 7 in this case).
Note that this coding already implies a log-like transformation because the
actual cover/abundance differences between the successive levels are generally
increasing. An alternative approach to using such estimates in data analysis
is to replace them by the assumed centres of the corresponding range of per-
centage cover. But doing so, you find a problemwith the r and + levels because
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these are based more on the abundance (number of individuals) of the species
than on their estimated cover. Nevertheless, using very rough replacements
such as 0.1 for r and 0.5 for + rarely harms the analysis (compared to the
alternative solutions).
Another useful transformation available in CANOCO is the square-root

transformation. This might be the best transformation to apply to count data
(number of specimens of individual species collected in a soil trap, number of
individuals of various ant species passing over a marked ‘count line’, etc.), but
the log-transformation also handles well such data.
The console version of CANOCO 4.x also provides the rather general ‘linear

piecewise transformation’ which allows you to approximate themore compli-
cated transformation functions using a poly-line with defined coordinates of
the ‘knots’. This general transformation is not present in theWindows version
of CANOCO, however.
Additionally, if you need any kind of transformation that is not provided

by the CANOCO software, you might do it in your spreadsheet software and
export the transformed data into CANOCO format. This is particularly use-
ful in cases where your ‘species data’ do not describe community composition
but something like chemical and physical soil properties. In such a case, the
variables have different units of measurement and different transformations
might be appropriate for different variables.

1.9. Transformation of explanatory variables

Because the explanatory variables (‘environmental variables’ and
‘covariables’ inCANOCOterminology) areassumednot tohaveauniformscale,
you need to select an appropriate transformation (including the popular ‘no
transformation’ choice) individually for each such variable. CANOCOdoes not
provide this feature; therefore, any transformations on the explanatory vari-
ables must be done before the data are exported into a CANOCO-compatible
data file.
But you should be aware that after CANOCO reads in the environmental

variables and/or covariables, it centres and standardizes them all, to bring
their means to zero and their variances to one (this procedure is often called
standardization to unit variance).
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Experimental design

Multivariate methods are no longer restricted to the exploration of
data and to the generation of new hypotheses. In particular, constrained
ordination is a powerful tool for analysing data from manipulative experi-
ments. In this chapter, we review the basic types of experimental design,
with an emphasis on manipulative field experiments. Generally, we expect
that the aim of the experiment is to compare the response of studied
objects (e.g. an ecological community) to several treatments (treatment levels).
Note that one of the treatment levels is usually a control treatment (although
in real ecological studies, it might be difficult to decide what is the con-
trol; for example, when we compare several types of grassland management,
which of the management types is the control one?). Detailed treatment of
the topics handled in this chapter can be found for example in Underwood
(1997).
If the response is univariate (e.g. number of species, total biomass), then

the most common analytical tools are ANOVA, general linear models (which
includebothANOVA, linear regressionand their combinations), or generalized
linear models. Generalized linear models are an extension of general linear
models for the cases where the distribution of the response variable cannot be
approximated by the normal distribution.

2.1. Completely randomized design

The simplest design is the completely randomized one (Figure 2-1).
We first select the plots, and then randomly assign treatment levels to individ-
ual plots. This design is correct, but not always the best, as it does not control
for environmental heterogeneity. This heterogeneity is always present as an
unexplained variability. If the heterogeneity is large, use of this design might
decrease the power of the tests.

16
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Figure 2-1. Completely randomized design, with three treatment levels and four
replicates (or replications).

Block 1 Block 2 Block 3 Block 4

ENVIRONMENTAL GRADIENT

Figure 2-2. The randomized complete blocks design.

2.2. Randomized complete blocks

There are several ways to control for environmental heterogeneity.
Probably the most popular one in ecology is the randomized complete blocks
design. Here, we first select the blocks so that they are internally as homoge-
neousaspossible (e.g. rectangleswith the longer sideperpendicular to theenvi-
ronmental gradient, Figure 2-2). The number of blocks is equal to the number
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Figure 2-3. Latin square design.

of replications. Each block contains just one plot for each treatment level, and
their spatial position within a block is randomized.
If there are differences among the blocks,∗ this design provides amore pow-

erful test than the completely randomized design. On the other hand, when
applied in situations where there are no differences among blocks, the power
of the test will be lower in comparison to the completely randomized design,
because the number of degrees of freedom is reduced. This is particularly true
for designs with a low number of replications and/or a low number of levels of
the experimental treatment. There is no consensus among statisticians about
when the block structure can be ignored if it appears that it does not explain
anything.

2.3. Latin square design

Latin square design (see Figure 2-3) assumes that there are gradients,
both in the direction of the rows and the columns of a square. The square is
constructed in such a way that each column and each row contains just one of
the levels of the treatment. Consequently, the number of replications is equal
to the number of treatments. This might be an unwanted restriction. How-
ever, more than one Latin square can be used. Latin squares are more popular
in agricultural research than in ecology. As with randomized complete blocks,
the environmental variability is powerfully controlled. However, when there
is no such variability (i.e. that explainable by the columns and rows), then the
test is weaker than a test for a completely randomized design, because of the
loss of degrees of freedom.

∗ And often there are: the spatial proximity alone usually implies that the plots within a block aremore
similar to each other than to the plots from different blocks.
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Figure 2-4. Pseudoreplications: the plots are not replicated, but within each plot
several subsamples are taken.

2.4. Most frequent errors – pseudoreplications

Pseudoreplications (Figure 2-4) are among themost frequent errors in
ecological research (Hurlbert 1984). A possible test, performed on the data col-
lected using such a design, evaluates differences among plot means, not the
differences among treatments. In most cases, it can be reasonably expected
that the means of contiguous plots are different: just a proximity of subplots
within a plot compared with distances between subplots from different main
plots suggests that there are some differences between plots, regardless of the
treatment. Consequently, the significant result of the statistical test does not
prove (in a statistical sense) that the treatment has any effect on the measured
response.

2.5. Combiningmore than one factor

Often, we want to test several factors (treatments) in a single experi-
ment. For example, in ecological research, wemight want to test the effects of
fertilization andmowing.

Factorial designs

The most common way to combine two factors is through factorial
design. This means that each level of one factor is combined with each level
of the second factor. If we consider fertilization (with two levels, fertilized
and non-fertilized) and mowing (mown and non-mown), we get four possible
combinations. Those four combinations have to be distributed in space either
randomly, or they can be arranged in randomized complete blocks or in a Latin
square design.
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Figure 2-5. The split-plot design. In this example, the effect of fertilization was
studied on six plots, three of them on limestone (shaded) and three of them on
granite (empty). The following treatments were established in each plot: control
(C), fertilized by nitrogen (N), and fertilized by phosphorus (P).

Hierarchical designs

In hierarchical designs, each main plot contains several subplots. For
example,we can study the effect of fertilizationon soil organisms.Forpractical
reasons (edge effect), the plots should have, say, a minimum size of 5m× 5m.
This clearly limits the number of replications, given the space available for the
experiment. Nevertheless, the soil organisms are sampled using soil cores of
diameter 3 cm. Common sense suggests that more than one core can be taken
from each of the basic plots. This is correct. However, the individual cores are
not independent observations. Here we have onemore level of variability – the
plots (in ANOVA terminology, the plot is a random factor).
The plots are said to be nested within the treatment levels (sometimes,

instead of hierarchical designs, they are called nested design). In such a
design, a treatment effect is generally tested against the variability on the near-
est lower hierarchical level. In the example above, the effect of fertilization
is tested against the variability among plots (within a fertilization treatment
level), not against the variability among soil cores. By taking more soil cores
fromaplotwedonot increase the error degrees of freedom; however,we decre-
ase the variability among the plots within the treatment level, and increase the
power of the test in this way.
Sometimes, this design is also called a split-plot design. More often, the

split-plot design is reserved for another hierarchical design, where two (or
more) experimental factors are combined as shown in Figure 2-5.
In this case, we have themain plots (with three replications for each level)

and the split-plots. Themain plots are alternatively called whole plots.
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The effect of the bedrock must be tested against the variability among
the main plots within the bedrock type. Note that this design is different and
consequently has to be analysed differently from the factorial design with two
factors, bedrock and fertilization – there is one additional level of variability,
that of the plots, which is nested within the bedrock type.

2.6. Following the development of objects in
time – repeated observations

The biological/ecological objects (whether individual organisms or
communities studied as permanent plots) develop in time. We are usually
interested not only in their static state, but also in the dynamics of their
development, andwe can investigate the effect of experimentalmanipulations
on their dynamics. In all cases, the inference is much stronger if the baseline
data (the data recorded on the experimental objects before the manipulation
was imposed) are available. In this case, we can apply a BACI (before after con-
trol impact) design (Green 1979).
In designed manipulative experiments, the objects should be part of a cor-

rect statistical design; we then speak about replicated BACI designs.
As has been pointed out by Hurlbert (1984), the non-replicated BACI is not

a statistically correct design, but it is often the best possibility in environmen-
tal impact studies where the ‘experiment’ is not designed in order to enable
testing of the effect. An example is given in Figure 2-6. In this case, we want to
assess the effect of a newly built factory on the quality of water in a river (and,
consequently, we do not have replicated sites). We can reasonably expect that
upstream of the factory, the water should not be affected, so we need a control
site above the factory and an impact site below the factory (nevertheless, there
might be differences in water quality along the river course). We also need to
know the state before the factory starts operating and after the start (but we
should be aware that theremight be temporal changes independent of the fac-
tory’s presence). We then consider the changes that happen on the impact site
but not on the control site∗ to be a proof of the factory’s impact.
Nevertheless, the observations within a single cell (e.g. on the control site

before the impact) are just pseudoreplications. Even so, the test performed in
this way is muchmore reliable than a simple demonstration of either tempor-
al changes on the impact site itself or the differences between the impact and
control sites in the time after the impact was imposed.†

∗ In ANOVA terminology, this is the interaction between time and the site factors.
† The only possibility of having a replicated BACI design here would be to build several factories of the
same kind on several rivers, which is clearly not a workable suggestion!
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Before:

After:

control

control

impact

impact

Figure 2-6. The non-replicated BACI (before after control impact) design.

Even if wemiss the ‘before’ situation, we can usually demonstrate a lot by a
combination of common sense and some design. For example, in our exam-
ple case, we can have a series of sites along the river and an abrupt change
just between the two sites closest to the factory (one above and one below it),
with the differences between the other sites being gradual.∗ This is often a sug-
gestive demonstration of the factory effect (see Reckhow 1990 for additional
discussion).
Another possibility is to repeat the sampling over time and use time points

as (possibly correlated) replication (Stewart-Oaten et al. 1986; Ter Braak &
Šmilauer 2002).
In designed experiments, the replicated BACI is probably the best solution.

In this design, the individual sampling units are arranged in some correct
design (e.g. completely randomized or in randomized complete blocks). The
first measurement is done before the experimental treatment is imposed (the
baselinemeasurement), and then the development (dynamics) of the objects is
followed. In such a design, there should be no differences among the exper-
imental groups in the baseline measurement. Again, the interaction of treat-
ment and time is of greatest interest, and usually provides a stronger test than
a comparison of the state at the end of experiment. Nevertheless, even here we
have various possible analyses, with differing emphases on the various aspects
that we are interested in (see Lindsey 1993). As we control the environmental

∗ Or similarly, time series from the impacted site, with an abrupt change temporarily coincident with
the impact-causing event.
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Figure 2-7. Replicated BACI design. The objects (individual plants) are completely
randomized andmeasured at the first time T0. Thereafter, the impact
(fertilization) is imposed and the development is followed (with two sampling
times T1 and T2 in our example). The null hypothesis we are interested in is: The
growth is the same in the control and impact groups.

heterogeneity by knowing the initial state, the block structure is usually not as
efficient as in the static comparisons. An example is given in Figure 2-7.
One should be aware that, with 5%probability, there will be significant dif-

ferences between treatments in the baseline data (when tested at α = 0.05). It
is therefore advisable to test the baseline data before imposing the treatments,
andwhensignificantdifferencesare foundre-assignthe treatments to theunits
(with the same randomprocess as used originally).
With the continuing development of statistical methods, the designs are

becoming more and more flexible. Often the design of our experiment is a
compromise between the statistical requirements and the feasibility of the
implied manipulations in the field. The use of pseudoreplication in designed
experiments is, nevertheless, one of themost commonmistakes and can lead to
serious errors in our conclusions. Each researcher is advised to have a clear idea
about how the data will be analysed before performing the experiment. This
will prevent some disappointment later on.

2.7. Experimental and observational data

Manipulative experiments in ecology are limited both in space and
time (Diamond 1986). For larger spatial or temporal scales we have to rely on
observational data. Also, each manipulation has inevitably some side-effects
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and, consequently, the combination of observational data and manipulative
experiments is necessary.Generally, the observational data aremore oftenused
in hypotheses generation, whereas the data from manipulative experiments
are used for hypotheses testing.However, this neednot always be so. Inmanip-
ulations on the community level, we usually affect a whole chain of causally
interconnected variables (e.g. in the fertilization experiment in Case Study 3
(Chapter 13), fertilization affected the cover of the crop, which, together with
the direct effect of the nutrients, affected the weed community). In replicated
manipulative experiments on a community level in space and time, there are
many factors that we are not able to control, but still affect the results (weather
in a year, bed rock of a site). When the response is species community compos-
ition, we often know the biological traits of some species (which we are not
able to manipulate). We primarily test the hypothesis concerning change of
species composition, but the results very often suggest new hypotheses on the
relationship between species traits and species response to the manipulation.
All those situations call for careful exploration of data, even in the analysis of
manipulative experiments (Hallgren et al., 1999).
Also in non-manipulative studies, we often collect data to test a specific

hypothesis. It is useful to collect data in a design that resembles the manip-
ulative experiment. Diamond (1986) even coined the term ‘natural experi-
ment’, for the situations in nature that resemble experimental designs and can
be analysed accordingly (for example, to compare the abundance of spiders
on islands with and without lizards). According to Diamond, such situations
are under-utilized: ‘While field experimentalists are laboriouslymanipulating
species abundances on tiny plots, analogous ongoing manipulations on a
gigantic scale are receiving little attention (e.g. expansionof parasitic cowbirds
inNorth America and theWest Indies, decimation of native fish by introduced
piscivores, and on-going elimination of American elms by disease).’ In non-
manipulative situations,however, onecanneverexclude thepossibilityof conf-
ounding effects – consequently, special attention should be paid to sampling
design thatminimizes this danger.
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Basics of gradient analysis

The methods for analysing species composition are usually divided
into gradient analysis and classification. The term gradient analysis
is used here in the broad sense, for any method attempting to relate
species composition to the (measured or hypothetical) environmental
gradients.
Traditionally, the classification methods, when used in plant community

ecology, were connected with the discontinuum approach (or vegeta-
tion unit approach) or sometimes even with the Clementsian superorgan-
ismal approach, whereas the methods of gradient analysis were connected
with the continuum concept or with the Gleasonian individualistic concept
of (plant) communities (Whittaker 1975). While this might reflect the his-
tory of the methods, this distinction is no longer valid. The methods are
complementary and their choice depends mainly on the purpose of a study.
For example, in vegetation mapping some classification is necessary. Even
if there are no distinct boundaries between adjacent vegetation types, we
have to cut the continuum and create distinct vegetation units for map-
ping purposes. Ordination methods can help find repeatable vegetation
patterns and discontinuities in species composition, and show any transi-
tional types, etc. These methods are now accepted even in phytosociology.
Also, the methods are no longer restricted to plant community ecology.
They became widespread in most studies of ecological communities with
major emphasis on species composition and its relationship with the und-
erlying factors. In fact, it seems to us that the advanced applications of
gradient analysis are nowadays found outside the vegetation sciences, for
example in hydrobiological studies (see the bibliographies by Birks et al. 1996,
1998).

25
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3.1. Techniques of gradient analysis

Table 3-1 provides an overview of the problems solved by gradient
analysis and related methods (the methods are categorized according to Ter
Braak& Prentice 1988). Themethods are selectedmainly according to the data
that are available for the analysis and according to the desired result (which is
determined by the question we are asking).
The goal of regression is to find the dependence of a univariate response

(usually the quantity of a species, or some synthetic characteristics of a com-
munity, suchasdiversityorbiomass) onenvironmental (explanatory) variables.
As the environmental variables can alsobe categorical ones, this groupofmeth-
ods also includes analysis of variance (ANOVA). By calibrationwe understand
the estimation of values of environmental characteristics based on the species
composition of a community. Typical examples are the estimates based on
Ellenberg indicator values (‘Zeigerwerte’, Ellenberg 1991), or estimates of
water acidity based on the species composition of diatom communities
(Batterbee 1984; Birks 1995). To use calibration procedures, we need to
know a priori the species’ responses to the environmental gradients being
estimated.
The goal of ordination is to find axes of the greatest variability in the com-

munity composition (the ordination axes) for a set of samples and to visual-
ize (using an ordination diagram) the similarity structure for the samples and
species. It is often expected that the ordination axes will coincide with some
measurable environmental variables, and when those variables are measured
we usually correlate them with the ordination axes. The aim of constrained
ordination is to find the variability in species composition that can be exp-
lained by the measured environmental variables. Ordination and constrained
ordination are also available in partial versions (not shown in Table 3-1), as
partial ordination and partial constrained ordination. In partial analyses,
we first subtract the variability in the species composition explainable by the
covariables and then perform a (constrained) ordination on the residual vari-
ability. Inhybrid ordination analyses, first x (x is usually 1, 2 or 3) ordination
axes are constrained and the remaining axes are unconstrained.
The environmental variables and the covariables can be both quantitative

and categorical.

3.2. Models of species response to environmental gradients

The species response to a continuous environmental variable can
be described by a rich variety of shapes. Modern regression methods deal
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Table 3-1.Methods of gradient analysis

Data used in A priori

calculations knowledge of
species--

No of envir. No of environment
variables species relationships Method Result

1, n 1 No Regression Dependence of the species on
environmental variables

pH
0

10

20

30

40

50

6.0 7.0 8.0 9.0

C
ov

er
 [

%
]

None n Yes Calibration Estimates of environmental
values

None n No Ordination Axes of variability in species
composition

S4

S3

S2

S1

Glechoma

Galium

CirsiumRubus

1, n n No Constrained
ordination

Variability in species
composition explained by
the environmental variables
Relationship of
environmental variables to
the species axes

N

pH

S1
S3

S4
S2

Galium

Rubus

Cirsium

Glechoma

Methods categorized according to Ter Braak & Prentice (1986).
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Figure 3-1. Comparison of the suitability of linear approximation of a unimodal
response curve over a short part of the gradient (left diagram) and over a larger
part of the gradient (right diagram). The horizontal bar shows the part of the
gradient we are interested in.

with this variety and also handle response variables characterized by various
distributions (see Chapter 8). However, the regression can also be a part of
the algorithm of multivariate analyses, where many regression models are
fitted simultaneously. For this purpose, we need a relatively simple model,
which can be easily fitted to the data. Two models of species response to
environmental gradient are frequently used: the model of a linear response
and that of a unimodal response. The linear response is the simplest approx-
imation, whereas the unimodal response model assumes that the species has
an optimum on the environmental gradient. To enable simple estimation,
the unimodal model assumes that the relationship is symmetrical around
the species optimum (see Hutchinson 1957, for the concept of resource
gradients and species optima). When using ordination methods, we must
first decide which of the two models should be used. Generally, both mod-
els are just approximations, so our decision depends on which of the two
approximations is better for our data. Even the unimodal response is a simp-
lification: in reality (Whittaker 1967), the response is seldom symmetrical,
and also more complicated response shapes can be found (e.g. bimodal
ones). Moreover, the method of fitting the unimodal model imposes further
restrictions.
Over a short gradient, a linear approximation of any function (including

the unimodal one) works well, but over a long gradient the approximation
by the linear function is poor (Figure 3-1). Even if we have no measured
environmental variables, we can expect that, for relatively homogeneous
data, the underlying gradient is short and the linear approximation
appropriate.
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3.3. Estimating species optima by the weighted
averagingmethod

The linear response is usually fitted by the classical method of (least
squares) regression. For the unimodal response model, the simplest way to
estimate the species optimum is by calculating the weighted average (WA(Sp))
of the values of environmental variables in the n samples where the species is
present. The species importance values (abundances) are used as theweights in
calculating the average:

WA(Sp) =

n∑
i=1
Envi × Abundi
n∑

i=1
Abundi

whereEnvi is thevalueof environmental variable in the ith sample, andAbundi
is the abundance of the species in the ith sample.∗ If needed, the species
tolerance (the width of the bell-shaped curve) can be calculated as the square
root of theweightedmean of the squared differences between the species opti-
mum and the actual values in a sample. The value is analogous to standard
deviation (and is a basis for the definition of SDunits formeasuring the length
of ordination axes, see Section 10.2):

SD =

√√√√√√√√

n∑
i=1
(Envi −WA(Sp))2 × Abundi

n∑
i=1
Abundi

The method of the weighted averaging is reasonably good when the whole
range of a species’ distribution is covered by the samples. Consider the dep-
endence displayed in Figure 3-2. If the complete range is covered, then the
estimate is correct (Table 3-2).
On the other hand, if only a part of the range is covered, the estimate is

biased. The estimate is shifted in the direction of the tail that is not truncated.
An example is presented in Table 3-3.

∗ Another possibility is to explicitly state the functional form of the unimodal curve and estimate its
parameters by themethods of non-linear regression, but this option ismore complicated and not
suitable for the simultaneous calculations that are usually used in ordinationmethods.
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Figure 3-2. Example of a unimodal species response with a range completely
covering the response curve.

When the covered portion of the gradient is short, most of the species will
have their distributions truncated, and the optimum estimates will be biased.
The longer the axis, the more the species will have their optima estimated
correctly. We can reasonably expect that the more homogeneous the data, the
shorter the gradient.

The techniques based on the linear response model are suitable for
homogeneous data sets; the weighted averaging techniques are
suitable for more heterogeneous data.

The decision is usually made on the basis of gradient length in detrended cor-
respondence analysis (DCA), which estimates the heterogeneity in community
composition (see Section 4.3).
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Table 3-2. Estimation of species optimum from the
response curve displayed in Figure 3-2, using a
weighted averaging algorithmwhen a complete range
of species distribution is covered

Environmental value Species abundance Product

0 0.1 0
20 0.5 10
40 2.0 80
60 4.2 252
80 2.0 160

100 0.5 50
120 0.1 12

Total 9.4 564

WA(Sp) =

n∑

i=1
Envi × Abundi
n∑

i=1
Abundi

= 564/9.4 = 60

Table 3-3. Estimation of species optimum from the
response curve displayed in Figure 3-2, using a
weighted averaging algorithmwhen only a part of the
range of species distribution is covered

Environmental value Species abundance Product

60 4.2 252
80 2.0 160

100 0.5 50
120 0.1 12

Total 6.8 474

WA(Sp) =

n∑

i=1
Envi × Abundi
n∑

i=1
Abundi

= 474/6.8 = 69.7
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3.4. Calibration

The goal of calibration is to estimate the values of environmental
descriptors on the basis of species composition.∗ This procedure can be used
only if we knowbeforehand the behaviour of species in relation to the environ-
mental variables to be estimated. Theoretically, the procedure assumes thatwe
have a training setwith both species and environmental data available, which
are used to estimate the relationships of species and environment (e.g. species
optima with respect to environmental gradients). Those quantified relation-
ships are then used to estimate the unknown environmental characteristics for
samples, where only the species composition is known.
The most commonly used method is weighted averaging. For this pur-

pose, the estimates of species optima in relation to selected environmental
gradients must be available. These estimated optima values are sometimes
called indicator values. For example in Central Europe, the indicator values
of most species are available (on relative scales) for light, nitrogen availability,
soil moisture, etc. (e.g. Ellenberg 1991).† The environmental value in a sample
(WA(Samp)) can then be estimated as aweighted average of the indicator values
of all the s present species, their abundances being used as weights:

WA(Samp) =

s∑
i=1
IVi × Abundi
s∑

i=1
Abundi

where IVi is the indicator value of ith species (presumably its optimum) and
Abundi is the abundance of ith species in a sample. The procedure is based
on the assumption of existence of species optima (and, consequently, of the

∗ A common-sensemotivation: the presence of polar bears indicates low temperatures; the presence of
Salicornia species, high soil salinity; and the presence of common stinging nettle, a high concentration
of soil nitrogen.

† However, these species indicator values arenot based on the analyses of training sets, but rather on
personal experience of the authors.
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Table 3-4. Estimation of nitrogen availability for two samples, Sample 1 and
Sample 2

Nitrogen IV Sample 1 IV× abund. Sample 2 IV× abund.

Drosera rotundifolia 1 2 2 0 0
Andromeda polypofila 1 3 3 0 0
Vaccinium oxycoccus 1 5 5 0 0
Vaccinium uliginosum 3 2 6 1 3
Urtica dioica 8 0 0 5 40
Phalaris arundinacea 7 0 0 5 35
Total 12 16 11 78
Nitrogen (WA) 1.333 7.090

(= 16/12) (= 78/11)

The nitrogen indicator values (IV) are listed first (according to Ellenberg, 1991). The a priori
known indicator values are shown in bold style (in the Nitrogen IV column), the collected data
and the calculations are shown in standard typeface.

unimodal species’ responses).However, theprocedures for calibrationbasedon
the assumption of a linear response also exist (even if they are seldom used in
ecology).
An example of the calibration procedure is given in Table 3-4.
Opinion on the use of indicator values and calibration differs among

ecologists. It is generally argued that it is more reliable to measure the abi-
otic environment directly than to use a calibration. However, for historical
records (not only relevés (samples) done in the past, but also palynological and
paleolimnological evidence, etc.) the calibration provides information that
may not be completely reliable, but it is often the only available.
Calibration is also one of the steps used inmore complicated analyses, such

as ordinationmethods.

3.5. Ordination

Theproblemof anunconstrained ordination canbe formulated in two
ways:

1. Find a configuration of samples in the ordination space so that the

distances between samples in this space do correspond best to the

dissimilarities of their species composition. This is explicitly done by

multidimensional scaling (MDS)methods (Kruskal 1964; Legendre &

Legendre 1998). ThemetricMDS (also called principal coordinates

analysis, see Section 6.4) considers the samples to be points in

amultidimensional space (e.g. where species are the axes and the
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position of each sample is given by the corresponding species

abundance). Then the goal of ordination is to find a projection of this

multidimensional space into a space with reduced dimensionality that

will result in aminimumdistortion of the spatial relationships. Note

that the result is dependent on howwe define the ‘minimumdistortion’.

In non-metricMDS (NMDS), we do not search for projection rules, but

using a numerical algorithmwe seek for a configuration of sample points

that best portrays the rank of inter-sample distances (see Section 6.5).

2. Find ‘latent’ variable(s) (ordination axes) that represent the best

predictors for the values of all the species. This approach requires the

model of species response to such latent variables to be explicitly

specified: the linear responsemodel is used for linear ordinationmethods

and the unimodal responsemodel for weighted averagingmethods. In

linearmethods, the sample score is a linear combination (weighted sum)

of the species scores. In weighted averagingmethods, the sample score is

a weighted average of the species scores (after some rescaling).

Note: The weighted averaging algorithm contains an implicit
standardization by both samples and species. In contrast, we can
select in linear ordination the standardized and non-standardized
forms.

The two formulations may lead to the same solution.∗ For example, princi-
pal component analysis can be formulated either as a projection in Euclidean
space, or as a search for latent predictor variableswhen linear species responses
are assumed.
In the CANOCOprogram, the approach based on formulation 2 is adopted.

The principle of ordinationmethods can be elucidated by their algorithm.We
will use the weighted averaging methods as an example. We try to construct
the ‘latent’ variable (the first ordination axis) so that the fit of all the species
using this variable as the predictor will be the best possible fit. The result
of the ordination will be the values of this latent variable for each sample
(called the sample scores) and the estimate of species optimum on that vari-
able for each species (the species scores). Further, we require that the species
optima be correctly estimated from the sample scores (by weighted averag-
ing) and the sample scores be correctly estimated as weighted averages of the
species scores (species optima). This can be achieved by the following iterative
algorithm:

∗ If samples with similar species composition were distant on an ordination axis, such an axis could not
serve as a good predictor of their species composition.
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� Step 1Start with some (arbitrary) initial site scores {xi}
� Step 2Calculate new species scores {yi} by (weighted averaging)
regression from {xi}

� Step 3Calculate new site scores {xi} by (weighted averaging) calibration
from {yi}

� Step 4Remove the arbitrariness in the scale by standardizing site scores

(stretch the axis)
� Step 5Stop on convergence, else go to Step 2

We can illustrate the calculation by an example, presented in Table 3-5. The
data table (with three samples and four species) is displayed using bold letters.
The initial, arbitrarily chosen site scores are displayed in italics. From those,
we calculate the first set of species scores by weighted averaging, SPWA1 (Step
2 above). From these species scores, we calculate new sample scores (SAWA1),
again by weighted averaging (Step 3). You can see that the axis is shorter (with
the range from 1.095 to 8.063 instead of from 0 to 10). The arbitrariness in
the scale has to be removed by linear rescaling and the rescaled sample scores
SAWA1resc are calculated (Step 4 above):

xrescaled = x − xmin
xmax − xmin

× length

where xmax and xminare the maximum and minimum values of x in the non-
rescaleddata and ‘length’ is thedesired lengthof the ordination axis.Note that
the length parameter value is arbitrary, 10.0 in our case. This is true for some
ordinations but there aremethodswhere the length of the axis reflects the het-
erogeneity of the data set (see e.g. detrended correspondence analysis (DCA)
withHill’s scaling, Section10.2).Now,we compare the original valueswith the
newly calculated set. Because the values are very different, we continue by cal-
culating new species scores, SPWA2. We repeat the cycle until the consecutive
sample scores SAWANresc and SAWAN+1resc have nearly the same value (some
criterion of convergence is used, for example we considered in our case values
0.240 and 0.239 to be almost identical).
Table 3-5 was copied from the file ordin.xls. By changing the initial values

in this file, you can confirm that the final values are completely independent
of the initial values. In this way, we get the first ordination axis.∗ The higher
ordinationaxes arederived in a similarway,with the additional constraint that
they have to be linearly independent of all the previously derived axes.

∗ In the linearmethods, the algorithm is similar, except the regression and calibration are not
performed using weighted averaging, but in the way corresponding to the linearmodel – using the
least squares algorithm.



36 3. Basics of gradient analysis

Table 3-5.Calculation of the first ordination axis by the weighted averaging (WA)
method. Further explanation is in the text

Samp1 Samp2 Samp3 SPWA1 SPWA2 SPWA3 SPWA4

Cirsium 0 0 3 10.000 10.000 10.000 10.000
Glechoma 5 2 1 2.250 1.355 1.312 1.310
Rubus 6 2 0 1.000 0.105 0.062 0.060
Urtica 8 1 0 0.444 0.047 0.028 0.027

Initial value 0 4 10
SAWA1 1.095 1.389 8.063
SAWA1resc. 0.000 0.422 10.000
SAWA2 0.410 0.594 7.839
SAWA2resc. 0.000 0.248 10.000
SAWA3 0.376 0.555 7.828
SAWA3resc. 0.000 0.240 10.000
SAWA4 0.375 0.553 7.827
SAWA4resc. 0.000 0.239 10.000

The whole method can be also formulated in terms of matrix algebra and
eigenvalue analysis. For practical needs, we should note that the better the
species are fitted by the ordination axis (the more variability the axis exp-
lains), the less the axis ‘shrinks’ in the course of the iteration procedure (i.e.
the smaller is the difference between SAWA and SAWAresc). Consequently,
the value

λ = xmax − xmin
length

is a measure of the explanatory power of the axis and, according to the matrix
algebraic formulation of the problem, it is called the eigenvalue. Using the
method described above, each axis is constructed so that it explains as much
variability as possible, under the constraint of being independent of the previ-
ous axes. Consequently, the eigenvalues decrease with the order of the axis.∗

3.6. Constrained ordination

Constrainedordination canbebest explainedwithin the frameworkof
ordinations defined as a search for the best explanatory variables (i.e. problem
formulation 2 in the previous section). Whereas in unconstrained ordinations
we search for any variable that best explains the species composition (and this

∗ A strictlymathematically correct statement is that they do not increase, but for typical data sets they
always do decrease.
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Table 3-6. Basic types of ordination techniques

Linearmethods Weighted averaging

Unconstrained Principal components analysis
(PCA)

Correspondence analysis (CA)

Constrained Redundancy analysis (RDA) Canonical correspondence
analysis (CCA)

variable is taken as the ordination axis), in constrained ordinations the ordi-
nation axes areweighted sums of environmental variables.Numerically, this is
achieved by a slight modification of the above algorithm, in which we add one
extra step:

� Step 3a Calculate amultiple regression of the site scores {xi} on the
environmental variables and take the fitted values of this regression as

new site scores

Note that the fitted values in a multiple regression are a linear combina-
tion of the predictors and, consequently, the new site scores are linear com-
binations of the environmental variables. The fewer environmental variables
we have, the stricter is the constraint. If the number of environmental vari-
ables is greater than the number of samples minus 2, then the ordination is
unconstrained.
The unconstrained ordination axes correspond to the directions of the

greatest variability within the data set. The constrained ordination axes corre-
spond to the directions of the greatest data set variability that can be explained
by the environmental variables. The number of constrained axes cannot be
greater than the number of environmental variables.

3.7. Basic ordination techniques

Four basic ordination techniques can be distinguished based on
the underlying species response model and whether the ordination is con-
strained or unconstrained (see Table 3-6, based on Ter Braak & Prentice, 1988).
The unconstrained ordination is also called indirect gradient analysis and the
constrained ordination is called direct gradient analysis.
For weighted averaging methods, detrended versions exist (i.e. detrended

correspondence analysis (DCA) implemented in the legendary DECORANA
program, Hill & Gauch 1980, and detrended canonical correspondence ana-
lysis (DCCA, see Section 4.5). For all methods, partial analyses exist. In par-
tial analyses, the effect of covariables is first removed and the analysis is then
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performed on the remaining variability. The number of constrained axes can-
not exceed the number of environmental variables. When we use just one
environmental variable, only the first ordination axis is constrained and the
remaining axes are unconstrained.
The hybrid analyses represent a ‘hybrid’ between constrained and uncon-

strainedordinationmethods. In standard constrainedordinations, there are as
manyconstrainedaxes as thereare independent explanatoryvariables andonly
the additional ordination axes are unconstrained. In a hybrid analysis, only a
pre-specified number of canonical axes are calculated and any additional ordi-
nation axes are unconstrained. In this way, we can specify the dimensionality
of the solution of the constrained ordinationmodel.
With ‘release’ from the constraint (after all the constrained axes are calcu-

lated), the procedure is able to find a ‘latent’ variable that may explain more
variability than the previous, constrained ones. Consequently, in most cases,
the first unconstrained axis explains more then the previous constrained axis
and, therefore, the corresponding eigenvalue is higher than the previous one.

3.8. Ordination diagrams

The results of an ordination are usually displayed as ordination dia-
grams. Plots (samples) are displayed by points (symbols) in all the methods.
Species are shown by arrows in linear methods (the direction in which the
species abundance increases) and by points (symbols) in weighted averaging
methods (estimates of the species optima). Quantitative environmental vari-
ables are shown by arrows (direction in which the value of environmental
variable increases). For qualitative environmental variables, the centroids are
shown for individual categories (the centroid of the plots,where the category is
present). More information on the interpretation of ordination diagrams can
be found in Chapter 10.
Typical examples of ordination diagrams produced from the results of the

four basic types of ordinationmethods are shown in Figure 3-3.

3.9. Two approaches

Having both environmental data and data on species composition, we
can first calculate an unconstrained ordination and then calculate a regression
of the ordination axes on themeasured environmental variables (i.e. to project
the environmental variables into the ordination diagram) or we can calculate
directly a constrained ordination.The two approaches are complementary
and both should be used! By calculating the unconstrained ordination first,
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Figure 3-3. Examples of typical ordination diagrams. Analyses of species
composition of 14 samples (S1 to S14), located on an elevation gradient, in plots
differing in slope and located on various bedrock types. The species are labelled by
the first four letters of the generic name and the first four letters of the specific
name. The quantitative environmental variables are elevation and slope, the
qualitative variable is the bedrock type, represented by three categories (basalt,
granite, limestone). Samples (relevés) are displayed as crosses. Partly artificial data.

we do not miss the main part of the variability in species composition, but we
canmiss that part of the variability that is related to themeasured environmen-
tal variables. By calculating a constrained ordination, we do notmiss themain
part of the biological variability explained by the environmental variables, but
we canmiss themain part of the variability that is not related to themeasured
environmental variables.
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When you publish your results, always be careful to specify the method
of analysis used. From an ordination diagram, it is impossible to distinguish
betweenconstrainedandunconstrainedordinations;becausemanyauthorsdo
not follow the convention of using arrows for species in linear methods, even
distinction between linear and unimodalmethods is not unequivocal.

3.10. Testing significance of the relation with
environmental variables

In an ordinary statistical test, the value of the test statistic calculated
from the data is comparedwith the expected distribution of the statistic under
the null hypothesis being tested. Based on this comparison, we estimate the
probability of obtaining results as different (or evenmore different) from those
expected under the null hypotheses, as in our data. The distribution of the test
statistic is derived from the assumption about the distribution of the original
data (this is why we assume the normal distribution of the response residuals
in least squares regression). In CANOCO, the distribution of the test statis-
tic∗ under the null hypothesis of independence is not known. This distri-
bution depends on the number of environmental variables, their correlation
structure, the distribution of the species abundances, etc. However, the dis-
tribution can be simulated and this is done in a Monte Carlo permutation
test.
In this test, an estimate of the distribution of the test statistic under the null

hypothesis is obtained in the followingway.Thenull hypothesis states that the
response (the species composition) is independent of the environmental vari-
ables. If this hypothesis is true, then it does not matter which observation of
explanatory variable values is assigned towhich observation of species compo-
sition. Consequently, the values of the environmental variables are randomly
assigned to the individual samples of species composition, ordination analysis
is done with this permuted (‘shuffled’) data set, and the value of the test statis-
tic is calculated. In this way, both the distribution of the response variables
and the correlation structure of the explanatory variables remain the same in
the real data and in the null hypothesis simulated data. The significance level
(probability of type I error) of this test is then calculated as:

P = nx + 1
N + 1

∗ The F -ratio, used in the later versions of CANOCO, is amultivariate counterpart of the ordinary
F -ratio, the eigenvalue was used in previous versions.
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Table 3-7. Example of permutation test for a simple linear regression

Plant Nitrogen 1st 2nd 3rd 4th 5th
height (asmeasured) permutation permutation permutation permutation etc.

5 3 3 8 5 5 · · ·
7 5 8 5 5 8 · · ·
6 5 4 4 3 4 · · ·

10 8 5 3 8 5 · · ·
3 4 5 5 4 3 · · ·

F -value 10.058 0.214 1.428 4.494 0.826 0.###

wherenx is thenumberofpermutationswhere the test statisticwasnot lower in
the randompermutation than in the analysis of original data, and N is the total
number of permutations. This test is completely distribution-free. Thismeans
that it doesnotdependonany assumption about thedistributionof the species
abundance values. More thorough treatment of permutation tests in general
can be found in Legendre & Legendre (1998), pp. 20–26.
Thepermutationschemecanbe ‘customized’ according to theexperimental

design from which the analysed data sets come. The above description cor-
responds to the basic version of the Monte Carlo permutation test, but more
sophisticated approaches are actually used in the CANOCO program – see
Chapter 5 and the Canoco for Windows manual (Ter Braak & Šmilauer,
2002).

3.11. Monte Carlo permutation tests for the significance
of regression

The permutation tests can be used to test virtually any relationship.
To illustrate its logic, we will show its use for testing the significance of a sim-
ple regressionmodel that describes the dependence of plant height on the soil
nitrogen concentration.
We know the heights of five plants and the content of nitrogen in the soil

in which they were grown (see Table 3-7). We calculate the regression of plant
height on nitrogen content. The relationship is characterized by the F-value
of the analysis of variance of the regression model. Under some assumptions
(normality of the data),we know thedistribution of the F-values under thenull
hypothesis of independence (F-distribution with 1 and 4 degrees of freedom).
Let us assume thatwe are not able to use this distribution (e.g. normality is vio-
lated). We can simulate this distribution by randomly assigning the nitrogen
values to the plant heights. We construct many random permutations and for
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each one we calculate the regression (and corresponding F-value) of the plant
height on the (randomly assigned values of) nitrogen content. As the nitrogen
values were assigned randomly to the plant heights, the distribution of the
F-values corresponds to the null hypothesis of independence. Significance of
the regression is then estimated as:

1 + no. of permutationswhere (F ≥ 10.058)
1 + total number of permutations

The F -ratio in CANOCOhas a similarmeaning as the F -value in ANOVA of the
regressionmodel and theMonteCarlopermutation test isused inananalogous
way.
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Using the Canoco forWindows 4.5 package

4.1. Overview of the package

The Canoco forWindows package is composed of several programs. In
this sectionwe summarize the role of each program in data analysis and in the
interpretation of results. The following sections then deal with some typical
aspects of this software use. This chapter is not meant to replace the docu-
mentation distributed with the Canoco for Windows package, but provides a
starting point for efficient use of this software.

Canoco forWindows 4.5

This is the central piece of the package. Here you specify the data you
want to use, the ordination model to apply, and the analysis options. You can
also select subsets of the explained and explanatory variables to use in the
analysis or change theweights for the individual samples. All these choices are
collected in a CANOCO project.
Canoco for Windows allows one to use quite a wide range of ordination

methods. The central ones are the linear methods (principal components
analysis, PCA, and redundancy analysis, RDA) and the unimodal methods
(correspondence analysis, CA, detrended correspondence analysis, DCA, and
canonical correspondence analysis, CCA), but based on them you can use
CANOCO to apply other methods such as multiple discriminant analysis
(canonical variate analysis,CVA)ormetricmultidimensional scaling (principal
coordinates analysis, PCoA) to your data set. From the widely used ordination
methods, only non-metric multidimensional scaling (NMDS) is missing.

CANOCO 4.5

This program can be used as a less user-friendly, but slightly more
powerful alternative to the Canoco for Windows program. It represents a

43
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non-graphical console (with the text-only interface) version of this software.
The user interface is similar to that of previous versions of the CANOCO pro-
gram (namely versions 3.x), but the functionality of the original program has
been extended.
The console version is much less interactive than the Windows version. If a

mistake is made and an incorrect option specified, there is no way to change
incorrect entries. The programmust be terminated and the analysis restarted.
Nevertheless, there are a few ‘extras’ in the console version’s functionality.

The most important is the acceptance of ‘irregular’ design specifications. You
canhave, for example, data repeatedly collected frompermanent plots in three
localities. If thedurationofdata collectionvaries amongsites, there isnoway to
specify this design to the Windows version of the package so as to ensure cor-
rect permutation restrictions during the Monte Carlo permutation test. The
console version allows you to specify the arrangement of the samples (in terms
of spatial and temporal structure and/or thegeneral split-plotdesign) indepen-
dently for each block of samples.
Another advantage of the console version is its ability to read the analysis

specification, which is normally entered by the user as the answers to individ-
ual program questions, from a ‘batch’ file. Therefore, it is possible to generate
such batch files and run few to many analyses at the same time. This option is
obviously an advantage only for experienced users.

WCanoImp and CanoImp.exe

The functionality of the WCanoImp program is described in
Section 1.7. When using this program, you are limited by the memory
capacity of the Windows’ Clipboard and also by the capacity of the sheet of
your spreadsheet program. For Microsoft Excel, you cannot have more than
255 columnsof data (assuming thefirst columncontains the row labels); there-
fore, you must limit yourself to a maximum of 255 variables or 255 samples.
The other dimension is more forgiving: Microsoft Excel 97 allows 65,536
rows.
If your data do not fit into those limits, you can either split the table, export

the individual parts usingWCanoImp and thenmerge the resulting CANOCO
files using the CanoMerge program (see next subsection, CanoMerge) or you
canuse theconsole form(commandline)of theWCanoImpprogram– program
file canoimp.exe. BothWCanoImpand canoimpprogramshave the samepur-
pose and the same functionality, but there are two important differences.
The first difference is that the input data must be stored in a text file

for canoimp. The content of this file should be in the same format as data
pasted from a spreadsheet program; namely, a textual representation of the
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spreadsheet cells,with transitionsbetween columnsmarkedbyTABcharacters
and the transition between rows marked by new-line characters. The simplest
way to produce such an input file for the canoimp.exe program is to proceed
as if using the WCanoImp program, up to the point that data are copied to
the Clipboard. From there, switch to the WordPad program (in Windows 9x
or Windows ME) or the Notepad program (in Windows NT, Windows 2000,
or Windows XP), create a new document, and select the Edit> Paste command.
Then save thedocument as anASCII file (WordPadprogramsupports other for-
mats aswell). Alternatively, save the sheet from the spreadsheet programusing
the File> SaveAs . . . commandand select the format calledTextfile (Tab separated)
(the format name can somewhat vary across the Excel versions). Note that this
works flawlessly only if the data table is the only content of the spreadsheet
document.
The seconddifference between theWCanoImputility and the canoimppro-

gram is the way in which options are selected. Whilst both programs have
the same options available, in WCanoImp they are easily selected by ticking
checkboxes;however, incanoimptheoptionsmustbe typedonacommandline
together with the names of the input and output files. So, a typical execution
of the program from the command prompt looks like this:

d:\canoco\canoimp.exe -C -P inputdta.txt output.dta

where the –C option means the output is in condensed format, while the –P
option means a transposition of the input data (i.e. the rows in the input
text file represent variables). The TAB-separated format will be read from
inputdta.txt and CanoImp will create a new data file (and overwrite any exist-
ingfilewith the samename)namedoutput.dta, using theCANOCOcondensed
format.

CanoMerge

Program CanoMerge can be used for three different purposes, often
combined at the same time.

1. The primary task of this program is tomerge two ormore datafiles,

containing the same set of samples but different variables. This is useful

in situations described in the previous subsection, where wewant to start

with a data table stored in aMicrosoft Excel spreadsheet and both the

number of samples and the number of variables (e.g. species) exceed 255.

You can divide such a table into several sheets, each with the same

number of rows (representing the samples), but with the set of variables
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Figure 4-1. CanoMerge program user interface.

split over the sheets (e.g. the first 255 species in the first sheet, the next

255 species in the second one, etc.). If you export such partial tables

separately from the Excel file into the data files with CANOCO format,

you can use the CanoMerge application (see Figure 4-1) to join them into

one large datafile, which will contain all the species.

You select all the files containing the partial tables, using the Add
files button and the program creates the newmerged data table after you

clicked theMerge button.
2. The CanoMerge program can be used to export your datafiles into

ASCII files with the TAB-separated file format. This is useful particularly

if you do not have your data available in the Excel spreadsheets or if the

data table is too large to fit there. The TAB-separated format files are

accepted bymost statistical packages. Note that you can transform even a

single input datafile in this way: you simply specify just the one file in the

dialog shown after the Add files buttonwas clicked.
3. Finally, you can create a new datafile from an existing one(s), which will

contain only the frequently occurring species. CanoMerge allows you to

filter the set of input variables (species, presumably, in this context) that

are copied to the output file depending on the number of non-zero values

(occurrences) they have in the data. This is quite a useful feature, because

in the CANOCO program you can delete particular species ormake them

supplementary, but there is no easy way to exclude less frequent species,

beyond the ‘downweighting of rare species’ feature. You can exclude

species with fewer than X occurrences using the Exclude variables with less
thanX positive values field in the CanoMerge program.
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CanoDraw 3.1

The CanoDraw 3.1 program was distributed with the Canoco for
Windows package when it first appeared, in version 4.0. The new versions of
the CANOCO package (from version 4.5) contain the CanoDraw for Windows
program andwewill stick to the new CanoDraw version in this book.

CanoDraw forWindows

CanoDraw forWindows is the program for visualizing ordination res-
ults obtained with the CANOCO program and exploring them in the context
of the original data used in the ordination analyses and any additional infor-
mation available for the project samples or variables.
Similar to Canoco for Windows, your work with CanoDraw is also centred

on projects. Each CanoDraw project is usually based on one CANOCO ana-
lysis. To create it, you specify the name of an existing (and already analysed)
CANOCO project. CanoDraw reads the analysis options from the .con (project)
file, imports the analysis results (from the CANOCO .sol file), and also
imports the original data files referred by the CANOCO project (files with
species data, and with environmental and supplementary variables, and with
covariables, if available). After the CanoDraw project has been created and
saved into a file (using the name with a .cdw extension), it is independent of
the existence and location of the original files that were used or produced by
CANOCO.
CanoDraw for Windows supports the creation of ordination diagrams, as

well as of various XY and contour plots, in which fitted regression models can
be displayed.

PrCoord

The PrCoord program calculates the full solution of principal coordi-
nates analysis (for which the abbreviation PCoA is used in this book, but be
aware that elsewhere the abbreviation PCOmay be used), also known asmetric
multidimensional scaling. Principal coordinates analysis allows you to sum-
marize (dis-)similarity (ordistance) amongasetof samples ina fewdimensions,
starting from an N × N matrix of dissimilarity coefficients (or distance mea-
sures). In this respect, PCoA is a kind of unconstrained ordination, like PCA
or CA, but with it you can specify the distance measure used by the method,
while in PCA andCA the type ofmeasure is implied (Euclideandistance in PCA
and chi-square distance in CA). The CANOCOprogram alone provides the pos-
sibility to calculate PCoA on an inputmatrix of intersample distances, but you
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musthave thematrixavailable in theCANOCO-compatible formatand it is also
quite difficult to obtain all the principal coordinates in CANOCO (by default,
only the first four axes are calculated).
More advancedmethods starting from the PCoA solution, such as distance-

based RDA (Legendre & Anderson 1999), require the use of all the principal
coordinates, and PrCoord program stores them all∗ in a datafile in CANOCO-
compatible format. In addition, not only can PrCoord read an existing matrix
of intersampledistances, it canalso calculate it for a relativelywide rangeofdis-
tancemeasures, from a primary datamatrix submitted in a file with CANOCO
format.

4.2. Typical flow-chart of data analysis with Canoco
forWindows

Figure 4-2 shows a typical sequence of actions taken when analysing
multivariate data. You first start with the data sets recorded in a spreadsheet
and export them into CANOCO-compatible data files, using the WCanoImp
program. In the Canoco for Windows program, you either create a new
CANOCO project or clone an existing one using the File> Save as. . . command.
Cloning retains all theproject settings andwe can changeonly the settings that
need to be changed.
Thedecision about the ordinationmodel, shown inFigure4-2, refers to ask-

ing new questions about your data, as well as to iterative improvement of the
ordination model that is used to address those various questions. The conse-
quent changes in ordination models then involve different standardization of
response variables, change in the set of used environmental variables and co-
variables, optional transformations of predictor variables, etc.
Each CANOCO project is represented by two windows (views). The Project

View summarizes the most important project properties (e.g. type of ordina-
tionmethod, dimensions of the data tables and names of the files in which the
data are stored). Additionally, the Project View features a column of buttons
providing shortcuts to the commandsmost often usedwhenworkingwith the
projects: running analysis, modifying project options, starting the CanoDraw
program, saving the analysis log, etc. The Log View records the users’ actions
on the project and the output created during the project analysis. Some of the
statistical results provided by CANOCO are available only from this log. Other
results are stored in the ‘SOL file’, containing the actual ordination scores. You

∗ More precisely, PrCoord stores all the principal coordinates with positive eigenvalues after an eventual
adjustment for negative eigenvalues, as described by Legendre & Anderson, 1999.
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Write data into
a spreadsheet

Export data into
Canoco-format files

with WCanoImp

Decide about the

ordination model

Fit selected
ordination model

with CANOCO

Explore results and
create diagrams
with CanoDraw

Figure 4-2. A simplified flow-chart of data analysis with Canoco forWindows.

can extend the contents of the Log View by entering new text (comments) into
the log: the Log Viewworks as a simple text editor.
You can define the project settings using the Project setupwizard. Thiswiz-

ard can be invoked by clicking the Options button in Project View. CANOCO
displays the first page from a sequence of pages containing various pieces of
information the program needs to know to run the analysis. This sequence is
not a static one; the page displayed at a certain time depends on the choices
made in the preceding pages. For example, some of the options are specific to
linear ordinationmethods, so these pages are displayed only if a linearmethod
(PCA or RDA) was chosen. You proceed between pages using the Next button.
Youmay return to the preceding pages using theBackbutton. Some of the criti-
cal choices tobemadewiththesetupwizardarediscussed inmoredetail later in
this chapter. On the last page, the Finish button replaces theNext button. After
you click this button, the changes in the options are applied to the project. If
you were defining a new project, CANOCO now asks for the name of the file in
which the project will be saved.
Once the project is defined, the analysis can be performed (the data ana-

lysed) by clicking the Analyze button in Project View (or, alternatively, by using
the shortcut button from the toolbar or using the menu command). If suc-
cessful, the results are stored in the solution file (its name was specified on
the second Project setup wizard page) and additional information is placed
into the Log View, where it might be inspected. In the Log View, you can
find a statistical summary for the first four ordination axes, information on
the correlation between the environmental variables and the ordination axes,
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an indication of any outlier observations and the results of the Monte Carlo
permutation tests. Part of this information is essential for performing cer-
tain tasks, but nothing needs to be retained for plotting the ordination dia-
gramswithCanoDraw. CanoDrawneeds only the results stored in the solution
file.∗

With CanoDraw, you can explore the ordination results and combine them
with the information from the original data. You can specify not only what is
plotted, but also various plot properties – range of axes, which items are plot-
ted, contents of the attribute plots, etc. The resulting diagrams can be further
adjusted: you can change the type of symbols, their size and colours, fonts used
for individual labels, line types, etc.

4.3. Deciding on the ordinationmethod: unimodal or linear?

This sectionprovides a simple-to-use ‘cookbook’ for decidingwhether
you shoulduse ordinationmethodsbasedonamodel of linear species response
to the underlying environmental gradient or weighted-averaging (WA) ordi-
nationmethods, corresponding to a model of unimodal species response. The
presented recipe is unavoidably over-simplified, so it should not be followed
blindly.
In the Canoco for Windows project that you use to decide between the uni-

modal and linearmethods, you try tomatchasmany choices that youwillmake
in the final analysis as possible. If you have covariables, you use them here as
well; if youuse only a subset of the environmental variables, use the subsethere
too. If you log-transform (or square-root-transform) species data, youdo it here
as well.
For this trial project, you select the weighted-averaging method with

detrending. Thismeans eitherDCA for indirect gradient analysis or detrended
canonical correspondence analysis (DCCA) for a constrainedanalysis. Thenyou
select the option ‘detrending by segments’ (which also implies the Hill’s scal-
ing of ordination scores) and the other options as in the final analysis and run
the analysis. You then look at the analysis results stored in LogView. At the end
of the log, there is the Summary table and in it is a row starting with ‘Lengths
of gradient’, looking like the following example:

Lengths of gradient : 2.990 1.324 .812 .681

∗ There is an exception to this rule: when you are creating scores for principal response curves (PRC, see
Section 9.3) with CanoDraw, youmust have the Log View contents available in a text file. Use the Save
log button to create such a file.
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Thegradient lengthmeasures thebeta diversity in community composition
(the extentof species turnover) along the individual independentgradients (or-
dination axes). Now you locate the largest value (the longest gradient) and if
that value is larger than 4.0, you should use unimodal methods (DCA, CA, or
CCA). Use of a linear method would not be appropriate, since the data are
too heterogeneous and too many species deviate from the assumed model of
linear response (see also Section 3.2). On the other hand, if the longest gradient
is shorter than 3.0, the linearmethod is probably a better choice (not necessar-
ily, see Section 3.4 of Ter Braak & Šmilauer 2002). In the range between 3 and
4, both types of ordinationmethods work reasonably well.

When deciding whether to use the linear or unimodal type of
ordination method, you must take into account another important
difference among them. The unimodal methods always implicitly
work with standardized data. CCA, CA or DCA methods summarize
variation in the relative frequencies of the response variables
(species). An important implication of this fact is that these methods
cannot work with ‘empty’ samples, i.e. records in which no species
is present. Also, the unimodal methods cannot be used when the
response variables do not have the same units.

4.4. PCA or RDA ordination: centring and standardizing

Centring and standardization choices (see Section 6.2) made in linear
ordination methods in the CANOCO program may substantially change the
outcomeof the analyses. In fact, you canaddressdifferentquestions about your
data (see the discussion in Section 14.3). Here we provide brief guidance for
selecting the right centring and standardization options.
This project setup wizard page is displayed for linear ordination methods

(PCA and RDA) and refers to the manipulations with the species data matrix
before the ordination is calculated.
Centring by samples (left column of the wizard page, Figure 4-3) results in

a zero average for each row. Similarly, centring by species (right column of the
wizard page, Figure 4-3) results in a zero average for each column. Centring by
species is obligatory for the constrained linearmethod (RDA) or for anypartial
linear ordinationmethod (i.e. where covariables are used).
Standardization by species (samples) results in the norm of each column

(each row) being equal to one. The norm is the square root of sum of squares
of the column (row) values. If you apply both centring and standardization, the
centring isdonefirst.After centringand standardizingby species, the columns



52 4. Using the Canoco forWindows 4.5 package

Figure 4-3. Centring and standardization options in the Project setupwizard.

represent variableswith zero average andunit variance. As a consequence, PCA
performed on the species data then corresponds to a ‘PCA on a matrix of cor-
relations’ (between species). If you do not standardize by species norm, the
resulting PCA is the ‘PCA on variance-covariance matrix’. Note that the stan-
dardization by species in situations where species differ substantially in their
average frequency and/or average quantity in the data can put rather toomuch
weight on rare species in the analysis.
Also note that you must always standardize by species (and probably not

standardize or centre by samples) in situations, where your response variables
(‘species data’) differ in theirmeasurement scales; for example,whenyou study
the variability of various physico-chemical parameters with PCA.
If you have environmental variables available in the ordination method

(always in RDA and optionally in PCA), you can select the standardization by
error variance. In this case, CANOCO calculates, separately for each species,
how much of its variance was not explained by the environmental variables
(and covariables, if there are any). The inverse of that error variance is then
used as the species weight. Therefore, the better a species is described by
the environmental variables provided, the greater weight it has in the final
analysis.

4.5. DCA ordination: detrending

The detrending of second and higher ordination axes of correspon-
dence analysis (leading to detrended correspondence analysis, DCA) is often

Administrator
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Figure 4-4. Scatter of samples from a correspondence analysis, featuring the
so-called arch effect. You can see the ‘arch’ by rotating your book by 180 degrees.

usedtocopewith theso-calledarcheffect, illustrated inFigure4-4byadiagram
with sample positions on the first two axes of correspondence analysis (CA).
The positions of the samples on the second (vertical) axis are strongly (but

not linearly) dependent on their positions on the first (horizontal) axis. This
effect can be interpreted as a limitation of the method in which the consec-
utive axes are made mutually independent (only the linear independence is
sought) or, alternatively, as a consequence of the projection of the non-linear
relations of response variables to the underlying gradients into a linear
Euclidean drawing space (see Legendre & Legendre 1998, pp. 465–472 for
more detailed discussion). Detrending by segments (Hill & Gauch 1980),
while lackinga convincing theoretical basis andconsideredas inappropriateby
some authors (e.g. Knox1989 orWartenberg et al.1987), is themost oftenused
approach for making the recovered compositional gradient straight (linear).
When you opt for detrending in your unimodal ordination model, CANOCO
displays theDetrendingMethod page, illustrated in Figure 4-5.
Use of detrending by segments is not recommended for unimodal

ordination methods where either covariables or environmental variables
are present. In such cases if a detrending procedure is needed, detrending by
polynomials is the recommended choice. You are advised to check the Canoco
for Windows manual for more details on deciding among the polynomials of
second, third, or fourth degree (Section 7.6 of Ter Braak & Šmilauer 2002).
Thedetrendingprocedure is usually not needed for a constrainedunimodal

ordination. If an arch effect occurs in CCA, this is usually a sign of some
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Figure 4-5. Detrendingmethod selection in the Project setupwizard.

redundant environmental variables being present. There may be two or more
environmental variables strongly correlated (positivelyornegatively)witheach
other. If you retain only one variable from such a group, the arch effect often
disappears. The selection of a subset of environmental variables with a low
cross-correlation can be performed using the forward selection of the environ-
mental variables in Canoco forWindows.

4.6. Scaling of ordination scores

The most important result of an ordination method applied to par-
ticular data is the ordination diagram. Using this diagram, it is theoretically
possible to reconstruct (with a certain level of error) not only the primary
data table (the species data), but also the matrix of (dis-)similarities among
our samples and the species correlation matrix.∗ Nobody attempts to recover
such data from an ordination diagram because the measured values are
available, but it is useful to go part way when interpreting the content of
the ordination diagram and generating interesting research hypotheses. The
precision of conclusions about the similarity of samples, relations between
species and/or environmental variables, etc. dependspartly on the relative scal-
ing of the scores on the individual ordination axes. One kind of scaling is
more favourable if the viewer’s attention is focused on the relation between

∗ For linear ordinationmethods; thematrix of dissimilarities (Chi-square distances) among samples
and among species is implied by the results of unimodal ordinationmethods.



4.6. Scaling of ordination scores 55

samples, whereas another is favoured if the relation between species is to be
interpreted.
The alternative scaling options allow you to support alternative aspects

of the visual interpretation of the ordination results. The choices made in
these pages do not change other aspects of the analysis (such as the amount
of variability explained by individual ordination axes, the strength and dir-
ection of relations between the explanatory variables and ordination axes, or
the type I error estimates provided by the significance tests in constrained
ordinations).
The options are somewhat similar in linear andunimodal ordinationmeth-

ods (see Figure4-6). First, the decisionmust bemade as towhether the viewer’s
attention will focus on the samples (this includes the comparison of classes
of samples, as portrayed by the nominal environmental variables) or on the
species during the interpretation of the resulting ordination diagrams.
Then, for the linear model, you must decide whether the lengths of arrows

should mirror the differences in the abundances of individual species in
the data (with dominant species generally having longer arrows than those
with small abundance values) or whether the abundance of individual species
should be transformed to a comparable scale. This latter choice corresponds
to the correlation biplots. If you select for the species scores to be divided by the
species standarddeviation, then the lengthof each species arrowexpresseshow
well the values of that species are approximated by the ordination diagram. If
you decide, on the other hand, that the scores arenot to be divided by the stan-
dard deviation, the arrow length shows the variability in that species’ values
across the displayed ordination (sub)space.
In the case of unimodal ordination, you should also decide on the method

for interpreting the ordination diagrams. For datawith very long composition
gradients (with large beta diversity across samples),∗ thedistance rule ismore
appropriate and so is Hill scaling. In other cases, biplot scaling provides ordi-
nation diagrams that can be interpreted in amore quantitative way.
If you plot separate scatter-plots of samples or species, your choice of focus

upon species or samples is irrelevant, because CanoDraw for Windows offers
automatic adjustment of CANOCO-produced scores. In this way, the resulting
scatter-plots are always scaled in the optimum way. Note, however, that this
effect cannot be achieved inordinationdiagramswhere several types of entities
are plotted together.
More information about the scaling of scores and its relation to interpreta-

tion of ordination diagrams is provided in Sections 10.1 and 10.2.

∗ Ordination axes with length in SD (species-turnover) units approximatelymore than 3.
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4.7. Running CanoDraw forWindows 4.0

TheCanoco forWindows application takes your specificationofmulti-
variate statistical analysis and applies it to the data file(s) you have chosen.
In CANOCO, you can do an interactive selection of explanatory variables and
review the overall quality of the fitted ordination model (amount of variabil-
ity explainedbyparticular ordination axes) aswell as the results of significance
tests (MonteCarlopermutationtests).But theecologically interpretable results
are obtained mostly from the ordination diagrams, created from the output
information provided by CANOCO. This is the niche for the CanoDraw prog-
ram.CanoDraw canbe starteddirectly from theCanoco forWindowsprogram,
using the CanoDraw button displayed in the Project Viewwindow.
When creating a new diagram with CanoDraw, you should concentrate on

the graph contents first: the range of the diagram axes, the plotted items, the
appropriate type of labelling of items in the diagram, etc. First and foremost,
you must decide what kind of diagram you want to produce. When summa-
rizing a CANOCO project where both species (community composition) and
environmental datawere used, the biplot diagram,which includes species and
environmental variables, is the most appropriate first choice. Before creating
that diagram, two important decisionsmust bemade about its content:

� The qualitative (categorical) environmental variables (i.e. factors) are best

represented by the centroid scores for the individual dummy variables.

For a factor, each dummy variable corresponds to one factor level. As its

name suggests, each centroid symbol represents the centroid (barycentre)

of the scores of samples belonging to that particular class (factor level).

CanoDraw uses these scores only for the variables that you specified as

nominal variables. You can select them (separately for environmental and

supplementary variables), using the twomenu commands in the Project>
Nominal variables submenu.

� For typical community composition data, it often does notmake sense to

display the scores of all species. Some are so rare in the data that no

relevant information can be provided about their ecological preferences.

Other speciesmight not be characterized well by the explanatory

variables used in the analysis. We usually try to define a subset of species

appearing in an ordination diagram using a combination of two criteria:

species fit and species weight. Both are accessible from the Inclusion Rules
page of the dialog box invoked by the Project> Settingsmenu command.

1. Species fit represents the percentage of variability in species values

explained by the ordination subspace onto which the species scores are

projected (usually the first two ordination axes). Informally, the
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species fit can be characterized as the quality of the description of the

‘behaviour’ of species values, derived from the particular combination

of ordination axes. This characteristic is not available for the

unimodal-model-based analyses where detrending by segments was

applied.

2. Species weight is normally usable only for unimodal ordination

models and is equal to the sum of abundances of the species taken over

all the samples.

To limit the set of plotted species, we usually increase the lower values of

both criteria ranges for unimodal ordinationmethods. However, for a

linear ordinationmethodwhere all species have the sameweight the only

option is to increase theminimum species fit. Note that you can

selectivelymanipulate the selection range concerning the fit of species to

horizontal (lower-order) axis of a displayed ordination diagram. This is

particularly useful when you use only one explanatory variable in

constrained analysis and, therefore, only the first axis reflects the relation

of species abundances to such a predictor.

Once the diagram is created (use the Create > Simple Ordination Plot command
and select the first item on the list for the species-environmental variables bi-
plot), you can reposition the individual labels, modify their properties (font
type, size, colour)or addsomeextra information (additional text, arrowspoint-
ing to some notable species, etc.). Alternatively, if you are not satisfied with
the diagram contents (too many species are displayed, for example), you can
adjust the program settings using the commands in the View and Project sub-
menus and recreate the graphusing theCreate>Recreate graph command.Note,
however, that in such a case all post-creation changes to your graph will be
discarded.
You can save the current state of any CanoDraw graph in a file with a .cdg

extension. CanoDraw provides basic support for managing multiple graphs
for each project and also for working with multiple projects at the same
time. CanoDraw graphs can be printed directly from the program, copied to
other applications through the Windows Clipboard, or exported in a variety
of exchange formats (BMP, PNG, Adobe Illustrator, and Enhanced Metafile
Format).

4.8. New analyses providing new views of our data sets

Working with multivariate data usually has an iterative aspect. You
might find it useful to modify the explanatory variables, based on your explo-
ration of the results you get from the initial analyses. This includes a selection
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of the subset of environmental (explanatory) variables based on the knowledge
you gain during the forward selection of environmental variables in CANOCO.
Based on the exploration of the relationship of explanatory variables

to the ordination axes and to individual species, you can transform the
environmental variables to maximize their linear relation with the gradients
being recovered by the ordinationmodel.
In some cases, the ordination results reveal two or more distinct groups of

samples, based on their different composition. In that case, it is often useful
to enhance the results by further separate analyses for each of those groups. In
a direct gradient analysis, this often leads to a different picture: the environ-
mental variables identifiable with the differences between the groups are fre-
quently different from the variables actingwithin such groups.
Another type of follow-up analysis is usedwhen you identify some environ-

mental variables that are important for explaining part of the structure in the
species data. In such a case you can turn those variables into covariables and
either test the additional effects of other potentially interesting explanatory
variables (partial direct gradient analysis) or just inspect the ‘residual’ variation
and try to informally interpret any pattern found in that way (partial indirect
gradient analysis).
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Constrained ordination and
permutation tests

In this chapter, we discuss constrained ordination and related
approaches: stepwise selection of a set of explanatory variables, Monte Carlo
permutation tests and variance partitioning procedure.

5.1. Linearmultiple regressionmodel

We start this chapter with a summary of the classical linear regression
model, because it is very important for understanding the meaning of almost
all aspects of direct gradient analysis.
Figure5-1presents a simple linear regressionused tomodel thedependence

of the values of a variable Y on the values of a variable X. The figure shows the
fitted regression line and also the difference between the true (observed) values
of the response variable Y and the fitted values (Ŷ; on the line). The difference
between these two values is called the regression residual and is labelled as e
in Figure 5-1.
An important feature of all statistical models (including regression

models) is that they have twomain components. The systematic component
describes the variability in the values of the response variable(s) that can be
explainedbyoneormoreexplanatoryvariables (predictors),usingaparameter-
ized function. The simplest function is a linear combination of the explana-
tory variables,which is the functionusedby (general) linear regressionmodels.
The stochastic component is a term referring to the remaining variability in
the values of the response variable, not described by the systematic part of the
model.The stochastic component isusuallydefinedusing itsprobabilistic, dis-
tributional properties.
We judge the quality of thefittedmodel by the amount of the response vari-

able’s variance that can be described by the systematic component. We usually
compare this to the amount of the unexplained variability that is represented

60
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Figure 5-1. Graphical representation of a simple linear regressionmodel.

by the stochastic component. We tend to present such a regressionmodel only
where all the predictors significantly contribute to its quality. We can select an
appropriate subset of the predictors using a stepwise selection. Its most fre-
quently used type is forward selection. We start forward selectionwith a null
model with no predictors, assuming that no part of the variability in the
response variable can be predicted and that it represents only stochastic vari-
ability. We then select a single predictor from the set of available variables –

usually theone leading toa regressionmodel that explains thegreatest amount
of the variability.+

Evenwhenadding thebestpredictor, its contribution to themodelmightbe
just due to chance: if we randomly swapped that predictor’s values, even such a
nonsense variablewould still explain a positive amount of the variability in the
values of the response variable, so wemust test the contribution of the consid-
ered candidate predictor. If the contribution of the selected candidate predic-
tor is judged to be non-random (‘statistically significant’), we can accept it and
repeat the process and try to find another good predictor in the pool of the re-
maining variables.We should again test its contribution and stop this selection
as soon as the ‘best’ among the remaining predictors is not ‘good enough’.

5.2. Constrained ordinationmodel

In Chapter 3, the linear and unimodal methods of unconstrained
ordination (PCA and CA, respectively) were defined as methods seeking one
or more (mutually independent) gradients representing ‘optimal’ predictors
for fitting the regression models of linear or unimodal species response. The

+ Under the constraint of using only one predictor, of course.
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optimality is limited by the assumptions of thesemethods and judged over all
the species in the primary data.
The methods of constrained ordination* have an identical task, but the

gradients that these methods ‘are allowed to find’ are further restricted.
Namely, these gradients must be linear combinations of the provided
explanatory (environmental) variables. Therefore, we try to explain again the
abundances of (all) individual species using synthetic variables (ordination
axes), but these variables are further defined using the values of the observed
(environmental) characteristics.
In this way, the methods of direct gradient analysis resemble the model of

multivariatemultiple regression.But in sucha regressionwithm responsevari-
ables (number of species) and p predictors (the environmental variables), we
must estimatem · p parameters (regression coefficients) from the data. This is
not the case with a constrained ordination, where the effect of predictors on
the response variables is ‘focused’ through a low number of intermediate gra-
dients – the ordination axes, called here the canonical (or constrained) axes.
There are as many canonical axes as there are independent explanatory vari-
ables, but we typically use only the first few of them.
InCANOCO,wequite oftenperformpartial analyseswhenweuse so-called

covariables in addition to the environmental (explanatory) variables. These
covariables represent the effectswewant to account for, and therefore remove
from the resulting ordination model. Covariables are used in a similar con-
text in analysis of variance. There we often specify quantitative covariables in
addition to factors. In traditional regression analysis, the notion of covariables
is not frequentlyused, as thedifference among themand the ‘true’ explanatory
variables is only in the way we look at them. Both types are explanatory vari-
ables in a regression model (and in an ANOVA or ordination model) and it is
only the role we attribute to them that differs.

5.3. RDA: constrained PCA

We will illustrate the concepts introduced in the previous section by
means of redundancy analysis (RDA, van denWollenberg 1977), a constrained
form of the linear ordination method of principal components analysis (PCA,
Hotelling 1933). We will use a very simple setup, where we try to determine
only the first ordination axis (the first principal component) and we have two
environmental variables (z1 and z2) available which define (‘constrain’) the
ordination axis of RDA.

* Also called direct gradient analysis or canonical ordinationmethods.
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Both PCA and RDA methods try to find values of a new variable (we will
denote it X ) that represents ‘the best’ predictor for the values of all the species
(response variables). The value of that new variable for the ith sample is Xi and
we use it to predict the values of the kth species in the ith sample based on the
following equation:

Yik = b0k + b1kXi + eik

Here both PCA and RDA must estimate two sets of parameters: the values Xi ,
which are the sample scores on the first ordination axis, and the regression
coefficients for each species (b1k), which are the species scores on the first
ordination axis. The additional parameter for each species (b0k) represents the
‘intercept’ of the fitted regression line and we can eliminate its estimation by
centring the primary data by species (i.e. subtracting the species averages, see
Section 4.4).
Here the similarity between PCA and RDA ends, because in the constrained

model of RDA the values of the sample scores are further constrained. They
are defined as a linear combination of the explanatory variables. In our
example, we have two such variables, z1 and z2, so this constraint can be
written as:

Xi = c1zi1 + c2zi2

Note that the parameters estimated here (c j for jth environmental variable) do
not represent the scores of the environmental variables that are usually plot-
ted in the ordination diagrams. Rather, they represent the Regr scores in the
output from a CANOCO analysis.
We may combine the above two equations into a single one, further

illustrating the relation of constrained ordination to multiple multivariate
regression:

Yik = b0k + b1kc1zi1 + b1kc2zi2 + eik

The expressions bik · c j represent the actual coefficients of a multiple multi-
variate regression model, which describes the dependency of abundance of
a particular species k on the values of (two) environmental variables z1 and
z2. If we fit such models independently for each of m species, we need to
estimate m · p regression coefficients (for p environmental variables). But in
RDA, the estimated coefficients are constrained by their definition (i.e. they are
defined as b · c ): if we use only the first canonical axis, we need to estimate only
m + p parameters (the b1k and c j coefficients, respectively). To use the first two
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Figure 5-2. Introductory page of the Project setupwizard for selecting theMonte
Carlo permutation type.

constrained axes, we need 2 · (m + p) parameters.* This is, for most datasets,
still a large saving compared with them · p parameters.

5.4. Monte Carlo permutation test: an introduction

CANOCO has the ability to test the significance of constrained ordi-
nation models described in the preceding section, using Monte Carlo per-
mutation tests. These statistical tests relate to the general null hypothesis,
stating the independence of the primary (species) data on the values of the
explanatory variables. Theprinciples of thepermutation testswere introduced
in Chapter 3, Sections 3.10 and 3.11, in an example of testing a regression
model and using the simplest possible type of permutation, i.e. completely
random permutation. But CANOCO provides a rich toolbox of specific setups
for the tests applied to data sets with a particular spatial, temporal or logical
internal structure, which is related to the experimental or sampling design, as
can be seen from Figure 5-2.
Thisfigure shows thefirstpageof a sequenceofpages available in theProject

setup wizard to specify the properties of the permutation test. The following
four sections providemore detailed treatment of permutation testingwith the

* This estimate disregards the remaining freedom in b and c values. For example, using 4 · b and c/4
instead of b and c would yield the samemodel. Amore careful mathematical argument shows that the
number of parameters is somewhat different (Robinson 1973; Ter Braak & Šmilauer 2002, p. 56).
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CANOCO program. The practical aspects of the testing are further illustrated
inmost of the case studies in this book.

5.5. Null hypothesismodel

The null model of the independence between the corresponding rows
of the species data matrix and of the environmental data matrix (the rows
referring to the same sample) is the basis for the permutation test in CANOCO.
While the actual algorithm used in CANOCO does not directly employ the
approach described here, we use it to better illustrate the meaning of the per-
mutation test.

� We start by randomly re-shuffling (permuting) the samples (rows) in the

environmental data table, while keeping the species data intact. Any

combination of the species and environmental data obtained in that way

is as probable as the ‘true’ data set, if the null hypothesis is true.
� For each of the data sets permuted in this manner, we calculate the

constrained ordinationmodel and express its quality in a way similar to

that used when judging the quality of a regressionmodel. In a regression

model, we use an F-statistic, which is the ratio between the variability of
the response variable explained by the regressionmodel (divided by the

number of themodel parameters) and the residual variability (divided by

the number of residual degrees of freedom). In the case of constrained

ordinationmethods, we use similar statistics, described inmore detail in

the following section.
� We record the value of such a statistic for each permuted (randomized)

version of the data set. The distribution of these values defines the

distribution of this test statistic under the null model (the histogram in

Figure 5-3). If it is highly improbable that the test statistic value obtained

from the actual data (with no permutation of the rows of the

environmental data table) comes from that distribution (beingmuch

larger, i.e. corresponding to an ordinationmodel of higher quality), we

reject the null hypothesis. The probability that the ‘data-derived’ value of

the test statistics originates from the calculated null model distribution

then represents the probability of a type I error, i.e. the probability of

rejecting a correct null hypothesis.

5.6. Test statistics

The previous section described the general principle of permutation
tests and herewe discuss the possible choices for the test statistics used in such

Administrator
高亮
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tests. We mentioned that such a statistic resembles the F-statistic used in the
parametric significance test of a regressionmodel. But the choice of definition
for this statistic in constrained ordination is difficult, because of the multi-
dimensionality of the obtained solution. In general, the variability in species
data, described by the environmental variables, is expressed bymore than one
canonical axis.The relative importanceof the canonical axesdecreases fromthe
first up to the last canonical axis, butwe can rarely ignore all the canonical axes
beyond the first one. Therefore, we can either express the accounted variance
using all canonical axes or focus on one canonical axis, typically the first one.
This corresponds to the two test statistics available inCANOCOversion3.x and
4.x and the two corresponding permutation tests:

� Test of the first canonical axis uses an F -statistic defined in the following

way:

F1 = λ1

RSS/(n − p − q )

The variance explained by the first (canonical) axis is represented by its

eigenvalue (λ1). The residual sum of squares (RSS) term corresponds to

the difference between the total variance in the species data and the

amount of variability explained by the first canonical axis (and also by the

covariables, if any are present in the analysis). The number of covariables

is q . The number of independent environmental variables (i.e. the total

number of canonical axes) is p. The total number of ordination axes is n.
� Test of the sum of the canonical eigenvalues, in which the overall effect of

p explanatory variables, revealed on (up to) p canonical axes, is used:

Ftrace =

p∑
i=1

λi/p

RSS/(n − p − q )

The RSS term in this formula represents the difference between the total

variability in the species data and the sum of eigenvalues of all the

canonical ordination axes (adjusted, again, for the variability explained

by covariables, if there are any).

As explained in the previous section, the value of one of the two test statis-
tics, calculated from the original data, is compared with the distribution of
the statistic under the null model assumption (with the relation between the
species data and the environmental variables subjected to permutations). This
is illustrated by Figure 5-3.
In this figure, we see a histogram approximating the shape of the distri-

bution of the test statistic. The histogram was constructed from the F values
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Figure 5-3. The distribution of the F -statistic values from aMonte Carlo
permutation test compared wiht the F -statistic value of the ‘true’ data sets. The
black area corresponds to permutation based F -ratio values exceeding the F -ratio
value based on the ‘true data’.

calculated using the permuted data.* The position of the vertical arrowmarks
the value calculated from the ‘real’ data. The permutations where the corre-
sponding F-like statistic values are above this level represent the evidence in
favour of not rejecting the null hypothesis and their relative frequency repre-
sentsourestimateof the type I errorprobability.Theactual formula,whichwas
introduced in the Section 3.10, is repeated here:

P = nx + 1
N + 1

where nx is the number of the permutations yielding an F-statistic as large
or larger than that from the real data and N is the total number of per-
mutations. The value 1 is added to both numerator and denominator be-
cause (under the assumption of the null model) the statistic value calculated
from the actually observed data is also considered to come from the null-
model distribution and, therefore, to ‘vote against’ the null hypothesis rejec-
tion. The usual choices of the number of permutations (such as 99, 199, or
499) follow from this specific pattern of adding one to both numerator and
denominator.

* The ‘true’ value was also included, however.
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Figure 5-4. Project setupwizard page for selecting restrictions for a permutation
test.

5.7. Spatial and temporal constraints

The way the permutation test was described in the preceding section
is correct onlywhen the collected set of samples does not have any implied int-
ernal structure; namely, if the samples are sampled randomly, independently
of each other. In this case, we can fully randomly re-shuffle the samples,
because under the null model each sample’s environmental data (values of
explanatory variable) canbematchedwith anyother sample’s species datawith
equal probability.
This is no longer true when the ‘relatedness’ between different samples is

not uniform across the whole data set. The basic three families of the internal
data set structure recognized by Canoco for Windows are represented by the
choices in the setupwizard page illustrated in Figure 5-4.
The samplesmay be arranged along a linear transect through space or along

a time axis. In such cases, the samples cannot be permuted randomly, because
we must assume an autocorrelation between the individual observations in
both the species and the environmental data. We should not disturb this cor-
relation pattern during the test because our hypothesis concerns the relations
between the species and environmental data, not the relations within these
data sets. To respect this autocorrelation structure, CANOCO (formally) bends
the sequence of samples in both the species and the environmental data into a
circular form and a re-assignment is performed by ‘rotating’ the environmen-
tal data band with respect to the species data band. The Canoco for Windows
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manual should be consulted for more details of this and other permutation
restrictions.
A similar spatial autocorrelation occurs when we generalize the location of

samples on a linear transect into positioning of samples in space. CANOCO
supports only the placement of samples on a rectangular grid.
The most general model of the internal structure for data sets is provided

by the split-plot design, the last item in the dialog in Figure 5-4. This type
of permutation restrictions is described inmore detail in the following section
and an example of its use is shown in Chapters 15 and 16.
All these restrictions can be further nested within another level represent-

ing the blocks. Blocks can be defined in your analysis using nominal covari-
ables and they represent groups of samples that are similar to each other
more than to the samples from the other blocks. To account for variation
due to blocks, check the Blocks defined by covariables option in the dialog illus-
trated in Figure 5-2. In the permutation test, the samples are permuted only
within thoseblocks,never across theblocks. Ifwecomparea constrainedordin-
ation model with a model of the analysis of variance, the blocks can be seen
as a random factor with its effect not being interesting for interpretation
purposes.

5.8. Split-plot constraints

The split-plot design restriction available in Canoco for Windows 4.0
and 4.5 allows us to describe a structurewith two levels of variability (with two
‘error levels’) – see Section 2.5.+

The higher level of the split-plot design is represented by so-calledwhole-
plots. Each of the whole-plots contains the split-plots, which represent the
lower level of the design (see also Figure 2-5). CANOCO provides great flex-
ibility in permuting samples at the whole-plot and/or the split-plot levels,
ranging from no permutation, through spatially or temporally restricted per-
mutations up to free exchangeability at both levels (see the setup wizard page
inFigure 5-5). Inaddition,CANOCOallows for thenotionofdependenceof the
split-plot structure across the individual whole-plots. In this case, the particu-
lar permutations of the split-plots within the whole-plots are identical across
the whole-plots.
The availability of the permutation types supporting the split-plot design

in CANOCO is important because it is also often used for evaluation of data

+ Another level can be added, in some cases, using permutationwithin blocks defined by covariables (see
Section 5.7).
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Figure 5-5. Project setupwizard page for specifying permutation restrictions for a
split-plot design.

where community composition at sampling plots was repeatedly evaluated at
different times. See Chapter 15 for additional details.

5.9. Stepwise selection of themodel

At the end of Section 5.1, the forward selection of explanatory vari-
ables for a regression model was described in some detail. The forward selec-
tion available in the CANOCO program has the same purpose and methodol-
ogy. It uses a partial Monte Carlo permutation test to assess the usefulness of
each potential predictor (environmental) variable for extending the subset of
explanatory variables used in the ordinationmodel.
If we select an interactive (‘manual’) forward selection procedure in the

Canoco forWindows program, CANOCOpresents an interactive dialog during
the analysis (Figure 5-6).
Figure5-6 illustrates the state of the forward selectionprocedurewhere two

best explanatory variables (moisture and manure) were already selected (they
are displayed in the lower part of the window). The values in the upper part
of the window show that the two selected variables account for approximately
57% (0.624 of 1.098) of the total variability explained by all the environmental
variables (i.e. explainedwhen all the variables in the top list are included in the
ordinationmodel).
The list of variables in the upper part of the window shows the remaining

‘candidate predictors’ ordered by the decreasing contribution that the variable
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Figure 5-6. Dialog box for the forward selection of environmental variables.

would provide when added to the set of variables already selected. We can see
that the variable ‘HF’ (‘hobby farming’ type of management) is a hot candi-
date. Itwould increase the amount of explained variability from0.624 to0.760
(0.624 + 0.136).
To judge whether such an increase is larger than a random contribution,

we can use a partial Monte Carlo permutation test. In this test, we use the
candidate variable as the only explanatory variable (so we get an ordination
model with just one canonical axis). The environmental variables already
selected (moisture andmanure, in our example) are used in this test as covari-
ables, together with any a priori selected covariables. If we reject the null
hypothesis for this partial test, we can include that variable in the subset.
The effect of the variable tested in such a context is called its conditional

(or partial) effect and it depends on the variables already selected. But at the
start of the forward selection process, when no environmental variable has yet
entered the selected subset, we can test each variable separately, to estimate its
independent,marginal effect. This is the amount of variability in the species
data that would be explained by a constrained ordination model using that
variable as the only explanatory variable. The discrepancy between the order
of variables sorted based on theirmarginal effects and the order corresponding
to a ‘blind’ forward selection (achieved by always picking the best candidate) is
caused by the correlations between the explanatory variables. If the variables
were completely linearly independent, both orders would be identical.
If the primary purpose of the forward selection is to find a sufficient subset

of the explanatory variables that represents the relation between the species
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and environmental data, thenwe have a problemwith the ‘global’ significance
level referring to the whole subset selection. If we proceed by selecting the
environmental variables as long as the best candidate has a type I error esti-
mate (P ) lower than some pre-selected significance level α, then the ‘global’
type I error probability is, in fact, higher than this level. We do not know how
large it is, but we know that it cannot be larger than Nc · α. Nc is the max-
imum number of tests (comparisons) that can be made during the selection
process.
The adjustment of the significance threshold levels on each partial test

where we select only the variables with a type I error probability estimate less
than α/Nc is called a Bonferroni correction (Cabin & Mitchell 2000; Rice
1989). Here the value of Nc represents themaximumpossible number of steps
during the forward selection (i.e. the number of independent environmental
variables). Use of Bonferroni correction is a controversial issue: some statisti-
cians do not accept the idea of ‘pooling’ the risk of multiple statistical tests.
There are also other methods of correcting the significance levels in partial
tests, reviewed inWright (1992). They are slightlymore complicated thanBon-
ferroni correction, but result inmore powerful tests.
We can also look at the problem of selecting a subset of ‘good’ explanatory

variables from a larger pool from a different angle: the probability that a vari-
able will be a significant predictor (e.g. of the species composition) purely due
to chance equals our pre-specified significance level. If we have, in constrained
ordination analysis, 20 environmental variables available, we can expect that
on average one of them will be judged significant even if the species are not
related to anyof them. Ifwe select a subset of thebest predictors, drop theother
variables, and then test the resultingmodel, wewill very probably get a signif-
icant relationship, regardless of whether the environmental variables explain
the species composition or not.
Let us illustrate the situationwith a simple example. For real data on species

composition of plots on an elevation gradient (Lepš et al. 1985; file tatry.xls,
the tatry sheet), we have generated 50 random variables with a uniform distri-
bution of values between zero and a random number between zero and 100
(sheet tatrand ).* Now, we suggest you use those 50 variables as the environ-
mental data.UseCCA (canonical correspondence analysis)with the default set-
tings and themanual forward selection. During the forward selection, use the
‘standard’ procedure, i.e. test each variable, and finish the forward selection
if the best variable has the significance level estimate P > 0.05. In this way,

* Themacro used to generate the values of environmental variables is included in the same Excel file so
that you can check how the variables were generated.
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three variables are selected (var20, var31 and var47). If you now test the result-
ing model, the global permutation test estimates the type I error probability
P = 0.001 (with 999permutations). Clearly, the forward selection (or any step-
wiseprocedure) is apowerful tool formodelbuilding.However,whenyouneed
to test the significance of the builtmodel, use of an independent data set is nec-
essary. If your data set is large enough, then the best solution is to split the data
into apartused formodel building, andapartused formodel testing (Hallgren
et al. 1999).
Another difficulty that we might encounter during the process of forward

selection of environmental variables occurs when we have one or more factors
coded as dummy variables and used as explanatory (environmental) variables.
The forward selection procedure treats each dummy variable as an indepen-
dent predictor, so we cannot evaluate the contribution of the whole factor at
once. This is primarily because the whole factor contributes more than one
degree of freedom to the constrained ordination model. Similarly, a factor
with K levels contributes K−1 degrees of freedom in a regression model. In a
constrainedordination, K−1 canonical axes areneeded to represent the contri-
bution of such a factor. While this independent treatment of individual factor
levels canmake interpretation difficult, it also provides an opportunity to eval-
uate the extent of differences between the individual classes of samples defined
by such a factor. The outcome is partly analogous to the multiple comparison
procedure in analysis of variance.$

5.10. Variance partitioning procedure

In theprevious section,weexplained thedifferencebetween thecondi-
tional andmarginal effects of individual explanatory (environmental) variables
upon the species data (the response variables). We also stated that the discrep-
ancy in the importance of explanatory variables, as judged by their marginal
effects and their conditional effects, is causedby the correlationsbetween those
explanatory variables. Any two explanatory variables that are correlated share
part of their effect exercised* upon the speciesdata.Theamountof the explana-
tory power shared by a pair of explanatory variables (A and B, say) is equal to
the difference between variable A’s marginal effect and its conditional effect
evaluated in addition to the effect of variable B.+

$ But here we compare the partial effect of a particular factor level with a pooled effect of the not-yet
selected factor levels.

* In a statistical, not necessarily causal, sense.
+ The relation is symmetrical – we can label any of the two considered variables as A and the other as B.



74 5. Constrained ordination and permutation tests
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X1 X2

Figure 5-7. Partitioning of the variance in the species data into the contributions of
two subsets of environmental variables (A, B, and the shared portion C) and the
residual variance (D).

This concept forms the basis of the variance partitioningX procedure
(Borcard et al.1992). In this procedure,weusually donotquantify the effects of
just two explanatory variables: rather, we attempt to quantify the effects (and
their overlap) of two or more groups of environmental variables representing
some distinct, ecologically interpretable phenomena. A separation of the vari-
ability of community composition in space and in timemight serve as a typical
example.
We will describe the variance partitioning procedure using the simplest

example with two groups of explanatory variables (X1 and X2). Each group
contains one or more individual environmental variables. The diagram in
Figure 5-7 presents the breakdown of the total variability in the species data
according to those two groups of variables.
TheareamarkedasDcorresponds to the residual variability, i.e. thevariabil-

ity not explained by the ordination model, which includes the environmental
variables fromboth the X1 and the X2 groups. FractionA represents the partial
effect of the variables from group X1, similarly fraction B represents the par-
tial effect of the variables in group X2. The effect shared by both groups is the
fraction C. The amount of variability explained by group X1, when ignoring
variables fromgroup X2, is equal toA+C.We estimate the individual fractions
A, B and C using partial constrained ordinations.
We estimate A from the analysis where variables from X1 are used as envi-

ronmental variables and the variables from X2 as covariables. Similarly, we est-
imate B as the sumof the eigenvalues of canonical axes from the analysiswhere

X Variance partitioning is also called variation partitioning (Legendre & Legendre, 1998), which is a
more appropriate name if we include unimodal ordinationmodels in our considerations.
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X2 act as environmental variables and X1 as covariables. We then calculate the
size of C by subtracting the sum of A and B from the amount of variability
explained by an ordination model with the variables from both X1 and X2

acting as explanatory variables. Occasionally, a shared variance fraction (such
as C in our example)might have a negative value, indicating that the joint exp-
lanatory effect of the two groups of variables is stronger than a sum of their
marginal effects. See Legendre and Legendre (1998), p. 533 for amore detailed
discussion of this issue.
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Similaritymeasures

In many multivariate methods, one of the first steps is to calculate
a matrix of similarities (resemblance measures) either between the samples
(relevés) or between the species. Although this step is not explicitly done in all
themethods, in fact each of themultivariatemethodsworks (even if implicitly)
with some resemblancemeasure. The linear ordinationmethods canbe related
to several variants ofEuclideandistance,while theweighted-averagingordina-
tionmethods canbe related to chi-squaredistances.The resemblance functions
are reviewed inmany texts (e.g. Gower & Legendre 1986; Legendre & Legendre
1998; Ludwig & Reynolds 1988; Orloci 1978), so here we will introduce only
themost important ones.
In this chapter, we will use the following notation: we have n samples

(relevés), containingm species. Yik represents the abundance of the kth species
(k = 1, 2, . . . ,m) in the ith sample (i = 1, 2, . . . , n).
It is technically possible to transpose the data matrix (or exchange i and

k in the formulae), thus any of the resemblance functions can be calculated
equally well for rows or columns (i.e. for samples or species). Nevertheless,
there are generally different kinds of resemblance functions suitable for
expressing the (dis)similarity among samples, and those suitable for describ-
ing similarity among the species.* This is because the species set is usually
a fixed entity: if we study vascular plants, then all the vascular plants in
any plot are recorded – or at least we believe we have recorded them. But
the sample set is usually just a (random) selection, something which is not
fixed. Accordingly, the similarity of (the vascular flora of) two samples is a

* By similarity of samples, wemean the similarity in their species composition. By similarity of
species, wemean the similarity of their distribution among the samples, which presumably reflects
the similarity of their ecological behaviour (those are often called species associationmeasures).
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meaningful characteristic, regardless of the sample set with which we are
working.+

On the other hand, similarity of two species has a meaning only within
some data sets; for example,Oxycoccus quadripetalus and Carexmagellanicamight
exhibit ahighsimilaritywithina landscape (because theyare foundtogetheron
peat bogs), whereas they will have a low similarity within a peat bog (because
Oxycoccus is foundonhummocks andCarex inhollows). The set of analysed sam-
ples is considered a randomselection of all possible samples in the studied area
(inclassical statistical terminology, a sampleofapopulationof samplingunits).
The species similarity in the analysed data set can be considered an estimate of
the species similarity in the studiedarea.Therefore, standarderrorsof estimate
canbe (and in some caseshavebeen) derived for the species similarities (see, e.g.
Pielou 1977, p. 210). Naturally, when the studied area is a peat bog, the results
will be different from those when the studied area is amountain complex.
Also, there is a reasonable null model for species similarity: the species oc-

cur independently of each other (this corresponds to the null hypothesis for a
2 × 2 contingency table or for a correlation analysis). Consequently, many of
themeasures of species similarity are centred around zero, with the zero value
corresponding to species independence (all the coefficients mentioned in the
following text). For similarities of samples, there is no similar null model.

6.1. Similaritymeasures for presence–absence data

There are two classical similarity indices that are used in vegeta-
tion studies for evaluating the similarity of samples: the Jaccard coefficient
(Jaccard 1901) and the Sörensen (Sörensen 1948) coefficient. To be able to
present their formulae, we first define values of a, b, c and d using a 2 × 2 fre-
quency table:

Species in sample B

present absent

Species in present a b

sample A absent c d

Therefore, a is the number of species present in both samples being com-
pared, b is the number of species present in sample A only, c is the number of

+ When the sample set is extended, new speciesmight appear in the whole data set, but all of them are
absent from the samples already present in the original set.
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species present in sample B only, and d is the number of species absent from
both samples. The Sörensen coefficient is then defined as

S = 2a
2a + b + c

and the Jaccard coefficient as

J = a

a + b + c

Although there are somedifferences between these two coefficients, the results
based on them are roughly comparable. For both coefficients, the similarity of
identical samples equals 1 and the similarity of samples sharingno species is 0.
When we need to express the dissimilarity of samples, usually 1 − S , or 1 − J
is used.X Note that the above coefficients do not use the d value. The number of
species absent from both samples does not convey any ecologically interesting
information, except in some specific cases.
For calculating the similarity of species, a, b, c and d aredefinedas follows:

Species B

present absent

Species A
present a b
absent c d

where a is the number of sampleswhere both species are present, b is the num-
ber of samples only supporting species A, c is the number of samples with
species B only, and d is the number of samples where neither of the two species
is present. As a measure of species similarity, we usually employ the measures
of ‘association’ in a 2 × 2 table. Themost useful ones are probably the V coeffi-
cient (based on the classical chi-square statistic for 2 × 2 tables):

V = ad − bc√
(a + b)(c + d )(a + c )(b + d )

and the Q coefficient:

Q = ad − bc

ad + bc

Values of both V and Q range from −1 to +1, with 0 corresponding to the
case where the two species are found in common exactly at the frequency cor-
responding to the model of their independence (i.e. where the probability of

X But you should use square-roots of these values when you need to obtain dissimilarities (distances)
withmetric properties.
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common occurrence Pi j is a product of the independent probabilities of occur-
rences of the species: Pi j = Pi · P j ). Positive values mean a positive association,
negative values imply a negative association.
The difference between the V and Q measures is in their distinguishing

between complete and absolute association (see Pielou 1977).Complete asso-
ciation is the maximum (minimum) possible association under given species
frequencies. Thismeans that for a complete positive association, it is sufficient
that either b or c is zero (i.e. the rarer of the species is always found in the
samples where the more common species is present). Similarly, for complete
negative association, a or d must be zero.Absolute positive association occurs
when both species have the same frequency and are always found together
(i.e. b = c = 0). Absolute negative association means that each of the samples
contains just one of the two species (i.e. a = d = 0). V is also called the point
correlation coefficient because its value is equal to the value of the Pearson
correlation coefficient of the two species, when we use the value of 1 for the
presence of species and 0 for its absence. This is a very useful property, because
qualitative data areusually coded thisway and the classical Pearson correlation
coefficient is readily available in virtually all computer programs.*

Note that, unlike the similarity of samples, the d value is absolutely neces-
sary for the similarity of species (contrary to recommendations of, for example,
Ludwig and Reynolds 1988, and others). We illustrate this by an example:

Table A

Species B

present absent

Species present 50 50
A absent 50 1000

Table B

Species B

present absent

Species present 50 50
A absent 50 5

In Table A, the two species, both with a low frequency, are found together
much more often than expected under the hypothesis of independence (this
might be the example of Carex and Oxycoccus at the landscape scale). Accord-
ingly, both V and Q are positive. On the other side, in Table B, both species
have relatively high frequencies, and are found much less in common than
expected under the independence hypothesis (e.g.Carex andOxycoccuswithin a

* However, we cannot trust here the related statistical properties of the Pearson correlation coefficient,
such as confidence intervals, statistical significance, etc., because their derivation is based on the
assumption of normality. For the statistical properties of V and Q coefficients, see Pielou (1977,
p. 210).
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peat bog). In this case, both V and Q are negative. Clearly, the species similarity
has a meaning only within the data set we are analysing. Therefore, the simi-
larity indices that ignore the d value are completely meaningless. Our experi-
ence shows that their value is determinedmainly by the frequencies of the two
species being compared. For further reading about species association, Pielou
(1977) is recommended.

6.2. Similaritymeasures for quantitative data

Transformation and standardization

When we use the (dis)similarities based on species presence–absence,
the information on species quantity in a sample is lost. From an ecological
point of view, it may be very important to know whether the species is a sub-
ordinate species found in a single specimen orwhether it is a dominant species
in the community.There are variousquantitativemeasures of species represen-
tation (sometimes generally called importance values): number of individuals,
biomass, cover, or frequency in subunits. Often the quantity is estimated on
some semi-quantitative scale (e.g. theBraun–Blanquet scale fordata about veg-
etation). The quantitative data are sometimes transformed and/or standard-
ized (see Sections 1.8 and 4.4). Transformation is an algebraic function
Y ′
ik = f (Yik) which is applied to each value independently of the other values.
Standardization is done, on the other hand, with respect to either the values
of other species in the same sample (standardization by samples) or the val-
ues of the same species in the other samples (standardization by species).
In vegetation ecology, the two extremes are presence–absence and non-

transformed species cover (similar results would be obtained using non-
transformednumbers of individuals, biomass orbasal area values). Inbetween,
there are measures such as an ordinal transformation of the Braun–Blanquet
scale (i.e. replacement of the original scale values r, +, 1 . . .with the numbers
1, 2, 3, . . . ) which roughly corresponds to a logarithmic transformation of the
cover data (or log-transformed cover, biomass, etc.). In many vegetation stud-
ies, this is a reasonable and ecologically interpretable compromise. Similarly
in animal ecology, the two extremes are presence–absence, and numbers of
individuals or biomass. The log transformation is again often a reasonable
compromise.
Van derMaarel (1979) showed that there is a continuum of transformations

that can be approximated by the relation Ytransf = Y z (see also McCune and
Mefford 1999). When z = 0 the data values are reduced to presence and
absence. As the value of z increases, the final result is increasingly affected by
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thedominant species. For similarpurpose, theBox–Cox transformation (Sokal
& Rohlf 1995) could also be used.
We have shown (Lepš &Hadincová 1992) that, when the analysis is based on

cover values, ignoring all species in a relevé that comprise less than 5% of the
total cover does not significantly affect the results. The results in this case are
completely dependent on the dominant species. Because of the typical distri-
bution of species importance values in most ecological communities (i.e. few
dominants and many subordinate species, whose counts and/or biomass are
much lower than those of the dominant ones), the same will be true for non-
transformed counts of individuals or biomass data. A log(Y + 1) transforma-
tionmight be used to increase the influence of subordinate species.
The data can also be standardized (and centred) by samples and/or by

species.Centring (‘centering’ inCANOCOuser interface)means subtractionof
the mean so that the resulting variable (species) or sample has a mean of zero.
Standardization usually means division of each value by the standard devi-
ation. After standardization by the sample (species) norm (square root of the
sumof squares of the values), the vector corresponding to the resulting sample
or species values has a unit length.* We can also standardize individual samples
or species by the total of all the values in a sample (species), thus changing the
values to percentages.
We shouldbe extremely carefulwith standardizationby species (eitherwith

or without centring). The intention of this procedure is to give all the species
the same weight. However, the result is often counter-productive, because a
species with a low frequency of occurrence might become very influential. If
the species is found in one sample only, then all of its quantity is in this sam-
ple alone,whichmakes this sample verydifferent fromtheothers.On theother
hand, the species that are found inmany samples do not attain, after standard-
ization, a high share in any of them and their effect is relatively small.
When we calculate similarities on data other than species quantities, often

each variable has its own scale. In this case, it is necessary to standardize the
variables by calculating the z-scores. This procedure corresponds to centring
and subsequent standardization by the variable norm. A typical example of
this comes fromclassical taxonomy: eachobject (individual, population) is des-
cribed by several characteristics, measured in different units (e.g. number of
petals, density of hairs, weight of seeds, etc.). When the similarity is calculated
from the rough data, the weight of individual variables changes when we
change their units – and the final result is completelymeaningless.

* The standardization by sample (or species) norm (also callednormalization) is equivalent to
standardization by the standard deviation value if the sample (or species) vectors have been centred
first. Whenwemention standardization in further text, we refer to standardization by the norm.
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The standardization by samples (either by sample norm or by the total) has
a clear ecologicalmeaning. Ifwe use it, we are interested only in proportions of
species (both for the standardization by totals and by the sample norm). With
standardization, two samples containing three species, in thefirst samplewith
50, 20 and 10 individuals and in the second sample with 5, 2 and 1 individual,
will be found to be identical.X Standardization by the total (i.e. to percentages)
is more intuitive; for example, zoologists frequently use those values and call
them ‘dominance’. The standardization by sample norm is particularly suit-
able when applied before calculating the Euclidean distance (see below). The
standardization by samples should be routinely used when the abundance
total in a sample is affected by the sampling effort or other factors that
we are not able to control, but which should not be reflected in the calculated
similarities.+

Similarity or distance between samples

Probably themost commonmeasure of dissimilarity between samples
isEuclideandistance (ED). For a datamatrixwithm species,with the value of
the kth species in the ith samplewritten asYik, theED is theEuclideandistance
between the two points:

ED1,2 =
√√√√

m∑

k=1

(Y1k − Y2k)2

If we consider the samples to be points in multidimensional space, with each
dimension corresponding to a species, then ED is the Euclidean distance be-
tween the two points in this multidimensional space. ED is a measure of dis-
similarity, its value is 0 for completely identical samples and the upper limit
(when the samples have no species in common) is determined by the represen-
tation of the species in the samples. Consequently, the EDmight be relatively
low, even for samples that do not share any species, if the abundances of all
present species are very low. This need not be considered a drawback, but it
must be taken into account in our interpretations. For example, in research on
seedling recruitment, the plots with low recruitment can be considered sim-
ilar to each other in one of the analyses, regardless of their species composi-
tion, and this is then correctly reflected by the values of EDwithout standard-
ization (see Chapter 14). If we are interested mainly in species composition,
then standardization by sample norm is recommended.With standardization

X The differences in ecological interpretations of analyses with andwithout standardization by sample
norm are discussed in Chapter 14.

+ For example, the number of grasshoppers caught in a net depends on the sampling effort and also on
the weather at the time of sampling. If we are not sure that both factors were constant during all the
sampling, it is better to standardize the data.
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Table 6-1.Hypothetical table

Samples

Species 1 2 3 4 1t 2t 3t 4t 1n 2n 3n 4n

1 10 5 1 0.33 1 0.58
2 10 5 1 0.33 1 0.58
3 5 0.33 0.58
4 5 0.33 0.58
5 5 0.33 0.58
6 5 0.33 0.58

Hypothetical table with samples 1 and 2 containing one species each and samples 3 and 4, con-
taining three equally abundant species each (for standardized data the actual quantities are not
important). Sample 1 has no species in common with sample 2 and sample 3 has no species in
common with sample 4. The samples with t in their labels contain values standardized by the
total; those with n are samples standardized by sample norm. For samples standardized by total,
ED1,2 = 1.41(=

√
2), whereas ED3,4 = 0.82, whereas for samples standardized by sample norm,

ED1,2 = ED3,4 = 1.41.

by sample norm (sometimes called standardized Euclidean distance or the
chorddistance,Orloci1967), theupper limit of thedissimilarity is

√
2 (i.e. the

distance between two perpendicular vectors of unit length).
Legendre&Gallagher (2001) discuss various data transformations and their

effect on theEuclideandistance (sometimes a special name is coined for the ED
after a particular data transformation is used).
The use of ED is not recommended with standardization by sample totals.

With this standardization, the length of the sample vector decreases with the
species richnessand, consequently, the samplesbecome (according toED)more
and more similar to each other. We will illustrate this situation by an exam-
ple inTable6-1. Thedecrease in similaritywith species richnessof the sample is
quite pronounced. For example, for two samples sharing no common species,
with each samplehaving10 equally abundant species, theEDwill be only0.45.
Among the ordination methods, the linear methods (PCA, RDA) reflect the

Euclidean distances between the samples (with the corresponding standard-
ization used in the particular analysis).
Another very popular measure of sample similarity is percentage (or

proportional) similarity. Percentage similarity of samples 1 and 2 is
defined as

PS1,2 =
2

m∑
k=1
min(Y1k,Y2k)

m∑
k=1
(Y1k + Y2k)
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Its value is 0 if the two samples have no common species, and it is 1.0 for two
identical samples (sometimes it is multiplied by 100 to produce values on the
percentage scale). If needed, it can be used as the percentage dissimilarity
PD = 1–PS (or PD = 100–PS, when multiplied by 100), also called the
Bray–Curtis distance (Bray & Curtis, 1957). When used with presence–
absence data (0 = absence, 1 = presence), it is identical to the Sörensen coeffi-
cient. If it is used with data standardized by the sample total, then its value is:

PS1,2 =
m∑

k=1

min(Y ′
1k,Y

′
2k)

with

Y ′
ik = Yik

m∑
k=1

Yik

These resemblance measures are used under a plethora of names (see, for
example,Chapter7 inLegendre&Legendre1998, orMcCune&Mefford1999).
Chi-squared distance is rarely used explicitly in ecological studies.

However, as linear ordination methods reflect Euclidean distance, unimodal
(weighted-averaging) ordination methods (CA, DCA, CCA) reflect chi-square
distances. In its basic version, the distance between samples 1 and 2 is
defined as:

χ
2
1,2 =

√√√√
m∑

k=1

S++
S+k

[
Y1k

S1+
− Y2k

S2+

]2

where S+k is the total of the kth species values over all samples:

S+k =
n∑

i=1

Yik

Si+is the total of all the species values in the ith sample:

Si+ =
m∑

k=1

Yik

and S++ is the grand total:

S++ =
n∑

i=1

m∑

k=1

Yik

The chi-squared distance is similar to Euclidean distance, but it is weighted
by the inverse of the species totals. As a consequence, the species with
low frequencies are over-emphasized.* The chi-square distance value for two

* This is why the optional ‘downweighting of rare species’ is available in unimodalmethods.
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identical samples is 0 and its upper limit depends on the distribution of the
species values. Legendre&Gallagher (2001) have shownthat the chi-squaredis-
tance is actually usedwhen the Euclidean distance is calculated after a particu-
lar type of data standardization.

Similarity between species

For species similarity based onquantitative data, the classicalPearson
correlation coefficient is often a reasonable choice. When it is used for qual-
itative (presence–absence) data, it is identical to the V coefficient. This shows
that it is a good measure of covariation for a wide range of species abundance
distributions (nevertheless, the critical values for the Pearson correlation co-
efficient are valid only for the data with an assumed two-dimensional normal
distribution). An alternative choice is provided by one of the rank correlation
coefficients, Spearman or Kendall coefficients. Values of all the correlation co-
efficients range from −1 for a deterministic negative dependence to +1 for a
deterministic positive dependence, with the value of 0 corresponding to inde-
pendence. Note that both rank correlation coefficients are independent of the
standardization by samples.

6.3. Similarity of samples versus similarity of communities

The above-described sample similaritymeasures describe just the sim-
ilarities between two selected samples. It is often expected that the samples
are representative of their communities. In plant ecology, this is usually
correct: either we believe in the minimal area concept – Moravec (1973)
(and consequently the relevés are taken accordingly and we believe that
they are good representatives of the respective communities and, therefore,
do not care any further) – or we are interested in the variation in species
composition at the spatial scale corresponding to the size of our samples
(quadrats).
The situation is very different in many insect community studies. There,

the individuals in a sample represent a selection (usually not a completely ran-
dom one) from some larger set of individuals forming the community. This
is especially true in the tropics, where species richness is high and not only a
fraction of individuals but also a small fraction of taxa is represented in the
sample. Even in large samples, many species are represented by single individ-
uals and consequently the probability that the species will be found again in a
sample froma similar community is nothigh. For example, in samples (greater
than 2000 individuals) of insects feeding on tree species in PapuaNewGuinea,
over 40% of species were represented by singletons (Novotný & Basset 2000).



86 6. Similaritymeasures

Consequently, the similarity of the two random samples taken from the com-
munitymight be low and depends on the sample size.
There are methods that attempt to measure the similarity of the sampled

communities, and so to adjust for the size of the compared samples. One such
measure is the normalized expected species shared index (NESS, Grassle
& Smith 1976). It is calculated as the expected number of species in common
between two random subsamples of a certain size drawn from the two
compared larger samples without replacement, normalized (divided) by the
average of the expected number of shared species in the two subsamples taken
randomly from the first sample and in two subsamples taken randomly from
the second sample. These measures, however, are not computationally sim-
ple and are not available in common statistical packages. The Morisita index
(1959), popular in zoological studies, is a special case of the NESS index. It
measures the probability that two individuals selected randomly from different
subsamples will be the same species. This probability is standardized by the
probability that two individuals selected randomly from the same subsample
will be the same species. It is calculated as:

Morisita1,2 =
2

m∑
k=1

Y1kY2k

(λ1 + λ2)S1+S2+

where

λi =

m∑
k=1

Yik(Yik − 1)

Si+(Si+ − 1)

The index can be used for numbers of individuals only, so:

Si+ =
m∑

k=1

Yik

is the total number of individuals in the ith sample.

6.4. Principal coordinates analysis

Principal coordinates analysis (PCoA or PCO, also calledmetric multi-
dimensional scaling, and described by Gower 1966) is a multivariate method
that attempts to represent in the Cartesian coordinate system a configuration
of n objects (samples), defined by a n × n matrix of dissimilarities (distances)
or similarities between these objects. Unlike the principal component analysis
(PCA),which canalsobedefined in similarway, PCoA is able to represent awide
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range of similarity (or distance)measures in the space of principal coordinates.
Similar to PCA, the first axis (principal coordinate) of the PCoA solution repre-
sents the truedistances in thematrix in thebest possibleway as canbe achieved
with one dimension. As in PCA, each axis has an eigenvalue that indicates its
importance. Therefore, starting from the first axis, the importance of princi-
pal coordinates decreases in the order of their decreasing eigenvalues.
There is, however, one additional ‘problem’,whichoften occurs in thePCoA

solution. Not all the (dis)similarity measures can be fully represented in the
Euclidean space. If this happens, PCoA produces one or more axes with neg-
ative eigenvalues. Because the eigenvalues represent the variance explained
on the corresponding principal coordinates, the scores of samples (objects)
on those axes are not real, but rather complex numbers (with an imaginary
component). These cannot be plotted, due to their non-Euclidean properties.
Consequently, the sum of absolute values of such negative eigenvalues related
to the sum of absolute values of all the eigenvalues represents the distortion
of the original distance matrix properties caused by projection into Euclidean
space. Anyway, in the standard applications of PCoA, we do not typically plot
all theprincipal coordinates corresponding to thepositive eigenvalues. Rather,
only the first few axes are interpreted, similar to other ordinationmethods.
To eliminate the presence of negative eigenvalues, at least two different

correction methods have been developed. These methods adjust the original
distance matrix to enable its full embedding in the Euclidean space of PCoA.
Instead of using such non-intuitive adjustments, we prefer either to choose a
different (dis)similaritymeasure or to perform its simple,monotonic transfor-
mation. For example, when the distances are based on a complement-to-1 (i.e.
1minus the coefficient value) of a non-metric similarity coefficient (such as the
Sörensen coefficient, see Section 6.1), then the square-root transformation of
such distance has the requiredmetric properties.
To calculate PCoA in the CANOCO program, you can use the PrCoord pro-

gram, available from version 4.5. You can use either a pre-computedmatrix of
distances or you can specify a data file in CANOCO format and select one of
the distances that PrCoord is able to calculate. PrCoord produces a new data
file (in CANOCO format) which contains sample coordinates on all PCoA axes
with positive eigenvalues. This format is handy for using the PCoA results to
calculate the constrained PCoA (the distance-based RDA, see Section 6.6) with
CANOCO,but you can alsouse this file todisplay just thePCoA resultswith the
CanoDraw program. Youmust use the file produced by PrCoord as the species
data file in theCANOCOanalysis and specify the principal component analysis
(PCA) method, with scaling of scores focused on inter-sample distances, no
post-transformation of species scores and centring by species only.
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Figure 6-1. First two axes of PCoAwith passively projected species centroids
(shown as empty triangles), altitude variable (shown as an arrowwith shaded
head), and position of individual samples (filled circles, labelled with sample
numbers). The arrows for the original scores on PCoA axes are also displayed
(the first two axes, labelled Ax1 and Ax2).

Wewill illustrate the application of PCoAusing theTatry data set, described
in detail in Section 7.1. To calculate PCoA, start the PrCoord program, specify
the tatry.spe file as the input datafile, with no transformations, Bray–Curtis
distance, andDonot use treatment of negative eigenvalues. For example, specify
tat pcoa.dta for the Output file. After you click the Calculate button, PrCoord
runs the analysis and reports that there are 14 principal coordinates (the
dimensionality is limited here by the number of samples): 10 first coordinates
have positive eigenvalues, one has an eigenvalue equal to zero, and then there
are three coordinates with negative eigenvalues. Also note the dominating
extent of variation explained on the first axis (λ1 = 1.226), compared with the
second axis (λ2 = 0.434).
Now create a new project in Canoco forWindows, specifying the tat pcoa.dta

file as species data. You can use the original species composition data (tatry.spe)
as supplementary variables, if you want to project them post hoc into the PCoA
space. The resulting diagram is shown in Figure 6-1.
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Here we specified both tatry.spe and tatry.env as supplementary data, and we
assumed a unimodal response of individual species along the gradient, so that
the supplementary variables representing plant species are shown as ‘nominal
variables’ (i.e. at centroids of the samples in which they occur).
Note that the original PCoA axes are precisely aligned with the axes of the

intermediate PCA and that this data set has probably just one interpretable,
altitudinal gradient, represented by the first principal coordinate. This is also
documented by the artificial character of the second axis, displaying the arch
effect. See Section 7.1 for additional ecological interpretation of the revealed
patterns.

6.5. Non-metricmultidimensional scaling

The method of ordination can be formulated in several ways (see
Section 3.5). A very intuitive one is finding a configuration in the ordination
space in which distances between samples in this space best correspond to dis-
similarities of their species composition. Generally, n objects could be ordi-
nated in n − 1dimensional spacewithout anydistortion of dissimilarities. The
need of clear visual presentations, however, dictates the necessity of reduction
of dimensionality (two-dimensional ordination diagrams are most often pre-
sented in journals).
This reduction could be done in ametric way, by explicitly looking for pro-

jection rules (using principal coordinates analysis, see previous section), or in a
non-metric way, by non-metric multidimensional scaling (NMDS, Cox & Cox
1994; Kruskal 1964; Shepard 1962). This method analyses the matrix of dis-
similarities between n objects (i.e. samples) and aims to find a configuration
of these objects in k-dimensional ordination space (k is a priori determined), so
that those distances in ordination space correspond to dissimilarities. A statis-
tic termed ‘stress’ is designed to measure the ‘lack of fit’ between distances in
ordination space and dissimilarities:

stress = 	[di j − f (δi j )]2

where di j is the distance between sample points in the ordination diagram,
δi j is the dissimilarity in the original matrix of distances, calculated from the
data, and f () is a non-metric monotonous transformation. In this way, the
‘correspondence’ is defined in a non-metric way, so that the method repro-
duces the general rank-ordering of dissimilarities (not exactly the dissimi-
larity values). The algorithm re-shuffles the objects in the ordination space
to minimize the stress. The algorithm is necessarily an iterative one, and its
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convergence depends on the initial configuration; also, the globalminimum is
not always achieved and, consequently, it is worthwhile trying various initial
configurations. TheNMDSmethod is now available inmost general statistical
packages, as well as in specializedmultivariate packages. The implementation
details differ among these programs (for example, it is possible to start from
various initial configurations and automatically select the result with lowest
stress).
In contrast to the other ordination method, the input data (in both met-

ric and non-metric multidimensional scaling) are not the original samples by
species table, but a matrix of similarities between objects. Consequently, vir-
tually any measure of (dis)similarity could be used.* Unlike other methods, in
NMDSthenumberof ordinationaxes (i.e. thedimensionality of theordination
space) is given a priori. In real applications, various dimensionalities (number
of axes, k) are tried, and the ‘proper’ number of dimensions is decided accord-
ing to the ‘quality’ of resulting models. The quality is measured by the stress
of the resulting configuration. As the method is normally used as an indirect
ordination, the interpretability of the results is usually one of the criteria. As
with the other indirectmethods, the axes could be a posteriori interpretedusing
measured environmental variables, which could be a posteriori projected to the
ordination diagram.
Wewill demonstrate the use of thismethodwith the Statistica program, on

the example data from the elevation gradient in the Tatry Mts., described in
Section 7.1. During the classification, you save the dissimilarity matrix in file
tatrydis.sta (see Section 7.3), and use this matrix now as the input data (or you
can calculate any (dis)similarity matrix, e.g. in Excel, and enter it according to
the rules for (dis)similarity matrices in Statistica). The startup panel is very
simple: you have to specify that you want to analyse all the variables (which
implies all the samples, in our case) and the number of dimensions to be used
(wewill use two in this example). The other options are related to the details of
thenumerical procedure, and thedefault valuesprobablyneednotbe changed.
The starting configuration will be Standard G-L, which means that the starting
configuration is calculated byusingPCA.Then you could follow thenumerical
procedure (particularly importantwhen there areproblemswith convergence).
The most important result for us is, however, the final configuration in the
ordination space. Even when you use more than two dimensions, graph the
final configuration as two-dimensional graphs, combining the axes as needed.
The final result is shown in Figure 6-2.

* Recall that this matrix is implicitly determined by selection of linear/unimodalmodel in the
response-model-based ordinations.
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Figure 6-2. Ordination diagram of NMDS of the Tatry data set, based on Euclidean
distances.

You can see that the method reasonably reconstructed the elevation
gradient: thefirst axis is strongly correlatedwith the elevation.The secondaxis
is difficult to interpret, and is clearly a quadratic functionof thefirst axis – even
the NMDS do not escape the arch effect.
NMDS is, however, usedmore oftenwith dissimilaritymeasures other than

Euclidean distance. We applied it to the matrix of percent dissimilarities. The
matrixwas calculatedusing amacro inExcel, file persim.xls – seeChapter7. The
results of NMDS based on percent dissimilarities (Figure 6-3) are (in this case)
very similar to thosebasedontheEuclideandistances– includingthequadratic
dependence of the second axis on the first.
The specialized programs provide more advanced options for NMDS than

theStatisticaprogram.Forexample, thePCORDprogramprovidesaprocedure
assisting you with the selection of an optimum dimensionality for the NMDS
solution.

6.6. Constrained principal coordinates analysis (db-RDA)

A constrained PCoA method, representing a canonical form for the
analysis of amatrix of (dis)similarities, was proposed by Legendre & Anderson
(1999) under the name distance-based RDA (db-RDA). To perform this type
of analysis, the analysis of principal coordinates must be performed on the
matrix of sample (dis)similarities and the resulting sample coordinates (using
all the axes with positive eigenvalues, after optional correction for negative
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Figure 6-3. Ordination diagram of NMDS of the Tatry data set, based on percent
dissimilarities.

eigenvalues, see Section 6.4) are entered as species data into a redundancy
analysis (RDA).
This method enables us to test hypotheses about the effects of explanatory

variables on community composition, while (almost) freely selecting the mea-
sure of (dis)similarity among the collected samples. Distance-based RDA can
use covariables and also reflect non-random sampling or the experimental
design duringMonte Carlo permutation tests.
Note, however, that we pay for this flexibility by losing the model of

species relation with the (constrained) ordination axes, which is fruitfully
used when interpreting the standard constrained ordinations (RDA or CCA).
While we can project selected species a posteriori into the db-RDA diagram,
there is no implied model of species response. Therefore, our decision to
show species as arrows (implying linear change of species abundances across
the db-RDA space) or as centroids (implying unimodal models) is an arbi-
trary choice, with no guaranteed coherence with the selected (dis)similarity
coefficient.

6.7. Mantel test

In some studies, we are interested in the relationship of two similar-
ity or distance matrices. For example, we have n individuals in a plant pop-
ulation, each individual being characterized by its genetic constitution (e.g.
allelic composition, determined bymethods ofmolecular biology such as PCR
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(polymerase chain reaction) or RFLP (restriction fragment length polymor-
phism)), and also by its position at a locality (as X and Y coordinates). Wewant
to test whether the distance between plants reflects genetic similarity. We can
use the X andY variables aspredictors and the allelic composition as a response
matrix and apply some constrained ordination. However, this would test for a
spatial trend in thegenetic composition, andwould showno relationship if the
populationwere composed of spatially restricted groups of genetically similar
individuals scattered over the locality.
An alternative approach is to calculate two matrices: the matrix of genetic

similarities and the matrix of physical distances between the individuals. We
can directly calculate the classical (Pearson) correlation coefficient (r ) between
the corresponding values of physical distance and genetic similarity (or we can
use a regression of genetic similarity on the physical distance). Such analyses
provide reasonable measures of how closely the two matrices are related (r ) or
howmuch of the genetic similarity is explained by the physical proximity (co-
efficient of determination R2). However, the parametric test of significance for
r (or the estimate of standard error of r ) will not be correct, because both are
based on the assumption that the observations are independent, which is not
true: thenumber of degrees of freedomis greatly inflated, aswehaven(n − 1)/2
pairs (distances) that enter the analysis, but only n independent observations.
If there is an individual which is genetically different from the others, all its
n − 1 similarities to other individuals will be very low, all based on a single
independent observation.
The best solution is to estimate the distribution of the test statistics (e.g. the

Pearson linear correlation r ) under the null hypothesis usingMonte Carlo per-
mutations. If there is no relationship between the spatial distance and genetic
similarity, then the locations of individuals can be randomly permuted, and
all the spatial arrangements are equally likely. Consequently, in the permuta-
tion, not the individual similarities (distances), but the identity of individuals
is permuted in one of the matrices (it does not matter which one). In this way,
the internal dependencies within each of the matrices are conserved in all the
permutations, and only the relationship between the spatial coordinates and
genetic properties is randomized.
One-tailed or two-tailed tests could be used, depending on the nature of

the null hypothesis. In the above example, we would very probably use the
one-tailed test, i.e. the null hypothesis would be that the genetic similar-
ity is either independent of, or increases with, physical distance, and the
alternative hypothesis would be that the genetic similarity decreases with
the distance (we can hardly imagine mechanisms that cause the genetic simi-
larity to increase with physical distance between individuals). Because the
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alternative hypothesis suggests negative r values, the estimate of type I error
probability is:

P = nx + 1
N + 1

where nx is number of simulations where r < rdata; for the two-tailed test, nx is
the number of simulations where |r | > |rdata|.
In practical calculations, the sum of products (which is quicker to calculate)

is used instead of r (which is, on the other hand, more intuitive). However, it
can be shown that the results are identical. Also, instead of permutations, an
asymptotic approximation can be used.
One of the two compared distance (or similarity) matrices can also be con-

structedusing arbitrary values, reflecting the alternativehypothesis in the test.
For example,whenstudyingdifferencesbetween twoormoregroupsofobjects
or samples, we can use a distance matrix, where the within-group distances
are set to 0 and the between-group distances are set to 1. See Section 10.5.1,
of Legendre & Legendre (1998), for further discussion.
The other examples of the use of theMantel test in ecology are as follows.

1. It can be expected that species with similar phenology competemore

than species with different phenology. Species that competemore can be

expected to have negative ‘inter-specific association’, i.e. they are found

together less often than expected, when recorded on a very small scale in

a homogeneous habitat (because of competitive exclusion). Twomatrices

were calculated, thematrix of phenological similarity of species and the

matrix of species associations, and their relationshipwas evaluated by the

Mantel test (Lepš & Buriánek 1990). No relation was found in this study.

2. In a tropical forest, a herbivore community of various woody plant

species was characterized by all the insect individuals (determined to the

species) collected on various individuals of the woody species in the

course of one year. Then, the abundance of all the investigated woody

species in about 100 quadrats was recorded. The twomatrices – matrix of

similarities of woody species’ herbivore communities, andmatrix of

‘inter-specific associations’ of woody species, based on the quadrat

study – were compared using theMantel test. It was shown that species

with similar distribution also had similar herbivore communities, even

when the relationship was weak (Lepš et al. 2001).

The Mantel test is now available in specialized statistical packages, such as
thePCORDorPRIMERprograms (seeAppendixC).Note that theMantel test is
also sometimesapplied toproblemswhere the twomatrices are calculated from
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the species composition data table and the table with explanatory variables.
Therefore, the various constrained ordination methods (CCA, RDA, db-RDA)
can also be applied to the same problem, with the extra advantage of visual-
izing the relation between the ecological community and the environment in
terms of individual species.



7

Classificationmethods

The aim of classification is to obtain groups of objects (samples,
species) that are internally homogeneous and distinct from the other groups.
When the species are classified, the homogeneity can be interpreted as
their similar ecological behaviour, as reflected by the similarity of their
distributions. The classification methods are usually categorized as in
Figure 7-1.
Historically, numerical classifications were considered an objective

alternative to subjective classifications (such as the Zürich-Montpellier
phytosociological system, Mueller-Dombois & Ellenberg 1974). They are
indeed ‘objective’ by their reproducibility, i.e. getting identical results with
identical inputs (in classical phytosociology, the classification methods
obviously provide varying results). But also in numerical classifications, the
methodological choices are highly subjective and affect the final result.

7.1. Sample data set

The various possibilities of data classification will be demonstrated
using vegetation data of 14 relevés from an altitudinal transect in Nı́zké Tatry
Mts, Slovakia. Relevé 1 was recorded at an altitude of 1200 metres above sea
level (ma.s.l.), relevé14 at1830ma.s.l. Relevéswere recordedusing theBraun–

Blanquet scale (r, +, 1–5, see Mueller-Dombois & Ellenberg 1974). For calcu-
lations, the scale was converted into numbers 1 to 7 (ordinal transformation,
VanderMaarel 1979). Datawere entered as a classical vegetation data table (file
tatry.xls) and further imported (using the WCanoImp program) into the con-
densed Cornell (CANOCO) format (file tatry.spe), to enable use of the CANOCO
and TWINSPAN programs. The data were also imported into a Statistica file
(file tatry.sta).

96
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Figure 7-1. Types of classificationmethods.

First, we look at the similarity structure displayed by the DCA ordination
method (see Section 3.7). The resulting diagram with species and samples is
shown in Figure 7-2.
The graph (Figure 7-2) demonstrates that there is linear variation in the

data, corresponding to the altitudinal gradient. Samples 1 to 5 are from
the spruce forest (characterized by plant species Picea abies, Dryopteris dilatata,
Avenella flexuosa, etc.), and samples 12 to 14 are from typical alpine grassland
(e.g. Oreochloa disticha), and there is also a dwarf-pine (Pinus mugo) zone in
between (with Calamagrostis villosa, Vacciniummyrtillus, see Figure 7-3). Nowwe
will explore how theparticular classificationmethods divide this gradient into
vegetation types and also demonstrate how toperform the individual analyses.

7.2. Non-hierarchical classification (K-means clustering)

The goal of this method is to form a pre-determined number of
groups (clusters). The groups should be internally homogeneous and differ-
ent from each other. All the groups are on the same level, there is no hierarchy.
Here, we will use K-means clustering as a representative of non-hierarchical
classifications.
For the computation, an iterative relocation procedure is applied. The pro-

cedure starts with k (desired number of ) clusters, and then moves the objects
to minimize the within-cluster variability and maximize the between-cluster
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Figure 7-2. Species-samples ordination diagramwith results of DCA of the
altitudinal transect in TatryMts (sample altitude is passively projected into the
diagram). Only the species with the highest weight (themost frequent ones) were
selected for display.

variability. When the clusters are different, then ANOVA for (at least some)
species shows significant results, so the procedure canbe thought of as ‘ANOVA
in reverse’, i.e. forming groups of samples to achieve the most significant dif-
ferences in ANOVA for themaximumnumber of species (variables).
The relocation procedure stops when no move of an object (sample)

improves the criterion. You should be aware that youmight get a local extreme
with this algorithm, and you can never be sure that this is the global extreme.
It is advisable to start with different initial clusters and check if the results
are the same for all of them.
We will use the Statistica program (procedure K-means clustering). In

Statistica, choose the Cluster Analysis procedure and select K-means clustering.
The variables to be used in clustering must be selected. To do so, click on the
Variables button and select the variables you want to use. Alternatively, you can
click on the Variables button and select only a subset and calculate the classifica-
tion using selected species only (just the herbs, for example).
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Figure 7-3. Response curves of the important species on the elevation gradient,
fitted in CanoDraw by a second-order polynomial predictor (GLMprocedure) –
see Chapter 8. m a.s.l. meansmetres above sea level.

Figure 7-4. Dialog box for specifying K-means clustering in the Statistica for
Windows program.

In the next panel, select forMembers of each cluster & distances.Here we learn
that samples 1–6 are in the first cluster, samples 7–11 are in the second clus-
ter, and the samples 12–14 are in the third one. The fact that the samples in
each cluster are contiguous in numbering is caused by the linear character of
the variation in our data. For other data sets, we can get one group contain-
ing, for example, samples 1, 3 and 5, and the other group containing samples 2
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and 4. For each cluster, we see the distances to the centre of the corresponding
cluster, e.g. for cluster 1:

Members of Cluster Number 1 (tatry.sta)

and Distances from Respective Cluster Center

Cluster contains 6 cases

Case No. Case No. Case No. Case No. Case No. Case No.

C 1 C 2 C 3 C 4 C 5 C 6

Distance 0.49637 0.577225 0.456277 0.600805 0.520278 1.017142

The samples seem to form a homogeneous cluster, with the exception of
sample 6, being an outlier (similarly, sample 10 is an outlier in cluster 2). The
results are inagreement (includingthedeterminationofoutliers)with theDCA
results.
Now, we can select for Cluster means and Euclidean distances. The table of the

Euclidean distances provides information on the similarity among the indi-
vidual clusters, and the table of cluster means displays the mean values of the
species in the particular clusters.
We can see that themost similar are clusters 1 and 2, themost dissimilar are

1 and 3 (as expected):

Euclidean Distances between Clusters (tatry.sta)

Distances below diagonal

Squared distances above diagonal

No. 1 No. 2 No. 3

No. 1 0 1.616661 3.178675

No. 2 1.27148 0 2.212292

No. 3 1.782884 1.487377 0

Further, the representation of species in the individual clusters is clear from
the table ofmeans:

Cluster Means (tatry.sta)

Cluster Cluster Cluster

No. 1 No. 2 No. 3

PICEABIE 5.416667 1.6 0

SORBAUCU 1.75 1.4 0

PINUMUGO 0.333333 6.4 1.333333

SALISILE 0 0.8 0

Clearly, Picea abies is common in cluster 1 (spruce forests) and missing in
cluster 3 (alpine meadows). The dwarf pine, Pinus mugo, is rare outside the
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middle ‘krumbholz’ zone. Further useful information is provided by the
Analysis of variance:

Between SS df Within SS df F signif. p
PICEABIE 71.68095 2 21.40831 11 18.41552 0.000309

SORBAUCU 6.3 2 23.575 11 1.469778 0.271826

PINUMUGO 107.6571 2 15.2 11 38.9549 1.02E-05

SALISILE 2.057143 2 12.8 11 0.883929 0.440566

JUNICOMM 6.547619 2 4.666667 11 7.716836 0.00805

VACCMYRT 0.32381 2 20.03333 11 0.0889 0.915588

OXALACET 16.16667 2 19.33333 11 4.599139 0.035353

HOMOALPI 1.414286 2 4.3 11 1.808971 0.209308

SOLDHUNG 18.66666 2 7.333336 11 13.99999 0.000948

AVENFLEX 16.89524 2 4.033331 11 23.03897 0.000117

CALAVILL 0.928572 2 40.875 11 0.124945 0.88378

GENTASCL 7.295238 2 5.633332 11 7.122571 0.010368

DRYODILA 8.914286 2 4.8 11 10.21428 0.003107

For each species, an ANOVA comparing the means in the three clusters is
calculated. Note that you should not interpret the p-values as ordinary type I
error probabilities, because the clusters were selected to maximize the dif-
ferences between them. Nevertheless, the p-values provide a useful indica-
tion as to which species differ considerably between clusters (or on which
species the classification is based). Picea abies, Pinus mugo, or Soldanella hun-
garica averages differ considerably between the clusters, whereas Vaccinium
myrtillus averages do not (this species is relatively common along the whole
transect).
ProgramStatistica does not allow standardization, but itmight be a reason-

abledecision to standardize thedataby samplenorm. If youdecide to, youhave
to carry out the standardization in the spreadsheet, before importing the data
into the Statistica program.

7.3. Hierarchical classifications

In hierarchical classifications, groups are formed that contain sub-
groups, so there is a hierarchy of levels. When the groups are formed from the
bottom (i.e. themethod starts with joining the twomost similar objects), then
the classifications are called agglomerative. When the classification starts
with division of the whole data set into two groups, which are further split,
the classification is calleddivisive. The term cluster analysis is often used for
agglomerativemethods only.
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Figure 7-5. Themethodological decisions affecting the results of an agglomerative
hierarchical classification.

Agglomerative hierarchical classification (cluster analysis)

The aim of these methods is to form a hierarchical classification (i.e.
groups containing subgroups) which is usually displayed by a dendrogram.
The groups are formed ‘from the bottom’, i.e. themost similar objects are first
joined to formthefirst cluster,which is thenconsideredasanewobject, andthe
joining continues until all the objects are joined in thefinal cluster, containing
all theobjects.Theprocedurehas twobasic steps: in thefirst step, the similarity
matrix is calculated for all the pairs of objects.∗ In the second step, the objects
are clustered/amalgamatedso that, after eachamalgamation, thenewly formed
group is considered tobe anobject and the similarities of the remainingobjects
to thenewly formedone are recalculated. The individualmethods (algorithms)
differ in the way they recalculate the similarities.
You should be aware that there are several methodological decisions affect-

ing the final result of a classification (see Figure 7-5).
Agglomerative hierarchical classifications are readily available in most sta-

tistical packages. We will demonstrate their use in the Statistica package;
however, the rules are similar in most packages. Statistica, similar to other
programs, allows for a direct input of the similarity matrix. This is useful
because Statistica contains only a limitednumber of dis/similaritymeasures. It

∗ Thematrix is symmetrical, and on the diagonal there are either zeroes – for dissimilarity – or the
maximumpossible similarity values.
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Figure 7-6. Dialog box for hierarchical, agglomerative clustering in Statistica for
Windows.

is possible to prepare a simplemacro, e.g. in Excel, that will calculate the simi-
larities and then import the similaritymatrix into the Statistica program.∗

In its basic form, the procedure used in the Statistica program is quite
simple:

� Select Joining (tree clustering) in the startup panel: for clustering of samples,

use the options in Figure 7-6.
� ALL the variables are selected (you can also do the analysis with a subset of
variables).

� Raw datameans that the raw data are in your data file, not the similarity

matrix.
� We selected the Complete Linkage amalgamation (clustering) procedure.

There are other possibilities and the decision affects the resulting

dendrogram. There are ‘shorthand’methods (e.g. Single Linkage) in
which the distance between the clusters is defined as the distance

between the closest points in the two compared clusters. These

methods produce dendrograms characterized by a high level of

chaining. The ‘longhand’methods (e.g. Complete Linkage) in which the
distance between two clusters is defined as the distance between the

furthest points, tend to produce compact clusters of roughly equal size

(Figure 7-7).

∗ You need to prepare the file according to the rules for similaritymatrices in Statistica: a symmetrical
squarematrix, with column names being the same as the row names, and an additional four rows as
follows. The first and second rows, whichmust be calledMeans and Std. dev., respectively, contain
averages and standard deviations of variables (necessary only for the correlation and covariance type).
The first column of the third row, which is calledNoCases, contains the number of items onwhich the
similarities are based (this does not affect the results of clustering). And , finally, the first column of the
fourth row, whichmust be calledMatrix, contains thematrix type: 1 = correlation, 2 = similarities,
3 = dissimilarities, and 4 = covariance.
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A

B

Figure 7-7. Distance between two clusters, A and B, as defined in the single linkage
(solid line) and in the complete linkage (dashed line) algorithms.

� After completing the analysis, it is useful to save the distancematrix,

using the ‘save distancematrix ’ button, in a file with the name tatrydis.sta.
This file can be used for calculating the non-metric multidimensional

scaling (NMDS, see Section 6.5).

There are many other methods whose underlying approach usually falls
somewhere between the two above-described methods. Among them, the
average linkage method used to be very popular. However, this term was
used inconsistently. The term unweighted-pair groups method (UPGMA)
describes its most common variant. In ecology, the ‘short hand’ methods are
usually of little use. Compare the resulting dendrograms on the left and right
sides of Figure 7-8. The results of the complete linkage algorithm are more
ecologically interpretable: when these groups are compared to our external
knowledge of the nature of the data, they can be judged as better reflecting the
elevation gradient. See Sneath (1966) for a comparison of various clustering
methods.
We first selected the Euclidean distance as a measure of sample similarity.

If you prefer to use the standardized Euclidean distance (chord distance)
instead, the data must be standardized before being imported into Statistica.
Unlike other software (PCORD software, for example, provides a much wider
selection of (dis)similarity measures, McCune & Mefford 1999), the Statistica
program has quite a limited selection of options, but you can use its ability to
import matrix of similarities from external sources (see above for additional
details). We have prepared a simple Visual Basic macro in Excel (file persim.xls),
which calculates percentage dissimilarities and saves them in a spreadsheet
in a form that can be directly imported into the Statistica program (including
the names of cases and variables). Figure 7-8 contains, for comparison, classi-
fications based both on Euclidean distances and percentage dissimilarity. The
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Figure 7-8. Comparison of single linkage (left panel) and complete linkage (right
panel) clustering of the samples, based on Euclidean distances (top) and
percentage dissimilarities (bottom). Note the higher degree of chaining in the
two dendrograms from single linkage (samples 14 and 10 do not belong to any
cluster, but are chained to the large cluster containing all the other samples).
The complete linkage results can be interpretedmore easily.
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1 2 3 4 2 1 4 3

Figure 7-9. Two different dendrograms that represent the same results of cluster
analysis. The order of subgroups within a group is arbitrary.

percentage-dissimilarity-based dendrogram using the single linkage method
is also difficult to interpret. However, the complete linkage results seem to
reflect the elevation gradient slightly better than those based on Euclidean
distances.
Also,oneof themost importantdecisionsgreatlyaffectingthesimilarityval-

ues is data transformation: according to our experience (Kovář & Lepš 1986),
the decision whether to use the original measurements (abundance, biomass
or cover), the log-transformation of these values, or the presence–absence data
influences the resulting classificationmore than the selection of the clustering
rule. The standardization by samples has amajor effectwhen the sample totals
are very different.
For most ordinary agglomerative classifications the same result can be pre-

sented by many different dendrograms. What matters in a dendrogram is
which entities (e.g. samples or sample groups) are joined. However, it does not
matter which of the two groups is on the left and which on the right side.
Figure 7-9 shows two dendrograms that represent exactly the same result of
cluster analysis. We cannot say, for example, whether the samples 1 and 4 are
more similar to each other than samples 2 and 3. Unlike in the TWINSPAN
method (described below), the orientation of the subgroups in the agglomer-
ative classification dendrogram is arbitrary (usually depends on the order in
which the data are entered) and, therefore, should not be interpreted as being
a result of the analysis.
It is interesting to compare the results of the classifications with DCA

ordination. The results of detrended correspondence analysis (Figure 7-2) sug-
gest that there is a fairly homogeneous group of samples 1 to 5 (the samples
fromspruce forest). All the classificationmethods also recognized this groupas
being distinct from the remaining samples. DCA suggests that there is rather
continuous variation with increasing elevation. The individual classifications
differ in the way this continuous variation is split into groups. For example,
sample 11 is in an intermediate position between the sub-alpine shrubs and
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Figure 7-10. The classification of species. Note that the procedure distinguished a
group of alpine grassland species reasonably well (Primulaminima, Salix herbacea,
Carex sempervirens,Campanula alpina) on the left side of the diagram. Similarly,
species of the spruce forest are on the right side of the diagram.

alpine meadows in the ordination diagram and even the complete linkage
classificationsdiffer in their ‘decision’: the sample is allocated to the sub-alpine
groupwhen the classification is basedonEuclideandistances, and to the alpine
groupwhen classification is based on percentage similarity.
You can also perform cluster analysis of variables (i.e. of the species in our

example). In this case, the correlation coefficient will probably be a reason-
able measure of species distributional similarity (to convert it to dissimilarity,
1−r is used). Note that the appropriate similaritymeasures differ according to
whether we cluster samples or species. The results of the clustering of species
are displayed in Figure 7-10.

Divisive classifications

Indivisive classifications, thewhole setofobjects isdivided ‘fromthe
top’: first, thewhole data set is divided into two parts, each part is then consid-
ered separately and is divided further. When the division is based on a single
attribute (i.e. on a single species), the classification is called monothetic,
when based on multiple species, the classification is polythetic. The sig-
nificance of monothetic methods is mostly a historical one. The classical
‘association analysis’ was a monothetic method (Williams & Lambert 1959).
The advantage of the divisive methods is that each division is accompanied by
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a rule used for the division, e.g. by a set of species typical for either part of the
dichotomy.
The most popular among the divisive classification methods is the

TWINSPANmethod, described thoroughly in the following section.

7.4. TWINSPAN

The TWINSPAN method (from Two Way INdicator SPecies ANalysis,
Hill 1979; Hill et al. 1975) is a very popular method (and the program has
the same name) among community ecologists and it was partially inspired by
the classificatorymethods of classical phytosociology (use of indicators for the
definition of vegetation types). We treat it separately, based on its popularity
among ecologists. The idea of an indicator species is basically a qualitative one.
Consequently, themethodworkswithqualitativedataonly. Inordernot to lose
the informationabout the species abundances, theconceptsofpseudo-species
and pseudo-species cut levels were introduced. Each species can be repre-
sented by several pseudo-species, depending on its quantity in the sample. A
pseudo-species is present if the species quantity exceeds the corresponding cut
level. Imagine that we selected the following pseudo-species cut levels: 0, 1, 5
and 20. Then the original table is translated to the table used by TWINSPANas
follows:

Species Sample 1 Sample 2

Cirsium oleraceum 0 1
Original

Glechoma hederacea 6 0
table

Juncus tenuis 15 25

Cirsoler1 0 1

Glechede1 1 0

Table with pseudo-species used in
Glechede2 1 0

TWINSPAN
Junctenu1 1 1

Junctenu2 1 1

Junctenu3 1 1

Junctenu4 0 1

In thisway, quantitativedata are translated intoqualitative (presence–absence)
data.
In TWINSPAN, the dichotomy (division) is constructed on the basis of a

correspondence analysis (CA) ordination. The ordination is calculated and the
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00 01

10

Figure 7-11. Sample splits in a TWINSPAN classification.

samples are divided into the left (negative) side and the right (positive) side of
the dichotomy according to their score on the first CA axis. The axis is divided
at the centre of gravity (centroid). However, usually there are many samples
near the centre of gravity. Consequently, many samples are close to the border,
and their classification would depend onmany factors. Therefore, a new ordi-
nation is constructed,whichgives ahigherweight to the ‘preferentials’, i.e. the
species preferring one or the other side of the dichotomy. The algorithm is
rather complicated, but the aim is to get a polarized ordination, i.e. an ordina-
tionwheremost of the samples are not positioned close to the centre of gravity.
Therefore, the classification of the samples is not based somuch on the species
commontobothpartsof thedichotomy,butmostlyonthespecies typicalofone
part of the dichotomy and consequently (in concordance with phytosociologi-
cal tradition) these species canbe considered to be good indicators of particular
ecological conditions.
In the first division, the polarity (i.e. which part of the dichotomy will be

negative and which positive) is arbitrarily set. In the subsequent divisions,
polarity is determined according to the similarity of dichotomy parts to the
‘sister’ group in a higher-level division. For example, in the dendrogram in
Figure 7-11, group 01 is more similar to group 1 than group 00 is to group 1.
A result of this process is that the samples are ordered in the final table, andwe
get a table that is similar to an ordered phytosociological table.
Also, the determined ‘rule’ (i.e. the set of species, that were important for

a particular division) is printed by the program at each step. This greatly
increases the interpretability of the final results. The classification of samples
is complementedbya classificationof species and thefinal table is basedon this
two-way classification.

TWINSPAN analysis of the Tatry samples

In the following text, we will demonstrate the use of TWINSPAN for
the analysis of 14 relevés from the altitudinal transect that we used in previ-
ous sections. TWINSPAN is useful for large data sets, but the small data set is
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used here for simplicity. We used the file tatry.spe, i.e. the file imported using
theWCanoImpprogram into theCornell-condensed (CANOCO) format. Inour
sample analysis,we asked for the long output to showwhat information canbe
obtained from the program (usually, only short output is requested – even the
short output is pretty long).
First, the headings are printed and the program lists the options selected.

The important ones are:

Cut levels:

.00 1.00 2.00 3.00 4.00 5.00

Because the data were converted into numeric values using ordinal trans-
formation, there is no reason to further ‘downweight’ the higher values.When
the data are in the form of estimated cover, it is reasonable to use the default
cut levels, i.e. 0 2 5 . . . .The cut levels 0 1 10 100 1000 give results correspond-
ing to a logarithmic transformation and are useful when the data are numbers
of individuals, differing in order ofmagnitude.
From further options note the following (all have their default values):

1. Minimum group size for division: 5

2. Maximum number of indicators per division: 7

3. Maximum number of species in final tabulation: 100

4. Maximum level of divisions: 6

Option 1means that groups containing fewer than 5 relevés are terminal,
i.e. they are not further divided. For small data sets, it might be reasonable to
decrease this value to 4.
Option 2 represents the number of indicators per division; usually, the

default value is a reasonable choice.
Option 3: if you have more than 100 species, only the 100 most common

species will be included in the final tabulation. You can increase the value, if
necessary.
Option 4 represents an alternative way to control the divisions (controlling

by the size of the group using option 1 is a better solution). For a data set of
reasonable size, the value 6 is usually sufficient.
The program output starts with the description of first division:

DIVISION 1 (N= 14) I.E. GROUP ∗
Eigenvalue .565 at iteration 1

INDICATORS, together with their SIGN

Oreo Dist1(+)
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The indicator for thefirst division isOreochloa disticha (the1 at the endmeans
that the first pseudospecies cut level was used, i.e. the presence of the species is
enough for the indicator to be considered present).

Maximum indicator score for negative group 0 Minimum indicator score for

positive group 1

Items in NEGATIVE group 2 (N= 10) i.e. group ∗0
Samp0001 Samp0002 Samp0003 Samp0004 Samp0005 Samp0006 Samp0007 Samp0008

Samp0009 Samp0010

BORDERLINE negatives (N= 1)

Samp0009

Items in POSITIVE group 3 (N= 4) i.e. group ∗1
Samp0011 Samp0012 Samp0013 Samp0014

The output displayed above represents the division of samples. Note the
warning for sample 9 that this sample was on the border between the two
groups (this warning appears only when you ask for a long output).
Now, the species preferring one side of the dichotomy (preferentials) are

listed,with the number of occurrences in each of the groups (e.g. Picea abieswas
present in seven samples from the negative group and in one sample from the
positive group). Note that the preferentials are determined with respect to the
number of samples in each group and also for each pseudospecies cut level sep-
arately. Preferentials are provided in the long output only.

NEGATIVE PREFERENTIALS

Pice Abie1( 7, 1) Sorb Aucu1( 7, 0) Oxal Acet1( 7, 0) Sold Hung1( 5, 0)

Aven Flex1( 10, 1) Gent Ascl1( 8, 0) Dryo Dila1( 8, 0) Pheg Dryo1( 6, 0)

Pren Purp1( 2, 0) Poly Vert1( 3, 0) SoAu cJu 1( 3, 0) Luzu Pilo1( 2, 0)

etc . . .

POSITIVE PREFERENTIALS

Juni Comm1( 0, 2) Ligu Mute1( 4, 4) Sold Carp1( 2, 4) Ranu Mont1( 1, 2)

Hupe Sela1( 3, 3) Geun Mont1( 2, 2) Vacc Viti1( 2, 4) Puls Alba1( 0, 2)

Gent Punc1( 2, 3) Soli Virg1( 1, 1) Luzu Luzu1( 1, 1) Oreo Dist1( 0, 4)

etc . . .

NON-PREFERENTIALS

Pinu Mugo1( 5, 2) Vacc Myrt1( 10, 4) Homo Alpi1( 10, 4) Cala Vill1( 8, 3)

Rume Arif1( 4, 1) Vera Lobe1( 5, 3) Pinu Mugo2( 5, 2) Vacc Myrt2( 10, 4)

Homo Alpi2( 10, 4) Cala Vill2( 8, 3) Rume Arif2( 4, 1) Vera Lobe2( 5, 3)

etc . . .

End of level 1



112 7. Classificationmethods

will be further
divided

Oreochloa disticha

S
11

,S
12

,S
13

,S
14

0 1

Figure 7-12. The first division in the TWINSPAN example.

We can now start with drawing the dendrogram. The part that is now clear
is displayed in Figure 7-12.
Thepositivegroup is terminal, because it is smaller thanfive samples,which

is the selected minimum size for division. The next level follows (without the
preferentials shown):

DIVISION 2 (N= 10) I.E. GROUP ∗0
Eigenvalue .344 at iteration 1

INDICATORS, together with their SIGN

Pice Abie1(-)

Maximum indicator score for negative group -1 Minimum indicator score for

positive group 0

Items in NEGATIVE group 4 (N= 7) i.e. group ∗00
Samp0001 Samp0002 Samp0003 Samp0004 Samp0005 Samp0006 Samp0007

Items in POSITIVE group 5 (N= 3) i.e. group ∗01
Samp0008 Samp0009 Samp0010

DIVISION 3 (N= 4) I.E. GROUP ∗1
DIVISION FAILS - There are too few items

End of level 2
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Figure 7-13. The second-level division in the TWINSPAN example.

In a similar way, we can continue to construct the dendrogram (Figure 7-13).
The next division level is displayed here:

DIVISION 4 (N= 7) I.E. GROUP ∗00
Eigenvalue .279 at iteration 1

INDICATORS, together with their SIGN

Pinu Mugo1(+)

Maximum indicator score for negative group 0 Minimum indicator score for

positive group 1

Items in NEGATIVE group 8 (N= 5) i.e. group ∗000
Samp0001 Samp0002 Samp0003 Samp0004 Samp0005

Items in POSITIVE group 9 (N= 2) i.e. group ∗001
Samp0006 Samp0007

Note the meaning of indicator species Pinus mugo here. It is an indicator
within group 00 (containing seven samples), where it is present in just two
of the samples, 6 and 7 (forming the positive group 001). However, it is also
common in samples 8, 9, 10, 11 and 12. This illustrates that the indicators are
determined and should be interpreted just in a particular division context, not
for thewhole data set. Group 001 is characterized by the presence of Pinusmugo
in contrast to group 000, and not within the whole data set. The advantage of
TWINSPAN becomes clear here, as the orientation of groups (i.e. which group
will be negative and which positive) depends on which of the groups is more
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Figure 7-14. Final state of the TWINSPAN classification for the sample data.

similar to group 01 (and this group, among others, has Pinus mugo in all of its
samples).
We will not show further divisions (group 000 contains five samples and

still can be divided further), and will finish the dendrogram at this level
(Figure 7-14). The fact that each division is accompanied by only one indi-
cator is rather exceptional (probably a consequence of the small data size).
Usually, each division is accompanied by several indicators for each part of the
dichotomy. However, note that the indicators are the species used in the divi-
sions. They might be very few and might be available only for one side of the
dichotomy. This does notmean that there are nomore species characteristic of
either side of the dichotomy. If you want to characterize the division by more
species, you should use the ‘preferentials’ from the TWINSPAN output.
In a similarway, TWINSPANalso constructs the classification (dendrogram)

for species.
Finally, the TWINSPAN output contains the sorted data table. It resembles

a classical orderedphytosociological table and is accompanied by the classifica-
tion of both samples and species (Table 7-1).



Table 7-1. Final sorted species data table,
produced by TWINSPAN

SSSSSSSSSSSSSS

aaaaaaaaaaaaaa

mmmmmmmmmmmmmm

pppppppppppppp

00000000000000

00000000000000

00000000011111

21345678901234

4 Sali SIle ---------5---- 0000

29 Anth Alpi -----2---3---- 0000

30 Hype Macu ------2--3---- 0000

31 Rubu Idae ------2--3---- 0000

28 Aden Alli -----2---2---- 0001

1 Pice Abie 6666665---5--- 001000

7 Oxal Acet 55344-4--3---- 001001

9 Sold Hung 43444--------- 001001

18 Luzu Pilo 2-2----------- 001001

20 Luzu Sylv --3243-------- 001001

12 Gent Ascl 23333333------ 001010

14 Pheg Dryo 4333-33------- 001010

15 Pren Purp 2----3-------- 001011

16 Poly Vert 3----33------- 001011

22 Stel Nemo ---2--3------- 001011

2 Sorb Aucu 42-23444------ 00110

10 Aven Flex 34543443343--- 00110

13 Dryo Dila 333333-3-3---- 00110

17 SoAu cJu 3-----32------ 00110

19 Athy Dist 3-23335--53--- 00111

6 Vacc Myrt 54646666636653 01

8 Homo Alpi 44454454334334 01

11 Cala Vill 33365-54-6445- 01

21 Rume Arif --23--4--33--- 01

3 Pinu Mugo -----3666665-- 10

23 Vera Lobe ----2333-4322- 10

27 Hupe Sela -----223--22-3 10

36 Soli Virg ---------2--2- 10

33 Vacc Viti -------33-3343 1100

35 Gent Punc -------3-4333- 1100

37 Luzu Luzu ---------3--4- 1100

24 Ligu Mute ----233--23333 1101

25 Sold Carp -----54---3333 1101

26 Ranu Mont -----2-----33- 1101

32 Geun Mont ------2--3-33- 1101

5 Juni Comm -----------24- 111

34 Puls Alba -----------32- 111

38 Oreo Dist ----------5564 111

39 Fest Supi ----------3444 111

40 Camp Alpi ----------34-4 111

41 Junc Trif ----------4453 111

42 Luzu Alpi ----------33-- 111

43 Hier Alpi ----------233- 111

44 Care Semp -----------545 111

45 Tris Fusc -----------33- 111

46 Pote Aure ------------32 111

47 Sale Herb -------------5 111

48 Prim Mini -------------4 111

00000000001111

0000000111

0000011
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Note thatwe can read the three levels of division andmemberships of all the
samples in corresponding groups from the bottom three lines. For example,
samples 11–14 are in group 1 (which is not further divided).
The TWINSPAN program was written in the late seventies (Hill, 1979).

Computer time was precious then and, consequently, very lax convergence
criteria were used, which might lead to unstable solutions in some data sets
(Oksanen &Minchin, 1997). Be sure that you are using amore recent program
version with strict convergence criteria.
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Regressionmethods

Regressionmodels allowus todescribe thedependenceof (usually) one
response variable (which might be quantitative or qualitative) on one or more
predictor variables. These can be quantitative variables and/or factors. In this
broad view, regressionmodels also include statisticalmethods such as analysis
of variance (ANOVA) and the analysis of contingency tables.
During the eighties, many new types of regression models were suggested,

usually extending in some way the well-established ones. This chapter pro-
vides a short summary of those methods that we find useful for a posteriori
analysis of the patterns of individual response variables (species) or predictors
(environmental variables) in ordination space, or generally for exploration of
ecological data.
Most of the regressionmodels introduced in this chapter (except the regres-

sion and classification trees) are available in the CanoDraw 4 program and we
illustrate their use in the concluding, tutorial, part of this chapter.

8.1. Regressionmodels in general

All regressionmodels share someassumptionsabout the responsevari-
able(s) and the predictor(s). To introduce these concepts, we will restrict our
attention to themost frequently used kind of regressionmodel, where exactly
one response variable is modelled using one ormore predictors.
The simplest way to describe any such type of regression model is the

following:

Y = EY + e

where Y refers to the values of response variable, EY is the value of the response
variable expected for particular values of the predictor(s) and e is the variability
of the true values around those expected values EY. The expected value of the

117
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Table 8-1. Summary of the differences between systematic and stochastic components of
a statistical model

Systematic component (EY) Stochastic component (e)

Is determined by our research hypothesis Mirrors a priori assumptions of themodel
Its parameters (regression coefficients) are
estimated by fitting themodel

Its parameter(s) are estimated during or after
fitting (variance of response variable)

We interpret it and perform (partial) tests on it or
on its individual parameters

We use it to estimate themodel quality
(regression diagnostics)

response can be formally described as a function of the predictor values:

EY = f (X1, . . . , Xp)

In the terms of Section 5.1, the EY part is often called the systematic
component of the regression model, while the e part is called the stochastic
component of the model. The properties and roles they have, when we apply
regressionmodels to our data, are compared in Table 8-1.
When we fit a regression model to our data, our assumptions about its

stochastic component∗ are fixed, butwe canmanipulate the contents and com-
plexity of the systematic component. In the simplest example of the classical
linear regressionmodel with one response variable Y and one predictor X, the
systematic component can be specified as:

EY = f (X ) = β0 + β1 · X
Butwe can, in fact, achieve a larger complexity inmodelling the dependence of
Y on X byapolynomialmodel.Wecanshift themodel complexityalongarange
starting with a null model EY = β0, through the linear dependency given
above, to the quadratic polynomial dependency EY = β0 + β1 · X + β2 · X2,
up to a polynomial of the nth degree, where n is the number of data obser-
vations we have available, minus one. This most complex polynomial model
(representing the so-called full model) goes exactly through all the data
points, but provides no simplification of the reality (which is one of the basic
tasks of a statistical model). We have simply replaced the n data points with n
regression parameters (β0, . . . ,βn−1). The null model, on the other hand, sim-
plifies the reality so much that we do not learn anything new from such a
model,† and advance of our knowledge is another essential service provided by
statistical models.

∗ Usually assumptions about the distributional properties, the independence of individual
observations, or a particular type of cross-dependence between the individual observations.

† Not a completely correct statement: from a null model we learn about the average value of the
response variable.



8.2. General linearmodel: terms 119

Fromour discussion of the two extreme cases of regressionmodel complex-
ity, we can clearly see that the selection of model complexity spans a gradient
from simple, not so precise models to (overly) complexmodels. Also, themore
complicated models have another undesired property: they are too well fitted
to our data sample, but they provide biased prediction for the non-sampled
part of the statistical population. Our task is, in general terms, to find a
compromise, amodel as simple as possible for it to be useful, but neithermore
simple normore complex than that. Such amodel is often referred to as a par-
simoniousmodel or theminimal adequatemodel.

8.2. General linearmodel: terms

The first important stop on our tour over the families of modern
regression methods is the general linear model. Note the word general –

another type of regression method uses the word generalized in the same
position, but meaning something different. In fact, the generalized linear
model (GLM), discussed in the next section, is based on the general linear
model (discussed here) and represents its generalization.∗

What makes the general linear model different from the traditional linear
regression model is, from the user’s point of view, mainly that both the quan-
titative variables and qualitative variables (factors) can be used as predictors.
Therefore, the methods of analysis of variance (ANOVA) belong to the family
of general linearmodels. For simplicity, we can imagine that any such factor is
replaced (encoded) by k − 1 ‘dummy’, 0/1 variables, if the factor has k different
levels.
In this way, we can represent the general linear model by the following

equation:

Yi = β0 +
p∑

j=1

β j · X ji + ε

but we must realize that a factor is usually represented by more than one pre-
dictor X j and, therefore, bymore than one regression coefficient. The symbol ε
refers to the random, stochastic variable representing the stochastic com-
ponent of the regression model. In the context of general linear models,
this variable is most often assumed to have a zero mean and a constant
variance.
This model description immediately shows one very important property of

thegeneral linearmodel– it isadditive.Theeffectsof the individualpredictors

∗ Wemean this sentence seriously, really☺
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aremutually independent.∗ If we increase, for example, the value of one of the
predictors by one unit, this has a constant effect (expressed by the value of
the regression coefficient corresponding to that variable), independent of the
values the other variables have and even independent of the original value of
the variable we are incrementing.
The above-given equation refers to the (theoretical) population of all possi-

ble observations, which we sample when collecting our actual data set. Based
on such a finite sample, we estimate the true values of the regression coeffi-
cients βj , and these estimates are usually labelled as bj . Estimation of the val-
ues of regression coefficients is what we usuallymeanwhenwe refer tofitting
a model. When we take the observed values of the predictors, we can calculate
thefitted (predicted) values of the response variable as:

Ŷ = b0 +
p∑

j=1

b j · X j

The fitted values allow us to estimate the realizations of the random variable
representing the stochastic component– sucha realization is called the regres-
sion residual and labelled as ei :

ei = Yi − Ŷ i

Therefore, the residual is the difference between the observed value of the
response variable and the corresponding value predicted by the fitted regres-
sionmodel.
The variability in the values of the response variable can be expressed by the

total sum of squares, defined as

TSS =
n∑

i=1

(Yi − Y )2

where Y is themean of Y.
From the point of view of a fitted regressionmodel, this amount of variabil-

ity can be further divided into two parts – the variability of the response vari-
able explained by the fittedmodel – themodel sum of squares, defined as

MSS =
n∑

i=1

(Ŷ i − Y )2

∗ This does notmean that the predictors cannot be correlated!
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and the residual sum of squares defined as

RSS =
n∑

i=1

(Yi − Ŷ i )2 =
n∑

i=1

e2
i

Obviously TSS=MSS+RSS.We can use these statistics to test the significance
of the model. Under the global null hypothesis (‘the response variable is inde-
pendent of the predictors’)MSS is not different fromRSS if both are divided by
their respective number of degrees of freedom.∗

8.3. Generalized linearmodels (GLM)

Generalized linearmodels (McCullagh&Nelder1989) extend the gen-
eral linearmodel in two important ways.
First, the expected values of the response variable (EY ) are not supposed to

be always directly equal to the linear combination of the predictor variables.
Rather, the scale of the response depends on the scale of the predictors through
some simple parametric function called the link function:

g (EY ) = η

where η is the linear predictor and is defined in the same way as the whole
systematic component of the general linearmodel, namely as:

η = β0 +
∑

β j X j

The use of the link function has the advantage that it allows us to map values
from the whole real-valued scale of the linear predictor (reaching, generally,
from −∞ to +∞) into a specific interval making more sense for the response
variable (such as non-negative values for counts or values between 0 and 1 for
probabilities).
Second, generalized linear models have less specific assumptions about the

stochastic component compared to general linear models. The variance needs
not be constant but can depend on the expected value of the response vari-
able, EY. This mean–variance relation is usually specified through the statisti-
caldistributionassumedfor the stochasticpart (and, therefore, for the response
variable). But note that themean–variance relation (described by the variance
function, seeTable8-2), not the specific statistical distribution, is the essential
property of themodel specification.†

∗ See any statistical textbook formore details, e.g. Sokal & Rohlf (1995).
† This is known as the quasi-likelihood approach to generalized linearmodelling.
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Table 8-2. Summary of useful combinations of link functions and types of response
variable distributions

Typical link Reference Variance function
Type of variables function distribution (mean-variance relation)

Counts (frequency) Log Poisson V ∝ EY
Probability Logit Binomial V ∝ EY · (1 − EY )
(relative frequency) or probit

Dimensions, ratios Inverse or log Gamma V ∝ EY2

Quite rare type of Identity Gaussian V = const
measurements (‘normal’)

The assumed relation between the variance (V ) of the stochastic part and the expected values of
response variable (EY ) is also indicated.

The options we have for the link functions and for the assumed type of
distribution of the response variable cannot be combined independently, how-
ever. For example, the logit link function maps the real scale onto a range
from 0 to +1, so it is not a good link function for, say, an assumed Poisson
distribution, and it is useful mostly for modelling probability as a para-
meter of the binomial distribution. Table 8-2 lists some typical combinations
of the assumed link functions and the expected distribution of the response
variable, together with a short characteristic for the response variables match-
ing these assumptions. Note that as with classical linear regression models
and ANOVA, it is not assumed that the response variable has the particular
types of distribution, but that it can be reasonably approximated by such a
distribution.
With this knowledge, we can summarize what kinds of regression models

are embraced by the GLMs:

� ‘classical’ general linearmodels (includingmost types of analysis of

variance)
� extension of those classical linearmodels to variables with non-constant

variance (counts, relative frequencies)
� analysis of contingency tables (using log-linearmodels)
� models of survival probabilities used in toxicology (probit analysis)

The generalized linearmodels extend the concept of a residual sumof squares.
The extent of discrepancy between the true values of the response variable
and those predicted by themodel is expressed by themodel’sdeviance. There-
fore, to assess the quality of a model, we use statistical tests based on the
analysis of deviance, quite similar in concept to an analysis of variance of a
regressionmodel.
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An important property of the general linear model, namely its linearity, is
retained in the generalized linear models on the scale of the linear predictor.
The effect of a particular predictor is expressed by a single parameter – linear
transformation coefficient (the regression coefficient). Similarly, the model
additivity is kept on the linear predictor scale. On the scale of the response
variable, things might look differently, however. For example with a logarith-
mic link function, the additivity on the scale of linear predictor corresponds to
amultiplicative effect on the scale of the response variable.

8.4. Loess smoother

The term smoother is used for the method of deriving a (non-
parametric) regression function fromobservations. The fitted values produced
by smoothing (i.e. by application of a smoother) are less variable than the ob-
served ones (hence the name ‘smoother’).
There are several types of smoothers, some of them not very good, but

simple to understand. An example of such a smoother is the moving average
smoother. An example of a better smoother is the loess smoother (earlier
also named lowess). This smoother is based on a locally weighted linear regres-
sion (Cleveland &Devlin 1988; Hastie & Tibshirani 1990). The area (band for a
single predictor) around the estimation point, which is used to select data for
the local regression model fit, is called the bandwidth and it is specified as
a fraction of the total available data set. Therefore, bandwidth value α = 0.5
specifies that at each estimation point half of the observations (those closest to
the considered combination of the predictors’ values) are used in the regres-
sion. The complexity of the local linear regression model is specified by the
second parameter of the loess smoother, called degree (λ). Typically, only two
values are available: 1 for a linear regression model and 2 for a second-order
polynomial model.
Furthermore, the data points used to fit the local regression model do not

enter itwith the sameweight. Theirweights dependon their distance from the
considered estimation point in the predictors’ space. If a data point has exactly
the required values of the predictors, its weight is equal to 1.0 and the weight
smoothly decreases to 0.0 at the edge of the smoother bandwidth.
An important feature of the loess regression model is that we can express

its complexity using the same kind of units as in traditional linear regres-
sion models – the number of degrees of freedom (DF) taken from the data by
the fitted model. These are, alternatively, called the equivalent number of
parameters. Further, because the loess model produces fitted values of the
response variable (like other models), we can work out the variability in the
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valuesof theresponseaccounted forby thefittedmodelandcompare itwith the
residual sumof squares. Aswehave thenumber ofDFs of themodel estimated,
we can calculate the residual DFs and calculate the sum of squares per one
degree of freedom (corresponding to themean square in an analysis of variance
of a classical regression model). Consequently, we can compare loess models
using an analysis of variance in the samewaywe do for general linearmodels.
Good alternative smoothers are the various types of smoothing splines, see

Eubank (1988) formore details.

8.5. Generalized additivemodels (GAM)

The generalized additive models (GAMs, Hastie & Tibshirani 1990)
provide an interesting extension to generalized linearmodels (GLMs). The so-
called additive predictor replaces the linear predictor of aGLMhere. It is also
represented by a sum of independent contributions of the individual predic-
tors; nevertheless the effect of aparticularpredictor variable isnot summarized
using a simple regression coefficient. Instead, it is expressed – for the jth pred-
ictor variable – by a smooth function s j , describing the transformation from
the predictor values to the (additive) effect of that predictor upon the expected
values of the response variable.

ηA = β0 +
∑

s j (X j )

The additive predictor scale is again related to the scale of the response variable
via the link function.
We can see that generalized additive models include generalized linear

models as a special case, where for each of the predictors the transformation
function is defined as:

s j (X j ) = β j · X j

In the more general case, however, smooth transformation functions (usually
called ‘smooth terms’) are fitted using a loess smoother or a cubic spline
smoother. When fitting a generalized additive model, we do not prescribe the
shapeof the smooth functionsof the individualpredictors, butwemust specify
the complexity of the individual curves, in terms of their degrees of freedom.
Wealsoneed to select the type of smootherused tofind the shape of the smooth
transformation functions for the individual predictors.
With generalized additive models, we can do a stepwise model selection

including not only a selection of the predictors used in the systematic part of
themodel but also a selection of complexity in their smooth terms.
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Generalized additive models cannot be easily summarized numerically, in
contrast to generalized linear models where their primary parameters – the
regression coefficients – summarize the shape of the regressionmodel. The fit-
ted additivemodel is best summarizedbyplotting the estimated smooth terms
representing the relation between the values of a predictor and its effect on the
modelled response variable.

8.6. Classification and regression trees

Tree-based models are probably the most non-parametric kind of
regression models one can use to describe the dependence of the response
variable values on the values of the predictor variables. They are defined by a
recursive binary partitioning of the data set into subgroups that are succes-
sively more and more homogeneous in the values of the response variable.∗

At each partitioning step, exactly one of the predictors is used to define the
binary split. The split that maximizes the homogeneity and the difference
between the resulting two subgroups is then selected. Each split uses
exactly one of the predictors – thesemight be either quantitative or qualitative
variables.
The response variable is either quantitative (in the case of regression trees)

or qualitative (for classification trees). The results of the fitting are described
by a ‘tree’ portraying the successive splits. Eachbranching is describedby a spe-
cific splitting rule: this rule has the form of an inequality for quantitative pre-
dictors (e.g. ‘VariableX2 < const ’) or the form of an enumeration of the possi-
ble values for a factor (e.g. ‘VariableX4 has value a, c, or d ’). The two subgroups
defined by such a split rule are further subdivided, until they are too small or
sufficiently homogeneous in the values of the response. The terminal groups
(leaves) are then identified by a predicted value of the response value (if this is a
quantitative variable) or by a prediction of the object membership in a class (if
the response variable is a factor).
When we fit a tree-based model to a data set, we typically create (‘grow’)

an overcomplicated tree based on our data. Then we try to find an optimum
size for the tree for the prediction of the response values. A cross-validation
procedure is used to determine the ‘optimum’ size of the tree. In this proce-
dure, we create a series of progressively reduced (‘pruned’) trees using only a
subset of the availabledata and thenweuse the remainingpart of thedata set to
assess the performance of the created tree: we pass these observations through

∗ The division is very similar to recursive binary splitting done by TWINSPAN, but there the
multivariate data set is split and also the splittingmethod is different.
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the hierarchical system of the splitting rules and compare the predicted value
of the responsevariablewith itsknownvalue.For each size (‘complexity’) of the
tree model, we do it several times. Typically, we split the data set into 10 parts
of approximately the same size and, for each of these parts, we fit a tree model
of given complexity using the remaining nine parts and then we use the cur-
rent one for performance assessment. A graph of the dependency of the tree
model ‘quality’ on its complexity (model size) has typically a minimum cor-
responding to the optimum model size. If we use a larger tree, the model is
overfitted – it provides a close approximation of the collected sample, but a
biased description of the sampled population.

8.7. Modelling species response curves with CanoDraw

This section is a short tutorial for fitting the various regressionmodels
that describe the relationship between a quantity of a particular species and
the environmental gradients or gradients of community variation. The pro-
cess of fitting various regression models (generalized linear models, general-
ized additive models and loess smoother) will be illustrated for the CanoDraw
for Windows program, distributed with CANOCO. In this tutorial, you will
study the change in abundance of six selected sedge species in wet meadow
communities, along the compositional gradient represented by the first ordi-
nation axis of DCA. This sample study uses the same data set that is used
in Case study 2 (Chapter 12), and you should check that chapter for a more
detailed description. The selected sedge species belong to themore frequently
occurring sedges in the species data and their optima (approximated by their
scores in theordination space) span thewhole rangeof compositional variation
in the sampled community types, as can be seen from Figure 8-1.
The first ordination axis represents a gradient of increasing trophic level of

underground water (from left to right in the diagram) and decreasing concen-
trationofCa,MgandNa ions. In your regressionmodels describing the change
of species abundances, the ‘species response curves’, you will use the scores
of individual samples on the first DCA axis as the explanatory variable. The
results of the detrended correspondence analysis are stored in the file contain-
ing CanoDraw project, regress.cdw. Open the project in CanoDraw forWindows
if youwant to work through this tutorial.
Start with building a regressionmodel for Carex panicea (labelled as CarxPani

in the sample project). To get your first impression about the change of abun-
danceof this species along thefirstordinationaxis, createanXY-scatterplot and
supplement it with the non-parametric loess model. To do so, use the Create>

Attribute Plots > XY(Z) Plot and in the dialog box select Analysis Results> Sample
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Figure 8-1. Biplot of environmental variables and the selected six Carex species,
based on a DCAmethod.

scores> Samp.1 in the X VARIABLE list. In the Y VARIABLE list select Data Files >

Species data and there the CarxPani item. In the lower left corner select the Loess
option and also check the Supplement model with datapoints option. The desired
final state of the dialog is illustrated in Figure 8-2.
Often, youwill be interested in a species response tomeasured environmen-

tal variables, rather than to compositional gradients (represented by the ordi-
nation axes). In such a case, you should select in the X VARIABLE area the
required variable in one of the folders within the Data Files or the Imported data
folders.
After you press the OK button, you must confirm or change the options for

the loess model. Keep the default choices there (Local linear model, no Parametric
fit, noDrop square,Normalize scale, andRobustfitting, and Span equal to0.67). After
the model is fitted, CanoDraw summarizes it in another dialog. Close the dia-
log by clicking the OK button. CanoDraw displays the diagram, similar to the
one shown in Figure 8-3.
Note that in yourdiagramthe individual datapoints are labelled.To remove

the labels, select any one of them by clicking it with the left mouse button
and then press Ctrl-H to select the other labels. Remove the labels by press-
ing the Delete key on the keyboard. You can see in the diagram that the ver-
tical coordinates of plotted points are surprisingly regularly spaced. This is
because the abundances of individual species in this data set were recorded
on a semi-quantitative estimation scale with values ranging from 0 to 7.
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Figure 8-2. Selections to bemade in the XYDiagramOptions dialog when fitting
the loessmodel.
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Figure 8-3. Abundance of Carex panicea plotted against the first DCA axis together
with a fitted loessmodel.
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Figure 8-4. GLM Settings dialog: options for fitting unimodal response curves.

The curve estimated by the loess smoother suggests a unimodal shape of the
response.
You will now fit the classical unimodal response curve (‘Gaussian model’,

see Section 3.9.3 in Ter Braak & Šmilauer 2002) to the same data, i.e. response
curve describing change of CarxPani values along the first ordination axis.
Repeat the steps used in the previous fitting, including the selection of vari-
ables in the XY Diagram Options, as illustrated in Figure 8-2. Change in this
dialog box the following options: use the GLM choice instead of Loess in the
VISUALIZATION MODEL area and in the middle part of the dialog change the
Labelling option value from Labels to None (to remove sample labels more easily
than for the previous diagram).
After you press the OK button, CanoDraw displays new dialog box where

you can modify the specification for the fitted generalized linear model. The
required settings are illustrated in Figure 8-4.
You are fitting a generalized linearmodelwith the predictor variable (scores

of samples on the first ordination axis) used in the formof a second-order poly-
nomial. In addition, you specify the Poisson distribution, with an implied log
link function. Note that we do not assume that the response variable values
really have the Poissondistribution. Butwefind this is the best choice amongst
the available options, particularly because the (implied) log link function is
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Figure 8-5. Summary of a fitted unimodal response curve.

needed to fit the Gaussian-shaped response curve (with the tails approaching
zero), rather than the plain second-order polynomial parabolic curve. Addi-
tionally, the choice of Poisson distribution implies that the variance is propor-
tional to the mean (see Table 8-2), and this does not seem unreasonable. After
you close this dialog with theOK button, the regressionmodel is fitted and fit-
ting results are summarized in another dialog box, shown in Figure 8-5.
Information in the upper part of the dialog summarizes the model prop-

erties, which you specified in the preceding dialogs. The fitted model is
comparedwith thenullmodel (EY = const) and the dialog showsboth the raw
deviance values for both models as well as a deviance-based F test comparing
the difference between the deviances of the null model and the fitted model
(in the numerator of the F statistic ratio) with the deviance of the null model
(in the denominator). Both terms are adjusted for the number of degrees of
freedom, so they correspond to the mean-square terms in the traditional F
statistic used in ANOVAmodels.
In thewhite area at thebottomof this summarydialog, the estimated values

of individual regression coefficients, as well as the standard errors of the esti-
mates are shown.∗ The last columngives the ratio between the estimate and its

∗ CanoDraw ignores the estimated scale parameter (or dispersion parameter) in these error estimates.
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standard error. In classical regression models these ratios are used for testing
thepartial hypotheses about individual regression coefficients, i.e.H0 : b j = 0.
Under the null hypothesis (and fulfilled assumptions about the distributional
properties of the response variable and independence of individual observa-
tions), these statisticshave the t (Student) distribution.Note, however, that this
approximationdoes notwork verywell for thewhole family of generalized lin-
ear models, so comparison of the values with the critical values of the t distri-
bution is not recommended.
The area above the list of coefficient estimates is used only if a second-

order polynomial model was fitted, using either the log or logit link function
(i.e. the Distribution type was specified as Binomial, Poisson, or Gamma with log
link). In such cases, CanoDraw attempts to estimate the two parameters of the
species response curve. The first parameter is the position of the curve max-
imum on the gradient represented by the predictor variable (Samp.1 in your
case), called Optimum. The second parameter is the ‘width’ of the fitted curve,
namedTolerance.Dependingon themeaningof thepredictor variable, the toler-
ance parameter can be sometimes interpreted as the width of the species niche
with respect to a particular resource gradient (‘niche dimension’). Depending
on the quality of the fitted unimodal model, CanoDraw can provide the
estimated variability of the two parameters (the S .E . fields) and, in the case of
the optimum, estimate the 0.95 confidence interval for the estimate. The
Max. value field specifies the fitted (predicted) abundance of the species at
the predictor value equal to the optimum estimate (i.e. the ‘height of the
curve’).
The estimated values of the tolerances and optima of individual species can

be used for further data exploration or testing of hypotheses concerning the
behaviour of individual species. Note, however, that you must be careful to
select an appropriate predictor for such models. If you use the sample scores
on thefirstDCAaxis as the predictor variable, you canuse the resultingmodels
to illustrate inmuch detail themeaning of the ordination results, but you can-
not draw any independent conclusions from the positions of species optima
(or change in species tolerances) along the DCA axis. This is because the dis-
persion of the species scores, as well as the variation of the sample scores
(affecting the width of the fitted response curves) are systematically modified
by the weighted averaging (and also the detrending) algorithm.
To obtain valid tests of differences among the species in relation to resource

gradients, you would need to specify in CanoDraw independently measured
explanatory variables as your predictors. In that case, the ordination analysis
performed with CANOCO is not involved at all, but it still provides a useful
‘framework’, representing a rich source of ideas about which environmental
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Figure 8-6. Fitted species unimodal responsemodel, using GLMwith a
second-order polynomial predictor.

gradients canbe important forvariation incommunity compositionandwhich
species respond to which factors.
The fitted regressionmodel is shown in Figure 8-6.
The second-order polynomial is a very strict specification for the shape

of the response curve. The response of species often takes more complicated
shapes and it is difficult to describe them with the more complicated polyno-
mial terms. Therefore, other families of regression models can be useful here,
e.g. generalized additive models. Before you try to fit the response curve for
CarxPani with a generalized additive model, you should first explore whether
the just-fitted regressionmodelprovides anadequatedescriptionof the species
behaviour along the DCA axis.
To do so, we will plot the GLM regression residuals against the predic-

tor values (Samp.1). Click onto any empty place in the diagram with the right
mouse button and select the Residual plots command from the pop-up menu.
CanoDraw displays a dialog where you can specify what to plot in the regres-
sion diagnostics plot and how to plot it. Specify the options as illustrated
in Figure 8-7. You select the Raw residuals option rather than the Absolute val-
ues one because this type of residual is better for identifying an inappropri-
ate shape of the fitted response curve along the ordination axis. The absolute
residual values (eventually square-root transformed) are better for identifying
change in the variability with the fitted response values (termed heteroscedas-
ticity in classical regression models). You also checked the Add LOESS model
option because the smoother line can help you to identify any such systematic
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Figure 8-7. Residual plot settings for identifying the appropriateness ofmodel type
and complexity.

deviation from the postulated polynomial model. Note that youmust also ask
to save the residuals and fitted values here. You will use these data when com-
paring two types of fitted response curve later in this tutorial.
Before the residual plot is shown, CanoDraw asks you to approve or change

settings for the loess smoother used to summarize behaviour of the regres-
sion residuals with respect to predictor values (keep the default settings
there) and then summarizes the fitted loess model. Note that the predictor
variable does not explain much about the residual variability (coefficient of
determination, labelledMultiple-R squared, has a value of 0.027, implying that
less than 3% of the variability was explained). The resulting graph is shown in
Figure 8-8. In our opinion, there is no substantial trend neglected by the uni-
modal generalized linear model. The regularly curved patterns of the points
are a consequence of the limitation of the response variable values to whole
numbers.
Youwill nowcompare thefitted response curvewith another one, estimated

with a generalized additivemodel (GAM). To compare the two kinds ofmodels
‘head-to-head’, you need to fit a generalized additive model not only with the
same type of distribution assumed for the response variable (andwith the same
link function), but also with a comparable amount of complexity. To compare
with a second-order polynomial model, you must specify smooth term com-
plexity as2DF.Butwe think it is better to letCanoDrawcomparemodels ofdif-
fering complexity (butwith an identical predictor, i.e. the sample scores on the
firstDCAaxis) andselect thebestone.CanoDrawwillmeasure theperformance
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Figure 8-8. Regression residuals from the GLMmodel plotted against the
predictor values.

of individual candidatemodels using the Akaike InformationCriterion (AIC). This
criterion attempts to measure model ‘parsimony’, so it penalizes a candidate
model for its complexity,measuredusing thenumber ofmodel degrees of free-
dom (see Hastie & Tibshirani 1990, or Chambers &Hastie 1992, for additional
discussion).
So, start your fitting with the same dialog box (XY Diagram Options), but

specify the GAM option in the lower left corner of this dialog. When you close
it, CanoDraw displays dialog where you set options for the fitted generalized
additive model. Make sure you change the default settings to match those
shown in Figure 8-9.
You specified value 4 in the Predictor 1 (DF=) field. If the Stepwise selection

using AIC option was not selected, a generalized additive model with a smooth
term for Samp.1 with complexity of four degrees of freedom would be fitted.
But themodel selection option is enabled (checked), soCanoDrawwill fit a null
model (which is, in fact, identical to the null model we mentioned when fit-
ting GLM) and four alternative generalized additive models with increasing
complexity (DF equal to 1, 2, 3, 4). If you specify a non-integer number in the
Predictor 1 field, CanoDraw fits a model with the integer sequence of DFs up to
the integer immediately below the specified value and then themodelwith the
specified complexity. For example, if thefield valuewere3.5, CanoDrawwould
make a comparison between a null model and themodels with 1, 2, 3, and 3.5
DFs. Note that the distribution specification is identical to the one you used
when fitting the generalized linearmodel.
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Figure 8-9. Settings for generalized additivemodel withmodel complexity
selection.

After you press theOK button, CanoDraw selects themodel complexity and
informsyouabout itwith theModelSelectionReportdialog.Wereproduce its con-
tents here:

AIC-BASED MODEL SELECTION

Response: CarxPani

Predictor: Samp.1

Selected model is marked by asterisk

Model AIC

------------------------

Null model 80.16

s(X,1) 77.19

s(X,2) 69.18

* s(X,3) 68.66

s(X,4) 69.14

As you can see, themodelwith threedegrees of freedom (s(X,3)) has the low-
estAICvalue (thehighest parsimony). This is the onewhichCanoDrawaccepts,
summarizes in the following dialog box, and plots in the diagram illustrated
in Figure 8-10.
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Figure 8-10. Species response curve fitted with a generalized additivemodel with
df = 3.

The curvehas an asymmetrical shape, but in general correspondswell to the
generalized linear model you fitted before. To compare these twomodels tog-
ether, you can plot fitted values of CarxPani from one model against the fitted
values from the other model. Alternatively, you can similarly plot the residu-
als from the two models. The two alternatives provide complementary infor-
mation, because the residuals are defined as the actual response variable values
minus the fitted values, and the two models share the values of the response
variable. Whatever option we choose, we need to store the fitted values and
residuals of this generalized additivemodel in the project and there is no other
way to do so than to create a residual plot. So, repeat the procedure illustrated
for the generalized linearmodel andmake sure that the Save resids andfittedopt-
ion is checked.Note thatnodifference fromthepreviously created residualplot
can be seen in the new residual plot (not shown here).
You will compare the fitted GAM and GLM by plotting the residuals from

GAM against the residuals fromGLM. To do so, use again the Create>Attribute
Plots> XY(Z) Plot command, andmake your choices as shown in Figure 8-11.
Note that no regressionmodel is fitted this time (optionNone in the VISUAL-

IZATION MODEL field) and that the diagram aspect ratio is fixed with the Iso-
scaling option. The resulting graph is shown in Figure 8-12.
You can see there is little discrepancy between the two fittedmodels.
Finally, we illustrate how to fit and plot species response models for mul-

tiple species at the same time, determining the appropriate model complex-
ity for each species (response variable) independently. You should return to the
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Figure 8-11. XYDiagramOptions for the diagram comparing the residuals of two
regressionmodels.
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Figure 8-12. XY diagram comparing the residuals of two alternative regression
models.

beginning of this section and study the diagram in Figure 8-1, containing six
selected sedge species which you will compare with respect to their distribu-
tion along themain gradient ofmeadow community variation, represented by
the first DCA axis. Because it is quite possible that you may need to refer to
this species group in several diagrams, you should define the group explicitly
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Figure 8-13. Definition of the group of sedge species.

within the project. Go to the Project menu and select the Define Groups of >

Species. A new dialog (named Species Group Manager) appears and you should
click the By Selection button in the Create area. Another dialog appears and you
should select the appropriate species names in the left list and move them to
the right list by clicking the Select button. The desired final state is illustrated
in Figure 8-13.
After you close this dialog with the OK button, you can change the default

group name (Group of species 1) using the Rename button in the group manager
dialog. Leave the dialog using the Close button.
To create a diagram with response curves of multiple species, you can use

the same command you used when you fitted response curves for CarxPani,
because you can select multiple variables in the Y VARIABLE list. But you will
take a shortcut here and use the Create > Attribute Plots > Species response curves
command. In the dialog box, which appears after you select the command,
select theGeneralizedAdditiveModel (GAM) option in theResponseModel Type area.
In the middle part, select the name of the group you just created in the right-
hand list. You can check that the group members were selected in the left-
hand list (titled Species to plot). Now you should select the predictor variable.
Click the Axis 1 in the left listbox in the lower part of the dialog. As you can
see, you can alternatively fit the response curves with respect to individual
environmental variables. If you want to use a different kind of predictors (e.g.
sample richness, values of covariates, or values of supplementary variables),
youmust use the XY(Z) diagram command. Confirm your choices with theOK
button.
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Figure 8-14. Response curves of six sedge species, fitted using generalized additive
models.

Note that in thedialog that appears now (titledGAMOptions) youwill spec-
ify options for all the response variables (species) at once. To comparemultiple
species models, you probably want to keep the fitted curves simple. Specify,
therefore, value 3 in the Predictor 1 field. Use the Poisson option in the Distribu-
tion area andmake sure the Stepwise selection using AIC option is checked.
After you close this dialog, CanoDraw selects ‘optimum’ model complex-

ity for each of the specified species and reports about the model selection and
about the selected model properties. Finally, the diagram is drawn, similar to
the one in Figure 8-14.
Note that your diagramhas all the response curves drawnwith solid lines of

different colour, but with uniform width. Wemodified the line appearance to
better support the black andwhite reproduction.
We will remind you here that the roughly unimodal shape of the response

curves for all the species isnot anartefact of the specifiedmodel type (unlike the
situation where you would fit second-order polynomial GLMs without model
complexity selection). Generalized additive models are able to fit monotoni-
cally changingorabimodal response shape, evenwith the limitof threedegrees
of freedom imposed in our example.



9

Advanced use of ordination

This chapter introduces four specializedormoreadvanced techniques,
which build on the foundations of ordination methods and can be used with
theCanoco forWindowspackage. All fourmethods are illustrated in one of the
case studies presented in Chapters 11–17.

9.1. Testing the significance of individual constrained
ordination axes

If you use several (partially) independent environmental variables in
a constrained ordination, the analysis results in several constrained (canoni-
cal) ordination axes. In CANOCO, it is easy to test the effect of the first (most
important) constrained axis or the effect of the whole set of constrained axes.
But youmay be interested in reducing the set of constrained axes (the dim-

ensionality of the canonical ordination space), and to do so you need to find
how many canonical axes effectively contribute to the explanation of the
response variables (to the explanation of community variation, typically). To
do so, youmust test the effects of individual constrained axes. Their indepen-
dent (marginal) effects do not differ from their additional (conditional) effects,
of course, because they aremutually linearly independent by their definition.
Let us start with the simplest situation, when you have a constrained ordi-

nation (RDA or CCA) with no covariables. If you need to test the significance
of a second (or higher) canonical axis for such constrained analysis, you should
clone the corresponding CANOCO project, i.e. create a new project, similar to
the original one but containing, in addition, covariable data. You will use the
scores of the samples on the constrained axes, which were calculated in the
original project. If you specify the sample scores (environment-derived scores
SamE) on the first axis as your only covariable, CANOCO will, in the new ana-
lysis, attempt to construct the constrained axes so that they are independent of

140
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this covariable.Therefore, thefirst axis found in thenewanalysiswill be identi-
cal to the second constrained axis of the original analysis. Now, you can simply
use the testof thefirst canonical axis,which isdirectlyavailable in theCANOCO
program. This test will, in effect, refer to the original second constrained (sec-
ondmost important) axis. Similarly, if youwant to test the effect of a third con-
strained axis, you must specify both the first and the second constrained axes
of the original analysis as two covariables in a new project.
To turn one or more constrained axes into covariables, you can open the

solution (.sol) file produced in the original project with the Microsoft Excel
program and extract the SamE scores from there with the help of the
WCanoImpprogram (see Section 1.7). Note that the constrained sample scores
(which are defined as linear combinations of the environmental variables) are
usually placed at the very end of the solution file. The sample scores calculated
from the species scores (the Samp scores) are near the beginning of the file, so
make sure you do not use them bymistake.
There is a shortcut, which allows you to skip the export of the sample scores

from the solution file. CANOCO is able to use a solution file as its input data.
The problemwith this approach is, however, that CANOCO reads the incorrect
set of sample scores (the Samp scores, not the SamE scores), unless you modify
the solution filemanually in away that causes CANOCO tomiss the first occur-
rence of sample scores. The required change to the solution file is described in
Section 8.2.4.2 of the CANOCO referencemanual (Ter Braak& Šmilauer 2002).
If your original constrained analysis contained some covariables, youmust,

of course, combine these covariables with the constrained sample scores, so
you must create a new data file before you can analyse the project testing the
significance of second and higher constrained axes.
Also note that the above-suggested algorithm for testing the higher con-

strained axes cannot be used in a DCCA (detrended canonical correspondence
analysis). If you use detrending by segments, the tests cannot be performed
at all, and if you select detrending by polynomials the required algorithm is
much more complicated and it is described in Section 8.2.4.3 of the CANOCO
referencemanual (Ter Braak & Šmilauer 2002).
Check Section12.2 inCase study2 for an example of testing the significance

of the second constrained axis.

9.2. Hierarchical analysis of community variation

If you study variation in a biotic community at several spatial or tem-
poral scales, you must take into account the hierarchical arrangement of the
individual scale levelswhen analysing the data. If your sampling design allows
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doing so, you may ask questions that involve the hierarchical nature of your
data:

1. How large are the fractions of the total community variation that can be

explained at the individual scale levels?

2. Is it possible to identify levels that influence significantly the community

composition?

In this section, we will illustrate the required procedures on a theoreti-
cal level. An example of studying community variation on different spatial
(landscape) levels is providedbyCase study6 inChapter16, using crayfish com-
munities as an example.
Let us start with the definitions of terms used in the following discussion.

We will assume your species data (Y ) were collected at three spatial levels. Let
us assume a hypothetical project, for which you can imagine that threemoun-
tain rangeswere sampled, in each of them threemountain ridgeswere selected
(at random), and then three peakswere selectedwithin each of the nine ridges.
Species data were collected using five randomly positioned samples on each of
the 27mountains (peaks). We will describe the spatial location of each sample
by three dummy variables representing mountain ranges (SLA1 to SLA3), by
another nine dummy variables identifying the ridges (SLB1 to SLB9), and
another 27 dummy variables identifying themountain peaks (SLC1 to SLC27).
The term ‘variation explained by’ refers to classical variance when linear
ordination methods (PCA, RDA) are used. When weighted-averaging (uni-
modal) ordination methods (CA, CCA) are used, it refers to so-called inertia.
For simplicity, we will refer to linear methods when describing the required
kind of analysis.

Total variation

The total variation in species (response) data can be calculated using
the unconstrained PCA, with no environmental variables or covariables. We
can describe the corresponding ordination model (similar to the formal
description of regressionmodels, used in some statistical packages) as:

Y = const

i.e. this is the null model, with no predictors.
The total variation in X can be decomposed into four additive compo-

nents: variation explained at the range level, variation explained at the ridge
level, variation explained at the mountain peaks level and the within-peak (or
residual) variation.
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Variation among ranges

To estimate the variation explained at the highest spatial level of
ranges (SLA), in an RDA we must use the SLA variables as environmental vari-
ables (predictors) and ignore the other SLx variables, i.e. the ordinationmodel
will be:

Y = SLA

To test this effect (the differences amongmountain ranges),we canuse aMonte
Carlo permutation test where we randomly reassign the membership in SLA
classes (i.e. which mountain range the data come from). We should keep the
other, lower-level spatial arrangement intact (not randomized), however, so
that we test only the effect at this spatial level. Therefore, we must permute
the membership of whole mountain ridges within the ranges, i.e. we must
use a split-plot design where the ridges (not the ranges) represent the whole
plots and the groups of 15 samples within each ridge represent the split-plots.
The whole plots will be permuted randomly (they will randomly change their
membership in ranges), while the split-plots will not be permuted at all.

Variation among ridges

When estimating the variation explained at the intermediate spatial
level of ridges (SLB), we must use the SLB variables as predictors. This is not
enough, however, because their marginal (independent) effect includes the
effect at thehigher spatial level (SLA),whichwehave estimatedalready.∗There-
fore, the SLA variables should be used as covariables in the partial RDA.We can
formally describe this partial constrained ordination as:

Y = SLB | SLA

i.e. we extract from X the effect of level SLB, after we have accounted for the
effect at level SLA. In otherwords,wemodel here the variability among ridges,
butwithin ranges.
When testing the SLB level effect (differences between the ridges), we must

randomly (in an unrestricted way) permute the membership of mountain
peaks within the ridges (with all five samples from each peak holding tog-
ether during the permutations), butwe shall not permute across themountain
ranges (theSLA level). Toachieve this,wemustdo the restricted (split-plot type)
permutations within blocks defined by the SLA covariables.

∗ Wehave nine ridges: from the identity of a ridge (coded by SLB1 to SLB9 dummy variables), we can tell
to whichmountain range a sample belongs.
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Variation among peaks

The variation explained by themountain peaks can be estimated (and
tested) with a similar (partial RDA) setup as used before, except we are now
working at a lower level. We will use the SLC variables as environmental
variables and the SLB variables as covariables:

Y = SLC | SLB
Further, we will not use the split-plot design permutation restrictions here.
Instead,wewill randomly allocatemountain peak identity to our samples, but
only within the permutation blocks defined by the SLB covariables (i.e. within
each of the ninemountain ridges).

Residual variation

Westill haveonehierarchical component to estimate. It is the variation
in community composition among the individual samples collected at the ind-
ividual peaks. This is the residual, lowest-level variation, so we cannot test it.
To estimate its size, we will perform partial unconstrained ordination, i.e.
a PCA with SLC variables used as the covariables and with no environmental
variables.

Note also the following aspect of hierarchical partitioning of community vari-
ation. Aswemove from the top levels of the hierarchy towards the lower levels,
the number of degrees of freedom for spatial levels increases exponentially: we
have only three mountain ranges, but nine ridges and 27 peaks. Predictably,
this fact alonewill lead to the increasing size of variation explained by the pro-
gressively lower levels. The amount of explained variation (represented by the
sumof canonical eigenvalues) corresponds to the sum-of-squares explained by
a regression term in a linear regression, or by a factor in an ANOVAmodel. To
compare the relative importance of individual hierarchical levels, we should
divide the individual variation fractions by their respective degrees of freedom.
Themethodfor calculating thenumberofDFs for individualhierarchical levels
is outlined in Section 16.3.

9.3. Principal response curves (PRC)method

When we experimentally manipulate whole communities, we often
evaluate the effect of the experimental treatments over a longer period. The
response to disturbance imposed on an ecosystem or to the addition of nutr-
ients has a strong temporal aspect. When we need to compare the com-
munity composition at sites differing in experimental treatment, with the
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Figure 9-1. Sample diagramwith principal response curves, from Section 15.8. M is
formowing the plot; F is for its fertilization and R is for the experimental removal
of the dominant plant species.

control (unmodified) plots at different sampling times, it is quite difficult
to do so using an ordination diagram from a standard constrained ordina-
tion. The temporal trajectory is usually not running straight through the
ordination diagram, so it is difficult to evaluate the extent of differences
among the individual time steps and also among the individual treatments.
Van den Brink & Ter Braak (1998, 1999) developed a new method called
principal response curves (PRC), which focuses exactly on this aspect of the
data.
The primary result of the PRC method is one or several sets of response

curves, representing temporal trajectories of community composition for each
of the experimental treatments. An example of a set of eight principal response
curves (corresponding to eight experimental treatments applied to grassland
vegetation) is shown in Figure 9-1.
A diagram displaying principal response curves can be usefully supple-

mentedby a one-dimensional diagramshowing the species scores on the corre-
spondingRDAaxis, as illustrated in Figure 9-1.We can combine the value read
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from a PRC for a particular treatment and time with the species score: if we
calculate an exponential transformation of their multiple, the value predicts
the relative size of that species abundance in comparison to its abundance in
the plotswith the control treatment at the same time. For example, the species
Scorzonera humilis (scorhumi) has its score equal to−1.0 on the first RDA axis.We
can predict from the diagram that in the third year its cover will be 32% lower
on the fertilized-only plots, compared with the control plots. This is because
the F curve value in 1996 is (approximately) 0.38, so we predict the relative
species cover as exp (−1.0 · 0.38) = 0.68. Note that such a quantitative inter-
pretation rule requires log-transformation of the original species data and that
it was derived with the assumption of count data. However, the interpretation
also carries on to the log-transformed cover estimates used in the study from
which Figure 9-1 originates.
The PRC method is based on a partial redundancy analysis. If we have

K treatment levels, coded as Z1, . . . , ZK dummy variables in a CANOCO data
file, and we measure the community composition at permanent sites at L
time points, coded as T1, . . . , TL dummy variables, then we should set up the
redundancy analysis model where T variables are used as covariables, and the
interactions of the Z and T variables are used as the environmental variables.
Because we want the control treatment to represent a reference point for each
measurement time, wemust omit the interactions involving the Z1 variable (if
the control treatment is represented by this variable).
The canonical (regression) coefficients (the Regr scores) of the remaining

interaction terms for the first RDA axis then represent the extent of the dif-
ference between the particular treatment and the control, at a particular time
point. The canonical coefficients must be transformed, however, to undo the
standardizationwhichCANOCOperformson the environmental variables and
the species data. The actual formula for transforming the Regr scores can be
found in the CANOCO reference manual (Ter Braak & Šmilauer 2002, sec-
tion 8.3.10), but the necessary calculations can be performed by CanoDraw for
Windows (using theProject> Import variables> SetupPRCscores command).There
are as many response curves originating from the first RDA axis as there are
treatment levels, in addition to control treatment.
Because the effect of experimental treatments at different sampling times

cannot usually be summarized with only one constrained axis, we can con-
struct second or even a further set of principal response curves. Note that the
effect represented by the first-order and the additional response curves should
be ascertained using a permutation test on the first canonical axis (or using
themethod outlined in this chapter, Section 9.1, to test for second and further
constrainedRDAaxes). In thepermutation test,we should randomly reallocate
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the experimental treatment of each whole time series. That means that all
the samples taken at a particular permanent site ‘travel’ together during each
permutation. The easiest way to assure this is to specify in the CANOCO prog-
ram the individual time series (all the samples, taken through time at one site)
as whole plots and ask for random permutations of the whole plots and no
permutation of the split-plots.
The construction and testing of PRC is illustrated in Case study 5, in

Chapter 15.

9.4. Linear discriminant analysis

In some situations, we have an a priori classification of the studied obj-
ects (individuals of various species, sampling plots for vegetation description,
etc.) and we want to find a quantitative classification rule using the values of
measured (explanatory) variables to predict membership of an object in one of
the pre-specified classes. This is a task for classical discriminant analysis. We
will focushere ondiscriminant analysis seen as anordinationmethod that best
reflects groupmembership.
Fisher’s linear discriminant analysis (LDA), also called canonical variate

analysis (CVA, used for example in CANOCO reference manual, Ter Braak &
Šmilauer 2002), is a method that allows us to find the scores for the clas-
sified objects (i.e. the samples in CANOCO terminology). The object scores
are expressed as linear combinations of the explanatory variables that opti-
mally separate the a priori defined groups. The method is available in Canoco
for Windows with some additional features not available in the standard
implementations of this method.
To perform LDA in CANOCO, the classification of samples must be used as

the species data. Each variable then represents a single class and the samples
belonging to a class have a value of 1.0 for this variable and zero values for
the other variables. This is the appropriate coding for classical discriminant
analysis, where the classification is ‘crisp’.∗

The variables we want to use for the discrimination enter the analysis in
CANOCO as environmental variables. We then select a canonical correspon-
dence analysis (CCA) using Hill’s scaling with a focus on the species distances
(value−2 in the console version of CANOCO).

∗ CANOCO allows us to perform a discriminant analysis based on a ‘fuzzy’ classification, where (some)
samples can belong to several classes at the same time. This situationmight represent a true partial
membership in several classes or our uncertainty about the truemembership for those samples. The
only requirement for fuzzy coding is that the sum of sample values in the species data is equal
to one.
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The one distinct advantage of doing LDA in CANOCO is that we might
perform a partial discriminant analysis. In such an analysis, we can look
for explanatory variables allowing us to discriminate between given classes in
addition to other known discriminatory variables.
Other distinct features of LDA in CANOCO are the ability to select a subset

of the discriminating (explanatory) variables by means of forward selection of
environmental variables and the ability to test the discriminatory power of the
variables by the non-parametricMonte Carlo permutation test.
Whenplotting the results, the species scores represent themeans (centroids)

of the individual classes in the discriminatory space. Scores of samples (the
SamE scores) are the discriminant scores for the individual observations. A
biplot diagram containing biplot scores of environmental variables ( BipE)
presents the table of averages of individual explanatory variables within indi-
vidual classes, while the regression/canonical coefficients ( Regr scores) of envi-
ronmental variables represent the loadings of the individual variables on the
discriminant scores.
Note that the lengths of the arrows for discriminating descriptors (plotted

as the biplot scores of environmental variables) do not correspond properly to
thediscriminatorypower of theparticular variable. TheCANOCOmanual sug-
gests in Section 8.4.3.1 how to rescale the length of individual arrows to reflect
their efficiency for separating the a priori classes. The necessary steps are also
illustrated in Case study 7, Chapter 17.
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Visualizingmultivariate data

The primary device for presenting the results of an ordination model
is the ordination diagram. The contents of an ordination diagram can be used
to approximate the species data table, thematrix of distances between individ-
ual samples, or thematrix of correlations or dissimilarities between individual
species. In ordination analysis including environmental variables, we can use
the ordination diagram to approximate the contents of the environmental
data table, the relationship between the species and the environmental vari-
ables, the correlations among environmental variables, etc. The following two
sections summarize what we can deduce from ordination diagrams that result
from linear and unimodal ordinationmethods.
Beforewediscuss rules for interpretingordinationdiagrams,wemust stress

that the absolute values of coordinates of objects (samples, species, explanatory
variables) in ordination space do not have, in general, any meaning.∗ When
interpretingordinationdiagrams,weuse relativedistances, relativedirections,
or relative ordering of projection points.

10.1. What we can infer from ordination diagrams:
linearmethods

An ordination diagram based on a linear ordination method (PCA
or RDA) can display scores for samples (represented by symbols), species
(represented by arrows), quantitative environmental variables (represented by
arrows) and nominal dummy variables (represented by points – centroids –

corresponding to the individual levels of a factor variable). Table 10-1 (after

∗ There are some exceptions to this statement. In analyses with particular options selected, distances
between sample pointsmeasure their dissimilarity in composition turnover (SD) units; in other cases
one can project tips of arrows of environmental variables onto ordination axes to read the value of
correlation between the variable and the sample scores on an ordination axis.
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Figure 10-1. Projecting sample points onto species vector (of the Spc 2 species) in a
biplot from a linear ordination. Here we predict the largest abundance of Spc 2 in
samples Sa4 and Sa2, then sample Sa3 is predicted to have a lower abundance near
the average of Spc 2 values, and the expected abundance decreases evenmore for
Sa1 and Sa5.

Ter Braak 1994) summarizes what can be deduced from ordination diagrams
based on these scores. Additionally, the meaning of the length of species arr-
ows in the two types of ordination scaling is discussed, and information
about calculating the radius of the equilibrium contribution circle is given.
In the ordination diagram the equilibrium contribution circle displays the
expected positions of the heads of species arrows, under the assumption that
the particular species contribute equally to the definition of all the ordina-
tion axes. Note that an equilibrium contribution circle has a common radius
for all species only in a biplot diagram focusing on inter-sample distances (see
Legendre & Legendre 1998, for additional discussion).
If we project the sample points perpendicular to a species’ arrow, we obtain

an approximate ordering of the values of this species across the projected sam-
ples (see Figure 10-1). If we use the sample scores that are a linear combination
of the environmental variables$ (SamE scores, typically in RDA), we approxi-
mate thefitted, not theobserved, valuesof those abundances.+ This interpreta-
tion is correct for both kinds of scaling. If centring by species was performed,∗

$ ProgramCanoDraw uses the SamE scores for samples in the ordination diagrams from direct gradient
analyses (RDA, CCA). This default option can be changed, however.

+ See Section 5.3 for a description of the linear ordination techniques in terms of fittingmodels of
a species linear response.

∗ This is the case in themajority of analyses using linear ordinationmethods.
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Figure 10-2. Distances between sample points in an ordination diagram. If we
measured the dissimilarity between sample Sa5 and the other samples using
Euclidean distance, the distance between sample Sa5 and Sa2 is predicted to be
the shortest one, the distance to samples Sa3 and Sa4 the next shortest, and finally
the distance to sample Sa1 the longest (i.e. samples Sa1 and Sa5 are predicted to
show the greatest dissimilarity).

a sample point projecting onto the beginning of the coordinate system (per-
pendicular to a species arrow) is predicted to have an average value of the cor-
responding species. The samples projecting further from zero in the direction
of the arrow are predicted to have above-average abundances, while the sample
points projecting in the opposite direction are predicted to have below-average
values.
Theperpendicularprojectionofpoints onto thevectors (arrows) is called the

biplot rule in this context.
Only in the scaling focused on sample distances does the distance between

the sample points approximate their dissimilarity, expressed using Euclidean
distance (see Figure 10-2).∗

Only in the scaling focused on species correlations do the relative direc-
tions of the species arrows approximate the (linear) correlation coefficients
among the species (Figure 10-3). In the case of covariance-based biplots (where
species scores arenotpost-transformed) theapproximatedcorrelationbetween
two variables is equal to the cosine of the angle between the corresponding

∗ Note that the actual distancemeasure approximated in an ordination diagrammay often be different
from the rough Euclidean distance. For example, if you specify standardization by sample norm in
CANOCO, the distances between sample points approximate so called Chord distance (see Legendre
&Gallagher 2001, and Section 6.2).
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Figure 10-3. Angles between the species arrows in a diagram from a linear
ordinationmethod. As the arrows for the two species Spc 1 and Spc 2meet nearly at
right angles, the species are predicted to have a low (near-to-zero) correlation.
More precise approximation in the default scaling options (with species scores
being post-transformed) is achieved by the biplot projection rule.

arrows. Therefore, arrows pointing in the samedirection correspond to species
that are predicted to have a large positive correlation, whereas species with
a large negative correlation are predicted to have arrows pointing in opposite
directions.
If the species scores are post-transformed (divided by species standard

deviation), we can estimate the correlations by perpendicularly projecting
the arrow tips of the other species onto a particular species arrow. In most
cases, we obtain very similar conclusions with both alternative interpretation
rules.
We can apply a similar approximation when comparing the species and

(quantitative) environmental variable arrows (see Figure 10-4). For example, if
thearrowforanenvironmental variablepoints ina similardirection toa species
arrow, the values for that species are predicted to be positively correlated with
the values for that environmental variable. This interpretation is correct for
both types of scaling of ordination scores.
The sample points can also be projected perpendicularly to the arrows of

environmental variables (seeFigure10-5). This givesus the approximateorder-
ingof the samples inorderof increasingvalueof that environmental variable (if
we proceed towards the arrow tip and beyond it). The environmental variables
(and covariables) are always centred (and standardized) before the ordination
model is fitted. Thus, similar to projecting the sample points on the species
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Figure 10-4. Angles between arrows of species and environmental variables in an
ordination diagram from a linearmethod.When comparing the correlation of
environmental variable B with the two species, we predict from the angles that B
is slightly negatively correlated with species Spc 1 and has a larger positive
correlation with species Spc 2 (the higher the value of B, the higher the expected
value of Spc 2). The biplot projection of the species arrow tips onto the arrow of an
environmental variable provides amore precise approximation.
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Figure 10-5. Projecting sample points onto the arrows of a quantitative
environmental variable. Note that variable A is predicted to have similar values
for the samples Sa3 and Sa4 even though they are located at different distances
from the environmental variable line.
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Figure 10-6. Measuring angles between arrows of quantitative environmental
variables. The angle between the two variables suggests that they are almost
non-correlated.

arrows, aprojectionpointnear zero (the coordinate systemorigin) corresponds
to the average value of that particular environmental variable in that sample.∗

The angle between the arrows of the environmental variables can be used to
approximate the correlations among those variables in the scaling focused on
species correlations (see Figure 10-6). Note, however, that this approximation
is not as good as the onewewould achieve if analysing the environmental data
table as the primary data in a PCA. If the scaling is focused on inter-sample dis-
tances, we can interpret each arrow independently as pointing in the direction
inwhich the sample scores would shift with an increase of that environmental
variable’s value.The lengthof thearrowallowsus tocompare the sizeof suchan
effect across the environmental variables (remember that all the environmental
variables enter the analysis with a zero average and a unit variance).

CANOCO output allows a different (and usually a more useful) interpreta-
tion for the dummy environmental variables. These variables have only the 0
and 1 values and they are created by re-coding a factor variable. Such variables
can be represented by symbols that are placed at the centroids of the scores for
samples that have a value of 1 for the particular dummy variable. We can view
the original factor variable as a classification variable and then the individual
dummy variables correspond to the individual sample classes. We can say that

∗ Note, however, that the constrained ordinationmodel is aimed at approximating the relations
between species data and the environmental variables, rather than an optimal approximation of the
environmental values for the individual samples.
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Figure 10-7. Projecting centroids of dummy environmental variables on species
arrows in an ordination diagram from a linearmethod. Here we predict the
largest average abundance of species Spc 2 for the samples belonging to the class
n II, with samples from the n I and n III classes having a lower (and similar)
average predicted abundance.

the centroid score for a dummy variable (referred to as CenE in the CANOCO
documentation) represents the average of the scores of samples belonging to
that class.
Ifweproject the centroids of dummyenvironmental variables onto a species

arrow, we can approximate the average values of this species in the indi-
vidual classes (Figure 10-7). Similarly, the distance between the centroids of
environmental variables approximates (in the scaling focused on inter-sample
distances) the dissimilarity of their species composition, expressed using
Euclideandistance (i.e. howdifferent is the species compositionof the classes).∗

In both types of scaling, the distance between the centroids of individual
sample classes and a particular sample point allows us to predict membership
of that sample (Figure 10-8). A sample has the highest probability of belong-
ing to the class with its centroid closest to that sample point. We must note
that in a constrained analysis, where the dummy variables are used as the only
explanatory variables, the constrained sample scores (SamE scores) have identi-
cal coordinates to the CenE scores of the classes to which the samples belong.

∗ Note, however, that if we do compare the positions of centroids in a constrained ordinationmodel
(RDA or, with the unimodalmodel, CCA), the underlying ordinationmodel is ‘optimized’ to show the
differences between the classes. An unbiased portrait can be obtained from an unconstrained
ordination with the centroids of dummy environmental variables post hoc projected into the
ordination space.
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Figure 10-8. Measuring the distance between sample points and centroids of
dummy environmental variables. We can predict here that sample Sa1 has the
highest probability of belonging to class n I, and has the lowest probability of
belonging to class n III.
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Figure 10-9. Projecting centroids of environmental variables onto arrows of
quantitative environmental variables. The samples from class n II are predicted to
have the largest average value of variable A, followed by samples from class n I; the
samples from n III have the lowest average value of the variable A.

If we project the centroids of dummy environmental variables onto an arr-
ow of a quantitative environmental variable, we can deduce the approximate
ordering of that variable’s average values in the individual sample classes
(see Figure 10-9).
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10.2. What we can infer from ordination diagrams:
unimodalmethods

The interpretation of ordination diagrams based on a unimodal ordi-
nationmodel is summarized in Table 10-2 (followingTer Braak&Verdonschot
1995). It has many similarities with the interpretation we discussed in detail
for the linear ordination model in the preceding section, so we will point the
reader to the preceding section when required.
The main difference in interpreting ordination diagrams from linear and

unimodal ordination methods lies in the different model of the species
response along the constructed gradients (ordination axes). While a linear
(monotonic) change was assumed in the preceding section, here (many of ) the
species are assumed to have an optimumposition along each of the ordination
axes with their abundances (or probability of occurrence for presence–absence
data) decreasing symmetrically in all directions from that point.∗ The esti-
mated position of that species’ optimum is displayed as its score, i.e. as a point
(symbol). These positions are calculated as the weighted averages of the sam-
ple positions with weights related to the species’ abundances in the respective
samples.
Another important difference is that the dissimilarity between samples is

based on the chi-square metric, implying that any two samples with identi-
cal relative abundances (say two samples with three species present and their
values being 1 2 1 and 10 20 10, respectively) are judged to be identical by a
unimodal ordinationmethod.Thedissimilarity of thedistributionofdifferent
species is judged using the same kind of metric, being applied to a transposed
datamatrix.
Themutual position of sample and species points allows us to approximate

the relative abundances in the species data table. The species scores are near
the points for samples inwhich they occurwith the highest relative abundance
and, similarly, the sample points are scatterednear thepositions of species that
tend to occur in those samples (see Figure 10-10). This kind of interpretation is
called the centroid principle. Its more quantitative formworks directly with

∗ The question about howmany species in one’s data should show a linear or a unimodal response with
respect to the environmental variables frequently arises among canoco users in trying to decide
between linear and unimodal ordinationmethods. The key fact for answering this is that the
ordinationmodel is simply amodel. Wemust pay for the generalization it provides us with some
(sometimes quite crude) simplification of the true community patterns.We should try to select the
type of ordinationmodel (linear or unimodal), improved by an appropriate transformation of the
species data, which fits better than the alternative one, not the one which fits ‘perfectly’. While this
might sound like a highly disputable view, we do not think that data sets where the choice of one or
the other ordination type would be inappropriate occur very often.
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Figure 10-10. The distance between a species point and the sample points. The
species Spc 2 is predicted to have the highest relative abundance in the samples Sa3
and Sa4 and the lowest one in sample Sa5 (it is probably absent from this sample).

distances between points. If we order the samples based on their distance to
a point for a particular species, this ordering approximates the ordering based
on the decreasing relative abundance of that species in the respective samples.
For shorter gradient lengths (less than 2 SD units, approximately) we can

interpret the positions of species and samples in the ordination plot using the
biplot rule (see Figure 10-11). This is similar to the interpretation used in
the ordination diagrams based on the linear ordination methods. We simply
connect the species points to the origin of the coordinate system and project
the sample points perpendicular to this line.∗

The distance between the sample points approximates the chi-square dis-
tances between samples in thebiplot scalingwith the focus on species, but only
if the ordination axes used in the ordinationdiagramexplain a similar amount
of variability (if they have comparable eigenvalues).
IfweuseHill’s scalingwith its focus on inter-sample distances, then thedis-

tancebetweenthe samples is scaled in ‘species turnover’ unitsX that correspond
to the labelling of the ordination axes. The samples that are at least four units
apart have a very lowprobability of sharing any species, because a ‘half change’
distance in the species composition is predicted to occur along one SD unit.
The distance between species points in the biplot scaling (with its focus

on the species distances) approximates the chi-square distance between the
species distributions (see Figure 10-12).

∗ In DCA, use the centroid of sample scores instead of the coordinates’ origin.
X These units are called SD units, a term derived from the ‘standard deviation’ (i.e. width) of a species
response curve (see Hill & Gauch 1980).
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Figure 10-11. Biplot rule applied to species and sample points in an ordination
diagram from a unimodal ordinationmethod. The species Spc 2 is predicted to
have the highest relative frequency in samples Sa4 and Sa2 and the lowest one in
sample Sa5. This species is predicted to occur in samples Sa3 and Sa1with its
average relative frequency.
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Figure 10-12. Measuring the distance between species points.

If we project species points onto an arrow of a quantitative environmental
variable, we get an approximate ordering of those species’ optimawith respect
to that environmental variable (see Figure 10-13). Similarly, we can project
sample points on the arrow for a quantitative environmental variable to
approximate values in the environmental data table, but only if biplot scaling
is used.
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Figure 10-13. Projecting species points onto arrows of quantitative environmental
variables. We can interpret the graph by saying that species Spc 2 is predicted to
have its optimumwith respect to environmental variable B at higher values of that
variable than species Spc 1.

Interpretation of the relationships between environmental variable arrows
(either using the angle between the arrowsor comparing the relative directions
and size of the impact) is similar to the interpretation used in linear methods,
described in the preceding section (see also Figure 10-6).
For centroids of dummy environmental variables (see previous section for

an explanation of their meaning), we can use the distance between the species
points and those centroids to approximate the relative total abundances of
the species in the samples of that class (summed over all the samples in the
particular class) – see Figure 10-14.
Comparison between the sample points and centroids of dummy variables

and between the centroids and the arrows for the quantitative environmental
variables proceeds as in linearmodels, as described in the previous section.
The distance between the particular centroids of dummy environmen-

tal variables is interpreted similarly to the distance (dissimilarity) between
the sample points. In this case the distance refers to the average chi-square
distances (or turnover, depending on the scaling) between the samples of the
corresponding two sample classes.

10.3. Visualizing ordination results with statisticalmodels

The results of ordination methods can be summarized in one or a
fewordinationdiagrams; in addition, thedeterminedcompositional gradients
(ordination axes) can be used as a framework within which we can study
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Figure 10-14. Measuring the distance between species points and centroids of
dummy environmental variables. The average relative frequency of species Spc 1 is
predicted to be highest in class n I, followed by n II and then by class n III.

the behaviour of individual variables, various sample characteristics (such
as species richness or diversity), or even the relationship between various
variables.
The relationships between various variables (including independent vari-

ables, as well as the scores of samples or species on the ordination axes) can
be abstracted (‘formalized’) with the help of regression models and their use
is illustrated in the tutorial in Section 8.7. Program CanoDraw also contains
other visualizationmethods, which we illustrated here.
You can create, for example, a plot displaying the values of a particular

environmental variable in ordination space. The actual value of the selected
variable in a sample is displayed at the sample position using a symbol with
its size proportional to the value. If we expect the value of the environmental
variable to changemonotonically across the ordination (sub)space (or even lin-
early, as in the constrained ordinationmodel), wemight recognize such a pat-
tern from this symbol plot (see Figure 10-15). However, plotting individual
sample values for even a medium-sized data set often does not allow for an
efficient summary of the pattern. In such case, some kind of regression model
should be used (GLM, GAM, or loess smoother, see Chapter 8).

10.4. Ordination diagnostics

Ordination diagrams and attribute plots can also be used to check how
well the data analysedwith an ordinationmethod fulfil the assumptions of the
underlyingmodel.
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Figure 10-15. Attribute plot with symbols, illustrating the variation in the values of
theMoisture variable. BF, NM, SF andHF are nominal (qualitative)
environmental variables, while Use, A1 hor,Moisture andManure are
(semi-)quantitative environmental variables.

The first obvious check concerns our assumption of the shape of the species
response along the ordination axes, which represent the ‘recovered’ gradients
of the community composition change.∗ We can fit regressionmodels describ-
ing the change of species values along the ordination axes with the Create >

Attribute Plots > Species response curves command. In the case of both linear and
unimodal ordination methods, we should probably let CanoDraw select the
regression model complexity, whether we use generalized linear or general-
ized additive models. The steps needed, as well as additional considerations,
are given in Section 8.7.
Another assumption of constrained ordination methods (both RDA and

CCA) is that the gradients of community composition change depend on the
environmental descriptors in a linear way. This is enforced by the constrained
ordination methods, where the constrained ordination axes are defined as

∗ With an underlying environmental interpretation in the case of constrained ordinationmethods.
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Figure 10-16. Attribute plot showing the values of the fit of species into the
ordination space (the CFit statistics in CANOCO output).

linear combinations of the submitted environmental variables. Nevertheless,
often a simple monotone transformation of a predictor can lead to its sub-
stantially higher predictive power. This happens, for example, if you study
the successional development of (plant or other kind of ) a community during
secondary succession. The pace of community change is usually highest at the
beginning and slows down continually. If you use the time since the start of
succession as a predictor, the community change is usually better explained by
the log-transformed predictor. This corresponds to a non-uniform response of
community composition along the successional time gradient.
The CANOCOmanual refers to ordination diagnostics with a somewhat

different meaning; namely, it refers to the statistics calculated with the ordi-
nationmethod. These statistics describe, in general terms, howwell the prop-
erties of individual samples and of individual species are characterized by the
fitted ordination model. This statistic is named CFit in the case of species (see
Ter Braak and Šmilauer 2002, Section 6.3.11.2) and can be used in CanoDraw
to select which species occur in the ordination diagram. Additionally, we can
plot these values in the ordination space (see Figure 10-16).
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Figure 10-17. An example of t-value biplot. Jun art is Juncus articulatus; Ran fla is
Ranunculus flammula, Pla lan is Plantago lanceolata, Achmil is Achilleamillefolium and
Lol per is Lolium perenne.

10.5. t-value biplot interpretation

A t-value biplot is a diagram containing arrows for the species and ar-
rows or symbols for the environmental variables. It is primarily used to reveal
statistically significant pair-wise relationships between species and environ-
mental variables (i.e.which species dependonwhich environmental variables).
We interpret the t-value biplot using the biplot rule (see Section 10.1). Using
the biplot projections, we approximate the t-values of the regression coeffi-
cients,whichwewouldget for amultiple regressionwith theparticular species
acting as a response variable and all the environmental variables as predictors.
To interpret the t-value biplot (see Figure 10-17 for an example), we project

the tips of the environmental variable arrows onto a line overlying the arrow
of a particular species. If the environmental variable arrow’s tip projects on
the line further from the origin than the species’ arrowhead, we deduce that
the t-value of the corresponding regression coefficient is larger than 2.0. This
also holds true for projection onto the part of the line going in the opposite
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direction, with the t-value being less than −2.0. Projection points between
these limits (including the coordinate system origin) correspond to t-values
between −2 and +2, with the predicted value of a T statistic being 0.0 for the
coordinates’ origin.
If we want to find which species have a significant positive relationship

with a particular environmental variable, we can draw a circle with its centre
mid-way between the arrowhead for that variable and the origin of the coor-
dinate system. The circle’s diameter is equal to the length of that variable’s
arrow. Species lines that end in that circle have a positive regression coeffi-
cient for that environmental variable with the corresponding t-value larger
than 2.0. We can draw a similar circle in the opposite direction, corresponding
to a significant negative regression coefficient. These two circles are so-called
Van Dobben circles (see Ter Braak & Šmilauer 2002, Section 6.3.12) and they
are illustrated in Figure 10-17 for the variableMoisture. We can deduce (under
the assumption of a sufficient number of samples – data points) that increas-
ing moisture positively affects species such Jun art or Ran fla, and negatively
affects the abundance of species such asPla lan,Achmilor Lol per.Note that there
are as many independent pairs of Van Dobben circles as there are explanatory
(environmental) variables.
Additional information on t-value biplots can be found in Ter Braak &

Šmilauer (2002), Section 6.3.12.
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Case study 1: Variation in forest bird
assemblages

The primary goal of the analyses demonstrated in this case study is to
describe the variability of bird communities, related to the differences in their
habitat.
The data set originates from a field study by Mirek E. Šálek et al.

(unpublished data) in Velka Fatra Mts. (Slovak Republic) where the bird
assemblages were studied using a grid of equidistant points placed over the
selected area of montane forest, representing a mix of spruce-dominated
stands and beech-dominated stands. There was a varying cover of deforested
area (primarily pastures) and the individual quadrats differed in their altitude,
slope, forest density, cover and nature of shrub layer, etc. (see the next section
for description of environmental variables). The primary data (species data)
consist of the number of nesting pairs of individual bird species, estimated by
listening to singing males at the centre points of each quadrat. The data val-
ues represent an average of four observations (performed twice in each of two
consecutive seasons).

11.1. Datamanipulation

The data are contained in the Excel spreadsheet file named birds.xls.
This file has two sheets.Wewill use thedata contained in thefirst sheet (named
birds ), where the bird species observed in only one of the quadrats were omit-
ted (the full data are available in the other sheet, labelled birds-full ). Note that
the birds sheet contains both the species data (average abundance of individual
bird species) and the environmental data (description of habitat characteristics
for the particular quadrat). The species data are contained in the columns A to
AL (column A contains sample labels and then there are data for 37 species) and
the environmental data in the columns AN to BA (column AN contains sample
labels again, followed by 13 environmental variables).

168
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There is only one quantitative variable, Altit, specifying the average altitude
of the sampled quadrat in metres above sea level. The next eight columns rep-
resent a mixture of semi-quantitative and strictly ordinal variables, describ-
ing: forest cover in the whole quadrat (Forest ), average density of forest stands
(ForDens ), relative frequencyofbroad-leaved tree species in the tree layer (BrLeaf,
with 0 valuemeaning spruce forest, and 4 only broad-leaved trees), total shrub
layer cover (E2), percentage of coniferous species (spruce) in the shrub layer
(E2Con), cover of the herb layer (E1) and its average height (E1Height ). The vari-
able Slopehas amore quantitative character; it corresponds to slope inclination
indegrees,dividedbyfive.The last fourvariables represent twopairsofdummy
variables coding two possible levels of two factors: the presence of larger rocks
in the quadrat (Rocks andNoRocks) and the position of the quadrat on the sunny
(south-east, south, and south-west) slopes (Warm and Cold ).
To analyse these data with CANOCO, you must transform them into text

files with CANOCO format. The species and environmental data must be pro-
cessed separately and stored in independent data files. First select the rectan-
gular area in the birds sheet representing the species data (columns A to AL and
rows 1 to 44). Copy the selected region to the Windows Clipboard (e.g. using
the Edit>Copy command) and store the data in a filewith the CANOCO format
named, for example, bird spe.dta, using the WCanoImp program, as described
in Section 1.7. You can use either the condensed or the full format. Similarly,
the environmental data stored in columns AN to BA and rows 1 to 44 should be
exported into the file named bird env.data. Parts of the contents of the two files
are illustrated in Table 11-1.

11.2. Deciding between linear and unimodal ordination

Start your analysis with the decision about the appropriate kind of
ordination model, using the method outlined in Section 4.3. Note again that
this procedure is recommended only when you do not have an indication of
which of the two families of ordination methods to use, based either on the
peculiarities of your data set or on your experience. In our particular exam-
ple, it is difficult to decide a priori about the method and so it is good to esti-
mate the heterogeneity in the species data, using the length of the community
composition gradients in species turnover units, as calculated by detrended
correspondence analysis. Define a new CANOCO project and in the project
setupwizardmake the following choices:

1. You have Species and environmental data available. While you do not need

the environmental variables in this step, you can acknowledge their
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Table 11-1. Part of the contents of the two data files used in this case study

Part of the created species data file
Bird species assemblages in montane forest, Velka Fatra, Slovak Rep.
(I5,1X,6(I6,F5.1))
6

1 9 1.0 12 2.0 14 1.0 17 1.0 19 1.0 22 1.0
1 25 1.0 27 1.0
2 9 1.5 12 3.0 13 0.5 14 2.0 17 0.8 19 0.5
2 21 0.5 22 1.0 23 0.5 24 1.0 27 0.5 29 0.8
2 32 0.3
3 7 1.0 9 1.0 12 3.0 14 2.0 15 0.5 22 0.5
3 23 0.5 24 1.0 26 0.5 27 0.5 30 0.5 32 0.5
3 33 0.3 34 0.5 35 0.5
4 9 1.5 12 2.8 14 1.0 22 0.5 28 0.5 29 0.5
4 32 0.5 34 0.3 35 0.5

...
43 3 1.0 9 2.0 12 1.5 14 1.0 19 1.5 20 0.5
43 21 1.0 22 1.0 24 0.5 27 1.0 28 0.5 29 0.5
0

AegiCaudAlauArveAnthTrivCertFamiColuPaluCorvCoraCucuCanoDryoMartEritRubeFiceAlbi

FiceParvFrinCoelLoxiCurvParuAterParuCrisParuMajoParuMontPhoePhoePhylCollPhylSibi

PhylTro PrunModuPyrrPyrrReguReguReguIgniSittEuroSylvAtriTrogTrogTurdMeruTurdPhil

TurdViscTurdTorqCardSpinRegu sp.ParuPaluMotaCineOriOri

R1 R2 R3 R4 R5 R6 R7 R8 R9 R10
R11 R12 R13 R14 R15 R16 R17 R18 R19 R20
R21 R27 R28 R29 R30 R31 R32 R37 R38 R39
R40 R41 R42 R43 R46 R47 R48 R49 R50 R51
R54 R55 R56

Part of the created environmental data file:
Birds data - habitat characteristics, Velka Fatra Mts., Slovak Rep.
(I5,1X,13F5.0)
13

1 860 4 3 2 2 2 3 1 8 0 1 0 1
2 1010 4 3 2 0 0 1 1 5 1 0 0 1
3 1070 4 2 2 2 2 4 1 8 0 1 0 1
4 1050 4 2 2 2 2 3 1 9 0 1 0 1
5 1030 4 2 2 2 2 6 1 7 0 1 0 1

...
42 1050 4 2 3 0 0 9 2 7 0 1 1 0
43 1045 1 2 4 3 1 9 2 8 0 1 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0 0

Altit Forest ForDens BrLeaf E2 E2Con E1 E1HeightSlope Rocks
NoRocks Warm Cold
R1 R2 R3 R4 R5 R6 R7 R8 R9 R10
R11 R12 R13 R14 R15 R16 R17 R18 R19 R20
R21 R27 R28 R29 R30 R31 R32 R37 R38 R39
R40 R41 R42 R43 R46 R47 R48 R49 R50 R51
R54 R55 R56
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availability here, because youwill use this project setup as the starting

point of your other CANOCO projects in this case study. At the bottom of

the first setupwizard page, select the indirect gradient analysis option,
however.

2. On the next page, locate the source data files with species and

environmental data and also specify a name for the file containing

CANOCO results and the directory where it will be placed. Note that for a

new analysis CANOCO offers the software’s installation directory after

the Browse button is pressed, whichmight not be appropriate,

particularly if youwork with a networked installation.

3. On the next setupwizard page, select the DCAmethod and by segments in
theDetrendingMethod page. On the next page, use Log transformation.∗

4. Do not check any option on the following page (Data Editing Choices ).
Pressing theNext button here brings you to the last setupwizard page
and you conclude the setup by selecting the Finish button there. The
resulting analysis must be saved now (e.g. under the name dca.con) and
you can run the analysis using the Analyze . . .button in Project
View.

5. You should now switch to the Log View to see the results. The first two

axes explain approximately 23% of the variability in the species data.

More important at this stage is the line giving the lengths of recovered

composition gradients (DCA axes):

Lengths of gradient : 2.001 1.634 1.214 1.613

The gradients are not very long, so you are advised to use the linear ordina-
tionmethods for analyses.

11.3. Indirect analysis: portraying variation in bird community

1. Start with an indirect analysis of the species data, using PCA as the

method to summarize the community variation. Evenwhen the

unconstrained analysis does not need the environmental variables, we

keep them in the analysis – in an indirect analysis they are passively

projected into the resulting ordination space and can suggest

interpretations for the principal components. You can start a new

CANOCO project using the previous one, where several choices (names of

the input data files, transformation of species data) remain appropriate

for this analysis. With the dca.con project opened in the Canoco for

∗ The alternative square-root transformation would work as well, with the additional bonus of escaping
the problem of the constant wemust add to the data values before calculating the logarithm, to
prevent taking the log of the zero values.
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Windowsworkspace, select the File> Save As . . . command from themenu

and specify a new name for your CANOCO project (pca.con is suggested
here). Select Clear the log windowwhen prompted by the CANOCO

program.

2. Now click theOptions . . .button in the Project View to invoke the setup

wizard again. On the first page, leave the Species and environment data
available choice, as well as the interpret patterns extracted from all variation
(indirect gradient analysis). On the next page, you should change the name

of the CANOCO results file (pca.sol is suggested here), and then change
fromDCA to PCA on the next page. The options on the Scaling:Linear
Methodswizard page have default values appropriate for your analysis.∗

Keep the transformation options as they were defined in the test project

with DCA (changing themwould partly invalidate the conclusionsmade

in the previous section).

3. The choices to bemade in the next setupwizard page (Centering and
Standardization) are crucial for the interpretation of the PCA results. In the

right half of this page, the default value is Center by species. The centring is
appropriate in almost any linear analysis, while the standardization

(most often to be performed in addition to centring) is not so easy. In this

case, if you stress the fact that the abundances of all species are in the same

units (counts of nesting pairs over comparable areas) and are therefore

comparable, youmight prefer not to standardize. If, on the other hand,

you take the view that different bird species with different territory size,

sociability and feeding habits differ in their potential frequency of

occurrence in the landscape, youmight prefer tomake the counts of

different species comparable by their standardization. The choice is not

easy, but in this tutorial follow the ‘no standardization, centre-only’

path. Further consideration for this choice is that the log transformation

makes the frequencies comparable, to some extent, as it lets the analysis

focus on relative change (see also Section 1.8). For the choices on the left

half of this wizard page, seemore comments in Section 14.3, where linear

ordinations with andwithout standardization by sample norms are

compared. Your analysis aims to portray both the differences in the

proportions taken by individual species and the difference in their

absolute counts. So, leave theNone option selected here (see Figure 11-1).

4. Leave the wizard page withData Editing Choices at its default state
(nothing selected there) and then close the project setupwizard sequence.

Run the analysis in the sameway as before and check the summary of the

∗ We aremore interested in the correlation among the counts of individual species and between the
species and environmental variables, rather than in the precise positioning of sample points in the
ordination space.
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Figure 11-1. Resulting state of the Centering and Standardization setupwizard page.

analysis results in the Log View. The following text provides comments

on selected parts of the CANOCO output displayed in this view.More

information can be found in the Canoco forWindowsmanual (Ter Braak

& Šmilauer 2002).

No samples omitted

Number of samples 43

Number of species 37

Number of occurrences 533

This summary information (you have to scroll up in the Log View to find it)
is a good place to check the correctness of your data sets and/or of the project
choices. If the displayed numbers differ from those you expected, you should
investigate the reasons for the discrepancies.

****** Check on influence in covariable/environment data ******

The following sample(s) have extreme values

Sample Environmental Covariable + Environment space

variable Influence influence influence

8 9 6.0x

14 2 6.1x

14 3 7.4x

****** End of check ******
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The information in this section can be used for different purposes and one
of them is checking for typing errors in the filewith explanatory (environmen-
tal) variables. Because CANOCO uses regression to relate the variation in the
species data to the values of environmental variables,+ you canuse the concepts
of ‘influence’ or ‘leverage’ to identify outlying observations in your data sets.
These observations correspond to sampleswithunusual values of environmen-
tal variables and/or covariables. In this example the output flagged sample 8 as
unusual for the environmental variable 9 (i.e. the variable Slope ). If you check
the file with environmental data, you can see that in sample 8, the variable 9
has a value of 1, the smallest value found in the data set and the second small-
est value is3, not2, so this quadrat on aflat part of the otherwise inclined study
area differs quite a lot from the other ones.
Yet, after comparing the value with the lab protocols, it was concluded that

this is a correct value. In many other real-world situations such an indication
can, in fact, correspond to a typing error in the spreadsheet, where the decimal
point was incorrectly shifted right or left from its true position (such as
entering value 21 instead of 2.1). Therefore, it is worthwhile to check all the
indicated cases before proceeding with the analysis. The other two ‘spotted’
outlying values are for the two variables describing forest cover and forest
density in quadrat 14. Again, this quadrat is really different from the other
ones, as it is the only onewithout any forest cover (i.e. onlywith the sub-alpine
pastures).
Most interesting is the Summary table at the end of the CANOCO output.

Total

Axes 1 2 3 4 variance

Eigenvalues : 0.207 0.132 0.094 0.074 1.000

Species-environment correlations : 0.886 0.778 0.675 0.603

Cumulative percentage variance

of species data : 20.7 33.9 43.3 50.8

of species-environment relation: 36.8 54.8 64.5 70.6

Sum of all eigenvalues 1.000

Sum of all canonical eigenvalues 0.442

You can see from this that the first two PCA axes (principal components)
explain 33.9% (0.207 + 0.132) of the variability in species data. You can
see that the amount of variability explained by individual axes decreases
gradually, so you must face the difficult problem of how many ordination

+ As part of the ordination space calculation in the case of direct gradient analysis and as a post hoc
interpretation in the case of indirect gradient analysis, see Sections 3.5 and 3.6 for further details.
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axes to present and interpret. One approach is to select all the ordination
axes explaining more than the average variability explained per axis. This
threshold value can be obtained by dividing the total variability (which is
set to 1.0 in linear ordination methods in CANOCO) by the total number
of axes. In our linear unconstrained analysis, the total number of axes is
equal to the smaller value of the number of species and of the number
of samples decreased by one, i.e. min (37, 43 − 1) = 37. This means that
using this approach we would need to display and interpret all the prin-
cipal components with eigenvalues larger than 0.0270, therefore not only
the first four principal components, but possibly more. The results from
this approach probably overestimate the number of interpretable ordination
axes. Alternatively, the so-called broken-stick model is used (see Legendre &
Legendre1998, p.409, foradditionaldetails).Usingthisapproach,wecompare
the relative amount of the total variability explained by the individual axes,
with the relative lengths of the samenumber of pieces intowhich a stickwith a
unit lengthwould separate when selecting the breaking points randomly. The
predicted relative length for the jth axis is equal to:

E (length j ) = 1
N

N∑

x= j

1
x

whereN is the total number of axes (pieces).
For the number of axes equal to 37, the broken-stickmodel predicts the val-

ues 0.1136, 0.0865, 0.0730 and 0.0640 for the first four principal components.
Again, this implies that the fractions of variability explained by the four axes
exceed values predicted by the null model and that all the axes describe non-
random, interpretable variation in the species data. See Jackson (1993) for an
additional discussion of selecting the number of interpretable axes in indirect
ordinationmethods. For simplicity, wewill limit our attention here to just the
first two (most important) principal components.
The decision about the number of interpretable ordination axes is some-

what simpler for the constrained ordinations, where we can test the signifi-
cance of all individual constrained (canonical) axes. Note that the distinction
between the uncertainty in selecting an interpretable number of uncon-
strained axes and the much more clear-cut solution for the constrained
axes stems from the semantic limitations of the word interpretable. In an
unconstrained analysis, we do not provide a specific criterion to measure
‘interpretability’, while in the constrained one we look for interpretability in
relation to the values of selected explanatory variables.
From the Summary table, you can also see that if you used the environmen-

tal variables to explain the variability in bird community composition, you
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Figure 11-2. Species–environment biplot diagram from the PCAwith
environmental variables passively projected into the resulting ordination space.

would be able to explain up to 44.2% of the total variability. Note, however,
that you are performing an indirect analysis, where the environmental
variables are post hoc projected into the already determined ordination space.
The results of this analysis are best presented by a species–environmental

variable biplot. The four dummy variables are displayed as centroids and the
reader is advised to consult Chapter10 formore information about visualizing
the effects of categorical variables.
To create the biplot diagram shown in Figure 11-2, you must click the

CanoDraw button and in the CanoDraw for Windows program (which was
started by CANOCO) confirm saving a CanoDraw project file (pca.cdw) con-
taining the information for creating diagrams for this project. To create the
biplot, first specify the nominal variables Rocks, NoRocks, Warm and Cold (us-
ing the Project>Nominal variables>Environmental variables command), and then
select Create > Simple ordination plot > Species and environmental variables. There
are toomany species arrows and labels in the resulting diagram, so you should
display only the bird species, which are well characterized by the first two
principal components. To do so, use the Project > Settings command and in the



11.4. Direct gradient analysis: effect of altitude 177

Inclusion Rules page specify the value 15 in the From field of the Species Fit Range
area, and close the dialog with theOK button. Then apply the new rule to your
graph using the Create>Recreate graphmenu command.
Thefirst principal component is correlatedmainlywith altitude (increasing

from the left to the right side of the diagram) andwith the relative importance
of broad-leaved trees in the tree layer (increasing in the opposite direction).
Species such as Turdus torquatus or Cuculus canorus or Anthus trivialis tend to have
larger abundance (or higher probability of occurrence) at higher altitude (their
arrows point in similar directions as the arrows forAltit), and also in the spruce
forest (their arrows point in opposite direction to the BrLeaf arrow). The sec-
ond ordination axis is more correlated with the cover of the herb layer (E1),
the height of the herb layer ( E1Height), average forest density (ForDens), and
the average cover of the shrub layer (E2). The ForDens versus the other
descriptors have their values negatively correlated (because their arrows point
in opposite directions).
The pairs of triangle symbols of the related dummy variables (Rocks and

NoRocks orCold andWarm) are not distributed symmetricallywith respect to the
coordinateorigin.This isbecause their frequency indata isnotbalanced; forex-
ample, the samples that have rocks present (and therefore have value1 forRocks
and 0 forNo Rocks) are less frequent, so the corresponding symbol for Rocks lies
further from the origin.

11.4. Direct gradient analysis: effect of altitude

There are several questions you can address with data sets concern-
ing the relationship between explanatory variables and species composition.
This tutorial is restricted only to detection of the extent of differences in
composition of bird assemblages explainable by the quadrat average altitude
(this section), and to studying the effects the other environmental variables
have in addition to the altitudinal gradient (see the next section). To quantify
the effect of altitude upon the bird community, youwill performa redundancy
analysis (RDA), using Altit as the only environmental variable.

1. Start by saving the original CANOCO project with PCA under a new

name: rda1.con is suggested.
2. Now youmustmake a few changes in the project setup. You invoke the

project setupwizard, as in the previous section, by theOptions . . . button.
On the first wizard page, change the option at the bottom from indirect
gradient analysis to direct gradient analysis. On the next page, change the
name of the file containing the CANOCO results (rda1.sol). You can see on
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the followingwizard page ( Type of Analysis) that themethodwas changed

from PCA to RDA because of changes on the first page.
3. You do not need tomake any changes on the following pages, up to the

Data Editing Choices page. There, you should check the box for deletion of
environmental variables. After you click theNext button, another page
with the titleDelete Environmental Variables appears. Here you select the
variables 2 to 13 (all the variables except Altit) and transfer them to the

right list using the>> button.

4. The next wizard page allows you to specify whether and in what way you

want to select the retained environmental variables. Because we have only

one environmental variable left, it does notmake sense to subset it any

further. Therefore, theDo not use forward selection option should remain

selected.

5. The next page is the first one concerningMonte Carlo permutation tests

and here you decide whether to perform the tests at all andwhat kind of

test to use. You have only one explanatory variable, so there will be only

one constrained (canonical) axis in this redundancy analysis. Therefore,

CANOCOwill produce the same results whether you choose the

Significance of first ordination axis or the Significance of all canonical axes
option. So select the test of the first ordination axis and in the right half

of the page keep the value 499 as the number of permutations. On the

next page, you selectUnrestricted permutations and close the setupwizard
on the following page using the Finish button.

6. After running the analysis, the resulting summary table appears in the

Log View:
Total

Axes 1 2 3 4 variance

Eigenvalues : 0.115 0.152 0.118 0.075 1.000

Species-environment correlations: 0.792 0.000 0.000 0.000

Cumulative percentage variance

of species data : 11.5 26.7 38.5 46.0

of species-environment relation : 100.0 0.0 0.0 0.0

Sum of all eigenvalues 1.000

Sum of all canonical eigenvalues 0.115

The canonical axis (axis 1) explains 11.5% of the total variability in the

species data and you can see that the first two of the following

unconstrained axes explain individuallymore variability than the

canonical axis (15.2% for axis 2, and 11.8% for axis 3). Nevertheless, the

explanatory effect of the Altitude is significant.
This is confirmed by the report about the performed significance

(Monte Carlo permutation) test, which follows the Summary

table:
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Figure 11-3. Species–environment biplot fromRDA summarizing differences in
bird assemblages along the altitudinal gradient.

**** Summary of Monte Carlo test ****

Test of significance of all canonical axes : Trace = 0.115

F-ratio = 5.323

P-value = 0.0020

( 499 permutations under reduced model)

Note that the reported significance level estimate (P = 0.0020) is the
lowest achievable value given the number of permutations you used

[(0 + 1)/(499 + 1)]. Thismeans that none of the 499 ordinations based on

the permuted data sets achieved as good a result as the ‘true’ one.

7. You can again summarize the results of this constrained analysis using

the species–environment variable biplot (as shown in Figure 11-3). To do

so, youmust create a new CanoDraw project specific for this analysis (see

previous section for summary of steps to be taken). Note that the diagram

has ‘mixed contents’: the first (horizontal) axis is constrained,

representing the variation in bird abundances explainable by the quadrat

altitude, while the second (vertical) ordination axis is already

unconstrained, representing the residual variation that is not explained

by the Altit variable. It is, therefore, advisable to display in this biplot
diagram only the species that have their abundances well explained by

the first ordination axis, i.e. by the altitude.

Such species can be selected as specieswell fitted by the sample scores on the
first ordination axis (see Section 5.3 for additional details about interpretation
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of PCA/RDA axes as regression predictors). Because the first RDA axis explains
approximately 11% of the variability in species data, you can say that a species
with an average ‘explainability’ by the first ordination axis will have at least
11%of thevariability in itsvaluesexplainedbythataxis.Youcanset this thresh-
old in the CanoDraw program using the dialog box invoked by the Project >

Settings menu command, using the Inclusion Rules page. Note that you must
use the Species field in the Lower Axis Minimum Fit, because only the horizon-
tal (‘lower’) axis is involved here. Note that only seven bird species pass this
criterion.

11.5. Direct gradient analysis: additional effect of other habitat
characteristics

We will conclude this case study with a more advanced partial con-
strained ordination, which helps to address the following question:

Can we detect any significant effects of the other measured habitat
descriptors upon the bird community composition, when we have
already removed the compositional variability explained by the
average quadrat altitude?

This question can be addressed using a redundancy analysis where the Altit
variable is used as a covariable, while the other descriptors are used as the
environmental variables.

1. Start your analysis again by ‘cloning’ the previous one, saving the rda1.con
project under the name rda2.con. Then, invoke the project setupwizard
and start by changing the project settings on the first page. You should

use covariables this time, so youmust change the selection from the

second to the third option in the upper part of this page. In the next page,

you now have the third field enabled and you can copy there the contents

of the second field, because youwill use the same file for both the

environmental variables and the covariables. You should also change the

name of the solution file here (to rda2.sol).
2. Keep the choices on the followingwizard pages up to the pageData

Editing Choices. Here, you can see that setupwizard has automatically

checked the deletion of covariables, because it is obvious that you need to

differentiate the two sets of explanatory variables. After clicking theNext
button, youmust change the list of environmental variables to be deleted,

actually swapping the contents of the two lists. You need to delete only
variable 1 and not variables 2–13. On the next page (titledDelete
covariables), you should delete variables 2–13 from the set of covariables
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and keep only the Altit variable there. Then leave theDo not use forward
selection option selected in the next page.

3. On the next wizard page, select Significance of canonical axes together, as you
cannot a priori expect that one constrained axis is sufficient to describe the
influence of the 12 environmental variables on the bird communities. On

the next page, keep the optionUnrestricted permutations selected, and do
not check the option Blocks defined by covariables (our covariable is a
quantitative descriptor and CANOCOwould create a separate block for

each unique altitude value). Finally, close the project setupwizard on the

following page.

4. After the analysis, the resulting Summary table is displayed (with the

other CANOCO output) in the Log View:

**** Summary ****

Total

Axes 1 2 3 4 variance

Eigenvalues : 0.112 0.067 0.042 0.034 1.000

Species-environment correlations : 0.886 0.810 0.818 0.765

Cumulative percentage variance

of species data : 12.6 20.3 25.0 28.8

of species-environment relation: 34.2 54.7 67.4 77.8

Sum of all eigenvalues 0.885

Sum of all canonical eigenvalues 0.328

You can see that the amount of variability explained by the other

habitat descriptors (in addition to the information provided by the

quadrat altitude) is quite high (32.8% of the total variability in the bird

counts data) compared with the variability explained by the altitude

(11.5%, seen also from this Summary table, as the Total variance− Sum of all
eigenvalues = 1.000 − 0.885). But you should realize that the current
ordinationmodel is muchmore complex (withDF = 10, given that
variable 11 is linearly dependent on variable 10 and, similarly, variable 13

is linearly dependent on variable 12).

5. The Summary table for this analysis is followed by the report on the

Monte Carlo permutation test. From it, you can see that the additional

contribution of the 12 descriptors is highly statistically significant

(P = 0.0020).
The species–environment biplot diagram summarizing the additional

effects of the other habitat characteristics, when the altitude effects are

already accounted for, is shown in Figure 11-4. Similar to the graph

in the preceding section, only the ‘well-fitting’ species are

included.
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Figure 11-4. Species–environment biplot diagram summarizing the effects of
habitat descriptors upon bird communities, after removing the altitudinal
gradient.

We can see that the current first axis partly reflects the difference

between the beech-dominated stands (on the right side) and the spruce

forest (on the left side) and also the differences in the development of the

herb layer (more developed in the sites on the right side of the ordination

diagram). The second ordination axis correlates (negatively) with the

total cover of the forest in the quadrat and, to a lesser extent, with average

forest density.
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Case study 2: Search for community
composition patterns and their
environmental correlates: vegetation of
springmeadows

In this case study, we will demonstrate a common application of
multivariateanalysis: the search forapattern inasetofvegetationsampleswith
availablemeasurements of environmental variables. The species data comprise
classical vegetation relevés (records of all vascular plants and bryophytes, with
estimates of their abundance using the Braun–Blanquet scale) in spring fen
meadows in thewesternmostCarpathianmountain ranges. Thedata represent
an ordinal transformation of the Braun–Blanquet scale, i.e. the r ,+, and 1 to 5
values of the Braun–Blanquet scale are replaced by values 1 to 7.∗ The relevés
are complemented with environmental data – chemical analyses of the spring
water, soil organic carbon content and slope of the locality. The ion concentra-
tions represent their molarity: note that the environmental data are standard-
ized in all CANOCOprocedures and, consequently, the choice of units does not
play any role (as long as the various units are linearly related).+ The data are
courtesy of Michal Hájek and their analysis is presented in Hájek et al. (2002).
The aimof this case study is todescribe basic vegetationpatterns and their rela-
tionshipwith available environmental data, mainly to the chemical properties
of the spring water.
The data are stored in the file meadows.xls, where one sheet represents the

species data, and theother one the environmental data (in comparisonwith the
original, the data are slightly simplified). The datawere imported to CANOCO

∗ Note that the scale is not linear with respect to species cover and roughly corresponds to logarithmic
transformation of cover, see Section 1.8.

+ The environmental variables are not transformed, but the ion concentrations, which are always
non-negative and often have a skew distribution, are log-transformed in such cases.

183
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format, using the WCanoImp program. Two files were created, meadows.spe
and meadows.env. Note that in the Excel file, the species data are transposed
(i.e. species as rows, samples as columns). This will often be the case in sim-
ilar broad-scale surveys, because the number of species is usually higher than
thenumber of columns in ordinary spreadsheets. If both thenumber of species
and the number of samples exceed themaximumnumber of columns, you can
use either the CanoMerge program (see Section 4.1), or you must use some of
the specializedprograms for storing largedatabases, to create thedatafilewith
a CANOCO format (the data presented here were extracted from a database
in the TURBOVEG program; Hennekens & Schaminee 2001). In fact, the ana-
lysed data set (70 samples, 285 species) is rather small in the context of recent
phytosociological surveys.

12.1. The unconstrained ordination

In the first step, you will calculate an unconstrained ordination – the
detrended correspondence analysis (DCA). No data transformation is needed,
because the ordinal transformation has a logarithmic nature with respect to
cover and provides reasonable weighting of species dominance. In DCA with
detrending by segments and Hill’s scaling, the length of the longest axis pro-
vides an estimate of the beta diversity in the data set (the value 3.9 for our data
set suggests that the use of unimodal ordinationmethods is quite appropriate
here). Theunconstrained ordinationprovides the basic overviewof the compo-
sitional gradients in thedata. It is alsouseful to include the environmentaldata
in the analysis – theywill not influence the species and samples ordination, but
they will be projected afterwards to the ordination diagram.
Let’s first inspect the summary in the log file:

Axes 1 2 3 4 Total inertia

Eigenvalues : 0.536 0.186 0.139 0.118 5.311

Lengths of gradient : 3.945 2.275 2.049 2.015

Species-environment correlations: 0.898 0.409 0.531 0.632

Cumulative percentage variance

of species data : 10.1 13.6 16.2 18.4

of species-environment relation: 26.4 28.4 0.0 0.0

Sum of all eigenvalues 5.311

Sum of all canonical eigenvalues 1.560

You can see that the first gradient is by far the longest one, explaining about
10% of the total species variability (which is a lot, given the number of species
in these data), whereas the second and higher axes explain much less. Also,



12.1. The unconstrained ordination 185

-0.60 0.40

-0
.1

0
0.

15

Ca
Mg

Fe
K

Na

Si

SO4 PO4

NO3

NH3Cl

Corg
pH

conduct
slope

-1.0 5.0

-0
.5

3.
0

AulaPalu

BryumPse

CallCusp

CampStel

ClimDend

CratoCom

PlagElat AgroCani

AnthOdor

BrizMedi

CarxEchi

CarxFlac

CarxFlav

CarxNigr
CarxPani

CirsRivu

DactMaja

EpipPalu

EquiPalu

ErioAngu

ErioLati

FestRubr

JuncArti

LysiVulg

PoteErec

RanuAcri

ValeSimp

Figure 12-1. The species–samples (triangles and circles, respectively) biplot of the
DCA of the whole data set in the lower diagram (only species with the highest
weight are shown), and retrospective projection of the environmental variables in
the upper diagram.

the first axis is very well correlated with the environmental data (r = 0.898),
and the correlation for the other axes is considerably lower. All this suggests
that the whole data set is governed by a single dominant gradient. The sum of
all canonical eigenvalues in the printout corresponds to the sum of all canon-
ical eigenvalues in the corresponding canonical analysis (i.e. it says howmuch
could be explained by the environmental variables if theywere used in similar,
but constrained, analysis).Thepercentagevarianceof the species–environment
relationship values represents percentages of this value. The number of axis
scores calculated for a species–environmental variable biplot is restricted in
a DCA, by default, to two. This is why the explained variability for the third
and fourth axis is shown as 0.
Let us now create an ordination diagram. We suggest that you present the

results in the formshown inFigure12-1, i.e. a separate species–samples biplot,
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with an added plot of fitted environmental variables. It is not possible to
include all the 285 species in the ordination diagramwithout total loss of clar-
ity. In theDCA, theonlypossibility is to select species according to theirweight,
i.e. according to their sum over all the samples.∗ Consequently, only one-tenth
of the total number of species is shown. Although this is probably the most
feasible way to show the diagram in a publication, one should be aware that
there is a substantial loss of information. You can accommodate more species
in such a plot by not plotting the sample symbols (or plotting them in a sepa-
rate scatterplot). Still, youwill be able to plot only aminority of all the species.
We recommend inspecting the CANOCO solution (.sol ) file, to get information
onmore species. The other possibility is to create several scatterplots of species
of varying frequency (in CanoDraw, the Project > Settings > Inclusion rules page
enables you tofirst select the specieswithweighthigher than30%, then species
with weight in the 25% to 30% interval, etc.). Journal editors will probably not
allow you to include all the plots in your paper, but you can learn about the
speciesbehaviour fromthoseplots.Anotherpossibility for thisdata set is toput
the bryophyte species into one plot, and the vascular plants into another one.
The samples are shown here without labels. Inspection of their general dis-

tribution suggests that there is a continuous variation of species composition
in the whole data set and that we are not, therefore, able to find distinct vege-
tation types in the data set. The projection of environmental variables reveals
that thefirst axis is negatively correlatedwith the pHgradient,with conductiv-
ity (conduct), and with the increasing concentration of cations (Ca,Mg and also
Na), andpositively correlatedwith soil organic carbon (Corg). Thepositionof in-
dividual species supports this interpretation – with Carex flacca, or Cratoneuron
commutatum being typical for the calcium-rich spring fens, and Aulacomnium
palustre, Carex echinata and Agrostis canina for the acidic ones. The relationships
of the species to the pH gradient are generally well known, and probably any
field botanist with basic knowledge of local flora would identify the first axis
with the pH gradient, even without any measured chemical characteristics.†

The second axis is more difficult to interpret, as there are several variables
weakly correlated with it.
The positions of arrows for environmental variables suggest that there is

a group of variables that are mutually highly positively correlated ( pH, Ca,

∗ Fit of species, which is another statistic useful for their selection into the ordination diagram, is not
available for analyses with detrending by segments. You can, therefore, consider detrending by
polynomials or a non-detrended analysis, and eventually define a group of well-fitting species there
and import it into this DCA project.

† The situationmight be rather different with other types of organisms, or in less known areas where
such intimate knowledge of individual species ecology is not available.
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Mg, Na, conductivity), and negatively correlated with organic carbon (Corg).
However, you should recall that the diagram with environmental variables
is based purely on their effect on species composition. A closer inspection
of the correlation matrix in the CANOCO Log View shows that the variables
are indeed correlated, but in some cases the correlation is not very great
(particularly the negative correlation with organic carbon). The correlation
matrix also confirms that the correlation of all the measured variables with
the second axis is rather weak.

12.2. Constrained ordinations

Now you can continue with the direct (constrained) ordinations.
Whereas in DCA you first extract the axes of maximum variation in species
composition, and only then fit the environmental variables, now you directly
extract the variation that is explainable by the measured environmental vari-
ables. You will start with a canonical correspondence analysis (CCA) using all
the available environmental variables. In the Global Permutation Test page of
the setup wizard, specify that both types of permutation tests are performed.
Both the test on thefirst axis and the test onall axes (on the trace) arehighly sig-
nificant (P = 0.002 with 499 permutations, which is the maximum under the
given number of permutations). However, the F value is much higher for the
test on the first axis (F = 4.801) than for the test on the trace (F = 1.497). This
pattern also appears in the Summary table, where the first axis explains more
than the second, third and fourth axes do together.

Total

Axes 1 2 3 4 inertia

Eigenvalues : 0.434 0.172 0.120 0.101 5.311

Species-environment correlations : 0.921 0.831 0.881 0.880

Cumulative percentage variance

of species data : 8.2 11.4 13.7 15.6

of species-environment relation : 27.8 38.9 46.6 53.1

Sum of all eigenvalues 5.311

Sum of all canonical eigenvalues 1.560

Youcancompare this summarywith that fromtheDCAyouusedbefore.You
will notice that the percentage variance explained by the first axis is very close
to that explained by the first axis in the unconstrainedDCA (8.2 in comparison
with 10.1), and also that the species–environment correlation is only slightly
higher. This suggests that the measured environmental variables are those
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responsible for species composition variation. And indeed, in the ordination
diagrams of DCA (Figure 12-1) and CCA (not shown here), the first axis of CCA
is very similar (both for the species and for the sample scores) to the first axis of
DCA.However, the secondaxesdiffer: theCCAshowsa remarkable archeffect–

the quadratic dependence of the second axis on the first one. Rather than try-
ing the detrended form of CCA (i.e. DCCA), we suggest that the arch effect is
caused by a redundancy in the set of explanatory variables (many highly corre-
latedvariables), and thatyoushould try to reduce theirnumberusinga forward
selection of environmental variables.
Before using the forward selection, it might be interesting to know

whether the second axis is worth interpreting, i.e. whether it is statistically
significant. To test its statistical significance, calculate the partial CCA with
the environmental variables identical to those in the first CCA, and the sample
scores (SamE, i.e. those calculated as linear combinations of the values of mea-
sured environmental variables) on the first axis used as the only covariable (see
Section 9.1 for additional details). In this analysis, the variability explained by
the original first axis is partialled out by the covariable, and the original second
axis becomes the first one in this analysis, the third axis becomes the second
one, etc. By testing the significance of the first axis in this analysis, you test, in
fact, the second axis of the original analysis.
How do you prepare the file with the covariable? The easiest way is to

open the solution file as a spreadsheet (e.g. in Excel) and copy the appropriate
kind of sample scores to the Windows Clipboard. Be sure that you are using
the SamE scores – they are at the end of the solution file. The copied scores
must be in one column. Then, you will use the WCanoImp program to create
a CANOCO-format data file.
It is worthwhile checking that the axes correspond to the original analysis

(i.e. that the original second axis is now the first axis, etc.). Indeed, the results
exactly correspond to the original analysis:

Total

Axes inertia

Eigenvalues : 0.172 0.120 0.101 0.096 5.311

Species-environment correlations : 0.831 0.881 0.880 0.911

Cumulative percentage variance

of species data : 3.5 6.0 8.1 10.0

of species-environment relation: 15.3 26.0 35.0 43.5

Sum of all eigenvalues 4.877

Sum of all canonical eigenvalues 1.126
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Table 12-1.Marginal and conditional effects obtained from the summary of forward
selection

Marginal effects Conditional effects

Lambda
Variable Var.N Lambda1 Variable Var.N A P F

Ca 1 0.35 Ca 1 0.35 0.002 4.79
Conduct 14 0.32 Conduct 14 0.13 0.002 1.79
Mg 2 0.30 Corg 12 0.11 0.002 1.60
pH 13 0.24 Na 5 0.12 0.002 1.58
Corg 12 0.24 NH3 10 0.10 0.020 1.45
Na 5 0.18 Fe 3 0.09 0.018 1.34
NH3 10 0.15 Cl 11 0.10 0.082 1.39
Si 6 0.12 pH 13 0.08 0.056 1.25
SO4 7 0.12 Si 6 0.08 0.126 1.17
K 4 0.12 Mg 2 0.08 0.188 1.11
Fe 3 0.10 NO3 9 0.08 0.332 1.07
Cl 11 0.10 SO4 7 0.06 0.488 0.99
Slope 15 0.10 K 4 0.06 0.842 0.86
NO3 9 0.09 PO4 8 0.06 0.812 0.85
PO4 8 0.08 Slope 15 0.06 0.814 0.83

The test of the first axis is significant (F = 1.979, P = 0.018). This shows
that the original first axis, despite being clearly dominant, is not sufficient to
explain the species–environment relationships in the data. In a similar man-
ner, we could continue with testing the third and higher axes; but the third
axis is not significant for this project.
You now know that there is a close correlation between environmen-

tal variables and species composition. You will use the forward selection to
build a simpler model (with fewer explanatory variables), but one that still
sufficiently explains the species composition patterns. First, it is useful to
inspect the marginal effects of all environmental variables (i.e. the indepen-
dent effect of each environmental variable). They can be easily obtained in
CANOCO by asking for automatic forward selection, with the best k equal
to the number of variables. You should ask for the Monte Carlo tests dur-
ing the automatic forward selection, and you will also see the sequence of
the forward selection steps, together with corresponding conditional effects
(i.e. the effect that each variable brings in addition to all the variables
already selected). Both tables can be obtained by using the ‘FS-summary’ but-
ton in the Project View in Canoco for Windows. The results are shown in
Table 12-1.
From the table with marginal effects, you can see that the calcium (Ca)

concentration is the most important factor for species composition, followed
by the conductivity, Mg concentration and pH. All these variables are closely
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correlated, as expected from their causal relationships – conductivity is in
fact a measure of dissolved ions, and similarly pH is a function of the dis-
solved ion concentration. It is, consequently, not surprising that, after the Ca
variable is selected, the conditional effects of conductivity, pHandMgdecrease
dramatically. In fact, only the conductivity qualifies for the final model when
the 0.05 probability threshold level for entry of a variable is adopted. Finally,
the following variables are included in the model: Ca, conductivity, organic
carbon (Corg), Na, NH3 and Fe. The last two variables have relatively small
marginal effects. However, they are independent of the other variables (note
their low inflation factors in theLogView) and, because theyprobably affect the
species composition, they add an explanatory power to the previously selected
variables. You should note that the final selection tells you, in fact, that this
is a sufficient set of predictors, and that further addition of variables does not
significantly improve the fit. You should be extremely careful when trying to
interpret the identified effects as the real causal relationships (e.g. by conclud-
ing that the effect ofMg isnegligiblebecause it isnot included in thefinal selec-
tion). If variables in a group are closely correlated, then only a limited number
of them is selected. It is often simply a matter of chance which of them is best
correlated.After thebest variable is selected, the conditional effects of variables
correlated with it drop, sometimes dramatically. Even if they are functionally
linkedwith the response (i.e. community composition), the test is ratherweak.
Also, the results of selection sometimes change with even a relatively minor
change in the set of predictors from which we select the final model. How-
ever, this is a general problemof all observational studieswithmany correlated
predictors.
The ordination diagram (Figure 12-2) reveals the same dominant gradient

that was found in the previous analyses. However, the arch effect is less pro-
nounced (without theuseofdetrending).Also, the effects of individual selected
predictors can be better distinguished. When plotting the diagram, you can
select the species either according to their weight or according to their fit to
axes. But you should usually combine bothmethods – the specieswith highest
weights are useful for comparison with the DCA, whereas the species with the
highest fit are often ecologicallymore interesting. (Here, only the species with
highestweight are shown inFigure12-2, to enable comparisonwith the results
of DCA in Figure 12-1.)
The diagram in Figure 12-2 shows the possible danger in selecting species

according to the highest weight.X Potentilla erecta, Festuca rubra, Carex nigra,

X But similar problems can occur evenwhen you combine fit andweight as selection criteria, because the
species have to pass both limits to be included in the graph.
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Figure 12-2. The species–environmental variables biplot of CCAwith
environmental variables selected by the forward selection procedure. The species
with the highest weight are shown.

Anthoxanthum odoratum and Carex echinata are suggested asmost typical species
for stands with a high soil carbon content; in fact, they are not very typical of
such habitats. Because the acidic habitats were rare in comparison with the
calcium-rich stands, their typical species were present in few samples, and
consequently they did not have sufficient weight in the analysis. The selection
according to the fit would display Sphagnum species to be typical for acidic bog
habitats.
Now we can also inspect some synthetic community characteristics. In

Figure 12-3, the size of the symbols corresponds to the species richness in
individual samples.
To obtain this graph, select the Create > Attribute Plots > Data Attribute

Plots command. In the Attribute Plot Options dialog, click in the Select vari-
able to plot window on Species > Sample Stats > Number of species, and in the
right side of the dialog select Labeling: No labels, Visualization method: Symbol,
and Additional content: Environmental variables. You can see in the resulting
diagram that the traditional wisdom of higher species diversity in calcium-
rich habitats does not apply to this data set. When working with the number
of species, one should be sure that the size of the sample plots was con-
stant. In our case (as in other similar phytosociological surveys), the plot size
changes slightly between samples. However, the noise that can be caused
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Figure 12-3. The sample–environmental variables biplot with symbol size
corresponding to the number of species in the sample.

by variability in plot size is small relative to richness differences in the
data.

12.3. Classification

Another insight for this data set canbe obtained from its classification.
The TWINSPAN results are presented here as an example (Figure 12-4). The
TWINSPAN was run with the default options (see Section 7.4), and the pseu-
dospecies cut levelswere 0, 2, 4 and 6.Wewill present the results only up to the
seconddivision (i.e. classificationwith four groups), although thereweremore
divisions in the program output.
There are several possibilities as to how to use the environmental variables

when interpreting classification (TWINSPAN) results. You can run, at each
division, a stepwise discriminant analysis for the two groups defined by
the division∗; in this way, you will get a selection of environmental vari-
ables and a discriminant function, constructed as a linear combination of the
selected environmental variables. The other possibility is to inspect, for each
division,which environmental variables show thegreatest differences between
the groups (e.g. based on ordinary t-tests of all the variables; in such a heuris-
tic procedure, you need not be too scrupulous about the normality). The envi-
ronmental variables selected by the stepwise procedure will often not be those
with the largest differences between the groups, because the stepwise selec-
tion is based on the largest conditional effects in each step, which means that

∗ The DISCRIM program doing exactly that is described in Jongman et al. (1987) and is available from
theMicrocomputer Power Co., USA, http://www.microcomputerpower.com
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Figure 12-4. The results of the TWINSPAN classification. Each division is
accompanied by the indicator species. More explanations are given in the
text.

the predictors correlated with variables already selected are excluded. Both
approaches, however, provide information that is potentially interesting. You
can also compare the environmental values among the final groups only (as in
Figure 12-5). But in this case, youwill not obtain information about the impor-
tance of individual variables for individual divisions. Because these procedures
involve data exploration rather than hypothesis testing, we are not concerned
here aboutmultiple testing and Bonferroni correction.
The search for a pattern is an iterative process, and is (at least in plant com-

munities) usually based on the intimate biological knowledge of the species.
Unlike hypothesis testing, at this stage the researcher uses his/her extensive
field experience (i.e. the information that is external to the data set analysed).
We have demonstrated here what can be inferred from multivariate data ana-
lyses. Further interpretationswould be based on our knowledge of the biology
of the species.

12.4. Suggestions for additional analyses

There are many other analyses that one could do during the data
exploration. Here we suggest just four interesting approaches:

1. The Ca andMg ions are usually highly correlated in nature.We can be

interested in the effect of one of themwhen the other one is kept

constant. This can be achieved with two partial analyses: each of the

variables will be a (single) environmental variable in one of the analyses

and a (single) covariable in the other one.
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Figure 12-5. Box andwhisker plots of molarity values of calcium (Ca), magnesium
(Mg), NH3 in the spring waters, and of the weight percentage of soil organic
carbon, categorized according to the four groups defined by the TWINSPAN
classification.Whiskers reach to the non-outlier extremes; outliers are shown as
points.

2. Wemight be interested in howwell correlated the species composition

gradients are in vascular plants and in bryophytes. We can calculate the

unconstrained ordination (DCA) first based on vascular plants only, and

then on the bryophyte taxa only and thenwe can compare the sample

scores on the ordination axes.

3. Wemight be interested in which of the environmental variables are the

most important ones for vascular plants, andwhich for bryophytes.We

can calculate separate constrained ordinations, and compare the

importance of individual environmental variables (for example, by

comparingmodels selected by the forward selection).

4. Further analyses are also possible with synthetic community

characteristics, such as species richness, diversity and their relation to the

environmental variables.

Wehave stressed several times that we are concentrating on a search for pat-
terns in this case study, and not on hypotheses testing. If you are interested
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in testing the hypotheses, and you have a large enough data set, you should
consider using the method suggested by Hallgren et al. (1999). They split the
data set into two parts. The first one is used for data diving, i.e. for the search
for patterns, without any restrictions (i.e. try as many tests as you want, any
‘statistical fishing’ is permitted). By this procedure, youwill generate a limited
number of hypotheses that are supported by the first part of the data set. Those
hypotheses are then formally testedusing the secondpart of thedata set,which
was not used in the hypothesis generation. See Hallgren et al. (1999) for the
details.
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Case study 3: Separating the effects
of explanatory variables

13.1. Introduction

In many cases, the effects of several explanatory variables need to be
separated, even when the explanatory variables are correlated. The example
below comes from a field fertilization experiment (Pyšek and Lepš 1991). A
barleyfieldwas fertilizedwith threenitrogen fertilizers (ammoniumsulphate,
calcium-ammonium nitrate and liquid urea) and two different total nitrogen
doses. For practical reasons, the experiment was not established in a correct
experimental design; i.e. plots are pseudo-replications. The experiment was
designed by hydrologists to assess nutrient runoff and, consequently, smaller
plots were not practical.* In 122 plots, the species composition of weeds was
characterized by classical Braun–Blanquet relevés (for the calculations, the
ordinal transformation was used, i.e. numbers 1–7were used for grades of the
Braun-Blanquet scale: r, +, 1, . . . . ,5). The percentage cover of barley was esti-
mated in all relevés.
Theauthors expected theweedcommunity tobe influencedbothdirectlyby

fertilizers and indirectly through the effect of crop competition. Based on the
experimentalmanipulations, the overall fertilizer effect can be assessed. How-
ever, barley cover is highly correlatedwith fertilizer dose. As the cover of barley
was not manipulated, there is no direct evidence of the effect of barley cover
on theweed assemblages. However, the data enable us to partially separate the
direct effects of fertilization from indirect effects of barley competition. This
is done in a similar way to the separation of the effects of correlated predictors
on the univariate response in multiple regression. The separation can be done
using the variable of interest as an explanatory (environmental) variable and
the other ones as covariables.

* We ignore this drawback in the following text.

196
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Table 13-1.The results of ANOVA on the complete regressionmodel
(calculated in the Statistica program)
Analysis of Variance; DV: NSP (fertenv.sta)

Sums of Mean
Squares DF Squares F p-level

Regress. 382.9215 2 191.4607 57.7362 2.98E-18

Residual 394.6195 119 3.31613

Total 777.541

13.2. Data

In this case study, you will work with simplified data, ignoring fertil-
izer type, and taking into account only the total fertilizer dose. Data are in the
files fertil.spe (relevés) and fertil.env (fertilizer dose and barley cover) and also in
the Excel file fertil.xls (so that you can try creating your own files for CANOCO
using the WCanoImp utility). The dose of the fertilizer is 0 for unfertilized
plots, 1 for 70 kg of N/ha, and 2 for 140 kg N/ha. The Fertenv worksheet also
contains the number of species in each relevé. These data were also imported
into the Statistica format ( fertenv.sta). You will first do a univariate analysis of
species numbers and then the corresponding analysis of species composition.

13.3. Data analysis

Theunivariate analysiswill be demonstratedfirst.Wehave twopredic-
tors (explanatory, or ‘independent’ variables), cover and dose, and one response,
number of species.+ You will use multiple regression. In multiple regression,
two tests are carried out. First, the complete model is tested by an analysis of
variance. The null hypothesis states: the response is independent of all the
predictors. The test results are in Table 13-1.
The null hypothesis was clearly rejected, and you can see that the regres-

sion sum of squares is roughly half of the total sum of squares (consequently,
R 2 = 0.5), which means that this model explains half of the variability in the
number of species. However, you still do not know which of the two explana-
toryvariables ismore important.This canbeseen fromtheregressionsummary
(Table 13-2).
The results show that the number of weed species decreases with both cover

and dose, that the direct effect of cover is much more important, and also that

+ This is also a simplification: one of the independent variables, cover, is dependent on the dose and
consequently the use of path analysis might be a feasible solution here (see Legendre & Legendre 1998,
p. 546). Nevertheless, from the point of view of the weed community, dose and cover can be considered
as two correlated predictors.
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Table 13-2.Themultiple regression summary, as calculated by the Statistica program
Regression Summary for Dependent Variable: NSP (fertenv.sta)

R = .70176746 R2 = .49247757 Adjusted R2 = .48394778

F(2,119) = 57.736 p<.00000 Std.Error of estimate: 1.8210

St. Err. St. Err.
BETA of BETA B of B t(119) p-level

Intercpt 9.423662 0.388684 24.24506 0

DOSE −0.02342 0.099678 −0.08501 0.361781 −0.23498 0.814629

COVER −0.68390 0.099678 −0.06174 0.008999 −6.86113 3.28E-10

BETAs are the standardized partial regression coefficients (in effect, they are independent of the
scale and consequently can be used to compare the importance of individual predictors), Bs are
the usual (partial) regression coefficients, ts are the t-statistics for tests of the null hypotheses Bi =
0 (corresponding p is also presented; naturally, t and p values are the same for standardized and
non-standardized coefficients).

cover is the only significant explanatory variable. If you calculate the univariate
regressions on each of the predictors separately (i.e. theirmarginal effects), you
will see that both of them are highly significant. This means that dose itself is
a good predictor for the number of species, but does not significantly improve
the fitwhen added to the predictor describing the cover of barley. On the other
hand, cover is a good predictor for the number of species and significantly
improves the fit when added to dose. We conclude that cover is sufficient to
explain the species number.
We now proceed with themultivariate analysis.$

The following steps are recommended:
First, calculate an unconstrained ordination using detrended correspon-

dence analysis (DCA). The results show the total variability by the length of the
axes, which gives a measure of the total heterogeneity in the vegetation data.
The length of the first axis in Hill’s scaling is 3.8, which is in the ‘grey zone’
where both linear and unimodalmethods should perform reasonably well.*

Second, calculate a constrained ordination with all of the environmental
variables available. The length of the gradient from the first analysis serves as
a lead for selecting between canonical correspondence analysis (CCA) and re-
dundancy analysis (RDA). Another lead should be whether one can expect the
majority of weed species to respond to fertilization and/or crop cover in a lin-
ear way or whether one can expect some (or all) species to have an optimum on
this gradient. Generally, if the species change their proportions on the gradi-
ent then the linear approximation is correct. If you expect qualitative changes

$ Note the difference: the species compositionmight change evenwhen the number of species does not;
in contrast, the test with the number of speciesmight, in some cases, be stronger than the test with
species composition. Consequently, the results might differ.

* See Section 4.3 for further details.
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in the species composition (many species appearing and disappearing) then
weighted averaging is better.
The authors of the published paper (Pyšek & Lepš 1991) used CCA. In this

example, youwill useRDA.RDAenablesuse of both the standardized andnon-
standardized analyses. Standardization by samples allows you to differentiate
between the effect upon the total cover and upon the species composition. Use
RDA (with the fertilizer dose and the barley cover as environmental variables) on
data not standardized by sample norm. These results will reflect both the dif-
ferences in total cover and the differences in the relative species composition.
Also use RDA on data standardized by the sample normwhere the results will
reflect only the differences in relative representations of particular species.+ In
this case, the results of analyseswith speciesdata standardizedby samplenorm
ornon-standardizedwere rather similar (andwere also similar to the output of
CCA#).Only results of thenon-standardizedRDAwill be shown in this tutorial.
For the third step, test the significance by a Monte Carlo permutation test,

using unconstrained permutations. This is a test of the H0: there is no effect
of the environmental variables on species representation, i.e. the effect
of both variables is zero. Because the analysis does not standardize the species
values, even a proportional increase of all the species is considered a change in
species composition. The rejection of the null hypothesis means that at least
one of the variables has some effect on the species composition of the vegeta-
tion. The meaning of this test is analogous to an overall ANOVA of the multi-
variate regressionmodel.
Next, inspect the analysis results. The effects of environmental variables

are highly significant (P = 0.002 with 499 permutations – the highest possi-
ble with this number of permutations). The ordination diagram suggests the
relationships of the species to the explanatory variables (Figure13-1). As usual,
the species with the highest fit with the axes are selected (Project > Settings >

InclusionRules). Thediagramshows that the explanatory variables arepositively
correlated, andmost of theweed species arenegatively correlatedwithboth the
dose and cover of barley. Only Galium aparine, a species able to climb stems of
barley, is positively correlated.
There are other possibilities for displaying and exploring the results of the

analysis provided byCanoDraw. In Figure 13-2, the sample scores based on the
species data are displayed, with the size of each symbol corresponding to the
number of species in the relevé. The environmental variables are also projected

+ However, you should note that the interpretation of standardized data based on the species data values
estimated on an ordinal scalemay be problematic.

# This corresponds well to the fact that the length of the first DCA axis in turnover (SD) units indicated
that both linear and unimodalmethods would performwell.
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Figure 13-1. The ordination diagram of RDAwith non-standardized data, with two
explanatory variables, cover and dose.

onto the diagram. The diagram displays clearly how the species richness
decreases with both dose and cover.
In this figure, the sample scores that are based on species compositions (i.e.

sample scores that are linear combinations of species in the sample, the Samp
scores in a CANOCO solution file) are used. In CanoDraw, the default for con-
strained ordination is to use the sample scores that are linear combinations
of the environmental values (SamE scores in aCANOCOsolutionfile). Although
the constrained ordination is constructed tominimize the difference between
the Samp and SamE scores, each of the two sets provides different information.
SamE scores are the values fitted by the model; in other words these scores
indicatewhere the samples shouldbe according to thefittedmodel. As a result,
when the SamE scores are displayed, all the samples with the same values of
environmental variables (i.e. all the samples with the same treatment in this
example) have exactly the same position in the ordination diagram.
Here itmight be better touse the Samp scores to display the variability in the

species composition. To do this in CanoDraw, select Project> Settings>Contents
and check the Plot SAMP scores even for . . . option. To create the diagram from
Figure 13-2, select the Create > Attribute Plots > Data Attribute Plot command,
select the Species > Sample Stats > Number of species in the listbox and select (or
check) theNo labels, Symbols andEnvironmental variables options on the right side
of the dialog.
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Figure 13-2. The biplot diagramwith environmental variables and sites, with the
size of the site symbols corresponding to species richness (number of species in
relevé).

The same information can also be presented by smoothed data (particularly
when you have many samples). To do this, select again the Create > Attribute
Plots>Data Attribute Plot command. In the dialog, select again Species> Sample
Stats > Number of species, and in the Visualization Method area an appropriate
method for smoothing (e.g. Loess). Donot forget to check theEnvironmental vari-
ablesoption in theAdditional contentsarea.Afteryouclick theOKbutton, youwill
be asked to specify details of the smoothing method. The plot in Figure 13-3
was obtained by using the default values for the loessmethod.
Finally, it is necessary to calculate two separate partial constrained ordi-

nations. In the first case, use the fertilizer dose as the environmental variable
and the barley cover as the covariable. The analysis will reflect the effect of
fertilization, which cannot be explained by the effect caused by the increased
barley cover (the conditional effect of fertilizer).
In the second analysis, use barley cover as the environmental variable and

fertilizer dose as the covariable. Here you ask about the conditional effect of
barley cover. This analysis reflects the variability caused by the differences in
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Figure 13-3. The isolines of species richness of samples, plotted in the RDA
ordination diagram.

barley cover that cannot be attributed to fertilization effects. Use both the ana-
lyses standardized and not standardized by sample norm. It is possible to use
constrained permutations (permutations within blocks) in the Monte Carlo
permutation test when dose is used as a covariable. Because dose has three sep-
arate values, theplotswith the samevalueof thedose canbe considered to form
a block. However, with the reduced model, use of within-block permutations
is not necessary, and unconstrained permutations might provide a stronger
test. The meaning of these tests of conditional effects is analogous to a test of
significance of particular regression coefficients inmultiple regression.

Note that it may sometimes happen (not in this data set) that the
analysis with both variables used as explanatory variables is (highly)
significant, whereas none of the analyses with one of the variables
used as an explanatory variable, and the other as a covariable, is
significant. This case is equivalent to the situation in a multiple linear
regression where the ANOVA on the total regression model is
significant and none of the regression coefficients differ significantly
from zero. This happens when the predictors are highly correlated.
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You are then able to say that the predictors together explain
a significant portion of total variability, but you are not able to say
which of them is the important one.

Variation partitioning (see Section 5.10 for additional information) decom-
poses the total variability intoapart that canbeexplainedsolelyby thedoseand
a part solely explained by the cover. As the two variables are highly correlated,
it is impossible to say, for some part of the variability, which of the variables
causes it. To calculate the individual parts of the variability decomposition,
you can use the results of the redundancy analyses that you have already
calculated:

1. The RDAwith both variables used as explanatory (environmental)

variables. You get:

Total
Axes 1 2 3 4 variance

Eigenvalues : 0.097 0.046 0.200 0.131 1.000
Species-environment

correlations : 0.705 0.513 0.000 0.000
Cumulative percentage variance
Cumulative percentage variance

of species data : 9.7 14.3 34.4 47.5
of species-environment
relation : 67.8 100.0 0.0 0.0

Sum of all eigenvalues 1.000
Sum of all canonical eigenvalues 0.143

The results show that 14.3% of the total variation in species data can be

explained by both variables together.

2. Now use the partial analysis with cover as the explanatory

(environmental) variable and dose as a covariable:

Total
Axes 1 2 3 4 variance

Eigenvalues : 0.074 0.200 0.131 0.102 1.000
Species-environment

correlations : 0.590 0.000 0.000 0.000
Cumulative percentage variance

of species data : 8.0 29.5 43.6 54.5
of species-environment
relation : 100.0 0.0 0.0 0.0

Sum of all eigenvalues 0.931
Sum of all canonical eigenvalues 0.074

The sum of all eigenvalues is after fitting covariables
Percentages are taken with respect to residual variances

i.e. variances after fitting covariables
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Figure 13-4. Partitioning of variance of species composition, explained by the cover
and dose factors.

This shows that cover explains 7.4% of the total variability in the species

data, which cannot be explained by dose. Note that you do not use the

percentage presented in the cumulative percentage variance of species

data (8%), because it is takenwith respect to the residual variation (i.e.

calculated after fitting the covariable), but you directly use the

appropriate canonical eigenvalue.

3. In a similarmanner, you can now use the partial ordination with dose as

the explanatory variable and cover as a covariable:

Total
Axes 1 2 3 4 variance

Eigenvalues : 0.047 0.200 0.131 0.102 1.000
Species-environment

correlations : 0.500 0.000 0.000 0.000
Cumulative percentage variance

of species data : 5.2 27.4 41.9 53.2
of species-environment
relation : 0.0 0.0 0.0

Sum of all eigenvalues 0.904
Sum of all canonical eigenvalues 0.047

The dose explains 4.7% of variability not accounted for by the cover.

4. Now you can calculate: total explained variability is 14.3%. Of those, 7.4%

can be explained solely by the effect of barley cover and 4.7% by the effect

of fertilizer dose. It is impossible to decide which of the environmental

variables is responsible for the remaining 2.2% of variability. The results

of variation partitioning can be displayed in a diagram (Figure 13-4).

Do not be discouraged that the explained variability is only 14.3%! The
explained variability also depends on the number of species and sites (on the
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dimensionality of the problem). In the RDAwith both variables, the third (i.e.
unconstrained) axis explains only 20%, and the first axis in a corresponding
PCAexplains only23.9%.Thefirst axis of PCA canbeunderstood as expressing
how much the data could be explained by the best possible environmental
variable. From this point of view, the explanatory power of cover and dose is
not so bad.When evaluating the results of the variance partitioningprocedure,
you should always compare the explained amounts of variancewith the results
of unconstrained analyses. Nevertheless, we do not think that you should
really ignore the unexplained fraction of variability, as some authors suggest
(e.g. Okland 1999).
When you compare the results obtained here with those of Pyšek & Lepš

(1991), you will find important differences. This is caused by the omission of
fertilizer type as an explanatory variable in your sample analyses. There were
relatively largedifferences in cover among the fertilizer typeswithin adose. All
these differences are now ascribed to the effect of barley cover. This also illus-
trates how biased the results can be when some of the important predictors
in the data are ignored in a situation when predictors are not experimentally
manipulated and are interdependent.
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Case study 4: Evaluation of experiments in
randomized complete blocks

14.1. Introduction

Randomized complete blocks design is probably the most popular
experimental design in ecological studies, because it controls in a powerful
way the environmental heterogeneity. For a univariate response (e.g. number
of species, total biomass) the results of experiments set in randomized com-
plete blocks are evaluated using a two-way ANOVA without interactions. The
interaction mean square is used as the error term – the denominator in the
calculation of F -statistics. In the following tutorial, you will use the program
CANOCO in a similar way to evaluate the community response (i.e. a multi-
variate response of the species composition of the vegetation). The example
is based on an experiment studying the effect of dominant species, plant lit-
ter andmoss on the composition of a community of vascular plants, with spe-
cial attention paid to seedling recruitment. In this way, some of the aspects of
the importance of regeneration niche for species coexistence were tested. The
experiment was established in four randomized complete blocks, the treat-
ment had four levels and the response was measured once. The experiment is
described in full by Špačková et al. (1998).Here is a simplifieddescriptionof the
experiment.
The experiment was established in March 1994, shortly after snowmelt, in

four randomized complete blocks. Each block contained four plots, each with
a different treatment: (1) a control plot where the vegetation remained undis-
turbed; (2) a plot with the removal of litter; (3) a plot with removal of the dom-
inant species Nardus stricta; and (4) a plot with removal of litter and mosses.∗

Each plot was 2m× 2m square. The original cover of Nardus strictawas about

∗ It seems that one treatment is missing – removal of mosses only; however, for practical reasons it was
impossible to removemosses without removing the litter.
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25%. Its removal was very successful, with nearly no re-growth. The removal
in the spring caused only minor soil disturbance that was not apparent in the
summer.

14.2. Data

In each central 1 m2 plot, cover of adult plants and bryophytes was
visually estimated in August 1994. At that time, a new square (0.5m× 0.5m)
was marked out in the centre of each plot and divided into 25 0.1m× 0.1m
subplots. In each subplot adult plant cover and numbers of seedlings were
recorded. In this case study, you will use the seedling totals in the 0.5m×
0.5m plots. The data are in the CANOCO-format files seedl.spe (species data)
and seedl.env (design of the experiment). In the seedlenv.sta file, the data on total
number of seedlings in quadrats are also presented. Those will be used to
demonstrate the analogous univariate analysis. Original data are in the seedl.xls
spreadsheet file.

14.3. Data analysis

You may ask whether it is necessary to use a multivariate method.
Would it not be better to test the effect on each species separately by a univari-
ate method (i.e. either by ANOVA, or by analysis of deviance)? It is much bet-
ter to use a multivariate method. There is a danger in using many univariate
tests. If you perform several tests at the nominal significance level α = 0.05,
theprobability of a type I error is0.05 in eachunivariate test. Thismeans that
when testing, say,40 species, you could expect two significant outcomes just as
a result of type I error. This can lead to ‘statistical fishing’, when one picks up
just the results of significant tests and tries to interpret them. We could over-
come this by using the Bonferroni correction,∗ but this leads to an extremely
weak test.We consider it possible (but some other statisticians probablywould
not) to use theunivariatemethods for particular specieswhenwefind the com-
munity response significant; however, you should keep inmind that the prob-
ability of a type I error is α in each separate test. You should be aware that if
you select the most responsive species according to the results of ordination,

∗ Bonferroni correctionmeans, in this context, dividing the nominal significance level by the number
of tests performed and performing the particular tests on the resulting significance level. This assures
that the overall probability of the type I error in at least one of the tests is equal or smaller thanα

(see Rice 1989 or Cabin &Mitchell 2000).
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Table 14-1.Results of ANOVA on randomized complete blocks design
Summary of all Effects; design: (seedlenv.sta)

1-TREATMEN, 2-BLOCK

Df MS df MS
Effect Effect Error Error F p-level

1 3 4513.229 9 1068.84 4.222548 0.040278

2 3 215.5625 9 1068.84 0.201679 0.892645
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Figure 14-1. The design of the experiment.

those species very probably will give significant differences, and the univari-
ate test does not provide any further information in addition to the results of
ordination.Nevertheless, evenwhen there arenodifferencesbetween the treat-
ments at all, in yourdata set some specieswill bemore common in someof the
treatments, just by chance.When you then plot the ordination diagram, select
the ‘most responsive’ species (by eye) and test them by ANOVA, the result will
very probably be significant.
The design of the experiment is shown in Figure 14-1. Each quadrat is char-

acterizedby (1) the typeof the treatment, and (2) theblocknumber. Performing
the univariate analysis is quite simple. In the ANOVA/MANOVAmodule of the
Statistica program you declare TREATMENt and BLOCK to be the independent
variables and SEEDLSUM (the total number of seedlings in a quadrat) to be the
dependent variable. In randomized complete blocks, the interaction between
treatment and blocks is used as the error term. State this in the next panel (by
using Pooled effect/error term> Error, and then selecting TREATMEN*BLOCK). You
will get the ANOVA table (Table 14-1).
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Figure 14-2. Box-and-whisker plot of number of seedlings in individual
treatments.

The analysis results show that the treatment effect is significant, but there
are hardly any differences between the blocks. Because the block does not
explain any variability, the analysis is weaker than it would be if you disre-
garded the block effects (then, p = 0.015).
Now, you canuse themultiple comparisons for testingpair-wise differences

(a little tricky in Statistica for ANOVA in randomized complete blocks), and/or
inspect the box-and-whisker plot (Figure 14-2). You can see that only the
removal of both litter and moss has a significant effect on the total seedling
number.∗

For the analysis with CANOCO, you should note that both treatment and
block are categorical variables and consequently have to be coded as a set of
‘dummy’ variables. The variables characterizing the block structure will be
used as covariables and the treatment variables will be the environmental vari-
ables.The correspondingdata set isdisplayed inTable14-2. CANOCOasks sep-
arately for the environmental data and for the covariables, so each of those can
be in a separate file. If all the environmental variables and covariables are in the
same file, you have to specify the same file name (seedl.env in this case) for both
the environmental variables and the covariables and then omit the treatment
variables from the covariable list and the block variables from the list of envi-
ronmental variables. It is very convenient to have the environmental variables

∗ Using the Duncan test, the combined removal treatment is different from all the other treatments,
while Tukey’s test, which is usually recommended, shows that the treatment differs only from the
Nardus removal.
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Table 14-2. Environmental data characterizing the design of the experiment
(CANOCOfile in full format)

Ohrazeni 1994-seedlings, design of experiment
(i3,8(f3.0))
8
1 1 0 0 0 1 0 0 0
2 0 1 0 0 1 0 0 0
3 0 0 1 0 1 0 0 0
4 0 0 0 1 1 0 0 0
5 1 0 0 0 0 1 0 0
6 0 1 0 0 0 1 0 0
7 0 0 1 0 0 1 0 0
8 0 0 0 1 0 1 0 0
9 1 0 0 0 0 0 1 0

10 0 1 0 0 0 0 1 0
11 0 0 1 0 0 0 1 0
12 0 0 0 1 0 0 1 0
13 1 0 0 0 0 0 0 1
14 0 1 0 0 0 0 0 1
15 0 0 1 0 0 0 0 1
16 0 0 0 1 0 0 0 1

control litter−rnardus−rlit+mossblock1 block2 block3 block4
rel1 rel2 rel3 rel4 rel5 rel6 rel7 rel8 etc.
rel11 rel12 rel13 rel14 rel15 rel16

and the covariables in the same file. You can select various subsets of environ-
mental variables and covariables in various partial analyses.
The fourth environmental variabledescribing the last typeof treatment (the

last level of the factor) is not necessary here: three ‘dummy’ variables are suffi-
cient for coding one categorical variable with four categories. The fourth vari-
able will be omitted from the calculations, as it is a linear combination of the
previous three variables (‘ lit+moss’ = 1 − ‘control’ − ‘litter-r’ − ‘nardus-r’).
However, it is useful to include it in the analysis because we will need to plot
the results using CanoDraw after the calculations. In this case, you would like
to plot the centroids of all four categories. Similarly, the separate (co-)variable
for the fourth block is not necessary.
As the vegetation in the plots is very homogeneous and you also have

only categorical explanatory variables, you will use redundancy analysis
(RDA), the method based on the linear model. Also, the length of the gra-
dient on the first axis of a DCA is 1.98; on the second axis, 1.41.∗ Even
more importantly, RDA (unlike CCA) also enables you to carry out both the

∗ See Section 4.3 for explanation.
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standardized and non-standardized analyses. Now, you can test (at least) two
hypotheses:

1. The first null hypothesis can be stated as follows: there is no effect of

themanipulation on the seedlings. To reject this hypothesis, it is

enough if the total number of seedlings differs between treatments, even

if the proportion of individual seedling species remains constant.When

the proportion of seedlings changes or when both the proportion and the

total number of seedlings change, the null hypothesis will obviously also

be rejected.

2. The second null hypothesis can be stated as: the relative proportions of

species among the seedlings do not differ between the treatments.

Rejecting this hypothesis means that the seedlings of different species

differ in their reaction to the treatment. The first hypothesis can be tested

only when you use no standardization by samples (the default in

CANOCO).When you use a standardization by samples (usually by the

sample norm), then you test the second null hypothesis.∗ The test of the
first hypothesis above is usuallymore powerful, but the rejection of the

second hypothesis is more ecologically interesting: the fact that seedlings

of different species respond in different ways to particular treatments is

a good argument for the importance of the regeneration niche for

maintenance of species diversity.

The calculation of RDA proceeds in a standard way. Just take care of the
following issues:

1. When you have environmental variables and covariables in the same file

do not forget to omit the appropriate variables. Omitting of covariables is

more important, because if the same variable is among the covariables

and the environmental variables, it will be automatically omitted from

the environmental variables, as it does not explain any variability.

2. When performing theMonte Carlo permutation test, you can ask for

permutation within blocks, conditioned by all three covariables (the

fourth is collinear and is omitted from the analyses). Each permutation

class will then correspond to a block in the experiment. The permutation

within blocks is shown in Table 14-3. This is the approach recommended

in the versions of CANOCO before 4.x (under the null hypothesis, the

treatments are freely exchangeable within a block). In the newer versions,

∗ Note that the standardization is part of the averaging algorithm in canonical correspondence analysis.
Consequently, a CCAwould not find any difference between the plots differing in total number of
seedlings, but with constant proportions of individual species.
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Table 14-3. Permutations within blocks

original block perm1 perm2 perm3 perm 4 perm 5
1 1 2 4 1 etc.
2 1 4 3 4 etc.
3 1 3 2 2 etc.
4 1 1 1 3 etc.
5 2 7 5 7 etc.
6 2 8 8 6 etc.
7 2 5 7 8 etc.
8 2 6 6 5 etc.
9 3 11 9 9 etc.

10 3 9 12 12 etc.
11 3 10 10 11 etc.
12 3 12 11 10 etc.
13 4 14 16 14 etc.
14 4 15 13 15 etc.
15 4 16 15 13 etc.
16 4 13 14 16 etc.

when using the reducedmodel test, the residuals after subtracting the

effect of covariables are permuted. In this case, we recommend using

unrestricted permutations (the increased strength is achieved without

inflating the type I error rate) (Anderson & Ter Braak 2002). The test

based on the within-block permutations is particularly weakwith a low

number of blocks and/or a low number of treatment levels.

Of the two suggested analyses, only the RDA on data not standardized by
sample norm shows significant results (P = 0.028 for the test on the first axis,
P = 0.056 for the test on all constrained axes, using 499 unrestricted permu-
tations in each test). The fact that the test of the first axis is much stronger
suggests that there is a strong univariate trend in the data. Accordingly, the
second canonical axis is not significant (see Section 9.1 for a description of
testing the significance of higher axes). Also, the ordination diagram (species–
environment biplot, Figure 14-3) confirms that themost different treatment is
the removal ofmoss and litter, with the samples with this treatment separated
from the others on the first canonical axis.
In Log View, you should notice the striking difference between the eigen-

values corresponding to the first and to the second ordination axes (0.281 and
0.031, respectively). This again suggests that the explanatory power of the
second axis is very weak. Also, with this difference between eigenvalues, there
is a huge difference between graphs produced with scaling focused on species
correlation and on the inter-sample distances. As the centroids of treatments
are calculated as averages of individual sample positions, the scaling focused
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Figure 14-3. Species–environment biplot of RDA on non-standardized data.
Species are shown by arrows and labelled by their generic names only, and the
centroids of treatments are displayed by triangles. Both diagrams show the scores
on the first two axes of identical analysis, but the left one (a) was producedwith
scaling of scores focused on inter-species correlations and the right one (b) with
scaling focused on inter-sample distances.

on species correlations exaggerates the differences between treatments on the
second axis (compare the two diagrams in Figure 14-3).
If you needed to make multiple comparisons, you would have to calculate

separate analyses with pairs of treatments (omitting all the samples with the
other treatments than the two compared; this change canbeperformedduring
the project setup), and thenuse the Bonferroni correction (in effect tomultiply
each P value obtained in aparticular test by thenumber of tests executed). This
gives, however, a very weak test.
When plotting the ordination diagram, the species–environment biplot is

the most informative display. In CanoDraw, two things should not be for-
gotten: (1) specify the experimental treatments as nominal variables (Project>
Nominal variables>Environmental variables) and (2) restrict thenumber of species
in the final graph. The species can be selected manually, but more use-
ful is the selection of species with the highest fit. Use Project > Settings >

InclusionRules andmodify (by the trial-and-errormethod) the lower limit of the
Species Fit Range option to achieve a reasonable number of species in the final
plot.
The ordination diagram also shows that Ranunculus, Potentilla and Cirsium

are the species responsible for differentiation and all of them prefer the treat-
ment with the removal of moss and litter. Although it seems that particular
species prefer particular treatments, the standardized RDAwas not significant
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(P ∼ 0.5), so you are not able to confirm that there are differences between
species in their seedlings’ reaction to the treatments.
There is an important difference between the ecological implications of

significant treatment effect in the standardized-by-samples and the non-
standardized analyses. The theory of a regeneration niche (Grubb 1977) sug-
gests that differential establishment of seedlings of various species in various
microhabitats is amechanism that supports species coexistence. Thedescribed
experiment tests this suggestion. If there was differential establishment, then
we could expect the proportions of species to be different in different treat-
ments. Unfortunately,wewere not able to demonstrate this.Wewere only able
to show that mosses and litter suppress seedling recruitment, but this conclu-
sion does not directly support Grubb’s theory.
In this experiment, there were hardly any differences between the blocks

(P ∼ 0.5). Consequently, when you ignore the blocks, both in ANOVA and in
RDA, you will get stronger tests. This is a nice illustration of the fact that the
blocks that do not explain any variability decrease the power of the tests (for
the non-standardized RDA, P would be 0.015 and 0.036 for the tests on the
first axis and on the sum of canonical eigenvalues, respectively).
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Case study 5: Analysis of repeated
observations of species composition
from a factorial experiment

15.1. Introduction

Repeated observations of experimental units are typical inmany areas
of ecological research. Inexperiments, theunits (plots) are sampledfirstbefore
the experimental treatment is imposed on some of them. In this way, you
obtain ‘baseline’ data, i.e. data where differences between the sampling units
are caused solely by random variability. After the treatment is imposed, the
units are sampled once or several times to reveal the difference between the
development (dynamics) of experimental and control units. This design is
sometimes called replicated BACI – before after control impact. To analyse the
univariate response (e.g.numberof species, or totalbiomass) in thisdesign, you
can usually apply the repeatedmeasurementsmodel of ANOVA.
There are two possibilities for analysing such data. You can use the split-

plot ANOVA with time, i.e. the repeated measures factor, being the ‘within
plot’ factor,∗ or you can analyse the data using MANOVA. Although the the-
oretical distinction between those two is complicated, the first option is usu-
ally used because it provides a stronger test. Nevertheless, it also has stronger
assumptions for its validity (see e.g. Lindsey1993; VonEnde1993). The interac-
tionbetween time and the treatment reflects the difference in thedevelopment
of the units between treatments. CANOCO can analyse the repeated observa-
tions of the species composition in a way equivalent to the univariate repeated
measurementsANOVA.Whereas all themodel terms are tested simultaneously
in ANOVA, in CANOCO you must run a separate analysis to test each of the
terms.Wewill illustrate the approachwithananalysis of a factorial experiment

∗ This is called a ‘univariate repeatedmeasurements ANOVA’.

215
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applying fertilization, mowing and dominant removal to an oligotrophic wet
meadow. The description of the experiment is simplified; a full description is
in Lepš (1999).

15.2. Experimental design

In this experiment,we tested the reaction of a plant community to var-
iousmanagement regimesand their combinations (mowing, fertilization), and
the effect of the dominant species tested by its removal. We were interested
in the temporal dynamics of species richness and species composition under
various treatments, and also in which species traits are important for their
reaction.
The experiment was established using a factorial design with three replica-

tions of each combination of treatments in 1994. The treatments were fertil-
ization, mowing and removal of the dominant species (Molinia caerulea). This
implies eight combinations in three replications, yielding 24 2m × 2m plots.
The fertilization treatment is an annual application of 65 g/m2 of commercial
NPK fertilizer. The mowing treatment is the annual scything of the quadrats
in late June or early July. The cut biomass is removed after mowing. Molinia
caeruleawasmanually removed (using a screwdriver) in April 1995with amin-
imum of soil disturbance. New individuals are removed annually.

15.3. Sampling

Plotswere sampled in thegrowingseason (Juneor July) eachyear, start-
ing in 1994. Note that initial sampling was conducted before the first experi-
mental manipulation in order to have baseline data for each plot. The cover of
all vascular species andmosseswas visually estimated in the central 1m2 of the
2m× 2mplot.

15.4. Data analysis

Dataare in the formof repeatedmeasurements; the sameplotwas sam-
pled four times. For a univariate characteristic (the number of species) the cor-
responding repeatedmeasurements ANOVAmodel was used (Von Ende 1993).
For species composition, RDA was used: RDA, a method based on a linear
species response, was used because the species composition in the plots was
rather homogeneous and the explanatory variables were categorical. Because
Molinia cover was manipulated, this species was specified as a supplemen-
tary species in the analyses. This is very important because otherwise
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we would show (with high significance) that Molinia has a higher cover
in the plots from which it was not removed. By using the various combi-
nations of explanatory (‘environmental’ in CANOCO terminology) variables
and covariables in RDA with the appropriate permutation scheme in the
Monte Carlo test, we were able to construct tests analogous to the testing of
significance of particular terms in ANOVA models (including repeated mea-
surements). Because thedata formrepeated observations that include the base-
line (before treatment) measurements, the interaction of treatment and
time is of the greatest interest and corresponds to the effect of the experimen-
tal manipulation. When we test for the interaction, the plot identifiers (coded
as many dummy variables) are used as covariables. In this way we subtract the
average (over years) of each plot, and only the changes within each plot are
analysed. Values of time were 0, 1, 2 and 3 for the years 1994, 1995, 1996 and
1997, respectively.This corresponds toamodelwhere theplotsof various treat-
ments do not differ in 1994 and the linear increase in difference is fitted by the
analysis.∗

The other possibility is to consider time as a categorical (i.e. nominal) vari-
able (each year would be a separate category) and to code it as several dummy
variables. In a ‘classical’ analysis using constrained ordination and diagrams,
both approaches can be used (but only the analyses using time as a quantitative
variable will be shown in this tutorial). A novel method of visualization of
results of repeated measurements analysis, the principal response curves
method (PRC, Van den Brink & Ter Braak 1999) has been suggested. It is an
extension of constrained ordinations and time is used as a categorical variable.
In this chapter, we will demonstrate the univariate analysis, the classical con-
strained ordinations and the PRCmethod. Because the creation of PRC curves
ismore tricky than the other topics, we present it in amore detailed, cookbook
fashion.
The original data are in Excel file ohraz.xls. The species data are in the work-

sheet ohrazspe, and the design of the experiment is in the ohrazenv worksheet.
Using the program WCanoImp, prepare condensed-format CANOCO species
file ohraz.spe and environmental data file ohraz.env. In bothfiles, the samples are
in the following order: samples from 1994 have numbers 1 to 24, samples
from 1995 are numbered 25 to 48, etc. The knowledge of this ordering will be
important for the description of the permutation scheme. The names of sam-
ples are constructed in the following way: r94p1means a sample recorded in
1994, plot 1. In the environmental data file, the first three variables (MOWING,

∗ This approach is analogous to the linear polynomial contrasts rather than the ordinary testing of
effects in repeatedmeasurement ANOVA.
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FERTIL, REMOV) describe which treatments were applied using the following
values: 1 = treated, 0 = non-treated. The next variable, Year, is the time from
the start of experiment, i.e. time as a quantitative variable. The next four
variables (Yr0, Yr1, Yr2 and Yr3) are dummy variables, describing the sampling
year as a categorical variable (so for all the records done in 1994, Yr0 = 1, and
Yr1 = 0, Yr2 = 0 andYr3 = 0). The following variables, P1 to P24, are theplot
identifiers (e.g. for all the records fromplot one, P1 = 1 andP2 to P24 are zero).
Youwill use this file as both environmental variables and covariables and select
(delete) appropriate variables in each context.

15.5. Univariate analyses

At first, the univariate analysis of the data on number of species in
quadrats will be demonstrated using the ANOVA/MANOVAmodule in the Sta-
tistica program. The data on species numbers are in the worksheet ohrstat and
also in the Statistica file ohrazenv.sta. Note that unlike for themultivariate anal-
ysis, where each relevé has to be presented as a separate sample, here each plot
is a separate sample, characterized by four variables (i.e. the repeatedmeasure-
ments of the species richness in the four consecutive years). The data on species
richness will be analysed by a repeatedmeasurement ANOVA.
In Statistica, you first state that the independent variables are MOWING,

FERTILization and REMOVal, and the dependent variables are numbers of
species in the four consecutive years (i.e.NSP0,NSP1,NSP2 andNSP3). Then you
specify that the repeatedmeasure design variable has four levels, and its name
is TIME. After confirming the information and asking for all the effects, you
will get the ANOVA table (Table 15-1).
Together, 15 various tests were performed.∗ Of greatest interest here are the

interactions of treatmentswith timehighlighted inTable 15-1 (and all of them
are significant). Themain effects and their interactions are also of interest, be-
cause sometimes theymay provide a stronger test than the interaction.

15.6. Constrained ordinations

For most of the tests shown in Table 15-1 it is possible to construct
a counterpart in the CANOCO analysis by a combination of environmental
variables and covariables.

∗ Interestingly, when you perform several t-tests instead ofmultiple comparisons controlling the
experiment-wise type I error rate, youwill get a clear response from some journal reviewers; when one
performs 15 tests in amultiway ANOVA, the type I error rate is also given for each individual test, and
nobody cares. (We realize that there is a difference between these two situations, but both provide an
opportunity for ‘statistical fishing’.)
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Table 15-1.Results of univariate repeatedmeasurements analysis of variance
from the Statistica program
Summary of all Effects; design: (ohrazenv.sta)

1-MOWING, 2-FERTIL, 3-REMOV, 4-TIME

df MS df MS
Effect Effect Error Error F p-level

1 1 65.01041 16 40.83333 1.592092 0.225112

2 1 404.2604 16 40.83333 9.900255 0.006241

3 1 114.8438 16 40.83333 2.8125 0.112957

4 3 87.95486 48 7.430555 11.83692 6.35E-06

12 1 0.260417 16 40.83333 0.006378 0.937339

13 1 213.0104 16 40.83333 5.216582 0.036372

23 1 75.26041 16 40.83333 1.843112 0.193427

14 3 75.53819 48 7.430555 10.16589 2.69E-05

24 3 174.2882 48 7.430555 23.45561 1.72E-09

34 3 41.48264 48 7.430555 5.58271 0.002286

123 1 6.510417 16 40.83333 0.159439 0.694953

124 3 14.67708 48 7.430555 1.975234 0.130239

134 3 11.48264 48 7.430555 1.545327 0.214901

234 3 2.565972 48 7.430555 0.345327 0.792657

1234 3 3.538194 48 7.430555 0.476168 0.700348

Interactions of treatments with time are displayed in bold typeface.

Table 15-2.Results of the analyses using RDA applied to cover estimates of the species in
1m× 1mplots

Explanatory % expl. r
Analysis variables Covariables 1st axis 1st axis F ratio P

C1 Yr, Yr∗M, Yr∗F, Yr∗R PlotID 16.0 0.862 5.38 0.002
C2 Yr∗M, Yr∗F, Yr∗R Yr, PlotID 7.0 0.834 2.76 0.002
C3 Yr∗F Yr, Yr∗M, Yr∗R, PlotID 6.1 0.824 4.40 0.002
C4 Yr∗M Yr, Yr∗F, Yr∗R, PlotID 3.5 0.683 2.50 0.002
C5 Yr∗R Yr, Yr∗M, Yr∗F, PlotID 2.0 0.458 1.37 0.084

Data are centred by species. No standardization by samples was done. Explanatory variables are
environmental variables in CANOCO terminology. % expl. 1st axis: percentage of species variability
explainedby thefirstordinationaxis, ameasureof theexplanatorypowerof thevariables. r 1st axis:
species–environment correlation on the first axis. F ratio: the F -ratio statistics for the test on the
trace. P : corresponding probability value obtained by the Monte Carlo permutation test, using
499 randompermutations.Yr: serialnumberof theyear;M:mowing; F : fertilization, R:Molinia re-
moval,PlotID: identifier of eachplot. The asterisk (∗) between two terms indicates their interaction.

We selected to test the following null hypotheses (see Table 15-2):

� C1: there are no directional changes in time in the species composition

that are common to all the treatments or specific for particular

treatments. This corresponds to the test of all within-subject effects in

a repeatedmeasures ANOVA.
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� C2: The temporal trend in the species composition is independent of the

treatments.
� C3 (C4, C5 ): Fertilization (or removal ormowing) has no effect on the

temporal changes in the species composition. This corresponds to the

tests of particular terms in a repeatedmeasures ANOVA (the three

highlighted rows in Table 15-1).

Note that when PlotID is used as a covariable, themain effects (i.e.M, F and
R) do not explain any variability and it is meaningless to use them, either as
covariables or as the explanatory variables.
In these analyses, time is considered as a quantitative (continuous) variable.

This means that you will use Year and delete the four variables Yr0 to Yr3. This
corresponds to a search for a linear trend in the data. If you look for general
differences in the temporal dynamics, you can consider time to be a categori-
cal variable and use the variables Yr0 to Yr3 (one of them is redundant, but use-
ful for plotting in the ordination diagrams) and delete the variable Year. In this
case, however, the interaction between treatment and timemust be defined as
interactions with all four dummy variables Yr0 to Yr3.
During the project setup in Canoco for Windows, you should not forget to

tick the checkboxesDelete species (anddeleteMolinia; alternatively, youcanmake
this species supplementary), Delete environmental variables, Delete covariables and
Define interactions of environmental variables and/or covariables, where neces-
sary. When defining an interaction, you can use the effects that were deleted
from the variables. So, for testing hypotheses C2 to C5 all the environmental
variables should be deleted and then their interactions defined.
The null hypothesisC1 is a littlemore complicated and difficult to interpret

ecologically. This analysis is useful for a comparison with the other analyses
in terms of the explained variability and of the species – environment corre-
lation on the first axis. For the other analyses, under the null hypotheses, the
dynamics are independent of the treatments imposed. This means that if the
nullhypothesis is true, thentheplots are interchangeable;however, the records
from the same plot should be kept together. Technically speaking, the records
done in different years in the same plot are subplots (within-plots) of the same
main plot (whole-plot) and the main plots are permuted. To do this, the follow-
ing options should be used during the project setup in Canoco forWindows:

Perform test: people usually use Both above tests. However, the procedurewhen
one performs both tests and then uses the one that gives a better result is not
correct. It may be expected that the test of the first ordination axis is stronger
when there is a single dominant gradient; the test of all constrained axes tog-
ether is stronger when there are several independent gradients in the data.
Note that with a single explanatory variable, the first axis and all the axes are
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Figure 15-1. Project setup page Split-Plot Design I.

the same.Use of the permutation under reducedmodel is recommended.Depend-
ing on your time available, computer speed and size of the problem, the num-
ber of permutations can be increased. The permutations should be Restricted
for spatial or temporal structure or split-plot design, then in the next setup wizard
page (see Figure 15-1) named Split-plot design, the Number of split-plots in whole-
plot is 4 (i.e. four records from each plot) and the split-plots are selected by the
rule Take 1 Skip 23. This corresponds to the order of records in the file: in our
case, the records from the same plot are separated by 23 records from the other
plots.∗ Thewhole-plots are freely exchangeable and ‘nopermutation’ is recom-
mended at the split-plot level.†

After running the analysis, it is advisable to check in the Log View the per-
mutation scheme. In your case, the output is:

∗∗∗ Sample arrangement in the permutation test ∗∗∗

Whole plot 1 :

1 25 49 73

Whole plot 2 :

2 26 50 74

Whole plot 3 :

3 27 51 75

etc . . .

∗ Take care: if you use permutation within blocks – which isnot your case here, then the number of
plots to skip is the number of plots to skipwithin a block.

† According to the CANOCOmanual:Optionally, the time point could be permuted also, but this . . . has a less
secure basis than the permutation of sites.
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Figure 15-2. Results of the C2 analysis. The significance of individual explanatory
variables is taken from the analyses C3–C5.

This shows that thewhole-plots are composed of the records from the same
plot, which is correct.
The relationship of particular species to experimental manipulations can

be visualized by ordination diagrams. Probably the best possibility is to dis-
play the results of the analysis of C2 by a biplot with environmental variables
and species (Figure 15-2). Because you used year as a continuous variable, the
interactions of time with the treatments are also continuous variables and are
shown by the arrows. Because time was used as a covariable, the trends should
be seen as relative to the average trend in the community. For example, the con-
cordantdirectionof a species arrowwith theFER∗YEARarrowmeanseither that
the species cover increases in the fertilized plots or that it decreases in the non-
fertilized plots (or both).

15.7. Further use of ordination results

The results of the analyses can be further used for other purposes. One
of the possibilities is to use the species scores. Species scores on the constrained
axis fromthe analyseswhere time∗treatmentwas theonly explanatory variable
and the other factors were covariables (C3 to C5) can be considered character-
istics of the species response to the particular treatment. Then the following
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biological characteristics of species were tested as possible predictors of this
response:

1. Species height, taken as themiddle of the height range given in the local

flora.

2. Presence of arbuscularmycorrhiza (AM), based on data fromGrime et al.

(1988) and from the Ecological Flora Database.

3. Seedling relative growth rate (RGR) fromGrime et al. (1988).

4. Because we expected that species similar toMoliniawould benefitmost

fromMolinia removal, we also used a fourth (ordinal) variable,

dissimilarity of the species fromMolinia, for predicting the effects of
Molinia removal. A value of 1was assigned to graminoids higher than

50 cm, 2 to broad-leaved graminoids smaller than 50 cm, 3 to

narrow-leaved graminoids smaller than 50 cm, and 4 to forbs. Spearman

correlation was used for the analysis of the relationship of this value with

the RDA score ofMolinia removal.

You can easily transfer the results of analyses from the solution (.sol) file
into a spreadsheet (use Excel and read the .sol file as delimited text format).
Then you can use the species scores as a response and add the biological char-
acteristics of the species you want to study (plant height, mycorrhizal sta-
tus, etc.) and use them as predictor variables. It is reasonable to omit the
species that have a low frequency in the data (those species show no response
in a majority of sampling units, simply because they were not present before
or after the treatment). Often, you will also be forced to omit the species for
which biological characteristics are not available. Then you can use the data
in any ordinary statistical package – we have done this using the Statistica
program.
Alternatively, you can import the external variables, describing biological

characteristicsof species, intoCanoDrawforWindows.Todoso, youcanuse the
Project > Import variables > From Clipboard command. When importing species
characteristics, make sure you specify that the imported data refer to species,
not to samples. Also, if you do not have the characteristic values available for
all your species, you must import the actual data values together with species
indices, identical to those used in the CANOCO project.
In our case study, plant height appears to be a good predictor of the species

response to fertilization: with increased availability of nutrients, the compe-
tition for light became more important, thus the potentially taller plants in-
creased their cover. This might be illustrated by the dependence of the species
score on the constrained axis of the analysis C3 on plant height (Figure 15-3).
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Figure 15-3. Dependence of the response to fertilization (expressed as the RDA
score on the constrained axis of analysis C3) on potential plant height. The species
with low frequency were omitted.

In this case, we considered the species to be independent entities and no
phylogenetic corrections (Silvertown&Dodd 1996) were applied.
On the contrary, the plant mycorrhizal status has nearly no predictive

power – the responseofplants to fertilizationdoesnotdependonwhether they
are mycorrhizal or not. In a similar way, the response of plant species to the
other factors can be compared with the species’ biological characteristics.

15.8. Principal response curves

The method of principal response curves (PRC, see Section 9.3) pro-
vides an alternative presentation of the data analysed in this case study. The
resulting response curve shows us the extent and directions of the develop-
ment of grassland vegetation under different experimental treatments, com-
paredwith the control treatment. Additionally,we can interpret the directions
of such composition changes using the response of individual plant species,
which can be well integrated with a PRC diagram.
The vertical scores of PRC curves are based on the scores of environmental

variables from a redundancy analysis (RDA), where the sampling time indica-
tors are used as covariables and the interactions between the treatment levels
and sampling times stand as environmental variables (see Section 9.3).
We will start with data stored in the Excel file ohrazprc.xls, in which the nec-

essary changes have already been applied. You can compare its contents with
the data used in the preceding analyses (present in the file ohraz.xls). Note that
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the main change has happened in the explanatory variables (the Design sheet).
You will use the sampling year only in the form of a factorial variable (coded
as four dummyvariablesYr0 toYr3) and the experimental treatments are coded
differently fromtheprevious analyses. Eachof the eightpossible combinations
of the three experimental treatments (mowing, fertilization and removal of
Molinia) is coded as a separate factor level (separate dummy variable, from 0 to
MFR).
Export the two tables (from the Species and Design sheets) into CANOCO-

format data files named, for example, prc spe.dta and prc env.dta. Create a new
project in Canoco for Windows: it will be a constrained (direct gradient) par-
tial analysis, i.e. with both environmental variables and covariables. Specify
the prc spe.dta file as the species data and use the prc env.dta for both the
environmental and the covariable data. We suggest you name the solution file
ohrazprc.sol and the whole project (when you are asked to save it at the end of
its setup) ohrazprc.con. Ask for the redundancy analysis (RDA) and on the Scaling
page select the Inter-sample distances and Do not post-transform options. Ask for
log transformation of the species data, and on the next page specify centring
by species; for samples, theNone option should be selected. On theData Editing
Choices page, remember to check theMAKE SUPPLEMENTARY checkbox in the
Species row. The DELETE option for Env. variables and Covariables should be pre-
checked, because you specified identical file for both types of explanatory vari-
ables. Additionally, you must check the DEFINE INTERACTIONS option in the
Env. variables row.
In the Supplementary Species page move the first species (molicaer) to the right

list, as the species presencewas experimentallymanipulated so it does not rep-
resent a response of the community. In the Delete Environmental Variables page,
move everything to the right list, as you will not use any of the original vari-
ables in the analysis. Instead, interactions between the treatments and years
(which you will define soon) will be used. Keep only the year indicators (Yr0 to
Yr3) in theDelete Covariables page andmove the other variables to the right list.
In the next setup page, youmust define interactions between the sampling

year indicators and the treatments. Note that the control treatment (with
label 0) should be excluded and not used for treatment definitions. Therefore,
7 × 4 = 28 interaction terms should be defined. To create an interaction term
between, say, the first year and themowing-only treatment, select the Yr0 vari-
able in the First variable list, the M variable in the Second variable list, and then
click the Add button. Continue similarly with the other 27 possible combina-
tions. Finally, the page contents should look as illustrated in Figure 15-4. Note
that the decision, which of the treatment levels should be regarded as con-
trol, is not unequivocal. Our decision to use the abandoned grassland (with no
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Figure 15-4. Defining interactions of time and treatment for PRC analysis.

mowing present) as a reference line is questionable and we will return to this
point later.
In the Forward Selection page keep the Do not use . . . option, but ask for

a permutation test of Significance of first canonical axis in the next setup page
(Global Permutation Test). We will be testing the differences between the whole
time series (four years of measurement) for each of the permanent plots.
Keep the Number of permutations default value of 499. In the next page, select
the Restricted for . . . option, and then select the Split-plot design option in the
Permutation Restrictions area. The four yearly measurements for each perma-
nent plot in the data file are interleaved with the measurements on the other
plots. Therefore, in the Split-Plot Design I page, you must not only specify that
there are four split-plots (i.e. four years of measurement) within each whole
plot, but also – on the right side of the page – that to collect the four split-
plots representingonewhole-plotCANOCOmust take1andskip the following
23 samples. On the next page, keep the default settings. They imply that you
will randomly permute the whole plots (the permanent plots with four years
of measurement) and the split-plots will not be permuted at all (the tempor-
al ordering of samples within each permanent plot will not be changed). Use
the Finish button to close the setupwizard and save the project under the name
ohrazprc.con.
After you have analysed the project, switch to CANOCO Log View. At its

end, you can see the results of the test for the first RDA axis, which is – in
our case – also the significance test of the first principal curve. There are other
items of interest in the analysis log if you calculate the PRC scores. Move up to
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the table of means, standard deviations and variance inflation factors for the
environmental variables. You can see that all the interaction terms have iden-
tical values there, thanks to the strictly balanced experimental design. Such
uniformity does not occur in every analysis; for example, if you have a differ-
ent number of replicates for individual treatment levels. The standard devia-
tion values for each interaction term are needed to calculate the PRC scores,
together with the species data standard deviation, presented under the name
TAU further up in the Log View (with value 0.59246). You can save yourself the
calculations with the help of the CanoDraw for Windows program. Neverthe-
less, you must save the analysis log in a text file. To do so, select the File> Save
log command from the Canoco for Windows menu. CANOCO offers the name
identical to the project name, but with the .log extension and we suggest you
accept it.
A question naturally arises as to whether just the principal response curves

for the first RDA axis are sufficient to represent the trends in the community
dynamics for vegetation under different experimental treatments. To answer
the question, you must test the significance of the second and (if second was
found significant) higher constrained RDA axes, using the method suggested
in Section 9.1. Note that in this project, you already have covariables (the Yrx
dummy variables) so youmust create a new data file with covariables, contain-
ing not only the four year indicators, but also the SamE scores from the current
analysis, exported from the ohrazprc.sol file.
We will not demonstrate the individual steps for testing the significance

of the higher RDA axes, but the results of the tests indicate that the PRCs
corresponding to the second RDA axis are not significant (P = 0.338 with
499 permutations).
Now, you will create a diagram with the principal response curves. Create

a new CanoDraw project from the ohrazprc.con project (click, for example, on
the CanoDraw button in CANOCO Project View). We will start the creation of
the PRC diagram by defining the PRC scores for the first RDA axis. Select the
Project > Import variables > Setup PRC scores command. Select all the interaction
terms in the listbox, keep the default setting of importing PRC scores just for
the first RDA axis, and locate the ohrazprc.log file using the Browse button. The
final look of the dialog contents should resemble the contents of Figure 15-5.
After you click theOK button, the PRC scores are created and stored among

the imported variables. Note, however, that you must still set up the horizon-
tal coordinates for the PRC diagram. These correspond to a quantitative time
(year) value for each combination of treatment and year. It is important to
realize that the individual points in this diagramdonot correspond to project
samples, but rather to individual environmental variables (their interaction
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Figure 15-5. Importing the PRC scores into a CanoDraw project.

Figure 15-6. Copying labels of environmental variables to theWindows Clipboard.

terms). The easiest way of creating a variable with the required X coordinates
is described in the following paragraphs.
Select the View > Project Details command and expand the Project Results >

Labels folder in the new window which appears after that. When you click the
item labelled EnvV.Labels with the right mouse button, CanoDraw displays a
summary of this particular variable (which stores the labels for environmental
variables). Click the Copy button in the Variable Summary dialog to copy both
indices and labels of environmental variables to the Windows Clipboard (see
Figure 15-6).
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Open a new document inMicrosoft Excel and paste the data from the Clip-
board. Two columns of data are pasted. The first one contains the indices of
individual environmental variables (theydonot start at1, butwith13, as the12
original environmental variables were deleted in the CANOCO project setup),
the secondcolumncontains thenamesof the interactionterms.Youwilluse the
second column to guide you about the appropriate value of the Time variable,
which you will now create in the third column. Write the new variable name
(‘Time’) at the top of the third column and write 0 in all rows that involve Yr0
in the interaction term, and similarly 1 for termswithYr1, etc. The exact order-
ing of terms depends on the order in which you defined them in the CANOCO
project setupwizard.
After youhave completed the third column (with seven0s, seven1s, seven2s

and seven 3s), delete the middle column, because labels cannot be imported
back into a CanoDraw project. Select the two remaining columns (only the
first 29 rows with column labels and data) and copy them to the Windows
Clipboard. Switchback to theCanoDrawprogramandselect theProject> Import
variables> From Clipboard command. CanoDraw displays a dialog box in which
youmust change the option on the left side from Samples to Environm. variables.
Keep the option First column contains indices selected (checked). Then you should
click the Import button.
Additionally, you need to classify the environmental variables into seven

classes, depending on which treatment they belong to. Use the Project >

Classify>Env.variablesandclick theNewselectbutton. In theManualClassification
dialog, you must define the seven classes corresponding to individual treat-
ments (use the Add class button) and place the interaction terms in the appro-
priate classes (keep the Continue with Class Members dialog option checked when
defining the class name), as illustrated in Figure 15-7. When you close the
Manual Classification dialog, make sure you selected the Use this classification in
diagrams option.
Finally, to create real curves, not only a scatter of points, you must define

a series collection for environmental variables. Each of the treatment types
will become a separate series in the collection, with the four interaction terms
arranged in the order of increasing year value. You canuse the just-created clas-
sification to make the definition of series collection easier. Select the Project >

Define Series of > Env. variables command and select the From class button. Select
the (only one) classification offered in the next dialog. Check in the Series
Collection dialog box that the four interaction terms within each series are
ordered so that the year value increases. If not, drag the items to their appro-
priate position in the right-hand listbox. After you close the dialog with the
OK button, make sure that the This collection is used . . . option is checked.
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Figure 15-7. Classification of environmental variables based on the treatment type.
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Figure 15-8. PRC1 diagram, the first attempt.

To create the PRC diagram, select the Create > Attribute Plots > XY(Z) Plot
command. Select the Imported data > For env. variables > Time variable in the
X VARIABLE field and, similarly, the PRC1 variable in the Y VARIABLE field.
Select the None option in the PROPERTIES > Labelling area and also None in
the VISUALIZATIONMODEL area. After you click the OK button, the diagram
is created (see Figure 15-8). If you do not see the legend at the bottom of your
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diagram, you can enable it in the Appearance page of the Project> Settings dialog
box. Note however, that the diagram is somewhat inefficient in reproducing
the results, so wewill modify it anyway.
Wewill not describe all the changes needed tomake the final PRC diagram,

but we will outline them here (the resulting diagram is part of the extended
PRC diagram, shown in Figure 15-10):

1. We encoded the treatments by line type, not by line colour. The lines for

treatments where fertilization was involved are substantially thicker

than the other lines. The lines for treatments including the removal of

Molinia have a dashed style, and lines where themowing treatment was

included are grey, not black.

2. We have added the reference line for control treatment to the legend and

also to the plot (it overlays the horizontal axis line).

3. Symbols were removed from both the plot and the legend. The legend

framewas removed and the layoutmademore condensed.

4. The labelling of the horizontal line was deleted (theminimum and

maximum) and the positions of individual years were labelled.

ThePRCdiagramcanbe substantially enhancedbyavertical1-Dplot, show-
ing the scores of species on the first RDA axis. We can then combine the value
read from a PRC curve with a species score to predict the relative change of the
species abundance (or cover, in our case) at a particular treatment and time.
Before creating the plot, wemust limit the set of plotted species only to species
with a reasonable fit to the first RDAaxis. It can be assumed thatwe canpredict
the expected abundances only for such species.
Select the Project > Settings command and in the Inclusion Rules page change

the Species value in the Lower Axis Minimum Fit area from 0 to 7. Only 20 ‘best-
fitting’ species will be selected from the total of 86 species. Note that use of the
values in the Species Fit Range area is not correct in this context, because species
with their abundances fitted badly by the first RDA axis but well by the second
RDA axismay become selected.
To create a 1-D plot, we should use an XY diagram with constant

X coordinates. Note, however, that CanoDraw will, by default, stretch even
the negligible range of the X values in such a diagram. We need to control the
shape of the resultingdiagram, so that it is tall andnarrow.Todo so, select first
the View > Diagram Settings command and check the Adjust graph aspect ratio in
the Properties 1 page.While here, we canmake the vertical axis of the upcoming
diagram more informative by switching to the Properties 2 page, checking the
option All tickmarks with labels, and un-checking (deselecting) the option Labels
on vertical axis are rotated.
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Figure 15-9. Creating a vertical 1-D plot with plotted species scores on the first
RDA axis.

Now select the Create > Attribute Plots > XY(Z) Plot command. In the X VARI-
ABLE area, select the Analysis Results > Species scores and there the Constant item
near thebottomof the list. In theYVARIABLE area selectAnalysisResults> Species
scores and then Spec.1 item. Keep the other options at their default values (see
Figure 15-9). When you click the OK button, CanoDraw first displays a dialog
named Aspect ratio for 45-deg. banking. Change the default value to 8. This will
make the diagram a rectangle eight times higher than is its width.
Wepolished the resultingdiagramto someextent∗ before combining itwith

the modified PRC diagram. The final presentation of the PRC analysis is dis-
played in Figure 15-10.
The PRC diagram shows that there are two directions of departure from the

vegetation composition on the reference plots (which are not mown, no fertil-
izer is addedto themandMolinia caerulea isnot removed fromthem).Themown
plots (with negative PRC scores) have a higher abundance of Nardus stricta, of
several small sedges (Carex pallescens, Carex panicea), and also of many forbs.
Also themosses (such as Aulacomniumpalustre or Rhytidiadelphus squarrosus) have
amuchhigher cover. The extent of themowing effect is somewhat smaller than
the oppositely oriented effect of fertilization, shown by the lines directed to
the positive side of the vertical axis. The fertilized plots become dominated by

∗ Removed Spec.1 label for vertical axis; removed horizontal axis labels; removed right-hand vertical axis
line; changed species symbols, and adjusted labels position to the right side of the reference line. The
two diagrams (with curves and species) were finally combined in the Adobe Photoshop program. Note
that only the zero values on the vertical axesmust be aligned, but not the scale of the axes.
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Figure 15-10. Final diagramwith principal response curves.

competitive grass species (Deschampsia cespitosa, Festuca pratensis, Poa spp.) with
only a few forbs (e.g. the tall forbAngelica silvestris) increasing their cover. There
is only a limited effect of dominant grass removal, and it is similar to the effect
of mowing (the dashed lines are generally at lower positions than the corre-
sponding solid lines).
The extent of increase in the cover of grasses such as Festuca pratensis,Poa spp.

or Festuca rubra can be quantified using the rules specified in Section 8.3.11.2 of
the CANOCO referencemanual (Ter Braak & Šmilauer 2002). The scores of the
three grass species are around the value of +1.5. If we look up the PRC score
of the fertilized-only plots (F in the diagram) in the year 1997, we see that it is
approximately+0.5. The estimated change is, therefore, exp(1.5 · 0.5) = 2.12,
so all the three grasses are predicted to have, on average, more than two times
higher cover in the fertilized plots compared with the control plots.
The variability of PRC scores in the year 1994, observed on the left side of

the diagram, cannot be caused by the experimental treatments (which were
started afterwards), so it provides a ‘yardstick’ tomeasure the backgroundvari-
ability among the plots. This suggests that there is probably no real difference
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Figure 15-11. PRC diagram for the first RDA axis. Themowing-only regimewas
taken as the reference (control) treatment.

among the three treatments, where fertilization was combined with mowing
and/or with removal ofMolinia. Likewise, the mown plots did not differ from
those where the removal treatment was added tomowing.
Wehave already discussed at the beginning of this section how the unmown

plots may not be the best choice for control treatment. If you want to use the
mown but unfertilized plots without Molinia removal as the reference level,
the only change to be made in the CANOCO project is to remove the interac-
tion terms including the M treatment, and add instead four new interactions
between year indicators and the 0 treatment.
If you create a new PRC diagram using the modified analysis (see

Figure 15-11), the only change is that the identity of the reference line, which
is ‘rectified’ (flattened) along the horizontal axis, has changed. The scores of
species on the first RDA axis (the right side of the plot) have not changed at all
and this assures us that the interpretation of the PRC curves has not changed
either.
Finally, we can compare the information you obtain from summarizing the

standard constrained ordination (as presented in Section 15.6) using an ordi-
nation diagram such as the biplot diagram in Figure 15-2, and that from the
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PRC diagram (e.g. Figure 15-10). It should be noted that the analyses and cor-
responding diagrams are not the only possible ones and you should proba-
bly run more of them when evaluating your research data. For example, the
constrained analyses with time coded as a categorical variable could also be
graphed, and the partial PRC analysis can be constructed for each of the fac-
tors separately, using the other ones as covariables. Also, you could compare
thespecies scoresonthefirstprincipal responseaxiswithspecies traits (andyou
would find that species with positive scores, i.e. those most positively affected
by fertilization, are the tall species).
However, when submitting a paper manuscript, one usually has very

restricted space, so only a small selection of the performed analyses can be pre-
sented in graphical form: only the most instructive diagrams are needed. The
PRC diagram is superior in its display of temporal trends. In our example,
the PRC diagram clearly shows that the development of plots diverges accord-
ing to the treatment during all the years, particularly for the fertilized plots
(and in this way confirms that the use of time as a quantitative variable is a
goodapproximation). In a longer runof the experiment,wewouldprobablybe
able to find some stabilization and could estimate the time needed to achieve
a ‘stable state’. On the contrary, the classical diagram is better at showing the
affinities of individual species to the treatments (which one ismore responsive
to mowing, and which to fertilization), and also the mutual relationships of
the effects (the similarity of effects of mowing and dominant removal). The
information presented in the two diagrams is partially overlapping, and par-
tially complementary.
Based on the combined information from all the analyses, we would con-

clude that many species (particularly the small ones) are suppressed by either
the fertilization or by the absence of mowing or by a combination of both fac-
tors. Only a limited number of (mostly tall) species is favoured by fertilization.
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Case study 6: Hierarchical analysis of
crayfish community variation

In this chapter, wewill study the hierarchical components of variation
of the crayfish community in the drainage of Spring River, north cen-
tral Arkansas and south central Missouri, USA. The data were collected by
DrCamilleFlinders (Flinders&Magoulick2002,unpublishedresults).Thesta-
tistical approach used in this study is described in Section 9.2.

16.1. Data and design

The species data consist of 567 samples of the crayfish community
composition. There are 10 ‘species’, which actually represent only five cray-
fish species, with each species divided into two size categories, depending
on carapace length (above or below 15 mm). Note that the data matrix is
quite sparse. In the 5670 data cells, there are only 834 non-zero values.
Therefore, 85% of the data cells are empty! This would suggest high beta
diversity and, consequently, use of a unimodal ordination method, such as
CCA. There is a problem with that, however. There are 133 samples with-
out any crayfish specimen present and such empty samples cannot be com-
pared with the others using the chi-square distance, which is implied by
unimodal ordination methods. You must, therefore, use a linear ordination
method.
The sampling used for collecting data has a perfectly regular (balanced)

design. The data were collected from seven different watersheds (WS). In
each, three different streams (ST) were selected, and within each stream, three
reaches (RE) were sampled. Each reach is (within these data) represented by
three different runs (RU) and, finally, each run is represented by three dif-
ferent samples. This leads to the total of 567 samples = 7 WS · 3 ST · 3 RE · 3
RU · 3 replicates. These acronyms will be used, when needed, throughout this
chapter.

236
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Table 16-1.Analyses needed to partition the total variance in the crayfish
community data

Variance Environmental Permuting Whole-plots
component variables Covariables in blocks represent

Watersheds WS None No ST
Streams ST WS WS RE
Reaches RE ST ST RU
Runs RU RE RE None
Residual None (PCA) RU n.a. n.a.

Total None (PCA) None n.a. n.a.

Bothdata tables are stored in the scale.xlsExcelfile, species compositiondata
in the species sheet, and thevariabledescribing the samplingdesign in the design
sheet.
When performing the variance decomposition, you must partition the

total variance into five different sources, using the method summarized in
Table 16-1.
Note that in the permutations tests assessing the effects of spatial scales

(watersheds, streamsandreaches)uponthecrayfishcommunity, the individual
samples cannot be permuted at random. Rather, the groups representing the
individual cases of the spatial levels immediately below the tested level should
be held together. This can be achieved using the split-plot design permutation
options.

16.2. Differences among sampling locations

You will start your analyses with a ‘standard’ PCA, in which you will
not constrain the ordination axes and youwill not use any covariables. Instead,
the indicator variables for the watersheds and streams are passively projected
to the ordination space to visualize the degree of separations at the twohighest
spatial levels.Note that you could alsouse the indicators (dummyvariables) for
the lower spatial levels, but the resulting diagramwould be too overcrowded.
Thefirst step youmust perform is to export the data sets intoCANOCOdata

files, usingWCanoImp.You canuse thenames scale sp.dta and scale en.env for the
data files. Note that in the design sheet, the first six columns (date to sample) do
not have an appropriate coding, so youwill not use them in your analyses.
Create a new CANOCO project named cray tot.con and specify an indi-

rect (unconstrained) analysis with scale en.dta used as environmental variables,
which are passively projected to the resulting ordination space. Analysis type
is PCA and you should keep the default values for the other options. Ask for
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deletion of environmental variables and in the Delete Environmental Variables
wizardpagekeeponly thevariables9 to36 (English toWest3) in the left-handcol-
umn.Consequently, only the positions of the sevenwatersheds and the21 (7·3)
streamswill be projected to PCA ordination space.
Create a new project for this analysis in the CanoDraw program and start

by specifying all the retained environmental variables as nominal (Project >

Nominal variables> Environmental variables). Some of the crayfish species are not
well correlatedwith themain gradients of species composition (principal com-
ponents), so their presence in the diagram provides limited information. To
suppress them, select the Project > Settings command and in the Inclusion Rules
page change the 0 value in the From field of the Species Fit Range area to 2. This
change excludes three of the 10 ‘species’, that have less than 2% of their vari-
ability explained by the first two PCA axes.
Create a biplotwith species and environmental variables (they are presented

as centroids of samples, because you specified them as nominal variables)
using theCreate>Biplotsand JointPlots> Species andenv. variables command.Note
that the diagram content is dominated by the difference of the Baywatershed
from the other ones, so most of the location centroids are concentrated in the
middle of the diagram. Therefore, we present here the same information split
into two diagrams. In the first (Figure 16-1) diagram, only the centroids for
watersheds are shown, together with the arrows for selected species. This dia-
gram indicates that themain gradient of species composition change is related
to increasing abundance of the punct crayfish species, and that the difference
of the samples from the Baywatershed can be explained by the more frequent
occurrence of the two ‘oz-X’ taxa.
The other diagram (Figure 16-2) shows only the central part of the previous

ordination diagram, and shows centroids not only for the watersheds (black
squares), but also for each of the three streams within each watershed (grey
squares), except the Bay, Bay2 andWf3 centroids, cut off from the diagram.
You can see that while the positions of some stream triples are clustered in

the proximity of their parental watershed, the difference among the streams is
much higher for others (such as Bay, but also Pinehill ).
The relevant part of the analysis log for this PCA is shown here:

*** Summary ****

Axes 1 2 3 4 Total variance

Eigenvalues : 0.382 0.192 0.128 0.096 1.000

Species-environment correlations : 0.472 0.745 0.640 0.599

Cumulative percentage variance

of species data : 38.2 57.4 70.2 79.8

of species-environment relation: 27.3 61.6 78.5 89.5

Sum of all eigenvalues 1.000
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Figure 16-1. First two PCA axes, with crayfish species and projected watershed
centroids.

The total variation in the species data is, of course, equal to 1.0, because
CANOCO standardizes in this way the species data values in linear ordination
methods. Thiswillmake it easier for us to read the explained variance fractions
in the other analyses. The first two principal components explain more than
57% of the total variation in crayfish community composition.

16.3. Hierarchical decomposition of community variation

Nowyouneed to create a separate CANOCOproject for each of the spa-
tial levels youwant to evaluate (see Table 16-1). Note that, in fact, you can omit
calculations for one of the levels, because the fractions sum up to 1.000. Prob-
ably the best choice for omission is the residual variation (within-runs vari-
ance), as there is no meaningful permutation test and defining the indicator
variables (to be used as covariables in the partial PCA) for individual runs is
quite tedious.∗ We will not provide detailed instructions for all the projects

∗ Youwill need to do exactly this anyway in the analysis of the effect at runs level, where the runs will
represent environmental variables.
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Figure 16-2. First two PCA axes, with projected centroids of watersheds and
streams.

you must set up here, but if you feel confused you can always look at the cor-
respondingCANOCOprojects, which are defined in the sample data collection
(see Appendix A).
Start with the analysis described in the first row of Table 16-1. This analysis

has no covariables, and the seven watershed indicator variables are used as the
environmental variables (see Figure 16-3).
Do not ask for forward selection of environmental variables, but in the

GlobalPermutationTestpage ask for Significance of canonical axes together.We cannot
a priori expect for only the first canonical axis to summarize all the differences
in crayfish community composition among the watersheds (or the other kinds
of location in the following analyses), so we should base our test on the whole
canonical space. We suggest you specify only 199 permutations, as the calcu-
lations for this large dataset can take a relatively long time. On the next setup
page, ask for Restricted for spatial or temporal structure or split-plot design and select
the Split-plot design option on the page after that.
When you arrive at the Split-Plot Design I setup wizard page, you must spec-

ify the size of whole-plots. As you remember from the introductory section,
we will permute individual streams, keeping all the reaches of a particu-
lar stream together. Therefore, all the samples within each stream represent
one whole-plot. Therefore, there are 27 split-plots within each whole-plot
(3 repl · 3 RU · 3 RE), so select this number. The samples representing one
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Figure 16-3. Thewatershed indicator variables are retained as environmental
variables when testing variation explained at the watershed level.

whole-plot are contiguous in the dataset, so you can keep the default settings
(take 1, skip next 0) on the right side of the setupwizard page (using take 27, skip
next 0would have the same effect, of course).
In the next, Split-Plot Design II page, specify free exchangeability of the

whole-plots (streams) andnopermutation for the split-plots. After you analyse
theproject (crayf ws.con), you candetermine the amountof variability explained
by the streams from the Summary table, using the Sumof all canonical eigenvalues
row (the last one).

**** Summary ****

Axes 1 2 3 4 Total variance

Eigenvalues : 0.075 0.059 0.039 0.011 1.000

Species-environment correlations : 0.540 0.565 0.427 0.329

Cumulative percentage variance

of species data : 7.5 13.4 17.3 18.5

of species-environment relation: 39.7 71.0 91.7 97.8

Sum of all eigenvalues 1.000

Sum of all canonical eigenvalues 0.189

The watersheds explain 18.9% of the total variability in crayfish commu-
nity data. CANOCO also reports in the analysis log about the permutation test
results. Because you specified some restriction on the permutations (the split-
plot design), CANOCO displays the indices of samples that were assigned to
individual parts of the design structure. This is useful for cross-checking the
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correctnessof the specifiedpermutation structure.Theactualpermutation test
results show that none of the 199 permuted (randomized) datasets produced
as large an amount of variability explained by watersheds as the true data con-
figuration, because we achieved the smallest possible type I error estimate (i.e.
(0 + 1)/(199 + 1) = 0.005).
The next step (second row inTable 16-1) quantifies the variability explained

at the streams level. We will use the ST variables (Bay1 up toWest3) as the envi-
ronmental variables and the sevenWSvariables (thenexthigher spatial level) as
the covariables. Because we do not want to involve the differences between
watersheds in the permutations simulating the null model, wemust permute
the whole-plots (the next lower spatial level, i.e. the reaches) randomly only
within each of the watersheds. Therefore, we will not only have the split-plot
design restrictions on the permutations, but we will also permute in blocks
defined by the covariables. So the important difference in the new project
(crayf st.con) setup is (in addition to specifying different environmental vari-
ablesandaddingthewatershed indicatorsas covariables) in thePermutationType
page, where you should check the Blocks defined by covariables option (and select
the Restricted for . . . option, of course). A new setup page will appear, asking
you to select which covariables define the blocks. You should select all seven
variables here. In the Split-Plot Design I page, the number of split-plots in each
whole-plot is 9 (3 repl · 3RU, in every reach).
You can see in the analysis results that streams explain 12.3% of the total

variability and that this is a significantlynon-randompart of the total variation
(P = 0.015).
The next analysis is similar to the one you just performed, except youmove

one level down in the hierarchical spatial structure: the placement of samples
in reaches (coded by variables with their names ending with R1, R2 and R3) is
used as environmental variables, and the 21 stream indicators are used as co-
variables. You should permute within blocks defined by these covariables and
use the split-plot structure,where thewhole-plots are the individual runs (each
with three samples− split-plots). The variability explained at the reaches level
is estimated as 15.8% of the total variability and the type I error of the permu-
tation test is estimated as P = 0.005.
The last variance component you will estimate is the variation between the

runs.Therunsarenot codedwith individualdummyvariables in the scale en.env
data file, so you must delete all the environmental variables in the setup wiz-
ard, and ask for definition of interaction terms for environmental variables.
In the Interactions of Environmental Variables page, you should define all possible
pair-wise interactions between the 63 reaches and the three variables named
Run1, Run2 and Run3. Note that the Runx variables code for run membership
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Table 16-2.Results of variance decomposition

Explained Mean square
Component variability (%) DF value Test significance

WS 18.9 6 3.150 0.005
ST 12.3 14 0.879 0.015
RE 15.8 42 0.376 0.005
RU 19.5 126 0.155 0.005
Residual 33.5 378 0.089 n. a.

Total 100.0 566 0.177 n. a.

within the context of each individual reach (i.e. the first runwithin a reach has
values 1, 0, 0 for these three variables for every reach). Therefore, youmust de-
fine 189 interaction terms here! When specifying the permutation you should
ask for unrestricted permutations (i.e. no split-plot design), but within the
block defined by covariables (i.e. within the individual reaches). The variation
explained at the runs level is 19.5% of the total variance. The significance level
estimate is P = 0.005.
Finally, you can deduce the amount of variability explained by the differ-

ences between the samples within runs by a simple calculation: 1.0 − 0.189 −
0.123 − 0.158 − 0.195 = 0.335.
The results of all the analyses are summarized in Table 16-2.
The table includes not only the absolute fraction of the explained variation,

but also the values adjusted by the appropriate number of degrees of freedom.
These are calculated (similar to a nested design ANOVA) by multiplying the
number of replications in each of the levels above the considered one by the
number of replications at the particular level, decreased by one. Note that by
the number of replications, we mean number within each replication of the
next higher level. For example, there are seven watersheds, each with three
streams, and each streamwith three reaches. Therefore, number of DFs for the
reach level is 7 · 3 · (3 − 1) = 42.
It is, of course, questionable which of the two measures (the variation

adjusted or not adjusted by degrees of freedom) provides more appropriate
information. On one hand, the reason for adjusting seems to follow naturally
from the way the sum of squares is defined.∗ On the other hand, it seems quite
natural to expect the increasing variation at the lower hierarchical levels: there

∗ It does notmatter here that we use the data which were standardized to total sum of squares equal to
1. All the components are calculated with the same standardization coefficient – the total sum of
squares of the data does not vary across the individual projects.
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must always bemore reaches than there are streams or watersheds, so a higher
opportunity for crayfish assemblages to differ.
In any case, the variation at the watershed level seems to be relatively high

compared with the other spatial scales, and all the spatial scales seem to
say something important about the distribution of crayfishes, given the fact
their ‘mean-square’ terms are substantially higher than the errormean-square
(0.089).
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Case study 7: Differentiating two species
and their hybrids with discriminant
analysis

While we can think of potential applications for linear discriminant
analysis (LDA) in ecology (such as finding differences in habitat conditions
among a priori recognized community types), its real use is quite infrequent.
This isprobably causedbythe fact thatmanyproblemsthat seemtobeagoodfit
for discriminant analysis produceweak rather than convincing results. A good
example of thismight be an attempt to use discriminant analysis for the selec-
tion of plant species indicating aparticular community type. Thediscriminant
analysis then attempts to separate the community types using a linear com-
bination of species abundances. However, because the species occurrences are
often strongly correlated and each of them alone provides little information,
it is usually impossible to single out few such diagnostic species, even if the
species composition differs strongly among the distinguished types. We will
therefore use an example from a numerical taxonomy here, in the hope that
the topic will be easily understood by ecologists and that they can apply the
hints provided to their own problems.

17.1. Data

The sample data were taken from a taxonomic study∗ of several
species of Melampyrum, hemiparasitic plants from the Scrophulariaceae fam-
ily. Eighty plant specimens were measured, selected from four taxonomic
groups: M. bohemicum from Czech localities, M. bohemicum from Austrian
localities, hybrid populations ofM. bohemicum × M. nemorosum, andM. nemoro-
sum. Each group was represented by 20 specimens, originating usually from
several local populations. You will be looking for the plant vegetative and

∗ Štech (1998); only a small subset of the collected data is used in our case study.
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flower-related characteristics, which would allow the four taxonomic groups
to be distinguished.
Thedata are contained in themelampyr.xlsExcel spreadsheetfile. Everything

is contained in a single sheet, the actual measurements coming first, followed
by the information important for a post-analysis modification of the biplot
(BipE) scores of selected characteristics, which will be described later in this
chapter.
Thefirst column,namedGroup, identifies the taxonomic group towhich the

particular observation (row) belongs. Note that this coding cannot be used in
CANOCO, so the same information is present in expanded form in the next
four columns.The individual levels (1–4) of theGroup variable are re-coded into
fourdummy (0/1) variables,whichalsohavemore informativenames.Thenext
22 columns (S1 to SDU2) contain various types of measurements taken mostly
on the flowers or on the bracts, which are parts of the inflorescence. The mea-
surement unit is millimetres. We will not explain the meaning of individual
characteristics here, but those selected for discriminationwill be characterized
later in the chapter.
CANOCO requires that the response and the explanatory variables reside in

separate input files. Therefore, we will export the classification of plants into
one file and the values of the 22 morphological characteristics into another
one. Select the data in columns B to E and copy them to the Windows Clip-
board. Store the classification in a file namedmel clas.dta, using theWCanoImp
program. Remember to check the [Generate labels for] Samples option, as the
individual rows have no labels. Export the morphological measurements in
spreadsheet columns F to AA to another file, named mel char.dta, in a similar
way. It may be worthwhile considering log-transformation of the measured
dimensions, but wewill ignore this issue in our tutorial.

17.2. Stepwise selection of discriminating variables

Create a new CANOCO project – we will use species data (mel clas.dta,
the classification of the ‘samples’ into four groups) and environmental vari-
ables (mel char.dta, the morphological measurements), and specify a con-
strained analysis on the same page. Specify the names of data files and
mel cva.sol as the name of the solution file (and, later on,mel cva.con as the name
of CANOCO project) on the next page. Specify canonical correspondence ana-
lysis (CCA)onthe followingpage. In theScalingpageof thesetupwizard, specify
focus on Inter-species distances and theHill’ s scaling option. Keep the default set-
tings for the other options, up to the Forward selection page, where you should
specify the Manual selection option. Make sure that the use of Monte Carlo
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Figure 17-1. Dialog displaying first step of the forward selection procedure.

permutation tests is enabled, and specify 999 for the number of permutations.
On the next wizard page, specify unrestricted permutations.
Click the Analyze button to start the stepwise selection of discriminating

variables. When the Forward Selection Step dialog appears for the first time (the
list with selected variables at the dialog bottom is empty), the marginal (inde-
pendent) effects of individual characteristics are shown (see Figure 17-1).
You can see that the discrimination ability differs substantially among the

individual characteristics. The variable S1 (width of lowest bract) explains
0.862 from the 1.889 of the total explainable inertia (i.e. almost 46% of the
total variation explainable by all the 22 characteristics). If you wish, you can
check the significance of the marginal effects of individual measured charac-
teristics by selecting in turn each characteristic in the list and clicking the Test
variable button. Be careful not to click the Include variable button (or to press the
Enter key, because that button is selected by default). When you include a vari-
able, the inclusion is irreversible for the particular analysis run. If you check
the marginal effects, you can see that almost all the variables have some dis-
criminating power, except the last four characteristics in the list (DDP, KT2,OT
and V1).
If you did not perform the tests, do the test on the first (the best) candidate

variable S1 now. A dialog named Report on Permutation Test appears. As you can
see the type I errorprobability value is estimated tobe0.0010. This is, of course,
the lowest achievable valuewhenwe use 999permutations. Select this variable
using the Includevariablebutton.CANOCOmoves thevariable into the lower list
(and shows it there with the recently estimated significance level). As you can
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see, ordering of the remaining candidate characteristics changed somewhat –

those that were more correlated with the S1 variable decreased in their impor-
tance after S1was selected (particularly the SDU2 variable).
You can continue with the selection of the best candidate in each step (the

one at the top of the list) until the type I error probability exceeds a threshold
selected apriori. Thequestion iswhich value touse as the threshold. If youwant
to have a well-discriminating group of descriptors that have a significant rela-
tionship with taxonomic group membership at the level 0.05 and you accept
the reasoning behind the adjustment of acceptance thresholds at the partial
decision steps (the Bonferroni correction, see Section 5.9 for additional com-
ments), there are atmost22decisions tobemadeduring the selectionof22pre-
dictors. Therefore, with the a priori selected threshold level of 0.05, you should
accept individual predictors with estimated type I error probabilities below
the 0.05/22 = 0.0023 value. When you apply this threshold to these data, you
should accept, in addition, the SHU1 variable (width of upper calyx teeth) and
the CT variable (length of corolla tube), both with the type I error estimates
equal to the lowestachievablevalue (0.001).Butbecause theprimarygoalofdis-
criminant analysis is to create reliable discriminating rules, we suggest that a
little redundancy won’t hurt (at least for a variable with significant marginal
effect), so we suggest you also accept the next candidate, the DHP variable
(length of the upper lip of the corolla), despite its significance estimate of
about 0.025. Note that these four best variables explain more than 79% (1.498
of 1.889) of the variation that would be explained by all the 22 descriptors
together. End the forward selection now using the Stop selection button.
CANOCO displays in its Log View the Summary table of the performed

analysis:

**** Summary ****
Total

Axes 1 2 3 4 inertia

Eigenvalues : 0.872 0.406 0.221 0.779 3.000
Species-environment correlations : 0.934 0.637 0.470 0.000
Cumulative percentage variance

of species data : 29.1 42.6 49.9 75.9
of species-environment relation: 58.2 85.3 100.0 0.0

Sum of all eigenvalues 3.000
Sum of all canonical eigenvalues 1.498

Note that toobtain theeigenvalues traditionallyusedtocharacterize thedis-
criminant scores (θ), youmust transform the values provided in this summary
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(λ) using the formula:

θ = λ/(1 − λ)

which is 6.81, 0.68 and 0.17 for the three canonical (discriminant) axes. Note
that the Total inertia is equal to the number of groupsminus one.

17.3. Adjusting the discriminating variables

Before we can create a CanoDraw project from this canonical variate
analysis (CVA) project, we should define an additional CANOCOproject, which
we will use to obtain the information needed to adjust the lengths of environ-
mentalvariables’ arrows, so that theybetterexpress theirdiscriminatingpower
(see Section 8.4.3.1 of Ter Braak & Šmilauer 2002, for additional discussion).
The biplot scores in a standard ordination diagram enable comparison among
the environmental variables using the variable standard deviation as the scal-
ing unit. But for the discriminant analysis, a better reference scale is provided
by thewithin-group standarddeviation (i.e. thewithin-groupvariability of the
environmental variables). To correct the lengths of arrows, represented by the
values in the BipE scores section in the solution file from the project just ana-
lysed, you must obtain support information about the between-group varia-
tion of the individual predictor variables (see Section 8.4.3.1 of Ter Braak &
Šmilauer 2002, formore details).
Define a new CANOCO project (named, for example, mela rda.con, and pro-

ducing themela rda.sol solutionfile). Specify constrainedanalysis – RDA – using
the mel char.dta as the species data and mel clas.dta as the environmental data
(note that this assignment is reversed compared with the preceding discrim-
inant analysis). Specify post-transforming of species scores (dividing by stan-
darddeviations) and scaling focusedon inter-species correlations, andcentring
byspecies. In theDataEditingChoicespagespecify thatyouwant toDELETE some
Species. Then, in the Delete Species page, delete all the characteristics except the
four retained during the forward selection in discriminant analysis (i.e. S1, CT,
DHP and SHU1). Select neither forward selection nor a permutation test. Ana-
lyse the project and look up in the resulting solution file the CFit section. The
%EXPL column contains the information we need to calculate correction fac-
tors for the BipE scores in the mel cva solution file. The required calculations
are illustrated in Table 17-1.
You must calculate the f factor (as 100 / (100−%EXPL) for each environ-

mental variable) and then multiply its square-root by the BipE score-values
in the other solution file (mel cva.sol) to obtain the modified BipE score. The
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Table 17-1.Calculating adjustment factors for biplot scores,
using the information from theCFit section of themel rda.sol file.
Columns not relevant to calculations were omitted

N Name % EXPL f sqrt( f )

2 S1 86.2 7.246 2.692
5 CT 26.55 1.361 1.167
8 DHP 23.52 1.308 1.143

15 SHU1 40.21 1.673 1.293

Table 17-2.Original and transformed biplot scores of species traits

Biplot score

N Name Original Modified

2 S1 0.3544 0.1059 0.0343 0.9540 0.2851 0.0923
5 CT 0.0360 0.3861 0.7398 0.0420 0.4506 0.8633
8 DHP −0.1045 0.4857 0.0013 −0.1194 0.5552 0.0015

15 SHU1 0.0924 0.7095 0.0486 0.1195 0.9174 0.0628

original and the modified BipE scores are shown in Table 17-2. Note that you
must open the mel cva.sol file in the Notepad program and replace the num-
bers present there with the new ones, using the same number of decimal
digits.
Then you can save the modified solution file, close the mel rda.con project,

and start CanoDraw from the original,mel cva.con project. CanoDrawwill read
the changed solution file and plot the morphological characteristics with the
modified arrow lengths.

17.4. Displaying results

To plot the first two discriminant axes, you should just use Create >

Biplots> Biplots and Joint Plots> Species and env. variables. Before doing that, how-
ever, select theView>DiagramSettings commandandmake sure that in the Prop-
erties 1 page the Show rescaling coefficients . . . option is selected. While there, you
canuncheck theRescale sample or species scores to optimality option, aswewill need
this option disabled for the second diagram we create in this project. While
you create the biplot with species (the taxonomic groups) and environmental
variables (the selectedmorphological characteristics), the Rescaling of ordination
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Figure 17-2. Diagram displaying first two discriminant axes. The discriminating
characteristics and the centroids of classes are shown.

scoresdialogappears,withavalueof1 suggested forboth the SpeciesandExplana-
toryvariables.We suggest youchange the scaling factor for explanatoryvariables
to, say, 5, to make the arrows longer. The resulting plot (with adjusted label
positions and text of the group labels) is shown in Figure 17-2.
It is obvious that the two involved species can be distinguished primarily

using the S1 characteristic, which has higher values forM.nemorosum. The hyb-
rids differ from both parental species in higher values ofDHP, CT and SHU1.
To evaluate the degree of separation among the groups of plants, we must

plot the diagram with sample scores. Note that the Mahalanobis distances
(Mahalanobis 1936) amongthe individualobservationsarepreservedwhenthe
scaling is focused on inter-species distances and this is why we disabled the
automatic adjustment of sample scores in theDiagram Settings dialog box.
The separation among the classes is best seen if the points corresponding

to different classes are shown with different symbol types and if an envelope
encloses all the points belonging to a particular class. In addition, we do not
need to have individual observations labelled.
Start with the Project > Classify > Samples command. Click the New from data

button and select all four dummy variables in the Species category and check
the Combine dummy variables option at the dialog bottom. Click the Create but-
ton and confirm the resulting classification with the OK button in the next
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Figure 17-3. Canonical scores of individual plants on first two discriminating axes.

dialog.When you return to the Available Classifications dialog, check theUse this
classification . . . option and Close the dialog.
Now you should go into the Project > Settings dialog and check the Draw

envelopes around Classes of – Samples option in the Contents page. Then move to
the Appearance page and select the None option in the Labelling of scores> Sample
labels. You can also ask for creation of a diagram legend in this page.
After you close this dialog, execute the Create > Scatter Plots > Samples com-

mand. The resulting diagram is shown in Figure 17-3.
Note that the two groups representingM. bohemicum populations collected

in two countries overlap substantially, while the hybrid plants overlap only a
little with theM. bohemicum parent and there is no overlap of theM. nemorosum
group with any of the other groups. The diagram is adjusted by differentiat-
ing line styles for group envelopes and the filling and symbol type options, to
make thegraph easier to read fromagrey-scale output.Additionally, the group
names are slightly edited.



Appendix A:

Sample datasets and projects

The sample datasets, Canoco and CanoDraw project files, and the files
with results of the analyses discussed in this book are available from our web
site: http://regent.bf.jcu.cz/maed/
You can download the sample files from there and find additional informa-

tion, including errata and additional notes about the topics discussed in this
book.
The sample files are available in compressed ZIP files, either separately for

each chapter or in one large ZIP file, containing all the files.
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Appendix B:

Vocabulary

Terms in bold text are listed as separate entries in this Appendix.

Attribute plot Scatter diagram based on sample scores and displaying a
particular attribute of samples (values of selected species,
selected environmental variable, diversity of species
composition etc.)

Biplot Ordination diagram displaying (at least) two different types
of objects (e.g. species and samples or samples and
environmental variables) that can be jointly interpreted
using the biplot rule (see Section 10.1)

Canonical axis,
Constrained axis

Axis of the ordination space which is constrained to be
defined by a linearmultiple regressionmodel using the
selected environmental variables as predictors

Centring Change of values of a variable, respecting particular context;
for example, all the values of a particular variable are changed
using a shared transformation ‘recipe’ to achieve zero average
value. Centring is, in contrast to standardization, performed
by a subtraction (or addition) operation

Covariables Also named covariates in other textbooks or statistical
software. These are explanatory variableswith their effects
upon the response variables (species data) acknowledged, but
not of primary interest. The covariables are used in partial
ordination analyses, where their effect is partialled out of the
ordinationmethod solution

Degrees of freedom Measure of complexity (‘number of parameters’) of a
statistical model. DFs are also used to express amount of
information left in the statistical sample after information
has been extracted with amodel
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Dummy variable A variable with 0 and 1 values (most often), coding a particular
level of anominal (factor) variable

Eigenvalue Measures the importance of the ordination axis, expressed as
the amount of variability in the primary data (response
variables, species data) explained by the corresponding axis.
This is a specific interpretation of this term, which has amore
general meaning in thematrix algebra

Environmental
variables

These are the explanatory variables in the ordination
methods that are of primary interest for interpretation. The
other kind of explanatory variable is a covariable. A
particular variablemight act as the environmental variable in
one analysis and as the covariable in another one

Explanatory
variables

Variables used to explain directly (in constrained gradient
analysis) or indirectly the variability in the primary (species)
data. Depending on their semantic role in the particular
analysis, they are further classified either as environmental
variables or as covariables

Gradient analysis A (mostly) multivariate statistical methodwhich attempts to
explain the abundances of species (or, more generally,
of any response variables) using continuous (quantitative)
explanatory variables. In the typical context, these variables
are supposed to correspond to a variation of the environment,
but they do not need to be directlymeasured (e.g. in indirect
ordinationmethods). The position of individual samples is
determined along the calculated gradients.Ordination
methods are a specific group of gradient analysis methods (see
Chapter 3)

Joint plot Ordination diagram displaying (at least) two different types
of objects (e.g. species and samples) that are jointly
interpreted by the centroid principle and not by the biplot
principle (see Section 10.2)

Linear ordination
methods

Ordinationmethods based on a species responsemodel,
where the straight lines are supposed to best describe the
change of the species values along the ordination
axes

Nominal variable
(=factor)

Variable which has a non-quantitative character and
indicates exclusive classes to which individual observations
belong
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Ordination diagram Two-dimensional scatter diagram displaying, using symbols
and/or arrows, scores of objects of one or several types
(e.g. species, samples, environmental variables), enabling
an easier interpretation of themultivariate data sets,
summarized by an ordinationmethod. An important
property of the ordination diagram is that its two axes cannot
be arbitrarily rescaled in respect of one to the other

Permutation test Test of null hypothesis, where the obtained value of the test
statistic is compared with a constructed estimate of its
distribution under the validity of a null hypothesis. This
distribution is achieved by randomly permuting (‘shuffling’)
the sampling units (observations) in accordance with the
particular null hypothesis

Relevé Traditional term from vegetation science. It refers to a sample
describing vegetation composition (usually percentage cover
of individual plant species or estimate of this cover on
a semi-quantitative scale, e.g. the Braun–Blanquet scale)

Sample In this book, we use the term sample differently from its
usual statistical meaning (for simplicity and to keep its use in
line with the documentation for the CANOCO software). We
mean by sample one sampling unit (object, site, one row in the
datamatrix)

Scores These values represent coordinates of various types of entities
(sample scores, species scores, scores of environmental
variables) in the ordination space, calculated by the
ordinationmethod. They are used to create ordination
diagrams

SD units Represent the extent of variation along ordination axes
constructed by unimodal ordinationmethods. Correspond to
weighted standard deviation units

Species We refer by this term to the response (dependent) variables in
ordinationmethods (i.e. the columns in the primary data
matrix, the species datamatrix)

Species response
model

Refers to the fitted curve/line describing the assumed shape of
the change of values of the response variable (a population
size or percentage cover of a biological species, for example)
with the values of explanatory variables (including here
even hypothetical gradients, such as ordination axes from
unconstrained gradient analysis)
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Standardization Change of values of a variable, respecting a particular context;
for example, all the values of a particular variable are changed
using a shared transformation ‘recipe’ to achieve unit
variation or unit sum of the values. Standardization is, in
contrast to centring, performed by amultiplication or by
a division operation

Supplementary
species, samples,
env. variables

The species, samples, or environmental variable that were
not used during the calculations performed by the ordination
method. But based on the ordination results, we can project
them passively into the ordination space. Therefore, these
entities do not contribute to themeaning of the ordination
results, but their meaning is interpreted using those results

Transformation Transformation is, generally, a change of values of a variable,
using a parametric (functional) ‘recipe’. In this book, we refer
to transformation when the individual entries in a data table
are transformedwith an identical recipe, not varying across
samples or variables. Most often, monotonous
transformations are used (which do not change ordering of
transformed values), such as log or square root.

Triplot An ordination diagram containing three types of objects
(species, samples, and environmental variables, inmost
cases) where all three possible pairs can be interpreted using
the biplot rule (see also the definition of the biplot term)

Unimodalmethods,
Weighted averaging
methods

Ordinationmethods based on a species responsemodel,
where a symmetrical, unimodal (bell-shaped) curve is
assumed to best describe the change of the species values
along the ordination axes



Appendix C:

Overview of available software

The use of any multivariate statistical method even for small datasets
requires a computer program to perform the analysis. Most of the known sta-
tistical methods are implemented in several statistical packages. In this book,
we demonstrate how to use the ordination methods with possibly the most
widely employed package, Canoco for Windows. We also show how to use
the methods not available in CANOCO (clustering, NMDS, ANOVA) with the
general package Statistica for Windows. In the next paragraph, we provide
information on obtaining a trial version of the CANOCO program, which you
can use to work through the tutorials provided in this book, using the sam-
ple datasets (see Appendix A for information on how to obtain the datasets).
We also provide an overview of other available software in tabular form and
show both the freely available as well as the commercial software. The atten-
tion is focused on the specialized software packages, targeting ecologists (or
biologists), sowedonot covergeneral statistical packages suchasS-Plus, SASor
GENSTAT.
The Canoco for Windows program is commercial software requiring

a valid licence for its use. But we reached agreement with its distributor
(MicrocomputerPower, Ithaca,NY,USA),whowill provideyouonrequestwith
a trial version of the software, whichwill be functional for a minimum of one
month. You can use it to try the sample analyses discussed in this book, using
the data and CANOCO projects provided on our web site (see Appendix A). To
contact Dr Richard Furnas fromMicrocomputer Power, write to the following
E-mail address: trial@microcomputerpower.com.
Table 20-1 lists the main available packages, which can be used for some or

many parts of the multivariate analysis of ecological data, and their function-
ality is compared. We do not own all the listed programs, so the information
is often based on the data excerpted from their web pages. For most of them,
the authors or distributors reviewed and corrected the provided information.
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260 Appendix C: Overview of available software

The listsof featuresareactual asof July2002andmightnotbe fully correct.The
table is followedby footnotes explaining themeaningof individual rows. Then
we provide individual paragraphs for each of the listed programs, with con-
tact information for the distributing companies or individuals and also
additional comments, when needed. Five additional programs (CLUSTAN,
DistPCoA, NPMANOVA, PolynomialRdaCca, and RdaCca) are listed only
there, as their functionality is rather specialized. Question marks in
Table 20-1 imply that we do not know about this particular aspect of program
functionality.
There now follows the list of contact information for the individual produc-

ers of the software listed in Table 20-1. The information providedwas accurate
at the time of printing.

� ADE-4, is available from server of LyonUniversity

<http://pbil.univ-lyon1. fr/ADE-4/>
� CANOCO forWindows, version 4.5, is distributed byMicrocomputer
Power, USA, <http://www.microcomputerpower.com>
and by Scientia, Hungary <http://ramet.elte.hu/∼scientia/>

� CAP, version 2.0, is distributed by Pisces Conservation Ltd., UK
<http://www.pisces-conservation.com/>

� DECODA, version 2.05, is distributed by Anutech Pty. Ltd., Australia
<http://www.anutech.com.au/TD/DECODA WWW/welcome.html>

� ECOM, version 1.33, is distributed by Pisces Conservation Ltd., UK
<http://www.pisces-conservation.com/>

� MVSP, version 3, is distributed by Kovach Computing Services, UK
<http://www.kovcomp.co.uk/mvsp/index.html>

� NTSYSpc, version 2.1, is distributed by Exeter Software, USA
<http://www.exetersoftware.com/cat/ntsyspc.html>

� PATN is distributed by CSIRO, Australia
<http://www.cse.csiro.au/CDG/PATN/>

� PCORD, version 4, is distributed byMjM Software, USA
<http://www.pcord.com>

� PRIMER, version 5, is distributed by Primer-E Ltd., UK
<http://www.primer-e.com>

� TheR package, version 4, is available from Philippe Casgrain web site
<http://www.fas.umontreal.ca/BIOL/casgrain/en/labo/R/v4/>.
Please, note that this software’s name can be confused with themore
general statistical package R, which is a non-commercial version of the S /
S-Plus system (see also the Vegan package below).

� SYN-TAX, version 2000, is available from Scientia, Hungary
<http://ramet.elte.hu/∼scientia/>
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� Vegan, version 1.5.2, is an add-on package for the R statistical system
(<http://cran.r-project.org/>).
Vegan package is available from Jari Oksanen,
<http://cc.oulu.fi/∼jarioksa/softhelp/vegan.html>

� ViSTA, version 6.4, is available from Prof. Forrest Youngweb site
<http://forrest.psych.unc.edu/research/>

� CLUSTAN, version 5.0, is a package specialized in clustering and it
provides almost every known algorithm of hierarchical agglomerative
clustering (in addition to othermethods such as K-means clustering) and
calculation ofmany coefficients of (dis)similarity. It is available from the
Clustan company, UK <http://www.clustan.com>

� DistPCoA is a simple program calculating principal coordinates analysis
(PCoA) with optional correction for negative eigenvalues; it is also able to
calculate the startingmatrix of distances, using one of several available
distancemeasures. It is available from P. Legendre’s web site, at
<http://www.fas.umontreal.ca/biol/casgrain/en/labo/distpcoa.html>

� NPMANOVA is a programwritten byM.J. Anderson, and it calculates
a non-parametric multivariate ANOVA, based on a selected kind of
distance (dissimilarity) measure. It supports the two-way balanced
ANOVA designs only. It is available, together with other programs, at
<http://www.stat.auckland.ac.nz/∼mja/Programs.htm>

� PolynomialRdaCca is a simple program calculating both polynomial
and linear versions of redundancy analysis or canonical correspondence
analysis. It is available from P. Legendre’s web site, at
<http://www.fas.umontreal.ca/biol/casgrain/en/labo/plrdacca.html>

� RdaCca is a simple program calculating redundancy analysis or canonical
correspondence analysis. It is available from P. Legendre’s web site, at
<http://www.fas.umontreal.ca/biol/casgrain/en/labo/rdacca.html>
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Novotný, V. & Basset, Y. (2000): Rare species in communities of tropical insect herbivores:

pondering themystery of singletons.Oikos, 89: 564–572

Okland, R.H. (1999): On the variation explained by ordination and constrained ordination

axes. Journal of Vegetation Science, 10: 131–136



References 265

Oksanen, J. &Minchin, P. (1997): Instability of ordination results under changes in input

data order: explanations and remedies. Journal of Vegetation Science, 8: 447–454

Orloci, L. (1967): An agglomerativemethod for classification of plant communities. Journal
of Ecology, 55: 193–205

Orloci, L. (1978):Multivariate Analysis in Vegetation Research, second edition. TheHague:
W. Junk B. V.

Pielou, E.C. (1977):Mathematical Ecology. New York: J. Wiley.
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